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Introduction

IBM® Planning Analytics for Microsoft Excel is a Microsoft Excel-based tool that professional report
authors use to build sophisticated, multiple-sheet, multiple-query reports against multiple databases.

Audience

This guide assumes that you are familiar with IBM Cognos® products, such as IBM Cognos for Microsoft
Office, and IBM TM1°. You should also be familiar with Microsoft Office applications, such as Microsoft
Excel.

Finding information

To find product documentation on the web, including all translated documentation, access IBM
Knowledge Center (http://www.ibm.com/support/knowledgecenter).

Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited
vision, to use information technology products. IBM Planning Analytics for Microsoft Excel has
accessibility features. For information on these features, see the accessibility section in this document.
For more information about the accessibility features in IBM Planning Analytics for Microsoft Excel, see
Appendix B, “Accessibility features,” on page 293

IBM Cognos HTML documentation has accessibility features. PDF documents are supplemental and, as
such, include no added accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not
currently available may be included. No implication of any future availability should be inferred. Any such
references are not a commitment, promise, or legal obligation to deliver any material, code, or
functionality. The development, release, and timing of features or functionality remain at the sole
discretion of IBM.

Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any variation of the Sample
Outdoors or Great Outdoors names, GO New Stores, Planning Sample, and SData depict fictitious
business operations with sample data used to develop sample applications for IBM and IBM customers.
These fictitious records include sample data for sales transactions, product distribution, finance, and
human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values
is coincidental. Other sample files may contain fictional data manually or machine generated, factual data
compiled from academic or public sources, or data used with permission of the copyright holder, for use
as sample data to develop sample applications. Product names referenced may be the trademarks of their
respective owners. Unauthorized duplication is prohibited.

© Copyright IBM Corp. 2009, 2019 xi
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Chapter 1. What's new in IBM Planning Analytics for
Microsoft Excel

There are new features in IBM Planning Analytics for Microsoft Excel. For more information, see the IBM
Planning Analytics for Microsoft Excel documentation on the IBM Knowledge Center (http://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0).

2.0.39 - Feature updates, December 21, 2018

IBM Planning Analytics for Microsoft Excel was refreshed on December 21, 2018 to include bug
fixes.Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was
new in the previous release, see 2.0.38 - Feature updates, November 27th, 2018 (https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_38.html).

Fix list
To see the fix list for this release, go to http://www-01.ibm.com/support/docview.wss?
uid=swg27049597#20R39.

New API function for Quick Reports

As of 2.0.39, you can use the ReplaceWithFormats function to replace the MDX statement in a Quick
Report with another MDX statement. ReplaceWithFormats also has an option to preserve or destroy
the existing sheet formatting in the Quick Report.

To find out more, see ReplaceWithFormats(https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
r_coc_sdk_flexviews_replacewithformatting.html).

2.0.38 - Feature updates, November 27, 2018

IBM Planning Analytics for Microsoft Excel was refreshed on November 27, 2018 to include bug
fixes.Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was
new in the previous release, see 2.0.37 - Feature updates, October 26th, 2018 (https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_37.html).

Fix list
To see the fix list for this release, go to http://www-01.ibm.com/support/docview.wss?
uid=swg27049597#20R38.

2.0.37 - Feature updates, October 26, 2018

IBM Planning Analytics for Microsoft Excel was refreshed on October 26, 2018 to include bug
fixes.Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what's new
in the previous release, see 2.0.36 - Feature updates, September 26th, 2018 (https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_36.html).

© Copyright IBM Corp. 2009, 2019
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Fix list
To see the fix list for this release, go to http://www-01.ibm.com/support/docview.wss?
uid=swg27049597#20R37.

2.0.36 - Feature updates, September 26, 2018

IBM Planning Analytics for Microsoft Excel was refreshed on September 26, 2018 to include the following
features and bug fixes.Updates to each version of Planning Analytics for Microsoft Excel are cumulative.
To see what's new in the previous release, see 2.0.35 - Feature updates, July 27th, 2018 (https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_35.html).

Fix list
To see the fix list for this release, go to http://www-01.ibm.com/support/docview.wss?
uid=swg27049597#20R36.

First time double-click in a Quick Report
When you double-click in a Quick Report for the first time, you'll be presented with a helpful dialog box.

You can choose the behavior that occurs when you double-click in a Quick Report. This option is usually
set in the Options dialog box, but as of version 2.0.36, you'll be able to set this option the first time you
double-click in a Quick Report.

For more information on the double-click option in Quick Reports, see Double-click option(https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
t_coi_gt_strtd_quickreport_doubleclick.html).

The Set Editor is accessibility compliant

As of 2.0.36, the Set Editor is compliant with accessibility. Improvements to the Set Editor includes the
support for keyboard navigation and screen readers.

For more information on using keyboard navigation in the Set Editor, see Keyboard navigation(https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_ug_cor_accssblty keys_for_ms_office.html).

2.0.35 - Feature updates, July 27th, 2018

IBM Planning Analytics for Microsoft Excel was refreshed on July 27th, 2018 to include the following
features and bug fixes.Updates to each version of Planning Analytics for Microsoft Excel are cumulative.
To see what's new in the previous release, see 2.0.34 - Feature updates, June 22, 2018 (https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_34.html).

Fix list
To see the fix list for this release, go to http://www-01.ibm.com/support/docview.wss?
uid=swg27049597#20R35.

Save data in the viewer as a CSV file
You can save data in a relational drill through as a CSV file in 2.0.35.

To find out more, see Save a drill through(https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_pax_drill_through_save.html).
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Animated GIFs in the Options dialog
You can view short animated GIFs in the Options dialog, starting in 2.0.35.

IBM Planning Analytics for Microsoft Excel now includes animated GIFs, images, and short descriptions in

the Options dialog to help you define your settings. Simply hover over the L icon next to a setting to
reveal additional information.

To find out more, see IBM Planning Analytics settings(https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/c_coi_gt_strtd_set_planning_analytics.html).

New API function for Quick Reports
You can replace the MDX statement in a Quick Report with another MDX statement, as of 2.0.35.

To find out more, see Replace(https:/www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/r_coc_sdk_flexviews_replace.html).

New optimization preview for DBS, DBSW, and DBSS functions.

Starting in 2.0.35, you can preview a new optimization, which improves performance for when DBS,
DBSW, or DBSS functions are used against invalid elements or restricted access elements.

If you're using IBM Planning Analytics for Microsoft Excel version 2.0.35 or later with IBM Planning
Analytics version 2.0.5, you can preview a hew optimization for DBS, DBSW, and DBSS functions.

To enable the new optimization, follow these steps:
1. Create a new json file in a text editor.
2. Add the following line to the file:

¥ "r35_EnableCrJsonBatch" : truet}

3. Name the file tmlfeatures.

4. Save the tmlfeatures.json file to the C:\Users\[user name]\AppData\Local\Cognos
\Office Connection folder.

5. Restart Microsoft Excel.

2.0.34 - Feature updates, June 22, 2018

IBM Planning Analytics for Microsoft Excel was refreshed on June 22, 2018 to include the following
features and bug fixes.

Filter attributes in the Set Editor by using a drop-down

You can now filter attributes in the Set Editor by using a drop-down list. To learn more, see Search for
members in a set.

Cascading drill through

If your TM1 modeler defined multiple levels of drill processes or drill assignment rules for a TM1 cube,
view, or relational table that you're working with, you can successively drill through multiple levels in your
report. To learn more, see Insert a Cascading drill through.
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Simplified set editor

The set editor has been simplified so that you can create a new set quickly by selecting members in the
Current Set pane and clicking Replace and close. To find out more, see Create or edit sets (https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
t_cxr_editing_sets_new.html).

Improved Dynamic Report performance
As of Planning Analytics for Microsoft Excel 2.0.34, Dynamic Reports can leverage new APIs and servers
from Planning Analytics 2.0.4 to improve performance for complex reports.

To see the fix list, click here: http://www-01.ibm.com/support/docview.wss?uid=swg27049597

2.0.33 - Feature updates, May 18, 2018

IBM Planning Analytics for Microsoft Excel was refreshed on May 18, 2018 to include the following
features and bug fixes.

Add multiple Dynamic Reports

Adding multiple Dynamic Reports is a great way to view, analyze, and compare data. To learn more, see
Create Dynamic Reports

Insert a Dynamic Report section

Inserting a Dynamic Report section allows you to view, analyze, and compare multiple subsets that share
the same context on a sheet. To learn more, see Insert a Dynamic Report section

Set the undo stack limit

You can now limit the number of undo actions a user can perform in an Exploration View. To learn more,
see Settings in the CognosOfficeReportingSettings.xml file

To see the fix list, click here: http://www-01.ibm.com/support/docview.wss?uid=swg27049597

2.0.32 - Feature updates, April 24, 2018

IBM Planning Analytics for Microsoft Excel was refreshed on April 24, 2018 to include the following
features and bug fixes.

New API functions for Planning Analytics for Microsoft Excel

Create
Create generates an Custom Report based on the host system URL, server name, cube name, and
view name. To learn more, see Create (https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/r_coc_dsk_customreports_create.html).

CreateFromMDX
CreateFromMDX generates a Custom Report based on a host system URL, server name, and MDX
string. To learn more, see CreateFromMDX (https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
r_coc_sdk_customreports_createfrommdx.html).
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To see the fix list, click here: http://www-01.ibm.com/support/docview.wss?uid=swg27049597

2.0.31 - Feature updates, March 19, 2018

IBM Planning Analytics for Microsoft Excel was refreshed on March 19, 2018 to include the following
features and bug fixes.

Caption names for views, sets, and Turbo Integrator processes can now be displayed in Planning
Analytics for Microsoft Excel

If your views, sets, and Turbo Integrator processes have caption names (including localized caption
names), these can now be displayed in Planning Analytics for Microsoft Excel. For localized caption
names, ensure that models are localized in the IBM Planning Analytics TM1 database.

New API functions for Planning Analytics for Microsoft Excel

GetSpecification
Use the GetSpecification API call to return the MDX string that is used to build the current
Exploration View. To learn more, see GetSpecification (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
r_coc_sdk_explorations_getspecification.html).

Create
Create generates an Dynamic Report based on the host system URL, server name, cube name, and
view name. To learn more, see Create (https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/r_coc_sdk_dynamicreports_create.html).

CreateFromMDX
CreateFromMDX generates a Dynamic Report based on a host system URL, server name, and MDX
string. To learn more, see CreateFromMDX (https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
r_coc_sdk_dynamicreports_createfrommdx.html).

GetMDX
Use the GetMDX API call to return the MDX for theDynamic Report row. To learn more, see GetMDX
(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/r_coc_sdk_dynamicreports_getmdx.html).

FormatAreaVisible
Use the FormatAreaVisible API call to show and hide the formatting area in a Dynamic Report. To
learn more, see FormatAreaVisible (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/r_coc_sdk_dynamicreports_formatareavisible.html).

To see the fix list, click here: http://www-01.ibm.com/support/docview.wss?uid=swg27049597

2.0.30 - Feature updates, January 30, 2018

IBM Planning Analytics for Microsoft Excel was refreshed on January 30, 2018 to include the following
features:

Drill through to more detailed data

If the cube that you are working on contains drill processes or drill assignment rules, you can drill through
certain cells to detailed data. To find out more, see Drill through to detailed data (https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
t_pax_drill_through.html).
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Download Planning Analytics for Microsoft Excel directly from Planning Analytics Administration

You can now download and install Planning Analytics for Microsoft Excel from the Planning Analytics
Administration Configuration settings page. The three most recent versions of Planning Analytics for
Microsoft Excel are available for download.

For more details, see Download additional components (https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.tml1_prism_gs.2.0.0.doc/
t_paw_download_additional_components.html).

View Statements added to Custom Reports by default

When creating a Custom Report from a view, a View Statement is now added by default. The View
Statement improves the speed of TM1 Web and IBM Planning Analytics Workspace when opening a
Custom Report as a published web sheet.

Fix List
To see the fix list, click here: http://www-01.ibm.com/support/docview.wss?uid=swg27049597

2.0.29 - Feature updates, December 18, 2017

IBM Planning Analytics for Microsoft Excel was refreshed on December 18, 2017 to include bug fixes.To
see the fix list, click here: http://www-01.ibm.com/support/docview.wss?uid=swg27049597

2.0.28 - Feature updates, November 23, 2017

IBM Planning Analytics for Microsoft Excel was refreshed on November 23, 2017 to include the following
new feature and bug fixes.

Planning Analytics for Microsoft Excel now delays the creating of hidden sheets

The Planning Analytics for Microsoft Excel add-in now delays the creation of hidden sheets when a book is
opened or created. Hidden sheets are now only created when a user opens or creates a Planning Analytics
for Microsoft Excel book.

Fix List
To see the fix list, click here: http://www-01.ibm.com/support/docview.wss?uid=swg27049597
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Chapter 2. Getting started

IBM Planning Analytics for Microsoft Excel is a Microsoft Excel-based tool. Use Planning Analytics for
Microsoft Excel to build reports with data sources from IBM Planning Analytics.

You can also use data from IBM Cognos Analytics.

Planning Analytics for Microsoft Excel provides an interactive drag-and-drop environment for you to
explore and analyze data, helping you find answers to your important business questions.

You can also use Planning Analytics for Microsoft Excel to achieve the following goals:

« Find and focus on items that are important to your business.

Understand trends and anomalies.

Compare data, such as details to summaries, or actual results to budgeted results.

Assess performance by focusing on the best or worst results.

Share your findings with others.
« Multi-dimensional analysis and exploration of large data sources within a familiar Excel environment.

Before you begin

Before you use IBM Planning Analytics for Microsoft Excel, ensure that you accomplish the following
tasks.

Configure your anti-virus software

To run Planning Analytics for Microsoft Excel, you must first configure your anti-virus software to allow
connections from both Microsoft .NET Runtime and Microsoft Excel.

For more information, see Configure your anti-virus software in the Planning Analytics Local Installation
and Configuration documentation.

Set up connections for TM1 Rest APIs

Planning Analytics for Microsoft Excel uses TM1 REST APIs from the IBM TM1 Server. An administrator
needs to configure the HTTP port number in the IBM TM1 Server configuration files for each TM1 Server.

For more information, see Setting up connections for TM1 REST APIs in the Planning Analytics Local
Installation and Configuration documentation.

Internet browser requirements
Planning Analytics for Microsoft Excel requires Internet Explorer 11.

Upgrade existing workbooks

You need to update the original TM1 server connections to the Planning Analytics Workspace URI if you
have workbooks from earlier versions of Planning Analytics for Microsoft Excel. Update your connections
by editing the connections in the Options screen.

For more information, see “Update Connection URLs” on page 21.

Use the Update connection utility to update Exploration View and Quick Report connections.
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For more information, see “Utilities” on page 23.

Getting oriented

When you start Microsoft Excel, the IBM Planning Analytics tab opens in the ribbon. The IBM Planning
Analytics tab is your starting point for working with IBM TM1 data in Microsoft Excel. When you log on to
an IBM TM1 system and create reports, you see other user interface features for working with IBM TM1

data.

The IBM Planning Analytics for Microsoft Excel user interface includes the IBM Planning Analytics tab,

the IBM task pane, which contains a source tree and several commands.

This video demonstrates how to set up connections to servers

User interface
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Figure 1: IBM Planning Analytics for Microsoft Excel user interface

The following legend describes the areas that are referenced in the previous image:
1. IBM Planning Analytics tab

2. Overview area

3. IBM Task pane

4. Source tree

5. Work area
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IBM Planning Analytics tab

The IBM Planning Analytics tab in the ribbon displays commands for starting IBM Planning Analytics for
Microsoft Excel, logging on to IBM TM1 systems, setting options, opening reports that are published to an
IBM TM1 Server Application Folder, and other tasks.

Start Planning Analytics for Microsoft Excel by creating a new workbook in Microsoft Excel and opening
the IBM Planning Analytics tab.

IBM task pane
The IBM task pane consists of two tabs:

« The first tab contains the source tree and controls for opening data sources.

« The Workbook tab contains the components of the active workbook. For example, any Exploration
Views, Quick Reports or Dynamic Reports that the workbook contains are listed.

The IBM task pane opens when you start IBM Planning Analytics for Microsoft Excel. You can move and
resize the pane.

The source tree displays the data sources that you selected.

« For TM1 data sources, the tree displays the cube, with its associated dimensions, members, and levels.
The source tree also displays saved views and Turbolntegrator processes.

« For IBM Cognos Analytics packages based on dimensionally modeled relational (DMR) and OLAP data
sources, the source tree displays a dimensional view of your data. The tree is organized into dimensions,
hierarchies, levels, and measures.

- For IBM Cognos Analytics packages based on relational data sources, the source tree displays query
subjects, which are organized into lists of data items.

You can add objects to a report by dragging them from the source tree to a worksheet.

The names of the dimensions, levels, and members in a data source come from the model. It is the
responsibility of the modeler to provide meaningful names that you can use when you create reports.

Trouble: If the IBM Planning Analytics tab is not displayed on the ribbon, see “The Cognos Office
interface fails to initialize in Microsoft Office ” on page 274.

Overview area

The overview area is displayed when you are viewing an Exploration View or a list. Use the overview area
as a convenient place to quickly explore and change the contents of the Exploration View or list.

For Exploration Views, the overview area displays the Rows, Columns, and Context areas. You populate
the Exploration View with data by adding items from the data source to these areas. For example, you can
place a Department dimension in the rows and a Source dimension in the columns. The items that you
place in the context area are used to filter the values. For example, you can filter the Exploration View to
display data for a specific year by selecting a year in the Time dimension. Each box in the rows, columns,
and context area represents a set of data in the data source.

Work area
The work area is a Microsoft Excel worksheet where you create and view reports.

When you create a new Exploration View or list, the work area displays a visual guide to help you build the
report. Drop zones show you where you can drag items from the source tree to create the report. You can
change, limit, or expand the items that you see in an Exploration View by using techniques such as
filtering and drilling, to quickly focus on the most significant items on your worksheet.
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If you want to use a more flexible report layout, rather than visual guides, you can create other types of
reports such as Quick Reports, Dynamic Reports, and Custom Reports.

Show or hide the IBM Planning Analytics ribbon

When you start IBM Planning Analytics for Microsoft Excel, an IBM Planning Analytics tab is displayed in
the ribbon. You can hide this tab if you decide to resume work on non-IBM TM1 workbooks and want to
show only Microsoft Excel commands and buttons.

Procedure

1. To hide the IBM Planning Analytics tab in Microsoft Office 2010 or 2013, click File, Options, and then
Customize Ribbon.

2. Under Customize the Ribbon, clear the IBM Planning Analytics check box.

3. Click OK.
To hide the IBM Planning Analytics tab in earlier versions of Microsoft Office, click Tools > Customize.
« To show or hide the IBM pane, select or clear the IBM check box.

- To show or hide the IBM Planning Analytics tab, select or clear the IBM Cognos for Microsoft
Office check box.
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Report types

IBM Planning Analytics for Microsoft Excel offers you the flexibility to create various report types, from
simple lists and Exploration Views to complex formula-based reports.

The report types that you can use depends on whether you are using an IBM TM1 data source or an IBM
Cognos Analytics package.
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Figure 2: Report types

You can create an Exploration View that shows sales by product line and then create a Quick Report that
shows budget projections by product line. You can then create Microsoft Excel calculations that reference
cells in the two reports.

If you have both TM1 and IBM Cognos Analytics available, you can create workbooks that contain both
TM1 and IBM Cognos Analytics reports.

You can also combine TM1 and IBM Cognos Analytics data in a single report by using formulas.

For example, you can create a Custom Report that uses a IBM Cognos Analytics package, add TM1
formulas, and then use the IBM Cognos Analytics and TM1 data in Microsoft Excel calculations.

Notes for IBM TM1 Perspectives users

If you are coming from using IBM TM1 Perspectives, you will notice some differences and improvements
in IBM Planning Analytics for Microsoft Excel.

Note: Some features might not work if Planning Analytics for Microsoft Excel and IBM TM1 Perspectives
are enabled concurrently in Microsoft Excel.

Features not implemented in Planning Analytics for Microsoft Excel
Some TM1 Perspectives features are not implemented in Planning Analytics for Microsoft Excel:

« Modeling is not available. Instead, use a modeling tool, such as IBM Cognos TM1 Performance Modeler
to create and maintain models, applications, and security permissions.

« The TM1 macro functions are not available. Instead, you can use the IBM API.

« The following methods to spread data are not available: Relative Proportional Spread, Relative Percent
Adjustment.

- Dynamic Reports are supported in Planning Analytics for Microsoft Excel, except for cell and password
protection.

 User defined consolidations are not available. This includes the usage of DBRW worksheet functions
that use subset names as a dimension element reference.

« Holds in formula reports are not visible in Planning Analytics for Microsoft Excel.

« Referencing non-default hierarchies is not supported in formula or legacy reports. The default hierarchy
must be the same-named hierarchy.
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The differences in implementation
Some TM1 Perspectives features are implemented differently in Planning Analytics for Microsoft Excel:

- Instead of slicing from the Cube Viewer into an Excel worksheet, in Planning Analytics for Microsoft
Excel you can right-click a view and insert it as the type of report you want. If you want to manipulate
the view first, insert it as an Exploration View, manipulate the view, and then convert it to the type of
report you want.

- When you refresh a Dynamic Report, the formatting is updated only if the number of rows in the data
area was changed or if a value in the ID column of the format range was changed. Otherwise, rebuild the
Dynamic Report (ALT+F9) to update the formatting. In TM1 Perspectives, the formatting is updated
when you recalculate (F9) a Dynamic Report.

« When you rebuild a Dynamic Report, rows and columns are inserted or deleted from the existing rows or
columns. In TM1 Perspectives, all rows and columns are deleted and then re-added.

« In Dynamic Reports, any change to the header row (the row with the TM1RPTROW formula) of the
report requires you to recreate the report. For example, if you change the formula or add a column, you
must re-create the Dynamic Report to see the results.

« In Dynamic Reports with nested rows, the member names in the nested rows are not grouped. Instead,
the member names are repeated.

« Zero suppression is done based on the column tuples that are present. In TM1 Perspectives, zero
suppression is done based on the product of the members of each dimension on the column (symmetric
column).

- Writeback mode for formulas is enabled by default in the Planning Analytics for Microsoft Excel
configuration file.

« A blank dimension element in a DBRW argument is displayed as an empty result in TM1 Perspectives,
but is displayed as #VALUE in Planning Analytics for Microsoft Excel. This difference is because Planning
Analytics for Microsoft Excel returns a true error response to an invalid element, which is displayed as
#VALUE. For information on how to correct a #VALUE error, see https://support.office.com/en-us/
article/how-to-correct-a-value-error-15e1b616-fbf2-4147-9c0b-0all1a20e409%e.

« The DBRA function is currently read-only in Planning Analytics for Microsoft Excel. If you are using
DBRA functions for write back in TM1 Perspectives and you want to perform write back in Planning
Analytics for Microsoft Excel, you can to use the DBRW function against
the }ElementAttributes_DimensionName control cube in Planning Analytics for Microsoft Excel
instead. Alternatively, you can write back using the control cube in an Exploration View or a Quick
Report.

The benefits of using Planning Analytics for Microsoft Excel
Using Planning Analytics for Microsoft Excel includes the following benefits:

« Planning Analytics for Microsoft Excel reports are designed to work even in a wide area network
environment, without the need for Citrix.
- Planning Analytics for Microsoft Excel offers the following improvements to formulas:
— DBRis equivalent to DBRW and DBS is equivalent to DBSW. DBR, DBRW, DBS, DBSA, and DBRA are
optimized to reduce network traffic and improve performance on wide area networks.

— If a SUBNM formula references a set, a drop-down arrow is displayed when you click the SUBNM cell.
You can use the drop-down list to select a different member in the set. You must be logged on to the
TM1 server to use this feature.

— The TM1USER function returns the user name, not the internal CAMID.

« You can copy and paste values multiple times in Planning Analytics for Microsoft Excel. In TM1
Perspectives, you can copy only one time, and then the clipboard is empty. You can also copy and paste
values across multiple cells in Planning Analytics for Microsoft Excel.
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 Planning Analytics for Microsoft Excel uses named styles, which means you can customize the
appearance of your reports easily.

 Reports that you open from the Application folder on an IBM TM1 server open with their actual names
and not a generated random name.

Enable trust access to the VBA project object model

Trust access to the VBA project object model is required for IBM Planning Analytics for Microsoft Excel.
Macros developed for IBM Planning Analytics for Microsoft Excel may not work properly if trust access to
the VBA project object model is not granted.

Procedure

. Start Microsoft Excel.

. Open a workbook.

. Click File and then Options.

. In the navigation pane, select Trust Center.

. Click Trust Center Settings....

. In the navigation pane, select Macro Settings.

. Ensure that Trust access to the VBA project object model is checked.
. Click OK.
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Results
Trust access to the VBA project object model will be granted for IBM Planning Analytics for Microsoft
Excel.

Open an IBM TM1 Perspectives workbook
You can open an IBM TM1 Perspectives workbook in IBM Planning Analytics for Microsoft Excel.

About this task
Before you open a TM1 Perspectives workbook, note the following points:

« If you open a workbook on a IBM Planning Analytics and convert it, you must publish the converted
workbook to make it available on the server.

- If the workbook contains action buttons, you are asked if you want to upgrade them. If you choose to
upgrade them, a backup copy of the workbook is saved, and then an upgrade process runs.

« You cannot edit or use an action button that was created in TM1 Perspectives unless you covert it.
- Background images are not maintained.

« Cells with an invalid parameter reference in TM1 Perspectives return a *key_exr notification. Cells
with an invalid parameter reference in Planning Analytics for Microsoft Excel will display #VALUE.

« Cells with a blank parameter reference in TM1 Perspectives are displayed as blank cells. Cells with a
blank parameter reference in Planning Analytics for Microsoft Excel will display #VALUE.

Procedure

1. Start Microsoft Excel.
. Open a TM1 Perspectives workbook.
. If you are prompted to convert action buttons, select an option and click OK.

. If you are prompted for the host, either select a TM1 system from the list or type the system URL, and
then click OK.

A N

The format of the URL is http://[sexver]: [port number], for example http://
myserver:9510

5. Log on to the TM1 server.
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Results
The report is displayed in IBM Planning Analytics for Microsoft Excel. The formulas in the report reference
the TM1 system that you specified.

Upgrade IBM TM1 Perspectives action buttons

This setting upgrades IBM® TM1° Perspectives action buttons to allow them to be used in IBM Planning
Analytics for Microsoft Excel.

About this task

Upgrading IBM TM1 Perspectives action buttons allows them to be used in IBM Planning Analytics for
Microsoft Excel. When upgrading action buttons, note the following points:

« Trust access to the VBA project object model must be granted in Microsoft Excel. See “Enable trust
access to the VBA project object model” on page 13.

You must have a TM1 Perspectives workbook that contains one or more action buttons.
- An administrator may upgrade action buttons in public and private workbooks.
« A non-administrator may only upgrade action buttons in private workbooks.

Once action buttons are converted for use in IBM Planning Analytics for Microsoft Excel, they will no
longer work in TM1 Perspectives. It is recommended that a backup of all TM1 Perspectives workbooks
is created before upgrading action buttons.

Procedure

1. On the IBM Planning Analytics toolbar, click Options ©*.

2. In the navigation pane, click IBM Planning Analytics.

3. Under Action Button Settings, click Upgrade Action Buttons.
4

. Optional: Under Backup Excel Files, click Browse and define a backup directory. This step will create
a backup of the TM1 Perspectives workbooks.

5. Under Conversion Log, click Browse and define a log directory.
. Click OK.

7. Using the drop down menu, select the system that contains a TM1 Perspectives workbook that needs
to be upgraded.

8. Select the server that contains a TM1 Perspectives workbook that needs to be upgraded.

9. Select a TM1 Perspectives workbook that contains the action buttons that need to be upgraded.
10. Click Upgrade.
11. Click OK.

o

Results
A dialog will indicate the number of files upgraded. In this instance, a file is a workbook that has had
action buttons within it upgraded for use in IBM Planning Analytics for Microsoft Excel.

Tip: By selecting the parent server or folder to upgrade, you can upgrade action buttons in multiple TM1
Perspectives workbooks.
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Chapter 3. Connecting to datasources

Connect to IBM Planning Analytics

You can connect to an IBM Planning Analytics datasource that is configured to be accessible from IBM
Planning Analytics Workspace local version 2.0.0 or later.

Users

If you are a user in IBM Planning Analytics for Microsoft Excel, you can use a Planning Analytics
datasource to do the following tasks:

« Create reports

« Open workbooks that are published on a TM1 Server Application Folder
« Explore data in a model or package

« Save your data and work locally

« Publish your workbooks to a TM1 Server Application Folder

« You can also modify data. For example, if your administrator distributes an enterprise-wide budget plan,
you can use IBM Planning Analytics for Microsoft Excel to create an Exploration View to review, analyze,
and update the portion of the plan that is assigned to you

Modelers

If you are a modeler in Planning Analytics Workspace, you can publish your models to a Planning
Analytics datasource. You can also include TurboIntegrator processes in the model and then use them in
IBM Planning Analytics for Microsoft Excel.

Administrators

If you are an administrator in Planning Analytics Workspace, you can use the Planning Analytics
Workspace Administration tool to configure the Planning Analytics URIs and authentication servers.

Connect to IBM Cognos Analytics

You can explore data that is published to an IBM Cognos Analytics server.

For IBM Cognos Analytics systems, the packages that you use to generate explorations are based on
models that are created in a modeling tool, such as Framework Manager.

A modeler uses a modeling application, such as Framework Manager, to create a package. A package can
be based on relational, dimensionally modeled relational (DMR), or OLAP data sources. A relational
package presents query subjects, which are organized into lists of data items. DMR and OLAP packages
present a dimensional view of data. The data in these packages is organized into dimensions, hierarchies,
levels, and measures. The modeler publishes the package to an IBM Cognos Analytics server, which you
can then access in IBM Planning Analytics for Microsoft Excel.

To work with IBM Cognos Analytics packages, you connect to an IBM Cognos Analytics server and then
select a package. You can use the package to create your own reports. You can also open and download
reports that are published to IBM Cognos Connection. You can explore the data and save your work
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locally. You can also publish your workbooks to IBM Cognos Connection or to an IBM Cognos studio to
share them with other users.

Set up a connection to a datasource

Access and share content by setting up your connections to a datasource.

A connection to an IBM Cognos Analytics system provides access to relational, OLAP, and dimensionally
modeled relational (DMR) packages. If you have a connection to an IBM Cognos Analytics system, you can
also open a report from IBM Cognos Connection and publish a Microsoft Office document to IBM Cognos
Connection.

You need to set up a connection to an IBM Planning Analytics Workspace URL if you want to access IBM
Planning Analytics datasources and share content.

You can use only datasources that were previously created and published to IBM Planning Analytics or
IBM Cognos Analytics. For more information about creating datasources, see the IBM Cognos TM1
Performance Modeler or the IBM Cognos TM1 Operation documentation.

For more information about creating Cognos BI packages (also known as IBM Cognos Analytics
packages), see the Framework Manager User Guide.

This video demonstrates how to set up a connection to a datasource

Before you begin

Contact your administrator for the URLs you'll need to connect to a datasource. The URL identifies the
location of the datasource.

« Example URL for an IBM Cognos Analytics system:
http://server_name/ibmcognos/cgi-bin/cognos.cgi

Do not use localhost to refer to the local computer that the IBM Cognos Analytics (IBM Cognos BI)
gateway is running on. By using localhost, the information sent to the server is routed back to the local
computer. As a result, requests to the report server will fail when importing prompted reports.

« Example URL for a IBM Planning Analytics Workspace datasource:

http://<IP of the system / system name>

Procedure
. Open the IBM Planning Analytics ribbon.

. Click Options to open the Options dialog box. &

. In the navigation pane of the Options dialog box, click IBM.

. Click Add to create a new connection to a datasource.

. In the Datasource Type box, select the datasource.

. In the Connection URL box, enter the URL provided by your administrator.
. In the Friendly Name box, enter a name for your new connection.

. Click Test Connection to test if the URL that you entered is live.
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If the connection fails, contact your administrator to verify the connection information.
9. Click Save.

Results

The saved connections appear in the IBM connections list and the friendly name appears in the Connect
drop-down on the ribbon.
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Log on to a datasource

To use a datasource as an authenticated user, open and log on to the datasource that contains the model
or package that you want to use.

Procedure

. Open the IBM Planning Analytics ribbon.

. Click Connect.

. Select the datasource that contains the model or package that you want to use.

. If there is more than one namespace, select a Namespace.

. Enter your User Name and Password, and then click Login.

. If the Select Package dialog box is displayed, select a server or package, and then click OK.
The Select Package dialog box is displayed if IBM Planning Analytics is running.
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Results
You are logged on to a datasource as an authenticated user. If you work in more than one datasource, you
can also be logged on to multiple datasources at the same time.

Open a model or package

Models and packages contain data that you can use to generate your reports. This topic guides you
through how you can open a model or a package from IBM Planning Analytics for Microsoft Excel.

For those using IBM Cognos Analytics systems, the packages that you use to generate reports are based
on models that are created in a modeling tool, such as Framework Manager. A model is a set of related
objects, such as query subjects, dimensions, filters, and calculations. Packages can be either relational or
dimensionally modeled datasources. Dimensionally modeled datasources can be rendered by using either
lists or Exploration Views.

Before you begin

Before you can open a model or package, check with your administrator to ensure that you have the
correct security permissions to the datasource containing the model or package.

Procedure

1. Open the IBM Planning Analytics ribbon.
2. Click Task Pane.

3. In the Task Pane, click & Open.
4. Select the datasource that contains the model or package that you want to use.
If you selected a BI system, log on to the system.
5. Select the model or package that you want to use.
6. If prompted, log on to the datasource.
7. For IBM Planning Analytics datasources, you can choose to show control objects and processes. Click

-

the control and processes icon and select your preferred option.

Results
Objects from the selected model or package, such as data items, appear in the source tree.
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Refresh a datasource, model, or package

Perform a refresh in the Task Pane to get the most recent version of the datasource, model, or package.

If something new was added to the datasource, model, or package that you're working on, you might not
see it in the Task Pane until you refresh. You can refresh in two ways:

- To refresh a model or package, right-click the highest level node in the Task Pane, and then click
Refresh.

« To refresh a datasource, click the refresh icon in the Task Pane.

Change the datasource and datasource type

You can change the datasource and datasource type that is used by a report.
Refer to the following topics:

« For Exploration Views or lists, see “Change the cube or datasource used by an exploration” on page
73.

« For Quick Reports, see “Change the cube and datasource used by a Quick Report” on page 80.

« For TM1 formulas and Custom Reports, see “Change the cube and datasource of Custom Reports” on
page 91.
« For Dynamic Reports, see “Change the model and cube used by a Dynamic Report” on page 86.

« For Custom Reports using IBM Cognos Analytics data, see “Change the server and package used by a
Custom Report” on page 169.

Open and download workbooks

You can open workbooks that are published to an TM1 Server Application Folder.
You can also download workbooks from IBM Cognos Connection.

To refresh your data or make enhancements, you can open or download published Microsoft Excel
workbooks and then use Microsoft Excel to make changes.

You can also open locally saved workbooks.

Note: If your workbook is in the xslb file format, you must be connected to the datasource that it is in
before you open the book.

If you are opening a workbook from an earlier version of a IBM Planning Analytics for Microsoft Excel, any
custom properties settings that were specified for the workbook is applied to the settings in the Options
dialog box.

For example, if a workbook from an earlier version of a Planning Analytics for Microsoft Excel is opened,
the address for the gateway might appear in the list of addresses under IBM connections, in the Options
dialog box.

Opening workbooks from the TM1 Server Application Folder

The TM1 Server Application Folder is a content store inside each of your models. You can store the
workbooks that you create or modify on the TM1 Server Application Folder. You can use the TM1 Server
Application Folder to share a report with a report author who is working in a different environment. You
can also save those workbooks on your computer or to a source code-controlled directory on a local
network or drive.
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Before you begin

Before you can open a workbook from the TM1 Server Application Folder, ensure that the following
statements are true:

« Workbooks are published to a public folder on a TM1 Server Application Folder.
« The datasource URL where workbooks are published is added to your list of connections.
« You know the name of the TM1 Server Application Folder where workbooks are published.

Procedure
1. Click the IBM Planning Analytics tab.

2. In the ribbon, click Open

3. In the Open dialog box, select the datasource connection that contains the workbook that you want to
open.

4. Select the model that contains the workbook that you want to open.
5. If prompted, log on.
6. Navigate to the folder that contains the workbook you want to open.

Tip: To return to the list of models in the datasource, click Servers.
7. Click the workbook, and click Open.

Results
The workbook opens. You can make changes, manipulate data, and publish it to TM1 Server Application
Folder for sharing.

Open a report from IBM Cognos Connection

You can store the reports that you create or modify on the IBM Cognos Analytics server. You can also open
and save those reports on your computer. This is useful if you want to send a report to a report author who
is working in a different environment, or you want to save the report to a source code controlled directory
on a local network or drive.

Folders in IBM Cognos Connection are logically labeled and organized to help you locate reports. Entries
in Public Folders are of interest to and can be viewed by many users. Entries in My Folders are accessible
by you only when you are logged on.

If you are working from IBM Cognos Connection, you can also download a Microsoft document and open it
in the application that was used to create it.

Before you begin

You must have write access to a folder to create entries.

Procedure

1. On the IBM Planning Analytics toolbar, click Open
2. Select the server that contains the report that you want.
3. Choose the type of folder in which the report is saved:
« To view files in public folders, click Public Folders.
« To view only your files, click My Folders.
4. Click the report that you want, and click OK.
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Results
The report appears in your workbook, slide, or document. You can make changes and manipulate data,
and publish it to IBM Cognos Connection for sharing.

Open a workbook containing Planning Analytics for Microsoft Excel styles

About this task

Note: Opening a workbook with Protected View enabled may prevent Microsoft Excel from loading
Planning Analytics for Microsoft Excel styles. In order to ensure that Microsoft Excel loads Planning
Analytics for Microsoft Excel styles in a workbook with Protected View enabled, you should:

Procedure

1. Save the workbook with Protected View disabled.

2. Close Microsoft Excel.

3. Open the workbook and launch Planning Analytics for Microsoft Excel.
4. Enable Protected View and save the workbook.

5. Close Microsoft Excel.

Download a workbook from IBM Cognos Connection

You can download a Microsoft Excel workbook from IBM Cognos Connection if it was published in one of
the IBM TM1 applications, such as IBM Planning Analytics for Microsoft Excel.

You can download documents created in Microsoft Excel, Microsoft PowerPoint, and Microsoft Word. The
default action for any Microsoft Office document is to download it.

For more information, see the IBM Cognos Analytics Administration and Security Guide.

Before you begin

You must have read and traverse permissions to access Microsoft Office documents in IBM Cognos
Connection.

Procedure

1. In IBM Cognos Connection, locate the workbook that you want to open.
2. Click more on the actions toolbar next to the document that you want to download.

The IBM Cognos Connection Actions page opens.

3. For a Microsoft Excel workbook, click View most recent document in Excel @

The File Download window appears.
4. Click Save and follow the prompts that appear.

You must save the workbook before using it with IBM Planning Analytics for Microsoft Excel.

Results
You can now perform the same actions that you would perform for any workbook.
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Chapter 4. Settings

You can set options that apply to IBM Planning Analytics for Microsoft Excel.

You can also set options that apply to specific explorations. For more information, see “Set properties” on

page 72.

IBM settings

Start application
You can choose the startup application. Click the application icon that best meets your needs.

Procedure

1. On the IBM Planning Analytics tab on the ribbon, click Options .
2. In the navigation pane, click IBM.

3. Choose the startup application.

4. Click OK.

Update Connection URLs
If the URL of an IBM system changes, you can edit the information to use the new URL.

Editing the URL updates the saved connection for the IBM Planning Analytics for Microsoft Excel
application, but not the connections for the reports in the workbook. To update the connections for
Exploration Views or Quick Reports in an open workbook, use the Update connection utility. For more
information, see “Utilities” on page 23.

About this task

When running this command, the name of the data source or package remains the same. You can use this
command to change only one server, such as a test server to another server, such as a production server.

You choose the URLs from the list of systems that you enter in the IBM connections section of the
Options dialog box.

Procedure

1. Open the file you want to update.

2. On the IBM Planning Analytics tab, click Options .
The Options dialog box is displayed.

. In the navigation pane, click IBM.

. Select the system you want to update and click Edit.

. Select the Datasource type.

. Type the new Connection URL in the field.

. Update the Friendly name field as required.

. Test the connection and click save.

. Click OK.
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Results
The open IBM enabled files are searched and the server information is updated.
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Set up forms-based user authentication

Forms-based authentication is not supported for connections to IBM Planning Analytics servers, it is only
supported for connections to IBM Cognos Analytics servers.

If your company uses Web-based access management software, such as SiteMinder, to provide single
signon in your security infrastructure, you must enable forms-based authentication. The forms-based
authentication service allows you to enter your credentials, such as your user name and password,
through a form on a Web page. If the credentials are valid, you are logged on to the site. The credentials
persist until you explicitly log off.

Procedure

1. On the IBM Planning Analytics tab, click Options .

2. In the navigation pane, click IBM.

3. Under Authentication, select the Enable forms based authentication check box.
4. Click OK.

Logging
A log file is an important diagnostic tool for investigating the behavior of applications. It can help you
troubleshoot problems by recording information about the environment, exceptions, and entry and exit
functions.

You can specify whether information is logged and at what level of detail. By default, log activities are
saved to the user_root_directory.

Enable logging if you are attempting to troubleshoot unexpected behavior. In this situation, the support
staff will want a copy of the entries in the log file.

Writing to log files may result in performance degradation.

Procedure

1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM.
3. Under Logging, select the Log level.
« To turn logging off completely, click None.
« Torecord only critical issues and events in the log, click Critical.
 To record errors as well as critical issues and events, click Error.
 To record warnings as well as errors and critical issues and events, click Warning.
« To record information as well as warnings, errors, and critical issues and events, click Information.
 To record all events and issues, even routine items, click AlL
4. Click OK.
The log file is created in 8APPDATA%\Local\Cognos\Office Connection\Logs.

The naming format for log files is yymmdd_hhmmss . txt.

Results

The next time that you start the application, activities and information about the environment are logged
in the file. From the Options dialog box, click the View logs button to open the folder that contains the log
files.

Cache management
You can reduce the file size of a workbook by clearing the cache.

22 IBM Planning Analytics: Planning Analytics for Microsoft Excel



About this task

For each workbook that you open or create during or after logging on, a cache worksheet is created. This
worksheet holds information about the data that needs to be rendered. You can clear the cache of
packages used in workbooks that use Planning Analytics for Microsoft Excel. Clearing the package cache
reduces the size of the workbooks by deleting unused data and metadata associated with formulas. The
Clear Cache button works for all the data sources and packages defined in Planning Analytics for
Microsoft Excel. After you clear the cache, you must save workbooks to see a reduction in file size.

Clear the cache when workbook size matters or when it is not necessary to store report results for faster
processing times. If the size of your workbook is too large due to extensive data, the clear cache function
reduces the size of the workbook. However, there is a trade-off: the processing time for populating the
workbook with data increases because the data must be retrieved from the IBM TM1 server instead of
relying on the data that is saved in the cache.

Alternatively, you can specify to clear the local cache of retrieved data each time that you save the
workbook or save the workbook with a new file name. You can do this by selecting the Clear cache on
save check box.

You can also automate the process for clearing the cache. For more information, see “ClearCache” on

page 194.

Procedure

1. Start Planning Analytics for Microsoft Excel.

2. Open a workbook.

3. From the IBM Planning Analytics tab, click Options and then click IBM.
4. Under Cache Management, choose how you want to clear the cache:

« To clear the local cache for the active workbook, click Clear Cache.

The cache is cleared and the size of the workbook is reduced. You can now open and save additional
workbooks. To avoid creating a cache worksheet for non-IBM TM1 workbooks, you must exit
Microsoft Excel.

« To clear the local cache each time that you save a workbook, or save a workbook with a new file
name, select the Clear cache on save check box.

Note: Data displayed in the workbook is cleared only when using the Clear All Data button < on
the IBM Planning Analytics tab.

5. Click OK, and then save the workbook.

Utilities
The Update connection utility updates the connections for Exploration Views or Quick Reports in an open
workbook.

Procedure
1. Open the file containing the reports that you want to update.
2. On the IBM Planning Analytics tab, click Options ©.
The Options dialog box is displayed.
. In the navigation pane, click IBM.
. Scroll to the Utilities section and click Update connection utility.
. Select the connection that you want to upgrade from in Old connection.
. Select the new connection and click OK.
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. Choose whether you want to refresh the data in the report. If you select Yes, then determine whether
you want to refresh just the data, or the data and report formatting.

8. After you have made your selection, you are prompted to log onto the server on the new connection.
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9. Refresh your workbook to complete the update.

IBM Planning Analytics settings

Application settings

Load recently used data source or package
This setting automatically loads the most recently used data source or package when you start IBM

Planning Analytics for Microsoft Excel.

About this task

If you usually work with the same data source or package, you can automatically load the most recently
used data source or package when you start IBM Planning Analytics for Microsoft Excel. This is most
useful when you use the data source or package regularly and you want an easy way to access it so that
you can quickly begin or resume work.

If the most recently used data source or package is inaccessible or missing, no source tree is shown.
Select another package to replace the missing one.

Procedure

1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Application settings, select the Load most recently used system and package check box.

4. Click OK.

Member display count limit
This setting defines the number of members shown in the source tree, drop zones, and search results.

About this task
You can limit the number of members shown in the Task Pane.

For IBM Cognos Analytics packages, this setting applies to dimensionally modeled data. It does not apply
to relational packages.

Procedure

1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.

3. If you want to limit the number of members shown in the source tree and in the search result dialog
box, under Application settings, in the Member display count limit box, type the maximum number
of members that can appear in the source tree before showing the More or Search option.

4. Click OK.
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Results

Member display count limit: 7
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Default expand direction

This setting defines the expand direction when you double click on a consolidated cell in an Exploration
View or list view.

About this task

Using this setting, you can define which direction your Exploration View or list expands when double
clicked. You can set the default to expand either above or below.

Note: This setting will only apply to new explorations created using dimensions after the option is
enabled. This setting will not apply to explorations which have already been created.

You can set your Exploration View or list to expand in the following directions when double clicked:
Expand Above

Double-clicking a consolidated member expands the children above their parent.
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1 Nuarter | 2 Ouarter 3 Ouarter |4 OQuarter.  Year

Scandinavia _| (1,346) (111) 481 802 (373)
Benelux I 3,292 3,632 3,511 (904) 2,047
Islands (8.158) 2373  |[6,995) 4,332 (8,048)
Central Europe [23,496) 15,522 9,005 16,175 17,207
Iberia {3,076 (606) (1,920) 2,443 (3,160)
Southern Europe (7,325) B.755 6,391 6,253 14,074
turaope |46, 792) 19,964 10,474 29,100 212,190
North America |-'H.-'I.H- 17.098 4,029 26,157 an7
South America (1,980 276 (1,475) 2,011 132
Americas [49,457) 17,974 2,553 29,668 739
World [96,249) 47,439 13,027 58,768 22,985

Expand Below

Double-clicking a consolidated member expands the children below their parent.

Year 1 Quarter 2 Quarter 3 Quarter 4 Quarter

World 22,985 (96,249) 47,439 13,027 58,768
Eurcpe 22,246 (46,7912) 29,464 10,474 29,100
Seandinavia (273) [1,446) (211) a8 202
Benelux 2,047 [3,292) 3,632 3.511 {904)
Islands [8,448) |8,158) 2,373 |6,995) 4,332
Central Europe 17.207 [23.496) 15,522 9,005 16,175
Iberia (3,160) |3,076) (606) [1,920) 2,443
Southern Europe | 14,074 :?.U"n:l 8,755 6,391 6,253

]— Americas ! 739 [49,457) 17,974 2,553 29,668
North America 407 (47,477) 17,098 4,029 26,757
South Amerira 332 |1,980) 276 (1,475) 2011

Procedure

1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.

3. Under Application settings, use the drop down below Default expand direction to select the default
expand direction.

4. Click OK.

Hide commit confirmation
This setting disables the confirmation prompt, which appears before a commit is performed.

About this task

Disable the confirmation prompt which appears before a commit is performed. Committing a change in a
worksheet will result in a confirmation prompt which appears before the commit is performed. This
setting will disable the confirmation prompt.

Procedure

1. On the IBM Planning Analytics tab, click Options &,

2. In the navigation pane, click IBM Planning Analytics.

3. Under Application settings, select the Hide commit confirmation check box.
4, Click OK.
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Results

Unselected
1BM
== | plan_chart_of_accourts plan_time ~—~ |plan_report plan_business_unit plan_department plan_exchange_rates
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c21 - f
A B & D E F G H 1 J -
1 " 2003 IBM
12 Sales 3,218,170,356 GO Auto
13 Other Revenue 1,696,881,203
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PAX Pl Sampl
15| Direct Costs 787,152,080 ,aml""g ;":: ¢ ‘
16| Other Costs 626,540,051 1BM Framework for Microsoft Office == A
17| cos e W# plan_BudgetPlanLineltem
ch — Do you want to commit changes to the database? ¥ plan_Control
18 Bank Charges 21,257,735 i Prviw arvies -&# plan_ExchangeRate
19 Board of Directors 17,355,870 plan_Report
20 Employee Relations 17,289,516 | Views
21 Printing 23,432,423,423 G- 2003 LY Actual
22 Seminars & Continuing Ed. 20,367,078 wﬁ, 2003 LY Budget
23 Taxes & Licenses 21,051,161 [~ ¥ " G- 2004 Budget v LY Actual
DI D G 8% 2004 LY Actual Budget
24 Office Expense 21,570,834 @---i; 2004 submitted budget
. Postage 21,166,001 i
= Rent % actual_budget_variance
b e - LTSRS [5-#& ExBudgetAatual
27 Repairs & Maintenance 21,602,747 -8 LY 2004 Actuals
28 Telephone 14,872,197 ¥~ pian_budget_input_ly_actug
29 Utilities 20,875,674 [-i4 zero_out_2003_actuals
30 Accounting Expense 21,625,521 (-4 zero out 2003 budget
31 Legal & Counsulting 20,403,921 /i Private views
32 Repairs, Customer Equipment 21,433,844 2+ plan_business_unit
33| ITExpense 21,434,020 e
34|  Other Expenses 320,756,117 z\aniexch;ngie ik
35 Wages Expense 732,962,545 B ]

Auto spread consolidated inputs
This setting proportionally spreads values entered in a consolidated cell across nested cells.

About this task
If you enable the Auto spread consolidated input option, the values you enter in consolidated cells will
be proportionally spread across the nested cells after you commit your data.

Note: Consolidated cells do not accept typed-in input in formulas-based reports, such as Custom Reports
or Dynamic Reports.

Procedure

1. On the IBM Planning Analytics tab, click Options ©*.

2. In the navigation pane, click IBM Planning Analytics.

3. Under Application settings, select the Auto spread consolidated input check box.
4. Click OK.

Exploration or list settings

Show system and package information in exploration and list sheet
This setting is used to display the system and package information in newly created Exploration Views or
list views.

About this task
You can choose to display the system and package information in your Exploration Views and list views by
enabling this setting.

Note: This setting only applies to Exploration Views and list views created after the setting is enabled.
This setting will not have an effect on explorations already opened.

Procedure

1. On the IBM Planning Analytics tab, click Options ©*.
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2. In the navigation pane, click IBM Planning Analytics.

3. Under Exploration or list settings, select the Show system and package information in exploration
and list sheet check box.

4. Click OK.

Results
Unselected
BM
= | region month —~ actvsbud model asocount 1
= | region(ist) " D[[ month fist) ™ O Adual ™ | SSeres18LSedan ~  Sales g
K22 - S | 1965101584
A B [ D E F G H 1 J K L M N [o] P Q
2
13 Jan Feb Mar Apr May Jun Jul Aug Sep oct Now Dec
14 Argentina 7,932 8,085 7,838 7201 5921 5861 5717 6,203 8231 9,239 8522 8,282
15 Belgium 3,764 4,546 4,082 3,507 2935 2994 2,758 3,127 4,077 4762 4071 3,488
Brazil 7,603 8,782 8,314 6,913 5,615 5,272 5,266 5,875 7,709 9,214 7,915 6,500
Canada 0 '] o 0 L] ] 0 0 1] 0 0 0
Chile 1,844 2,273 2,003 1,791 1,531 1,382 1,404 1,488 2,012 2,329 2,149 1,681
9 Denmark 1,920 2,247 2,129 1,867 1,506 1,433 1,429 1,563 1,934 2,407 2,074 1,732
20 France 35,617 39,418 39,241 32,194 26,162 26,437 23,998 26,173 37,002 44,127 37,804 29,312
21 Germany 39,153 42,362 43,898 36,609 30,781 29,483 28,135 31,745 39,380 47,077 41,825 33,905
2 Great Britain 20,056 21,982 20,159 17,686 15008 14,332 14,193 15,507| 19,651. 24,483 22,050 16,614
23 Greece 3,688 4,340 4,332 3,633 2961 2,866 2,834 3,026 3,920 4,684 4,046 3,513
24 Ireland 1,920 2,170 2,053 1,817 1,480 1,408 1,329 1,563 1,986 2,303 2,048 1,656
25 Italy 20,031 23,041 20,550 18,544 15391 13,795 14,043 15,305 20,095 24,794 21,722 17,091
2 Luxemburg 404 439 426 353 306 282 276 303 392 492 430 326
27 Mexico 11,013 12,838 12,170 11,303 9,291 8,650 7,974 8951 11,759 14,183 12,214 9,788
28 Netherlands 4,319 4,882 4,783 3911 3446 3,097 3,059 3,505 4,259 5,487 4,720 3,589
29 Norway 2,198 2,686 2554 2,220 1,838 1,791 1,605 1,790 2,483 2,873 2,503 2,033
30 Portugal 1,591 1,808 1,703 1,388 1,225 1,126 1,153 1,185 1,542 1,838 1644 1,405
31 Spain 8,033 8937 8539 7,090 5845 5810 5266 6228 8231 09,757 8,775 6,676
32 Sweden 2,779 3,229 3,055 2,548 2,067 1,996 1,856 2,093 2,770 3,261 2,933 2,459
33 United States o o o o o o 0 0 0 0 1] 0
34 Uruguay 1,137 1,317 1,227 1135 893 819 802 933 1,176 1,449 1,315 1,004
35 North America 11,013 12,838 12,170 11,303 9,291 8,650 7,974 8,951 11,759 14,183 12,214 9,788
36 South America 18,516 20,458 19,382 17,081 13,961 13,334 13,190 14,498 19,128 22,232 19,901 17,467
37 Scandinavia 6,806 8,163 7,738 6,635 5411 5221 4,800 5446 7,186 8541 7510 6,224
3 Benelux 8,487 9,867 9,291 7,771 6,687 6,373 6,093 6,934 8,728 10,740 9,230 7,403
Selected
Bm
= |region month = | actvsbud model account]
= |region fist) n[[ month fist) ~ 0 Actual ¥ | SSeries 18L Sedan ~  Sales I
K22 ~ ]\ 19651.01584
A B C D E F G H 1 J K L M N 4] P Q
3 System: Pav2stageqc: SData
4 Package: SalesCube
5 Created: 18/08/2017 8:59:05 AM
13 Modified: 18/08/2017 9:4 AM
7 Rows: region: region (list)
8 Columns: month: month (list)
9 Context: actvsbud: Actual, model: S Series 1.8 L Sedan, accountl: Sales
10 Filter rows:
11 Filter columns:
12
13 Jan Feb Mar Apr May Jun Jul Aug Sep Oct Now Dec
14 Argentina 7932 8085 7838 7241 5921 65861 5717 6,203 8231 9,239 8522 828
15 Belgium 3,764 4,546 4,082 3507 2935 2,994 2,758 3,127 4,077 4,762 4,071 3,488
16 Brazil 7,603 8782 8314 6913 5615 5272 5266 5875 7,709 9,214 7915 6,500
17 Canada 0 0 o o o o o 0 1] 0 0 (]
18 Chile 1,844 2,273 2,003 1,791 1,531 1,382 1,404 1,488 2012 2,329 2,149 1,681
19 Denmark 1,920 2,247 2,129 1,867 1,506 1,433 1,429 1,563 1,934 2,807 2,074 1,732
20 France 35,617 39,418 39,241 32,194 26,162 26,437 23,998 26,173 37,002 44,127 37,804 29,312
21 Germany 39,153 42,362 43,898 36,609 30,781 29,483 28,135 31,745 39,380 47,077 41,825 33,905
22 Great Britain 20,056 21,982 20,159 17,686 15,008 14,332 14,193 16,614
23 Greece 3,688 4,340 4,332 3633 2961 2,866 2,834 3,513
24 Ireland 1,920 2,170 2,053 1,817 1,480 1408 1,329 1,656
25 Italy 20,031 23,041 20,559 18,544 15391 13,795 14,043 17,001
26 Luxemburg 404 439 426 353 306 282 276 326
27 Mexico 11,013 12,838 12,170 11,303 9,291 8,650 1,974 8,951 11,759 14,183 12,214 9,788
28 Netherlands 4319 4,882 4783 3911 3,446 3,097 3059 3505 4250 5487 4729 3580

Assign exploration or list starting cell
This setting is used to enable a prompt, which defines the starting cell for a new Exploration View or lists
view.

About this task

You can choose to assign a starting cell when creating a new Exploration View or list view by enabling this
setting. After the setting is enabled, a prompt will appear for a starting cell when creating a new
exploration.
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Procedure

1. On the IBM Planning Analytics tab, click Options .

2. In the navigation pane, click IBM Planning Analytics.

3. Under Exploration or list settings, select the Assign exploration or list starting cell check box.
4. Click OK.

Results

A prompt will appear for a starting cell when creating a new exploration
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Preserve user formulas
This setting preserves the user formulas in an Exploration View, list view, or Quick Report.

About this task
You can choose to preserve user formulas in an Exploration View, list view, or Quick Report.

Note: If this setting is not selected, any formulas that you add to an Exploration View, list view, or Quick
Report will be discarded when you commit data.

Procedure

1. On the IBM Planning Analytics tab, click Options .

2. In the navigation pane, click IBM Planning Analytics.

3. Under Exploration or list settings, select the Preserve user formulas check box.
4. Click OK.

Hide refresh confirmation for each worksheet and workbook
This setting is used to hide the confirmation dialog box, which appears whenever you refresh an
Exploration View or a Quick Report.

About this task
Right clicking a cell in your Exploration View or Quick Report and selecting IBM Planning Analytics will
show you options for refreshing your workbook or worksheet. If you decide to refresh your workbook or
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worksheet from this menu, a confirmation dialog box will appear. Use this option to hide the confirmation
dialog box whenever you refresh your workbooks or worksheets.

Note: This setting does not apply to the Refresh or Refresh All Data buttons.

Procedure

1. On the IBM Planning Analytics tab, click Options ©*.

2. In the navigation pane, click IBM Planning Analytics.

3. Under Exploration or list settings, select the Hide refresh confirmation for each workbook or
worksheet check box.

4. Click OK.

Results
Left: Unselected
Right: Selected
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Expand with double-click
This setting is enables consolidated cells to expand when double-clicked.

About this task
By enabling this setting, you will be able to expand a consolidated member by double-clicking on it.

Enabling this setting will also override the default double click action in BI formulas.

Procedure

1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Exploration or list settings, select the Expand with double-click check box.

4. Click OK.

Results
You can now double-click a consolidated member to expand it.
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Allow sum on context dropdown
This setting enables you to select a sum of items in the context dimension drop down of an Exploration
View.

About this task
You can add a Sum button to the context dimension drop down of an Exploration View. After enabling this
option, you can click on the drop down and click Sum to select the sum of the items.

Procedure

1. On the IBM Planning Analytics tab, click Options .

2. In the navigation pane, click IBM Planning Analytics.

3. Under Exploration or list settings, select the Allow sum on context dropdown check box.
4. Click OK.

Results

A Sum button is added to the context dimension drop down.
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170,176,238 364,327,300

Prompt for uncommitted changes
This setting enables a confirmation prompt, which appears when you refresh an Exploration View or list
view.

About this task

Refreshing a workbook with uncommitted changes may result in the changes being lost. This setting will
enable a confirmation prompt before a refresh is made. The prompt will only display if there are changes
to the workbook that are uncommitted and at risk of being lost after a refresh.

Procedure

1. On the IBM Planning Analytics tab, click Options .

2. In the navigation pane, click IBM Planning Analytics.

3. Under Application settings, select the Prompt for uncommitted changes check box.
4. Click OK.

Settings 31



Results
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Context member dropdown limit
This setting defines the number of members displayed in an Exploration View’s dimension drop down.

About this task
Use this option to define the number of members to display in the dimension area drop down.

Procedure

1. On the IBM Planning Analytics tab, click Options .

2. In the navigation pane, click IBM Planning Analytics.

3. Locate Context member dropdown limit under Exploration or list settings.
4. Define a number.

5. Click OK.
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Results
Left: Context member dropdown limit set to 3.

Right: Context member dropdown limit set to 10.

Data display row limit
This setting defines the number of rows that are displayed in an Exploration View or list view.

About this task

If you are pulling large quantities of data while working on your Exploration Views or list views, you may
find that there is a delay. Limiting the number of rows that are displayed in your Exploration Views or list
views can help mitigate this delay.

Under the last row of your Exploration View or list view, you can double-click More or All to see the
remaining rows of data.

Procedure

1. On the IBM Planning Analytics tab, click Options .

2. In the navigation pane, click IBM Planning Analytics.

3. Locate Data display row limit under Exploration or list settings.
4. Use the field to define a number.

5. Click OK.

Results

Expand member limit
This setting defines the maximum number of members to display when you expand a consolidated
member in your Exploration View. This setting affects only IBM® Cognos® Analytics Exploration Views.

About this task
Note: This option affects only IBM Cognos Analytics Exploration Views.

Set the maximum number of members to display when you expand a consolidated member in your
Exploration View.

Procedure

1. Click Options “*, from the IBM Planning Analytics tab.

2. Click IBM Planning Analytics, from the navigation pane.

3. Locate Expand member limit under Exploration or list settings.
4. Use the field to define a number.

5. Click OK.
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Results

Grouping options
This setting defines the way in which cells are grouped when you nest dimensions.

About this task

You can nest multiple dimensions in a row or column. This setting will define how the dimensions appear

when nested.

Table 1: Grouping options

Options Description

Merge cells Repeating cells in the parent dimension are
merged.

Repeat labels Repeating cells in the parent dimension each have
labels.

Label top cell Only the top cell of the repeating cells in the parent
dimension has a label.

Left: Merge cells
Center: Repeat labels

Right: Label top cell

Procedure

1. On the IBM Planning Analytics tab, click Options .

2. In the navigation pane, click IBM Planning Analytics.

3. Locate Grouping options under Exploration or list settings.
4. Use the drop down menu to select an option.

5. Click OK.

Custom report settings

Set TM1RebuildOption when generating new formula content
This setting enables the TM1RebuildOption variable when you generate new formula content.

About this task

The TM1RebuildOption variable causes the worksheets in a book to be rebuilt upon opening. This
forces a recalculation to happen on each sheet in the book every time you open the book. The Set
TM1RebuildOption when generating new formula content setting enables the TM1RebuildOption
variable when you generate new formula content.

Procedure

1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.

3. Locate Set TM1RebuildOption when generating new formula content under Custom report
settings.

4. Select the check box.
5. Click OK.
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Expand with double-click (applies to package based data sources only)
This setting overrides the default double-click action in IBM® Cognos® Analytics formulas and enables you
to expand with double-click on IBM® Cognos® Analytics formulas in package based data sources.

About this task
Override the default double-click action in IBM Cognos Analytics formulas.

Procedure

1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.

3. Locate Expand with double-click (applies to package based data sources only) under Custom
report settings.

4. Select the check box.
5. Click OK.

Results

Refresh data on Excel recalculation Keys (F9, Shift F9)
This setting enables Custom Report refreshes by using Microsoft Excel recalculation keys.

About this task

Use this setting to enable Custom Report refreshes by using Microsoft Excel recalculation keys. When this
setting is enabled, you can use F9 to refresh the entire workbook or Shift + F9 to refresh the current

sheet.

Note: You need to restart Microsoft Excel after setting this option for it to take effect.

Procedure

1. On the IBM Planning Analytics tab, click Options .

2. In the navigation pane, click IBM Planning Analytics.

3. Locate Refresh data on Excel recalculation Keys (F9, Shift F9) under Custom report settings.
4. Select the check box.

5. Click OK.

Refresh data on writeback
This setting defines if and how you want to refresh your data on write back.

About this task

Use this setting to define if and how you want to refresh your data on write back.

Table 2: Refresh data on write back options

Option Description

None Data does not refresh on write back.

Workbook The data refreshes in the workbook on write back.
Worksheet The data refreshes in the worksheet on write back.
Procedure

1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
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3. Locate Refresh data on writeback under Custom report settings.

4. Select an option.
5. Click OK.

Quick report settings

Double-click option

This setting defines the action executed after double-clicking on dimensions or context areas of a Quick

Report.

About this task

You can use this setting to define the action that occurs after double-clicking on the dimension or context

areas of a Quick Report.

Table 3: Double-click options

Option Description

None No action occurs after double-click.

Replace Double-clicking a dimension or context member
opens up the set editor to allow a replacement of
the dimension / context member.

Toggle Expands and collapses consolidated members
when double-clicked on dimension areas.
Launches the set editor when double-clicked on
the context area.

Procedure

1. On the IBM Planning Analytics tab, click Options ©*.
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Double-click option under Quick report settings.

4. Select an option.
5. Click OK.

Results

Use level based indents

This setting enables level based indents between parent-child members in a Quick Report.

About this task

Level based indentations allow you to easily identify parent-child relationships in rows within Quick
Reports. By enabling level based indents, child row members will be indented under the parent row

member.

Procedure

1. On the IBM Planning Analytics tab, click Options ©*.
2. In the navigation pane, click IBM Planning Analytics.
3. Under Quick Report settings, select the Use level based indents check box.

4. Click OK.
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Results

Use type-in refresh
This setting, if enabled, refreshes a Quick Report automatically when you update a context member by
typing it into the report.

About this task
update a context member

You can use this option to refresh a Quick Report automatically when you add a member by typing it into
the report.

Procedure

1. On the IBM Planning Analytics tab, click Options ©*.

2. In the navigation pane, click IBM Planning Analytics.

3. Locate Use type-in refresh under Quick report settings.
4. Click the checkbox.

5. Click OK.

Results

Use server formatting
This setting removes custom formatting in a Quick Report and uses server formatting.

About this task

You can use this option to remove custom formatting in a Quick Report and use server formatting.

Procedure

1. On the IBM Planning Analytics tab, click Options .

2. In the navigation pane, click IBM Planning Analytics.

3. Locate Use server formatting under Quick report settings.
4. Click the checkbox.

5. Click OK.

Results

Action button settings

Settings in the CoghosOfficeReportingSettings.xml file

You can configure IBM Planning Analytics for Microsoft Excel by using the
CognosOfficeReportingSettings.xml file. The file is located in C: \Users\ [Usexr]\AppData
\Local\Cognos\Office Connection.

The following tables group the settings into categories:

- Settings that apply to all supported datasources
« Settings that apply only when you are using a IBM Cognos Analytics datasource
« Settings that apply only when you are using a TM1 datasource
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Table 4: Settings that apply to all supported datasources

cell when you create
explorations.

You can also turn this
feature on or off by using
the Assign Exploration
View or list starting cell
option in the Options
dialog box.

Name Description Allowed values Default value
CommitWithoutConfirmati | Commits valid data True, False False
on without prompting you to
confirm the commit.
You can also turn this
feature on or off by using
the Hide commit
confirmation option in the
Options dialog box. Or you
can use the Hide commit
confirmation option in the
Commit Changes dialog
box.
ContextMemberLimit Sets the number of Integer 15
members to display in the
drop-down list for
dimensions in the context
area of Exploration Views.
Click More to see more
members.
ConvertDropDown Sets the default Quick Reports: MapOnNewSheet
conversion option MapOnNewSheet,
displayed on the MapOnThisSheet,
explorations toolbar (used | MapAtSpecifiedLocation
for converting to another .
report type). Formulas:
FormulasOnNewSheet,
FormulasOnThisSheet,
FormulasAtSpecifiedLocat
ion
None
CustomStartingRange Prompts you for a starting | True, False False
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Table 4: Settings that apply to all supported datasources (continued)

Name

Description

Allowed values

Default value

DataRowLimit

Specifies the number of
rows to retrieve from the
server and display in
explorations, 0 = no limit.

You can also set this by
using the Data display
row limit option in the

Options dialog box.

Note: This is a global
setting for all explorations
in a workbook. You can
override this setting in the
Properties dialog box for
Exploration Views and
lists.

Integer

500

DefaultRefreshMode

Sets the default refresh
button displayed on the
explorations toolbar.

For example, if you set
DefaultRefreshMode=
PreviewOnly, the Preview
with No Data button is
displayed on the
explorations toolbar.

None

RunAllData: Refresh data
and formatting

RunAllDataWithout
Formatting: Refresh data
only

PreviewOnly: Preview
without data

None

ExplorationOverride
DoubleClick

Overrides the double-click
action in explorations.

True, False

True

ExplorationThresholdCont
extUnnamedSetSize

Defines the maximum
number of members in
unnamed and static sets
that will be shown when a
view is added to an
exploration.

Defines the size limit for
unnamed sets when a
view is added to an
Exploration.

Integer

1000
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Table 4: Settings that apply to all supported datasources (continued)

Name

Description

Allowed values

Default value

GroupingOption

Sets the way in which
cells are grouped when
you nest dimensions.

You can also set the
grouping option by using
the Grouping option in
the Options dialog box.

Note: This is a global
setting for all explorations
in a workbook. You can
override this setting in the
Properties dialog box for
Exploration Views and
lists.

None

Sparse: Labels the top cell
only

Normalized: Repeats
labels

Full: Merges cells

Full

InsertDetails

Sets the default insert
mode displayed on the
explorations toolbar.

For example, if you set
InsertDetails=
InsertSingleMember, the
Insert Single Member
button is displayed on the
explorations toolbar.

None
InsertSingleMember

InsertMemberWithChildre
n

InsertMemberWithChildre
n Dynamic

InsertMemberWith
Descendants

InsertMemberWithInputs

InsertMemberWithAncest
ors

InsertSingle Member

MemberLimit

Sets the maximum
number of child members

to show in the source tree.

You can also set this
option by using the
Member display count
limit option in the Options
dialog box.

Integer

1000

MruPackage Contains information
about the most recently
used datasource.

MruServer Contains information

about the most recently
used Cognos system.

40 IBM Planning Analytics: Planning Analytics for Microsoft Excel




Table 4: Settings that apply to all supported datasources (continued)

Name

Description

Allowed values

Default value

RefreshConfirmation

Displays a confirmation
dialog box when you
refresh a workbook or
worksheet.

You can also turn this
feature on or off by using
the Hide refresh
confirmation for each
worksheet and
workbook option in the
Options dialog box.

True, False

True

RefreshDropDown

Stores the refresh mode
most recently used on the
explorations toolbar.

None

RunAllData: Refresh and
apply server formatting

RunAllDataWithout
Formatting: Refresh and
apply Excel formatting

PreviewOnly: Preview
without data

RunAllData

ShowServerInExploration

Displays an information
area above explorations.
The information area
displays details such as
the server, row
dimensions, column
dimension, and so on.

You can also turn this
feature on or off by using
the Show system and
package information in
the Exploration View and
list sheet option in the
Options dialog box.

True, False

True

UndoStackLimit

Defines the limit on the
number of undo actions a
user can performin an
Exploration View.

Integer

15

UseMruPackage

Loads the most recently
used datasource at
startup.

You can also turn this
feature on or off by using
the Load most recently
used system and
package option in the
Options dialog box.

True, False

False
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Table 5: Settings that apply only to reports that use IBM Cognos Analytics datasources

Name

Description

Allowed values

Default value

ChunkSize

Sets the IBM Cognos
Analytics chunk size (row
count per request).

Integer

0

EnableBIToggle

For explorations using
IBM Cognos Analytics
datasources, enables the
Toggle_set expression
instead of adding all child
members.

True, False

False

ExpandMemberLimit

Sets the maximum
number of members to
display when you expand
an item.

You can also set this
option by using the
Expand member limit
option in the Options
dialog box.

Integer

4000

FormulaDefaultNumeric

For explorations, forces a
zero to be returned when
avalue is empty in the
result set.

True, False

False

FormulaResolution
Paused

Prevents formulas from
triggering a call to the
server.

True, False

False

OverrideDoubleClick

Overrides the default
double-click action in IBM
Cognos Analytics
formulas.

You can also set this
option by using the
Expand with double-
click option in the Options
dialog box.

True, False

True

RequestFormat

Specifies the format to
use when loading IBM
Cognos Analytics
explorations. You can also
set this option by using
the Request format
option in the Properties
dialog box for Exploration
Views.

CSV: Unformatted,
removes data formatting
from the model

rawXML: Formatted

rawXML
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Table 6: Settings that apply only to reports that use IBM TM1 datasources

Name

Description

Allowed values

Default value

ActionButtonBackupDir

Sets the default directory
for backing up workbooks
when upgrading action
buttons.

Path

C:\Users\<User>\Desktop

ActionButtonlLogDir

Sets the default directory
for saving the logs when
upgrading action buttons.

Path

C:\Users\<User>\Desktop

AllowAdvanceQueryUI

Displays the Show MDX
button on the Exploration
View toolbar.

True, False

False

AllowContextSum

Enables you to select a
sum of items for context
dimensions in Exploration
Views.

In an Exploration View,
click the drop-down for a
dimension in the context
area and click Sum.

True, False

True

AllowFormulaWriteBack

Enables the DBR, DBRA,
DBSA, and DBRW
functions to write values
back to the TM1 server.

True, False

True

AutoSpread
ConsolidatedInput

Converts values entered
in consolidated cells into
proportional spread
operations.

True, False

True

BulkUploadAutoCommitV
alid

Commits values in valid
intersections of a Quick
Report automatically,
without validating the
values first.

You can also turn this
feature on or off by using
the Automatically
commit valid
intersections option in
the Error Report dialog
box.

True, False

True
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Table 6: Settings that apply only to reports that use IBM TM1 datasources (continued)

Name

Description

Allowed values

Default value

DefaultExpandDirection

Sets the direction to
expand when you double-
click in an Exploration
View or list.

You can also change this
setting by using the
Expand Direction option
in the Properties dialog
box for Exploration Views
and lists.

EXPAND_ABOVE: Expands
child members above
their parent.

EXPAND_BELOW:
Expands child members
below their parent.

EXPAND_ABOVE

the metadata tree.

Expansions Defines macros for data A JSON expression {"T™M1": {"k":"1000",
entry: k, m, g, or user- “m":"1000000",
defined. These macros are “q":".001"}}1}}
applied to a value before it
is committed to the TM1
server.
FlexviewDefaultIndentOn | Sets Quick Reports to True, False True
indent by default.
FlexViewDoubleClickActio | Defines the double-click [ None: This allows the None
n action for Quick Reports. | normal Excel behavior to
You can also set this occur, which is to edit the
option by using the cell.
Double-click action ExpandAbove: Double
option in the Options O .
dialog box. clicking a consolidated
member expands the
children above their
parent.
ExpandBelow: Double
clicking a consolidated
member expands the
children below their
parent.
Replace: Double clicking
any member displays the
set editor, which you can
use to replace the
member.
IncludeControlObjects Displays the control cubes | True, False False
of a TM1 datasource in the
Select Package dialog
box. You can select a cube
and use it to create
reports.
IncludeProcesses Shows the processes in True, False False
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Table 6: Settings that apply only to reports that use IBM TM1 datasources (continued)

Name Description Allowed values Default value
MapAddedRowColumnSty [ Sets the style to apply NoStyle: No styles are NoStyle
le when you extend a Quick |applied to the extended
Report by adding rows or | values
columns. ServerStyle Apply server
styles to the extended
values
LastRowColumnStyle:
Apply the style of the
previous row or column to
the extended cells
MapHotRefreshEnabled Enables the Use Type-in | True, False False
Refresh option for Quick
Reports.
You can also turn this
feature on or off by using
the Use Type-in Refresh
option in the Properties
dialog box for Quick
Reports.
MapUseMergeAreas Allows the user to use True, False False
merged cells along the
axes of Quick Reports.
PreserveFormulas Preserves user formulas | True, False True
in an exploration or Quick
Report when you commit
data.
A Attention: If this
option is set to
False, any
formulas that you
addtoan
Exploration View
or Quick Report
are discarded
when you commit
data.
You can also turn this
feature on or off by using
the Preserve user
formulas option in the
Options dialog box.
PromptUncommitted When you refresh, True, False True

Changes

prompts you to confirm
before uncommitted
changes are lost.
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Table 6: Settings that apply only to reports that use IBM TM1 datasources (continued)

Name

Description

Allowed values

Default value

RefreshOnExcelHotkeys

Refreshes data on Excel
recalculation keys (F9,
Shift F9). User needs to
restart Excel after change.

True, False

False

RefreshOnWriteBack

Refreshes data on
writeback. The user can
define whether the data in
the workbook or
worksheet is refreshed.

None

Workbook: Refreshes data
in the workbook on
writeback.

Worksheet: Refreshes
data in the worksheet on
writeback.

None

SetEditorPreviewOn

Shows set members in the
Selection pane (Hierarchy
mode) of the Subset
Editor instead of the set
definition (Definition
mode).

You can toggle the display
in the Selection pane
using the View Set
Contents and View Set
Definition buttons.

True, False

True

SetRebuildOptionOnSlice

Sets the
TM1RebuildOption
variable. This variable
causes the worksheets in
the book to be rebuilt on
opening (which forces a
recalculation to happen
on each sheet in the
book).

True, False

False

UseGzipUpload

Enables Gzip compression
for data uploaded to TM1.

True, False

True

46 IBM Planning Analytics: Planning Analytics for Microsoft Excel




Chapter 5. Work with data and reports

You can connect to data sources and explore the data by using reports.

You can make changes to your reports by retrieving data and overriding any previous changes, removing
data, or converting dynamic data to static data to prevent future updates from the servers. You can also
share your reports with other users.

When you work with data from the IBM TM1 server, you are also able to write back data to the TM1 cube.

Planning Analytics for Microsoft Excel report types

When you are using data from an IBM Planning Analytics data source, you can work in multiple ways:
Exploration Views, lists, Quick Reports, Dynamic Reports, or Custom Reports (reports based on formulas).
You can use multiple types of report in a workbook. Each report type has its own benefits and limitations.

Lists
A list shows data in rows and columns. Each column shows the members of a dimension or set.

When you create a list, you use a single drop zone, columns, to create a list of members. A drop zone is an
area where you can drag items to include in a report. You can add more columns to populate the list with
additional information.

Use list explorations to show detailed information from a data source, such as customer lists or product
lists.

You can also create a list to look up the value of a member, and then use the value in another worksheet,
for example.

Some of the strengths that are associated with lists include drag-and-drop capabilities and visual cues
that are provided by the zone in the overview area. With lists, you can view all of the members in a
dimension or set easily and quickly.

Use a list:

« To create a list of members in a dimension

Exploration Views

An Exploration View shows data in rows and columns. An Exploration View also has a context area, which
you can use to filter the data in the Exploration View.

When you create an Exploration View, you use drop zones to add objects from the source tree to the rows,
columns, and context area of the report. A drop zone is an area where you can drag items to include in a
report.

Some of the strengths that are associated with Exploration Views include drag-and-drop capabilities and
visual cues that are provided by the drop zones in the overview area.

Use Exploration Views to compare and manipulate data so that you can better understand relationships
between data and the relative importance of individual data items.

For example, you look at revenue for the years 2012 - 2015 by sales region. You notice a dip in the
revenue for 2014. You focus the Exploration View on 2014 only and expand 2014 to show revenue results
by quarter. You then replace the sales region dimension with the products dimension to explore revenue
in 2014 from a different perspective.

Use an Exploration View:
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« To find answers to simple questions that can be found in your data source, such as the revenue for Tents
in the Americas for 2015

To build interactive Exploration Views that you or another user can drill up and down in

- When you are not concerned with formatting

To build a data set to convert and use in a more complex analysis, such as a formula-based report or a
Dynamic Report

Quick Reports

A Quick Report shows data in rows and columns. A context area above the Quick Report shows the
context members.

When you use Quick Reports, you drag-and-drop objects onto the regions of the report: rows, columns,
context, and data. You can create Quick Reports by using existing Exploration Views or views. You can
create multiple Quick Reports on a worksheet. You can also use multiple data sources.

For example, you create three Quick Reports on a worksheet to show different views of financial
performance by region. You then add a fourth Quick Report that uses a different IBM Planning Analytics
data source. You then create a Microsoft Excel calculation that references cells in the four Quick Reports
to add more information to the report.

Some of the strengths that are associated with Quick Reports include the ability to present multiple views
that use the same or different data sources in a worksheet, the ability to build complex layouts, and the
ability to add Excel calculations, charts, and formatting. With Quick Reports, you can move beyond simple
Exploration View layouts while still having the advantage of visual cues provided through the Quick Report
regions.

Use Quick Reports:

« To build complex, highly formatted reports

« To use multiple data sources or servers

« When the row and column definitions will not change

Custom Reports

When you use Custom Reports, you use TM1 worksheet functions to build the report. You can create a
Custom Reports report from scratch, you can build an Exploration View or Quick Report and convert it to
formulas, or you can create Custom Reports from a vube view.

Some of the strengths that are associated with Custom Reports include the ability to use multiple data
sources in the same worksheet; the ability to move cells, rows, and columns; and the ability to add Excel
calculations, charts, and formatting. With formula-based reports, you can move to a custom or complex
layout.

Use Custom Reports reports:

« To build a complex report that cannot be easily achieved with Quick Reports or Dynamic Reports
« To work with data from multiple servers and data sources in a report
« When formatting is important

Dynamic Reports

A Dynamic Report shows data in rows and columns. A context area above the Dynamic Report shows the
context members. Dynamic Reports use TM1 functions to define the components of the report, such as
context members, row members, and display properties. Dynamic Reports also use formulas to apply
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formatting to rows automatically. You can create a Dynamic Report from scratch or by converting an
Exploration View to a Dynamic Report.

Some of the strengths that are associated with Dynamic Reports include the ability to have dynamic row
members with customized formatting, the ability to expand and collapse rows, and the ability to use Excel
calculations and other Excel features in the report. With Dynamic Reports, you can create more complex
reports while still using interactive features, such as expanding and collapsing rows.

Use Dynamic Reports:

« To build a complex report that cannot be easily achieved with Quick Reports
« To apply formatting automatically to rows

IBM Cognos Analytics report types

When you are using data from an IBM Cognos Analytics package, you can work in three different ways:
Exploration Views, lists, or Custom Reports. You can move between the methods. Each of these methods
has its own benefits and limitations.

Lists

When you create a list, you use a single drop zone, columns, to create a list of items. A drop zone is an
area where you can drag items to include in a report. You can add more columns to populate the list with
additional information. In a list, each column shows all the values for a data item in the database.

Some of the strengths that are associated with lists include drag-and-drop capabilities and visual cues
that are provided by the drop zone in the overview area. With lists, you can view all the items in the tables
of your database easily and quickly.

You can open list reports in IBM Cognos Analytics - Reporting and IBM Cognos Workspace Advanced. You
also publish lists to Cognos Connection.

Data sources can be relational, OLAP, or dimensionally modeled relational (DMR).
Use a list:

- To create a comprehensive group of items in a query subject or table of the database
- To enumerate the members of an OLAP dimension

Exploration Views

When you create an Exploration View, you use drop zones to add objects from the source tree to the rows,
columns, measures, and context area of the report. A drop zone is an area where you can drag items to
include in a report. Exploration Views provide automatic formatting based on the underlying data.

Some of the strengths that are associated with Exploration Views include drag-and-drop capabilities and
visual cues that are provided by the drop zones in the overview area.

You can open Exploration Views in IBM Cognos Analysis Studio, IBM Cognos Analytics - Reporting, and
IBM Cognos Workspace Advanced. You also publish Exploration Views to Cognos Connection.

Use an Exploration View:

« To find answers to simple questions that can be found in your data source, such as the revenue for Tents
in the Americas for 2015

« To build interactive Exploration Views that you or another user can drill up and down in
« When you are not concerned with formatting
 To build a data set to convert and use in a more complex cell-based analysis

Custom Reports

When you use Custom Reports, you drag-and-drop objects directly onto the cells of a worksheet.
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Some of the strengths that are associated with Custom Reports include the ability to use multiple
packages in the same worksheet; the ability to move cells, rows, and columns; and the ability to add Excel
calculations, charts, and formatting. With cell-based reports, you can move beyond simple Exploration
View layouts. From a single cell, it is easy to create a detailed report.

Data sources can be dimensionally modeled relational (DMR) or OLAP. Relational data sources are not
supported.

Use Custom Reports:

« To add data and calculations that are not in the original data source
« To work with data from multiple data sources, packages, and servers

To create layouts with complex layouts, rather than a simple Exploration View
« When formatting is important
« When you are presenting a final view that does not require interactive exploration

Find items in the source tree

The data source or package that you select might contain large amounts of data. You can use several
techniques to find the items in the source tree that you need.

You can do the following:

- Expand a dimension to see successive levels and details
« Specify a greater or lesser number of items to show in the source tree
« Search for items

By default, the source tree shows 50 items for any one dimension at a time. You can change this value to
increase or decrease the number of items displayed. Depending on the size of the data source, you might
want to set a smaller value to improve performance. For more information, see “Member display count
limit” on page 24.

If you are using a IBM Planning Analytics data source and the number of members in the dimension is
greater than the member display limit, a More icon is displayed. If you click More, more members are
displayed. For example, if the member limit is 25 and you click More, another 25 members are displayed.

If you are using a IBM Cognos Analytics package and there are more than the specified number of items in
the dimension, a Search icon is displayed. If you click Search, you can enter your search criteria to find
the items that interest you.

Search for members in an IBM Planning Analytics data source

When the source tree displays an IBM Planning Analytics data source, you can search for members in the
data source by name or by attribute values.

Procedure
1. In the source tree, select a hierarchy or member.

« To search all members in a hierarchy, select a hierarchy.
- To search a member and its descendants, select a member.
2. Right-click the hierarchy or a member, and click Search metadata.
3. Define the search criteria.
To add search criteria, click the plus sign at the end of the search criteria row. To delete a search
criteria, click the minus sign at the end of the row.

4. Click Apply.
The search results are displayed. You can drag members from the search results list to the work area.

5. After you finish your search, click OK.
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Example

Suppose that you want to create an Exploration View that shows all Sedan car models that are also leaf
members. You want these members to be displayed in the rows of your Exploration View.

1. Open PriceCube on the SData server.

Note: SData is a sample TM1 Server Application Folder that is provided with TM1. PriceCube is a
sample cube that contains a Model dimension.

. Create a blank Exploration View.

. In the source tree, expand the Model dimension.

. Right-click the model hierarchy and select Search metadata.
. Create the search criteria.

o b~ W N

« Select Name, Contains, and type Sedan.
« Click the plus sign to add another row.
- Select Level, =, and enter 0.

Name Contains Sedan
Level = 0

6. Click Apply. The results are displayed.
7. Select all the members that are returned by your search.
8. Drag the members to the Rows drop zone in the Exploration View.

The rows of your Exploration View now display Sedan car models that are leaf members in the Model
dimension.

Search for items in an IBM Cognos Analytics package
When the source tree displays a package, you can search for items in the package by name.

Searching is limited to the immediate details of the selected item. In DMR packages, you can search only
one level down. For example, if searching for Star Dome Tent, you must select Tents and not Products to
perform your search.

In packages based on a cube, you can search in all descendants.

For information about searching for members in a IBM Planning Analytics data source, see “Search for
members in an IBM Planning Analytics data source” on page 50.

Procedure

1. In the source tree, click a dimension, hierarchy, or level, and click Search metadata.
2. In the Words box, type the words or characters for which you want to search.
3. In the Options box, click the search parameter you want to use.
4. If you want to perform a case-sensitive search, select the Match case check box.
If the database does not support this feature, it is disabled.
. In the Search In box, click the level in which you want to search.
6. Click Search.
7. After you finish your search, click Close.

o1

Results
The search items appear in the Results box. You can drag items directly from the Results box to the work

area. If you do not see the results box, you might need to resize the dialog box so that all the fields are
visible.

Tip: To make it easier to find items, you can specify the number of items to show in the source tree for the
current session. For more information, see “Member display count limit” on page 24.
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Refresh data

If the data in a report is changed, you can refresh the data to ensure that you are working with the latest
data.

About this task
You can refresh your entire workbook, a worksheet, a report, or selected cells.
- To update the entire workbook, on the IBM Planning Analytics tab, click Refresh All Data.

If you choose the Refresh the data only option, the data is refreshed and any user applied formatting is
preserved.

If you choose the Refresh the data and report formatting option, the data is refreshed and the default
formatting is applied. Any user applied formatting is removed.

All worksheets, including Exploration Views, lists, and Custom Reports are updated with the most
recent data.

If you choose to also refresh report formatting, formats are updated.

— Refreshing the report formatting applies only to Exploration Views and lists, and temporarily
overrides the Run with Excel formats option on the Exploration or List toolbar.

— Quick Reports update their formatting based on a per-Quick Report flag to use server formats
(instead of the global flag for explorations) and update formats every time the data is pulled.

— Custom Reports have no dynamic formatting component and use standard Excel formatting.

« Torefresh only the current worksheet, right-click any cell on the worksheet, click IBM Planning
Analytics > Refresh > Refresh worksheet.

» To refresh a specific report, follow these steps:

&

In an Exploration View or list, click %~ and select an option.

In a Quick Report, click 2

For a Dynamic Report, in the source tree, expand Dynamic Reports. Right-click the Dynamic Report
and click Refresh. For more information, see “Refresh, rebuild, or recreate” on page 83.

For Custom Reports, right-click any cell in the report, click IBM Planning Analytics > Refresh >
Refresh worksheet.

- To refresh only specific cells, right-click a cell or range of cells, click IBM Planning Analytics > Refresh
> Refresh selected cells.

Design Mode

Design Mode is a feature for Exploration Views, which enables and disables the refreshing of an
Exploration View upon every change. When Design Mode is enabled, you must manually refresh the
Exploration View. By default, Design Mode is disabled. To enable or disable Design Mode, click

I beniede] “found in the Exploration ribbon section.

Clear cell content

You can clear data from the cells in an exploration, cell-based analysis, or in Quick Reports.

The cleared cells remain as blank cells on the worksheet. Formats, such as number formats, conditional
formats, and borders are retained. Clearing the content does not break the link to the data source.

You might want to clear the data before you share a report so that

« Report consumers are required to refresh data to obtain recent changes from the data source
« Report consumers are authenticated before they are able to view report content
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You can clear data from an entire workbook, a worksheet, a report, or selected cells.

 To clear all data in a workbook, on the IBM Planning Analytics tab on the ribbon, click &1 Or, right-
click any cell on a worksheet, click IBM Planning Analytics > Clear data > Clear workbook.

« To clear all data only in the current worksheet, right-click any cell on the worksheet, click IBM Planning
Analytics > Clear data > Clear worksheet.

« To clear the data in a specific report, follow these steps:

— For an Exploration View or list, in the source tree, expand Current Explorations. Right-click the
Exploration View or list and click Clear Data.

— For a Quick Report, in the source tree, expand Quick Reports. Right-click the Quick Report and click
Clear Data.

— For a cell-based report, right-click any cell on the worksheet, click IBM Planning Analytics > Clear
Data > Clear Worksheet.

Note: The Clear Data command does not clear data from Dynamic Reports or Custom Reports.

« To clear data only from specific cells, right-click a cell or range of cells, click IBM Planning Analytics >
Clear Data > Clear Selected Cells.

You can also automate this task by using the ClearAllData method. For more information, see
“ClearAllData ” on page 194.

To restore the data, refresh the data. For more information, see “Refresh data” on page 52.

Note: Because of the way newer versions of Microsoft Excel open workbooks that were created in older
versions of Excel, some values are visible in a published and cleared workbook when it is opened in a
newer version of Excel. Opening the workbook in a newer version of Microsoft Excel triggers recalculation,
which includes a refresh of the IBM TM1 data. Data is authenticated with the credentials of the user that
opens the workbook.

Convert dynamic data to snapshots (static data)

If you modify a workbook, worksheet, or exploration that you do not want to update with changes from
the content store, you can convert the dynamic data items to snapshots (static data) by disconnecting
from the data source.

When you convert dynamic data to snapshots, any query-related information, such as calculations and
filters, is removed but the data values are preserved.

To convert all reports in a workbook to a snapshot, on the toolbar, click Snapshot > Convert Book to
Snapshot.

To convert a worksheet to static data, right-click a cell and click IBM Planning Analytics > Convert to
snapshot > Convert worksheet to Snapshot.

To convert a cell or range of cells to static data, right-click a cell or a range and click IBM Planning
Analytics > Convert to snapshot > Convert Selected Cells to Snapshot.

To convert data in reports, follow these steps:

« For an Exploration View or list, in the source tree, expand Current Explorations. Right-click the
Exploration View or list and click Convert to snapshot. Or, to convert all Exploration Views and lists,
right-click the Current Explorations folder and click Convert all to Snapshots.

« For a Quick Report, in the source tree, expand Quick Reports. Right-click the Quick Report and click
Convert to snapshot. Or, to convert all Quick Reports, right-click the Quick Reports folder and click
Convert to snapshot.

« For Custom Reports, Dynamic Reports, and cell-based reports, right-click any cell in the report, click
IBM Planning Analytics > Convert to snapshot > Convert worksheet to Snapshot.
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Copy and move worksheets

You can copy or move worksheets that contain reports based on IBM TM1 data. You can copy or move
worksheets within a workbook or between workbooks.

Before you begin
If you want to copy a worksheet that contains a Quick Report, start IBM Planning Analytics for Microsoft
Excel before you copy or move the worksheet.

Procedure

1. Go to the worksheet that you want to move or copy.
2. Right-click the worksheet tab and click Copy.
3. Copy the worksheet.
For more information, see the Microsoft Excel online help.

Share your analysis

Share your analysis to give colleagues an opportunity to view important information or contribute their
own pieces of data.

Several options exist for storing and distributing IBM Planning Analytics for Microsoft Excel-enabled
workbooks.

Publish a workbook to a TM1 Server Application Folder

You can publish workbooks that contain TM1 reports to a TM1 Server Application Folder. You can publish
lists, Exploration Views, Quick Reports, Dynamic Reports, and Custom Reports. Publish a workbook to
share it with other users.

This video demonstrates how to publish a workbook: https://youtu.be/2Pqy2r4rSZs

About this task

When you publish a workbook, it is saved under the TM1 Server Application Folder. The Workbook can
then be opened in TM1 Web, and in IBM Planning Analytics Workspace.

By default, workbooks are published as private, unless you publish the workbook to a public folder or
change the workbook from private to public. Private workbooks are available only to you. Public
workbooks are available to users who have access permissions for the TM1 Server Application Folder
where you published the workbook.

Lists and Exploration Views are displayed as static websheets in TM1 Web and IBM Planning Analytics
Workspace. This means that the data is not read from the TM1 Server Application Folder and so doesn't
change when the data on the server changes.

Custom Reports, Quick Reports, and Dynamic Reports are displayed as live websheets. A live websheet
maintains its connection to the TM1 Server Application Folder. If the data on the server changes, the live
websheet reflects the change.

You can use subfolders to organize workbooks. You can rename or delete folders and workbooks that you
created.

For example, you can publish a workbook that is called Budget Plan to a TM1 Server Application Folder
called Planning Sample in a folder called Budget. In TM1 Web, you can open the budget plan report by
connecting to the Planning Sample server and navigating to Applications > Budget. The workbook is
displayed in TM1 Web as a static websheet.

Note: For information about publishing a worksheet to a IBM Cognos Analytics system, see “Publish an
exploration to IBM Cognos Connection” on page 56.
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Procedure
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. On the IBM Planning Analytics tab, click Publish.
. Select a TM1 connection.

. Select a TM1 Server Application Folder.

. Select a folder or create a new folder.

By default, new folders are private. To make a new folder available to others, an administrator needs to
right-click the folder and click Make Public.

. Type a name for the workbook.

. Optional: Enter a description.

. Optional: Administrators may click the Make public check box to make the workbook public.
. Click Publish.

Publish a workbook to IBM Cognos Connection

Publish your IBM Planning Analytics for Microsoft Excel-enabled workbooks to IBM Cognos Connection to
share them with other users in a secure and centrally managed way. Users can refresh the data based on
their user authentication privileges in IBM Cognos Analytics.

You can also automate this task by using the Publish method. For more information, see “Publish” on
page 197.

If users do not have IBM Planning Analytics for Microsoft Excel installed, they can view the document and
its contents, but they cannot refresh the data or update the contents.

For information about publishing TM1 workbooks to a TM1 Server Application Folder, see “Publish a
workbook to a TM1 Server Application Folder” on page 54.

Procedure

1.
2.
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Open the workbook.
Choose whether you want to save your workbook with recent data:

« To save the workbook with the most up-to-date data, on the IBM Planning Analytics tab, click

Ty
Refresh All Data “— .

« To save the workbook as a template without data, on the IBM Planning Analytics tab, click Clear & ;
then choose the appropriate option.

. On the IBM Planning Analytics tab, click Publish ‘7' .

. If prompted, click your namespace and type your user name and password.

. In the Look in box, click the IBM Cognos BI system where you want to publish the workbook.
. Choose the type of folder in which you want to save the workbook:

« To save the workbook in a public folder, click Public Folders.
 To save the workbook in a private folder, click My Folders.

. In the Name box, type the name of your workbook.
. If you want, in the Description box, type a description for the workbook.
. Click Open.

Results
The workbook is published to IBM Cognos Connection.
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Publish an exploration to IBM Cognos Connection
Publish your Exploration View or list to IBM Cognos Connection to make it available to other users.

Only the exploration in the currently active worksheet is published to IBM Cognos Connection.

For information about publishing workbooks to a IBM Cognos Analytics server, see “Publish a workbook to
IBM Cognos Connection” on page 55.

Before you begin

Your system administrator must first give you the capability to publish reports to IBM Cognos Connection.

Procedure

1. Create and save your workbook.
2. Go to the tab that contains the exploration that you want to publish.

3. On the IBM Planning Analytics click Publish z .
The Publish dialog box is displayed.
4. In the Connection box, click the system where you want to publish the exploration.
5. Choose the type of folder in which you want to save the exploration:
« To save the exploration in a public folder, click Public Folders.
« To save the exploration in a private folder, click My Folders.
6. In the Name box, type a name.
The default is the name of the saved workbook.

7. In Description box, type a description for this report.
8. Click Open.

Results
The exploration is saved to IBM Cognos Connection.

Work with dimensionally modeled relational and OLAP data

For IBM Planning Analytics for Microsoft Excel, data items are organized hierarchically. Dimensional data
sources include OLAP data sources and dimensionally modeled relational (DMR) data sources. The source
tree provides a hierarchical-based view of the data.

Note: The names of levels and members in a dimension come from the model. It is the responsibility of
the modeler to provide meaningful names.

1. Package

Packages are subsets of a model, containing items that you can insert in a report.
2. Dimension
Dimensions are broad groupings of descriptive data about a major aspect of a business, such as

products, dates, or markets. The Information dimension includes additional objects, such as System
Name and Package Name that you can also drag and drop into the worksheet.

3. Level hierarchy

Level hierarchies are more specific groupings within a dimension. For example, for the Years
dimension, data can be organized into smaller groups, such as Years, Current Month, and All Dates.

4. Members folder

Members folders contain the available members for a hierarchy or level. For example, the Members
folder for the Years level hierarchy contains everything found in the Year, Quarter, and Month levels.
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5. Level

Levels are positions within the dimensional hierarchy that contain information at the same order of
detail and have attributes in common. Multiple levels can exist within a level hierarchy, beginning with
aroot level. For example, the Years level hierarchy has the following related levels.

Table 7: Example of related levels for the Years level hierarchy

Level Level name Description

Root Years The root level.

First Year Years in the Years root level. For
example, 2004, 2005, and
2006.

Second Quarter Quarters for each year in the

Year level. For example, 2004
Q1, 2004 Q2, and 2004 Q3.

Third Month Months for each quarter in the
Quarter level. For example, Jan,
Feb, and Mar.

Note: The Measures dimension, which is not shown in the table, contains the measures available in
the data source.

Run Cognos TM1 Turbolntegrator processes

You can run IBM Cognos TM1 TurboIntegrator processes from IBM Planning Analytics for Microsoft Excel.

A Turbolntegrator process contains a script of TurboIntegrator functions and commands to
programmatically import data as well as create and modify TM1 objects, such as cubes and dimensions.
An IBM TM1 administrator creates the TurboIntegrator process and saves the process on an IBM TM1
server. The administrator also assigns security privileges to the TurboIntegrator process. You must have
read access privileges to access the Turbolntegrator process from the source tree in IBM Planning
Analytics for Microsoft Excel. You cannot create a TurbolIntegrator process from IBM Planning Analytics
for Microsoft Excel.

You can run, monitor, and cancel TurboIntegrator processes directly from the source tree. You can also
change Turbolntegrator process parameters from the source tree.

1. Expand Processes in the source tree to see a list of available processes.
2. Right-click a process and then click Edit Parameters to edit it.
3. Right-click a process and then click Run Process to run it.

Note: A Turbolntegrator process that encounters a major error rolls back instead of committing any
changes. For example, errors such as the data source failing to open or attempting to write to a cube that
doesn't exist are major errors and trigger a rollback.

By default, when a process is running, there is no progress indicator. To monitor the execution of running
processes, right-click Processes, and then click Active Processes. In the Active Processes window you
can monitor process execution, and also cancel running processes.

You can also create an action button that runs a TurboIntegrator process. For more information, see “Run
a process” on page 185.

For more information about TurboIntegrator processes, see the IBM Cognos TM1 Turbolntegrator
documentation.
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Chapter 6. Explore TM1 data

Exploration Views and lists

To explore IBM TM1 data by using an Exploration View or list, select an IBM Planning Analytics data
source and choose items from that data source to place in the rows and columns of the Exploration View
or list.

Before you can create an Exploration View or list, the administrator must create a TM1 data source and
publish it to a location to which you have access. The administrator must also configure your access
privileges.

Administrators can create data sources and assign access privileges in IBM Cognos TM1 Performance
Modeler or IBM Cognos TM1 Architect.

When you create an Exploration View or list, you'll notice that the IBM Planning Analytics ribbon changes,
and includes an Exploration group and a Overview bar.

HOME  INSERT ~ PAGELAYOUT ~ FORMULAS ~ DATA  REVIEW VW  DEVELOPER

t-_ {5} Options r;l H‘=‘ = o /™) o Commit & Clear~
= 1
) Help - N 5 Discard 15 Snapshot -
Open Publish Exploration List Action Refresh

Button  Sheet~
Getting Started Content Add Data

The Overview bar is displayed when you are viewing an Exploration View or a list. Use the overview area
as a convenient place to quickly explore and change the contents of the Exploration View or list. For
Exploration Views, the overview area displays the Rows, Columns, and Context areas. You populate the
Exploration View with data by adding items from the data source to these areas. The items that you place
in the context area are used to filter the values. Each box in the rows, columns, and context area
represents a set of data in the data source.

IBEM

= |plan_chat_of_accounts Dnn plan_time ~ | plan_version plan_business_urit
=  plan_chart_of_accounts flist) plan_time_2004_qtrs_and_month ]  Fr2004 Budget ~| UK s

The Exploration group contains tools, which you can use to work with your Exploration View or list.

= MDX Convert To ~
E‘ ﬂ= ﬂ= Design Mode == Properties
7 ® - (3 Use Server Formats ~ v~ Overview

Exploration

Undo - Use the Undo tool to undo your last action.

ot
Note: By default, you can undo up to 15 actions. Your undo limit can be changed in the ' Options
dialog.

Redo - Use the Redo tool to redo your last action.

@ Save View - Use the Save View tool to save an Exploration View or list.
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[ Reset - Use the Reset tool to reset an Exploration View or list. This action will clear your Exploration
View or list.
ﬂ~ Swap Rows and Columns - Use the Swap Rows and Columns tool to swap the rows and columns of

an Exploration View for a different view of your data. To learn more, see “Swap rows and columns” on
page 67.

B Suppression Type - Use the Suppression Type tool to suppress/hide zeros in the rows, columns,
rows and columns, or apply no suppression at all.

=1 MDX MDX - Use the MDX tool to view or edit the MDX of the report.

[ % Design Mode Design Mode - Use the Design Mode tool to enable data updates only on refresh.

Cal Use Serve I
&| Use Server Formats Use Server Formats - Use the Use Server Formats tool to use server formats

when you refresh an Exploration View or list. This tool will remove custom formatting on refresh.

Convert To Convert To - Use the Convert To tool to convert an Exploration View to a Quick Report,
Dynamic Report, or Custom Report. To learn more, see “Convert to other report types” on page 71.

== Pro perties Properties - Use the Properties tool to set properties for an Exploration View or a list
that are specific to a worksheet. To learn more, see “Set properties” on page 72.

 Overview . . . .
Overview Overview - Use the Overview tool to show or hide the Overview bar.

Create a list
You can explore IBM TM1 data with lists.

Use list explorations to show detailed information from your database, such as customer lists or product
lists.

A list exploration is a report that shows data in rows and columns. You can create a list, for example, to
look up the names of members in a dimension and then reference the members in another worksheet
where they can be used for setting parameters.

Related concepts

“Insert blank columns” on page 61

Insert a blank column into a list to create white space or to add cell-based calculations. You can use the
new column to insert any Microsoft Excel calculation, such as AVG, MIN, or MAX and you can reference
cells both inside and outside the list.

Related tasks

“Create a list” on page 60

“Insert members” on page 63

“Suppress empty cells” on page 61

“Insert Microsoft Excel calculations” on page 73

“Nest rows or columns” on page 65

“Rename and reorder columns” on page 61

“Change the cube or datasource used by an exploration” on page 73
You can change the cube or datasource that is used by an exploration.

Create a list
When you create list, you begin with a blank list and then drag items from the Task Pane onto the list.
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Before you begin

You have access to an IBM Planning Analytics data source. The administrator has configured your access
privileges.

Procedure

1. Log on to a TM1 system and select a data source.
For more information, see “Open a model or package ” on page 17.
The source tree in the Task Pane displays the cube and related items of the data source, such as views.

2. On the IBM Planning Analytics tab, click List.
3. Add members to the list.
Drag dimensions, sets, or members from the Task Pane to the Columns drop zone.

Insert blank columns

Insert a blank column into a list to create white space or to add cell-based calculations. You can use the
new column to insert any Microsoft Excel calculation, such as AVG, MIN, or MAX and you can reference
cells both inside and outside the list.

Right-click a column header in the list where you want to insert a column, and click IBM Planning
Analytics > Insert user row/column.

A blank column is added next to the selected column.

Suppress empty cells
Sparse data can result in lists showing empty cells. To remove sparse data in a list, you can suppress
empty cells that contain a null or zero value.

Procedure

1. On the IBM Planning Analytics tab, click '=' Suppression type.
2. Click Suppress Rows Only.

Results
Suppressed items are hidden.

Note: To remove suppression, repeat step 1 and click No Suppression.

Rename and reorder columns
You can reorder columns in a TM1 list. You cannot rename a column.

Procedure

1. In the Overview area, click the arrow next to the column you want to reorder, and select Reorder /
Rename.
The Reorder / Rename dialog box is displayed.

2. To reorder columns, click a column name and use the arrow buttons to move the column.
3. Click OK.

Create an Exploration View
You can explore IBM TM1 data with Exploration Views.

Use Exploration Views to quickly change how you view performance measures, such as revenue or
budgeted production costs.

You can compare and manipulate data so that you can better understand relationships between data and
the relative importance of individual data items. Whether you want to assess revenue growth or to identify
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top performers, IBM Planning Analytics for Microsoft Excel provides the filtering and sorting support you
need for exploration and write back.

If you are already comfortable with exploration fundamentals, you may want to refine your Exploration
View by using tasks such as manipulating the rows and columns, adding calculations, and sharing the
results. For more information, see “Nest rows or columns” on page 65, “Add calculated rows and
columns” on page 66, and “Publish a workbook to a TM1 Server Application Folder” on page 54. You can
also edit data in Exploration Views. For more information, see “Edit data” on page 69.

Create an Exploration View

Create an Exploration View by using a view
You can create an Exploration View from a view. Views are listed in the source tree in the Views folder.

This video demonstrates how to create an Exploration View by using a view: https://youtu.be/
0jL9WGPeTkO

Before you begin

You have access to an IBM Planning Analytics data source. The data source includes views. The
administrator has configured your access privileges.

Procedure

1. Log on to a TM1 system and select a data source.

For more information, see “Open a model or package ” on page 17.

The source tree in the task pane displays the cube and related items of the data source, such as views.
2. Expand the Views folder.
3. Use one of the following methods to create an Exploration View.

- Drag a view onto a blank Exploration View.
« Right-click a view and click Exploration > On new sheet

« Toreplace an existing Exploration View, drag a view onto the Exploration View. Or, right-click a view
and click Replace Exploration.

 To convert a list to an Exploration View, drag a view onto the list.

4. Click Save to save your view. You can choose to save it as a private view, this is then available from a
folder called Private views, below the Views folder in the source tree.

Create an Exploration View from scratch

Creating an Exploration View allows you to fully customize how your report looks and what your report
analyzes. Creating an Exploration View from scratch is as easy as starting with a blank Exploration View
and dragging items from the source tree onto the Exploration View.

Before you begin

Ensure that you have access to an IBM Planning Analytics data source. Access privileges are configured by
your administrator. If you do not have access to a data source, speak with your administrator.

Watch this video to see how you can create an Exploration View.

About this task

Procedure

1. Log on to a TM1 system and select a data server.
For more information, see “Open a model or package ” on page 17.
The source tree in the task pane displays the cube and related items of the data source, such as views.
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2. On the IBM Planning Analytics tab, click Exploration
An Exploration View is created on a new worksheet.

3. Add members to the rows and columns. For more information, see “Add objects to rows, columns, and
the context area” on page 64.

Tip: You can use a view to build an Exploration View. In the source tree, expand Views and drag a view
onto the Exploration View.

4. Optionally, add members to the context area.

Insert members
You can insert members from the source tree to the rows and columns in an Exploration View that uses
TM1 data. You can also insert members to a column in a list that uses TM1 data.

About this task

You can control how members are inserted by setting the insert option in the Task Pane . You can use the
following insert options.

- Insert single member, which inserts the selected member.

« Insert member with children, which inserts the selected member and its components to one level as a
dynamic set.

- Insert member with descendants, which inserts an item and all levels of its component items as a
dynamic set.

- Insert member with ancestors, which inserts an item along with all its related components as a
dynamic set.

« Insert member with inputs, which inserts an item and its input or leaf items as a dynamic set.
You can also simultaneously insert all the members of a level “Insert all the members of a level” on page

64. In an Exploration View, you can also insert members from different levels of the same dimension
“Insert members from multiple levels of a dimension” on page 63.

For groups of members that you use frequently, you can create a set to make selection of them easier. For
more information about sets, see “Sets for TM1” on page 92.

Procedure

1. In the Task Pane, click and select the required option.
2. In the source tree, select the members that you want to insert.

3. Drag the members to the desired location in the exploration.

To add a member to the members that already exist in an Exploration View, hold down the Ctrl key
when dropping items into the drop zones. A highlighted bar indicates where you can drop the item.

You can use Shift+click or Ctrl+click to select multiple members in a dimension and then drag them to
the exploration. When selecting multiple members, the selected members are placed in the
Exploration View in the order that you click them. To avoid rearranging members after you drag them
into the Exploration View, click the members in the order of placement that you want.

Insert members from multiple levels of a dimension

For a mixed comparison, you can position members from different levels of a dimension adjacent to each
other in a TM1 Exploration View.

About this task

You can select members from a single dimension in the source tree. You can select both contiguous and
noncontiguous members from different levels.
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After you select members, you can drag the members to the Exploration View.

For groups of members that you use frequently, you can create a set to make selection of them easier. For
more information on sets, see “Sets for TM1” on page 92.

Procedure

1. In the source tree, expand the dimension to locate the members that you want to insert.

2. Use Shift+click or Ctrl+click to select multiple members in a dimension and then drag them to the
Exploration View.

Tip: When selecting multiple members, the selected members are placed in the Exploration View in
the order in which you click them. To avoid rearranging members after you drag them into the
Exploration View, click the members in the order of placement that you want.

Results
The members are displayed in the Exploration View.

Insert all the members of a level
You can simultaneously insert all the members of a level into a TM1 Exploration View. Levels define the
way data is grouped in dimensions.

About this task
Use this technique to insert members at the same level from multiple consolidated members.

For example, a Region dimension might contain levels for region, country, and city. You can click a single
country and instantly insert every country in the Region dimension into the Exploration View.

Procedure

1. In the source tree, expand a single member that contains the detail that you want in the Exploration
View.

2. From the Levels item, drag the level to the drop zone.

Results
The members are inserted into the Exploration View.

Note: You can also insert a level using the source tree. In the source tree, expand a dimension, expand
Levels, and then drag a level to the Exploration View.

Add objects to rows, columns, and the context area
Select the data that you want to appear in the TM1 Exploration View. You can insert dimensions,
members, and subsets.

Alternatively, you can use a view to populate the Exploration View.

Procedure

1. Create an Exploration View using an IBM Planning Analytics.

2. To use a view to populate the Exploration View, in the source tree, expand Views and drag a view onto
the Exploration View.

Or, drag a dimension, member, or set to the drop zones.
a. Drag a dimension, member, or set to the Rows drop zone.
b. Drag a dimension, member, or set to the Columns drop zone.

c. Drag dimensions, members, or sets to the context area. This step is optional. Use the context area
to filter the data in the Exploration View. For example, to filter the data by product, drag a member
of the Products dimension to the context area.
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When you drag a member to a drop zone, the member and its children are inserted by default. For
more information about inserting members, see “Insert members” on page 63.

For example, to display a dimension called Retailers in the rows, click the Retailers dimension in the
source tree and drag the dimension to the Rows drop zone.

3. Save your workbook.

Results
Members are displayed in the rows and columns of the Exploration View.

Columns and rows

Rename columns or rows
You cannot rename columns or rows in a TM1 Exploration View.

Reorder columns or rows
You can move columns or rows, including calculated columns or rows, in a TM1 Exploration View.

Procedure

1. In the Overview area, click the arrow next to the row or column and click Reorder / Rename .
2. Change the order of the members using the arrows.
3. Click OK.

Results
The row or column is moved in relation to the other rows or columns in the Exploration View.

Nest rows or columns

You can nest rows and columns in an Exploration View to compare information from more than one
dimension in a column or row. For example, an Exploration View shows the sales by product line for the
past fiscal year. You can nest a row to further break down the sales by order method.

You can also nest columns in a list.

In the overview area, you can drag the boxes that represent the nested items to change the nesting order.

Procedure

1. In the source tree, click the item that you want to insert. You can select a dimension, a set, or one or
more members in a dimension.

2. Drag the item to the location in the Rows or Columns drop zone that you want. Or drag the item onto
the exploration in the location that you want.

A highlight bar indicates where you can drop the item.

Insert blank columns or rows

Insert a blank column or row into an Exploration View to create white space or to add cell-based
calculations. You can use the new row or column to insert any Microsoft Excel calculation, such as AVG,
MIN, or MAX.

About this task

Depending on the type of data, such as relational or asymmetric you experience very different results.
Experiment with different approaches to see what makes sense in your environment.

After you insert a row or column into an Exploration View, the rows or columns are separated into two
distinct blocks of items before and after the inserted row or column. If you want to use the Expand level /
Collapse level feature, you must do so for each block separately.
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Procedure
1. Right-click a column or row header in the Exploration View where you want to insert a column or row.

If the Exploration View area expands, make sure that it does not overwrite items.
2. Click IBM Planning Analytics > Insert user row/column.

A blank column or row appears next to or under the selected column or row.

Results
The blank row or column is added to the Exploration View.

You can leave the row or column blank. You can also populate the blank column or row with a Microsoft
Excel calculation. For more information, see “Insert Microsoft Excel calculations” on page 73.

Add calculated rows and columns

Insert a calculation to make your Exploration View more meaningful by deriving additional information
from the data source. For example, you create an invoice, and you want to see the total sales amount for
each product ordered. Create a calculated column that multiplies the product price by the quantity
ordered.

About this task
In addition to simple arithmetic calculations, you can perform the following calculations:

% Of
Calculates the value of a selected member as a percentage of another member, for example, fourth
quarter as a percentage of the whole year or actual as a percentage of target.

% Change
Calculates the change in value of a selected member as a percentage, for example, growth from year
to year or variance from target.

% Of Base
This calculation is available only if you select two members from different hierarchies, one on rows
and the other on columns, for example, each region's contribution (on rows) to a yearly total (on
columns).

% Of Parent
This calculation is available only for TM1 data. The % of Parent calculation is available only if you
select two members from different dimensions, one on rows and the other on columns. % Of Parent
calculates the value of a selected member as a percentage of its parent, for example, January sales as
a percentage of sales for the whole year.

After you insert a calculation into an Exploration View, the rows or columns are separated into two distinct
blocks of items before or after the inserted row or column. If you want to use the Expand level / Collapse
level feature, you must do so for each block separately.

When calculations in the rows and columns of an Exploration View intersect, calculations are performed
in the following order:

« Addition or subtraction
« Multiplication or division

If both calculations have the same precedence, for example, if they are both functions, then the row
calculation takes precedence.

For information about adding Microsoft Excel calculations, see “Insert Microsoft Excel calculations” on
page 73.

Procedure

1. Right-click the columns or row headers that you want to use in the calculation.
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2. Click IBM Planning Analytics > Insert calculation and select the calculation that you want to
perform.

Note: Calculations that are not applicable to the items you selected are grayed out.

Results
The calculated row or columns appears in the Exploration View. You can rename the calculated column or
row. You can also move the calculated column or row.

Note: To remove a calculation, right-click the calculated row or column, click IBM Planning Analytics >
Hide.

Swap rows and columns

You can swap rows and columns for a different view of your data. For example, the rows contain quarters
of the fiscal year and the columns contain products. To track trends over time more easily, you can swap
them so that the rows contain products and the columns contain quarters.

Note: When you swap rows and columns in a TM1 Exploration View, sorting and top or bottom filters are
removed.

Procedure

Click Swap Rows and Columns .” on the toolbar.

Tip: You can also use the overview area to swap individual items on rows and columns by dragging the
items from one area to the other.

Sort rows by values
Sorting rows by values makes it easier for you to organize and analyze your data.

Procedure

1. Right-click the column header cell then click IBM Planning Analytics > Sort by values.
2. Select a sort option.

Results

In the overview area, a symbol appears in the columns box to indicate a sort is applied. To remove a sort,
right-click the header cell then click IBM Planning Analytics > Sort by values > Remove.

Note: When you swap rows and columns, a sort is removed.

Filter data using the context area
You can filter the data in a TM1 Exploration View using the context area. You can filter using dimensions,
members, and sets.

About this task

Changing context changes the values that appear. It does not limit or change the members in the rows or
columns.

For example, you have an Exploration View showing products in the rows and months in the columns. To
change the context to Asia, you drag Asia from the source tree to the Context drop zone in the overview
area. The Exploration View then shows only the values for Asia.

You can filter using multiple values in the context area. For example, you can drag Asia and Franchise
Stores to the context area. The Exploration View then shows only the values for franchise stores in Asia.

Procedure

1. Create an Exploration View using a TM1 data source.
2. In the source tree, select one or more items to filter on.
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- To filter using a dimension, select the dimension. The default member of the dimension is used for
the filter.

« To filter using a set, expand the dimension, expand Subsets, and select a set. The default member of
the set is used for the filter.

« To filter using a member, expand the dimension, expand Members, and select the member.
3. Drag the item you selected to the Context drop zone.

Results
The values in the Exploration View are filtered using the items you selected.

Notice that each item has a down-arrow beside it. Click the down arrow to see options for deleting or
changing the context member. For example, if you filtered using a set, you can click the down-arrow to
select a different member of the set to use in the filter.

Limit members
You can limit the members that are displayed in a TM1 Exploration View using a variety of techniques.

You can use the following techniques.

 Use zero-suppression to hide rows or columns that contain only missing values. For more information,
see “Suppress empty cells” on page 153.

« From either rows or columns, select the members you want to show in the Exploration View, right-click
the cells and select IBM Planning Analytics > Keep.

« Use the Data Display Row Limit option to limit the number of rows displayed in the Exploration View.

On the IBM Planning Analytics tab, click == Properties. In the Properties dialog box, set the number
of rows to display. For more information, see “Set properties” on page 72.

 Create a set of members. For more information, see “Sets for TM1” on page 92.

» Apply a filter to display the top or bottom values only. For more information, see “Show top or bottom
results” on page 68.

Suppress empty cells

Sparse data can result in Exploration Views showing empty cells. For example, an Exploration View that
matches employees with products, results in many rows of empty values for the revenue measure if the
employee does not sell those products. To remove sparse data in an Exploration View, you can suppress
empty cells that contain a null or zero value.

When you are working with IBM Cognos Analytics data, totals-based suppression is applied. Totals-based
suppression removes rows or columns where the total results in a null or zero value throughout the
Exploration View. You cannot remove sparse data from individual rows or columns.

Procedure
1. On the IBM Planning Analytics tab, click '=' Suppression type.
2. Choose where to apply the suppression:

« Suppress Rows Only
« Suppress Columns Only
« Suppress Rows and Columns

Results
Suppressed items are hidden.

Note: To remove suppression, repeat step 1 and click No Suppression.

Show top or bottom results
In an Exploration View that uses an IBM Planning Analytics data source, you can apply a filter to values to
display only the top or bottom results.
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About this task
You can apply a top or bottom filter in the following ways.

« Show only the top results to quickly determine the highest values in your data. For example, you want to
know which sales representative contributed the greatest amount to yearly sales, so you apply a top
percent filter.

« Show only the bottom results to quickly determine the lowest values in your data. For example, you
want to know which employees spent the fewest dollars on travel, so you apply a bottom rows filter.

Procedure

1. Right-click a column header cell then click IBM Planning Analytics > Sort by values > Top/Bottom.
2. Select a sort option and enter a value.
« For Top rows and Bottom rows, the value represents the number of rows to display.

 For Top percent and Bottom percent, the value represents a percentage of the sum of all values. For
example, you can type 10 to display the customers who contribute to the top 10% of revenue.

« For Sum of top rows and Sum of bottom rows, the value represents the sum of the results you want
to display. For example, you can type 10000000 to display the customers who contribute to the first
10 million dollars of revenue.

Results

In the overview area, a symbol appears in the columns box to indicate a top or bottom filter is applied. To
remove the filter, right-click the header cell then click IBM Planning Analytics > Sort by values >
Remove.

Note: When you swap rows and columns, a top or bottom filter is removed.

Drill down and drill up
You can drill down and drill up to change the focus of your analysis by moving between levels of
information.

Drill down to see more detail. For example, you can drill down to the lowest-level member to examine the
impact of a single aspect of your business.

Drill up to compare results. For example, you can examine revenue for a single product and then drill up to
see revenue for the entire product line for comparison.

Procedure

1. To drill down or up in a single row or column, right-click a cell and then click IBM Planning Analytics >
Drill Down or IBM Planning Analytics > Drill Up.

2. To drill down or up in both a row and column simultaneously, double-click the value at the intersection
of the row and the column.

Edit data
You can edit data in an Exploration View that uses an IBM Planning Analytics data source, if you have
Write access to the cells and the cells are editable.

Cell shading identifies the cells that you can edit.

« Light blue: A consolidated cell.

« Gray: A derived or locked cell. You cannot edit the value.
« White: A leaf cell.

« Dark gray: A cell with a hold applied. Place a hold on a cell to exclude it from data spreading. For more
information, see “Edit TM1 data by using data spreading” on page 103.

Planning Analytics for Microsoft Excel offers different ways to work with IBM TM1 data changes. You can
determine how your user group is designed to operate based on the options presented on the toolbar. For
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example, if you have been granted Sandbox capability, you have access to the New Sandbox and Delete
Sandbox options. For more information, see “Writeback mode” on page 98 and “Sandboxes” on page
99..

To edit a value in a cell, click the cell, type the new value, and then press Enter.

To save your changes, commit the data to the TM1 Server Application Folder.

On the IBM Planning Analytics toolbar, click +* Commit. A confirmation dialog box is displayed.

For more information, see “Commit data in a TM1 Exploration View ” on page 72.

Cell formatting indicates the state of data changes.

« Bold blue font: The value in the cell has changed but has not been committed to the TM1 server.

« Orange background: The value in the cell has been committed to your sandbox, but has not been
committed to Base.

After you commit the changes, the Exploration View displays the updated values in a normal font,
indicating that you have saved the changes.

Layouts
You can choose the most practical layout for your Exploration View.

The following layouts are available.

Basic

This layout contains one set of rows and one set of columns.

2

Figure 3: Example of basic sets

Nested

This layout contains sets nested either along the rows, the columns, or both.

1 3
2 4

Figure 4: Example of nested sets

Stacked

This layout contains two or more sets arranged one before another on the rows, next to each other on the
columns, or both.
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2 2

Figure 5: Example of stacked sets

Asymmetric
This layout contains both nested and stacked sets. Many combinations are possible.

To create asymmetrical nesting, nest the required sets. Right-click on an open space in the rows or

columns drop zone, then click Convert axis to asymmetric. To revert the axis to a symmetric set, click the
O

Convert axis to symmetric icon D, located above the rows or columns drop zone icon. You can then

delete nested members from a parent without deleting the nested member from all parents. For example,

you can show an actual category under previous years and show only the forecast category under the

current year, because no actual is available.

Note: You can only convert an axis to asymmetric if the axis contains more than one dimension.

4
516
2 1
1 3
3 2
4115
3
6 2
102
)

Figure 6: Example of asymmetric sets

Convert to other report types
You can convert Exploration Views to another report type.

For example, you can create a TM1 Exploration View, explore the data, and then convert the Exploration
View to a Custom Report to manipulate the data further using Microsoft Excel features.

The options available to you depend on whether you are using a TM1 data source or a IBM Cognos
Analytics package:

« You can convert TM1 Exploration Views to Quick Reports, Dynamic Reports, and Custom Reports.

— Create a Quick Report from an Exploration View

— Create a Dynamic Report from an Exploration View

— Create a Custom Report from an Exploration View
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 You can convert IBM Cognos Analytics Exploration Views to Custom Reports.

— “Convert from an Exploration View” on page 166

You can also convert the data in reports from dynamic data to static data. For more information, see
“Convert dynamic data to snapshots (static data)” on page 53.

Commit data in a TM1 Exploration View

After you have entered values in an Exploration View, you can commit your changes to save the values to
the TM1 server.

On the IBM Planning Analytics toolbar, click Commit +*. A confirmation dialog box is displayed.

Note: If you have enabled Hide commit confirmation in the Options dialog box, the confirmation dialog
box is not displayed and the values are committed to the TM1 server. If any errors are found, the Error
Report dialog box is displayed.

To preview the changes, click Preview Changes. The Commit Preview dialog box displays the data
changes, along with any errors. Click OK.

To commit the changes, click Yes. If any errors are found, the Error Report dialog box is displayed.
Note: You cannot undo changes after you have committed them to the TM1 server.

For information about resolving errors, see “Resolve errors when committing data to a TM1 server” on
page 108.

Set properties
You can set properties for an Exploration View or a list that are specific to a worksheet.

About this task

The settings in the Properties dialog box are specific to a worksheet. For information about setting global
options, see Chapter 4, “Settings,” on page 21.

In addition to changing settings, the Properties dialog box enables you to view information about the
worksheet including server and package information, and the date the worksheet was created.

Procedure

1. On the IBM Planning Analytics tab, click = Properties.

2. To change the starting location of your Exploration View or list, type a new row number in the Row
start box and a new column number in the Column start box.

3. If you are working with a TM1 Exploration View, you can choose whether to process data in either CSV
or raw XML format.

« To choose CSV format for faster processing of large data sets, in the Request format drop-down box,
click Unformatted Values.

« To choose raw XML format, in the Request format drop-down box, click Formatted Values.
4. If you are working with a IBM Cognos Analytics List, you can choose whether to process data in either
CSV or raw XML format.
« To choose CSV format for faster processing of large data sets, in the Request format drop-down box,
click Unformatted Values.

« To choose raw XML format, in the Request format drop-down box, click Formatted Values.

5. To control how labels appear in nested cells, set the Default grouping option.
Note: The Default grouping option controls how the Group / Ungroup feature works. For Exploration
Views, this is the automatic setting for presentation of metadata in nested rows and columns. For lists,

this determines how the Group /Ungroup menu items and buttons work.These settings override the
settings in the Options dialog box and affect only the current worksheet. You can leave cells
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ungrouped when you need to use Microsoft Excel lookup functions or you can group cells to provide for
greater readability. Changes to the Grouping option will be reflected in the worksheet immediately,
whereas changes in the Options dialog box will only be reflected when a new Exploration View is
created.

- To merge metadata into cells that span nested items and allow for full grouping, click Merge Cells.

« To repeat metadata in individual cells that span nested items, click Repeat Labels.

Use this option when you want to use other Microsoft Excel functions on the data.
« To limit cell metadata and merging to minimize labels, click Label Top Cell.
« To turn grouping off, click None.
6. To limit the number of rows displayed, set the Data Display Row Limit property.

7. After you are done setting options, click OK.

Insert Microsoft Excel calculations

You can insert any Microsoft Excel calculation, such as AVG, MIN, or MAX into an Exploration View or list.
You can reference cells both inside and outside the exploration.

Procedure

1. Insert a blank column or row.

2. Create the calculation in the first cell that applies to the inserted column or row.
You must create the formula for the calculation in the cell closest to cell Al (the upper left most cell) of
the inserted group.

3. After you have created the calculation for a single cell, from the toolbar, click Use Server formats to
remove custom formatting.

Results
The calculation is propagated to all the inserted cells.

Tip: You can apply conditional formatting to the calculated column or row. Select the column or row. Click
Home and then click Conditional formatting. Use the conditional formatting menu to choose the styles
for the cells.

Change the cube or datasource used by an exploration
You can change the cube or datasource that is used by an exploration.

Before you begin

The information area must be displayed above the Exploration View or list to complete this task. Show the
information area by enabling the Show system and package information in Exploration View or list

™y

sheet setting in the Options. Then click Refresh %~ to see the information area.

Procedure

1. Open the worksheet that contains the exploration.

2. In the information area above the exploration, double-click the cell that displays the System or
Package information.

3. In the Select package dialog box, you can change the datasource by using the System drop-down to
select a new datasource.

4. In the Select package dialog box, you can change the cube by expanding one of the models in the
main pane and selecting a new cube.

5. Click OK.
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Quick Reports

You use Quick Reports to work with IBM TM1 data in Microsoft Excel in a more dynamic way.

You can combine data from multiple data sources in a Quick Report and then enhance the data by using
Microsoft Excel formulas, formats, and cell references.

When you create a Quick Report or list, you'll notice that the IBM Planning Analytics ribbon changes, and
includes a Quick Report group.

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER IEM® Planning Analytics
= 2] Options 7| H ¢ /‘\  Commit & Clear~ plan_BudgetPlan:.. ~| |[Base] -
=! (7)Help~ ' % Discard 1'% Snapshot - VOLEHS +New

Connect Task Open Publish Exploration List Action Refresh
g Pane Button Sheet -

Getting Started Content Add Data Quick Report Sandbox

The Quick Report group contains tools, which you can use to work with your Quick Report.

plan_BudgetPlan:... ~

vOLBRHE

Quick Report

v Commit - Use the Commit tool to commit data changes in the Quick Report.

"~ Refresh - Use the Refresh tool to refresh the data in the Quick Report. To learn more about
refreshing Quick Reports, see “Refresh” on page 77.

‘Q Clear - Use the Clear tool to clear the data in the Quick Report. To learn more about clearing, see
“Clear cell content” on page 52.

U.:; Convert - Use the Convert tool to convert the Quick Report to a snapshot. To learn more about
converting to snapshots, see “Convert dynamic data to snapshots (static data)” on page 53.

l
= Highlight - Use the Highlight tool to highlight the Quick Report.

- Properties - Use the Properties tool edit the properties of the Quick Report.

Create a Quick Report
You can create a Quick Report from an Exploration View or from an existing view in the Task Pane.

This video demonstrates how to create Quick Reports: https://youtu.be/KDIFcpeUrnU.

After you create a Quick Report, you can change or add members, format the cells, and create charts from
the data. For example, you can change members and data using options such as typing the name of a
different member in a cell.

You can combine multiple Quick Reports on the same worksheet. Each Quick Report can be based on a
different data source. You can provide unique perspectives by creating calculations that reference
multiple Quick Reports. Another useful option for multiple Quick Reports on the same worksheet is to use
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cell references to apply the same filter to more than one Quick Report. For example, you create three
Quick Reports on a worksheet to show different views of financial performance by region. The region
name appears in cell B4 in the context region on the first Quick Report. In the second and third Quick
Reports, you change the region name cell to a cell reference to cell B4. After you create the cell
references, you update the first worksheet to show data for a different region, either by dragging a
different region to cell B4 or by typing a region name in cell B4. When you refresh the data, all Quick
Reports show data for the new region.

Sets are a useful tool for building explorations and Quick Reports with TM1 data. For more information
about creating sets, including dynamic sets that can automatically reflect changes in a dimension, see
“Sets for TM1” on page 92.

Quick Reports regions

Each Quick Report includes four regions: rows, columns, context, and data. Each region is a named range
in Microsoft Excel. For example, the defined name for the rows region of the first Quick Report you add to
a worksheet is tm1\\_0_R. You can use the names when you use Microsoft Excel features such as creating
formulas.

To highlight a region on the worksheet, from the Task Pane, right-click a Quick Report in the Quick
Reports folder and select a region from the Show Regions list.

Create a Quick Report from an Exploration View
Create a Quick Report from an IBM TM1 Exploration View when you finish your analysis and want to
present data by using more advanced cell-based features from Microsoft Excel.

When you convert Exploration Views to Quick Reports the application places the system information,
rows, and columns in named ranges.

If you have views, explorations, or other Quick Reports available in the Task Pane, you can drag these to a
worksheet to create a Quick Report. For more information, see “Create a Quick Report by using a view” on
page 75.

Procedure

1. Open or create an Exploration View.

2. Click Convert to and select an option.
For example, to create the Quick Report on a new worksheet, select Convert to > Quick Report > On
New Sheet.

Results

The Exploration View is converted to a Quick Report. The Quick Report is listed in the Task Pane >
Workbook tab in the Quick Reports folder.

Note: Calculations created in an Exploration View need to be recreated in Microsoft Excel after converting
to a Quick Report.

Create a Quick Report by using a view
You use a view, Exploration View, or a Quick Report to create a new Quick Report.

A worksheet can contain more than one Quick Report.

Procedure

1. Log on to a TM1 system and select a data source.

For more information, see “Open a model or package ” on page 17.

The source tree in the Task Pane displays the cube and related items of the data source, such as views.
2. Expand the Views folder.
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3. Use one of the following methods to create a Quick Report.

« Drag a view onto a worksheet.
« Right-click a view, click Quick Report, and select where to place the Quick Report.

Note: You can also create a Quick Report by dragging an Exploration View from the Explorations folder
onto a worksheet or by dragging a Quick Report from the Quick Reports folder.

Add members

You can add members to the rows and columns of a Quick Report. You can add a member from the same
dimension or a different dimension.

This video demonstrates how to add members to Quick Reports: https://youtu.be/8rYnw0OXfcSk

To add a row, select the cell below the last row title member, type a member name, and then click
Refresh .

To add a column, select the cell to the right of the last column title member, type a member name, and
then click Refresh .

Note: If the Use Type-in Refresh option is enabled, the Quick Report refreshes automatically. You do not
need to click Refresh. To enable type-in refresh, in the Task Pane > Workbook tab, right-click the Quick
Report and select Properties > Use type-in refresh.

By default, no cell styles are applied to the added values. You can change this behavior by setting the
MapAddedRowColumnStyle parameterin the CognosOfficeReportingSettings.xml file. The
possible values for the parameter are as follows:

- NoStyle: Do not apply any cell styles to extended values

« ServerStyle: Apply server styles to extended values

« LastRowColumnStyle: Apply the styles from the last row or column to extended values

Example

Suppose that you have a Quick Report with the following members in the rows and columns:

= Columns: Total Year, Jan, and Feb in cells B7, C7, and D7

- Rows: Existing Stores Revenue, Gross Margin %, and Returns and Allowances in cells A8, A9, and A10

Table 8: Example Quick Report

Total year Jan Feb
Existing Stores Revenue 123,072,189 10,197,973 12,597,973
Gross Margin % 36.66% 34.72 34.88
Returns and Allowances | 1,815,532 600,295 109,794

To add March to the Quick Report, type the member name, Mar, in cell E7, to the right of Feb.

To add Volume Discount to the Quick Report, type the member name, Volume Discount, in cell A11, below
Returns and Allowances.

Click Refresh on the Quick Report toolbar. If the Use type-in refresh option is enabled, you do not need
to click Refresh.

The Quick Report refreshes to show values for March and for Volume Discount.
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Table 9: Example Quick Report with March and Volume Discount added

Total year Jan Feb Mar
Existing Stores 123,072,189 10,197,973 12,597,973 13074105
Revenue
Gross Margin % 36.66% 34.72 34.88 41.5098
Returns and 1,815,532 600,295 109,794 140759.6
Allowances
Volume Discount 899712.4 74551.7 69551.7 95577.52

By default, the values in the new row and column are not formatted.

Replace members
Planning Analytics for Microsoft Excel includes several options for replacing members in a Quick Report.

About this task
To replace a member in a Quick Report, use one of the following options.

- Toreplace a member, drag an item from the Task Pane to a cell in the rows region, columns region, or
context region. You can replace a member with a member from the same dimension or a different
dimension.

For example, the context area shows that the Quick Report is filtered on Price. You drag a different
account, Units, to the Price cell to change the context.

- To change members from the same dimension, select a cell in the rows region, columns region, or
context region and from the context menu, select IBM Planning Analytics > Replace Members. Use the
Set Editor to choose members.

For example, the Quick Report shows data for the Europe region. You can use Replace Members to add
the Americas region. Europe and Americas are both part of the World dimension.

« To replace a member in the rows region, columns region, or context region, type the name of a different
member in the cell. You must type the name as it appears in the source tree. You can replace a member
with a member from the same dimension or a different dimension.

For example, the Quick Report includes a column for the S Series 2.5L Sedan model. To show data for a
different model, you type S Series 3.0L Sedan in the column heading.

Procedure
1. Replace a member in the Quick Report and press Enter.
2. Click Refresh **.

Note: If Use Type-in Refresh is enabled, you do not need to click Refresh.

Refresh

If the data in your Quick Report has changed, you can refresh the data to ensure that you are working with
the latest data. You can refresh data in several ways.

About this task
You can refresh your entire workbook, a worksheet, a report, or just selected cells.
- To update the entire workbook, on the IBM Planning Analytics tab, click Refresh All Data.

You can choose to Refresh the data only or Refresh the data and report formatting.

If you choose to also refresh report formatting, formats are updated.
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— Quick Reports update their formatting based on a per-Quick Report flag to use server formats
(instead of the global flag for explorations) and update formats every time the data is pulled.

« Torefresh only the current worksheet, right-click any cell on the worksheet, click IBM Planning
Analytics > Refresh > Refresh worksheet.

« To refresh a specific report, follow these steps:

— Ina Quick Report, click &

- To refresh only specific cells, right-click a cell or range of cells, click IBM Planning Analytics > Refresh
> Refresh selected cells.

« To refresh a Quick Report automatically when a context member changes, edit the Cognos TM1Web
configuration parameters and set the RecalcOnDataValidationChange value to true.

For more information, see Modifying TM1 Web configuration parameters.

« To automatically refresh values in a table when a new value is entered, enable the use type-in refresh
option. You can enable use type-in refresh in the Options dialog. For more information, see “Use type-
in refresh” on page 37.

Note: The type-in refresh option works if an input is made directly to the meta data element. For
example, if the user has a formula in the header cell and then changes the driver, type-in refresh will not
automatically update the data. In this scenario, the user will need to do an explicit refresh to get the
refreshed values based on that change.

For more information, see “Refresh data” on page 52.

Publish, share, and open
You can share Quick Reports with other IBM TM1 users by publishing the workbook to a TM1 Server
Application Folder.

When you open a Quick Report in IBM Planning Analytics Workspace or in TM1 Web, the Quick Report is
displayed as a live websheet. A live websheet maintains its connection to the TM1 server. If the data on
the server changes, a live websheet recalculates and reflects the changes. You can refresh or rebuild the
Quick Report or the workbook by using the buttons on the websheet toolbar.

Note: If the data in your Quick Report is not recalculating, ensure that the Quick Report is connected to
the correct server and that the server is available.

Published Quick Reports can be used as part of a sheet built in IBM Planning Analytics Workspace.

Note: In order for context members in published Quick Reports to synchronize with other dimensions in
IBM Planning Analytics Workspace, SUBNM formulas must be used in defining the context members.

For more information, see “Publish a workbook to a TM1 Server Application Folder” on page 54.

Delete
You can delete a Quick Report from a worksheet.

Procedure

1. In the Task Pane, Workbook tab, expand Quick Reports.

2. Locate the Quick Report you want to delete.
Tip: You can see where a Quick Report is located in a workbook. Right-click a Quick Report and select
Show Report.

3. Right-click the Quick Report you want to delete and select Convert to snapshot.

4. Click Yes.

5. Delete the rows and columns.
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Edit
You can edit data in a Quick Report, if you have Write access to the cells and the cells are editable.
If you are using server formats in the Quick Report, cell shading identifies the cells that you can edit.
« Light blue: A consolidated cell. You cannot edit the value.
« Gray: A derived or locked cell. You cannot edit the value.
« White: An editable cell.

« Dark gray: A cell with a hold applied. Place a hold on a cell to exclude it from data spreading. For more
information, see “Edit TM1 data by using data spreading” on page 103.

Planning Analytics for Microsoft Excel offers different ways to work with IBM TM1 data changes. You can
determine how your user group is designed to operate based on the options presented on the toolbar. For
example, if you have been granted Sandbox capability, you have access to the New Sandbox and Delete
Sandbox options. For more information, see “Writeback mode” on page 98 and “Sandboxes” on page

99.

To edit a value in a cell, click the cell, type the new value, and then press Enter.

To save your changes, you must commit the data to the IBM TM1 server. For more information, see
“Commit data in a Quick Report” on page 79.

If you are using server formats, the cell formatting indicates the state of data changes.

« Bold blue font: The value in the cell has changed but has not been committed to the TM1 server.

« Orange background: The value in the cell has been committed to your sandbox, but has not been
committed to Base.

After you commit the changes, the Quick Report displays the updated values in a normal font, indicating
that you have saved the changes.

Commit data in a Quick Report
After you have entered values in a Quick Report, you can commit your changes to save the values to the
TM1 server.

On the Quick Report toolbar, click Commit +'. The Commit Changes dialog box is displayed.

Note: If you have enabled the Hide commit confirmation option, the Commit Changes dialog box is not
displayed and the values are committed to the TM1 server. If any errors are found, the Error Report dialog
box is displayed.

To preview the changes, click Preview changes. The Commit Preview dialog box displays the data
changes, along with any errors. To commit valid changes, click Commit valid. If any errors are found, the
Error Report dialog box is displayed.

To commit changes without previewing them, in the Commit Changes dialog box, choose one of the
following options:

« To validate and then commit only the changed data, click Commit changes.

« To commit all data in the Quick Report without validating the data first, click Commit all. If any invalid
vales are found, they are displayed. You then have the option to continue and just commit valid data, or
to cancel and fix the invalid values.

Note: You cannot undo changes after you have committed them to the TM1 server.

For information about resolving errors, see “Resolve errors when committing data to a TM1 server” on
page 108.

Quick Report double-click options

Users can define the action executed after double-clicking on the dimension or context areas of a Quick
Report.
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About this task

You can use this option to define the action that occurs after double-clicking on the dimension or context
areas of a Quick Report.

Table 10: Drop down options

Argument Description
None No action occurs after double-clicking.
Replace Double-clicking a dimension or context member opens the set

editor to allow a replacement of that member.

Toggle Expands and collapses consolidated members when double-
clicked on the dimension areas. Launches the set editor when
double-clicked on the context area.

Procedure

1. On the IBM Planning Analytics tab, click Options ©*.

2. In the navigation pane, click IBM Planning Analytics.

3. Under Quick Report settings, select the option under the Double-click option drop down.
4. Click OK.

Change the cube and datasource used by a Quick Report
You can change the cube and datasource that is used by a Quick Report.

Procedure

1. Click the worksheet that contains the Quick Report.
2. In the Task Pane, Workbook tab, expand Quick Reports.

3. Right-click the Quick Report that you want to change, and click Properties.
The Properties dialog box is displayed.

4. Click Update....
The Select package dialog box is displayed.

5. In the Select package dialog box, you can change the datasource by using the System drop-down to
select a new datasource.

6. In the Select package dialog box, you can change the cube by expanding one of the models in the
main pane and selecting a new cube.

7. Click OK in the Select package dialog box.
8. Click OK in the Properties dialog box.

Dynamic Reports

You can use Dynamic Reports to create complex reports that combine the functionality of IBM TM1 with
Microsoft Excel features.

Dynamic Reports are implemented through a series of worksheet functions that define the components of
a form, such as context members, row members, and display properties. When you convert an Exploration
View to a Dynamic Report, the functions are created for you.
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Dynamic Reports support features available in explorations and Quick Reports, such as selectable context
members, stacked row and column dimensions, expandable/collapsible consolidations (rows only), zero
suppression (rows only), and inserting rows and columns (with some restrictions).

You can use a filter by adding the TM1RPTFILTER function, for more information, see “TM1RPTFILTER” on
page 134.

In addition, you can define dynamic formatting for the Dynamic Report by using standard Microsoft Excel
format options directly in the worksheet.

Column dimensions are static in Dynamic Reports. You cannot expand or collapse consolidated column
members in a Dynamic Report by clicking them. Although the column dimension members are set when
you create the Dynamic Report, you can manually edit column members. When you enter a valid member
name for a column member, the Dynamic Report returns values from the server.

When you create a Dynamic Report or list, you'll notice that the IBM Planning Analytics ribbon changes,
and includes a Dynamic Report group.

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER IBM® Planning Analytics
t- G Options r]! 0 Y & Clear~ 9 Rebuild Sheet = Show Format Areas
~l- ] . :
(2)Help~ . . — E Snapshot = dH Rebuild Book = Hide Format Areas
Connect Task Open Publish Exploration List Action Refresh -
- Pane Button Sheet - £ Recreate Book
Getting Started Content Add Data Dynamic Reports

The Dynamic Report group contains tools, which you can use to work with your Dynamic Report.

B Rebuild Sheet L—: Show Format Areas
{7 Rebuild Book 1—L Hide Format Areas
ﬁc Recreate Book

Dynamic Reports

EFE Bebusict Sheet Rebuild Sheet - Use the Rebuild Sheet tool to rebuild all Dynamic Reports in the current

sheet. To learn more about rebuilding in Dynamic Reports, see “Refresh, rebuild, or recreate” on page
83.

B Rebuild Book Rebuild Book - Use the Rebuild Book tool to rebuild all Dynamic Reports in the current
book. To learn more about rebuilding in Dynamic Reports, see “Refresh, rebuild, or recreate” on page 83.

" Recreate Book i i
g RO Recreate Book - Use the Recreate Book tool to recreate all Dynamic Reports in the

current book. To learn more about recreating in Dynamic Reports, see “Refresh, rebuild, or recreate” on
page 83.

4 oo Pt £ uems Show Format Areas - Use the Show Format Areas tool to show the format areas of
Dynamic Reports in the current sheet. To learn more about format areas in Dynamic Reports, see “Report
format” on page 87.

=i Hide Format Areas . . .
2 Hide Format Areas - Use the Hide Format Areas tool to hide the format areas of

Dynamic Reports in the current sheet. To learn more about format areas in Dynamic Reports, see “Report
format” on page 87.
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Create Dynamic Reports
You can create a Dynamic Report from a view or Exploration View that uses TM1 data.

Procedure

1. To create a Dynamic Report from an Exploration View, on the IBM Planning Analytics tab, on a
worksheet that contains an Exploration View, click Convert To > Dynamic Report and then select a
location.

2. To create a Dynamic Report from a view, right-click a view in the source tree, click Dynamic Report,
and select an option.

Results
The Dynamic Report is created in a new worksheet.

Note: If you rename the sheet that the Dynamic Report is created on, ensure that the sheet name:

- Starts with a letter, number, or an underscore.
« Does not contain any spaces.
« Does not contain any special characters.

Does not have the same name as an existing sheet in the workbook.
« Does not resemble a cell address (for example, A$35 or R2D2).

Add multiple Dynamic Reports
You can add multiple Dynamic Reports to your worksheet.

Before you begin

Adding multiple Dynamic Reports is a great way to view, analyze, and compare data. Before you add
multiple Dynamic Reports, it is important to be aware of the following limitations:

« Use a top to bottom design approach. Additional Dynamic Reports should only be added below an
existing Dynamic Report.

« Multiple Dynamic Reports cannot exist side by side and the rows of two Dynamic Reports can never
overlap.

« Additional Dynamic Reports cannot be added to the left of the first Dynamic Report.

 Multiple Dynamic Reports on the same worksheet will share the same format range. To learn more
about formatting a Dynamic Report, see “Report format” on page 87.

Procedure

1. Select a cell below an existing Dynamic Report.

2. Right-click a view in the source tree, click Dynamic Report, and select At current location or At
specified location.

Results
An additional Dynamic Report is added to the worksheet.

Note: If the values of your Dynamic Reports seem incorrect after adding multiple Dynamic Reports,
ensure that no two Dynamic Reports have overlapping rows.
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Insert a Dynamic Report section
You can insert additional sections to your Dynamic Reports.

About this task

Inserting a Dynamic Report section allows you to view, analyze, and compare multiple subsets that share
the same context on a sheet.

Procedure

1. Right-click on the Dynamic Report header row.

g b 0N

. Click IBM Planning Analytics.

. Click Insert Dynamic Report Section.

. Select the subset(s) you want to insert as a Dynamic Report section.

. In Number of Rows Below, define the number of rows below the Dynamic Report that you want the

Dynamic Report section to be added.
6. Click OK.

Results

The Dynamic Report section is added below the Dynamic Report. If you selected multiple subsets, then
multiple Dynamic Report sections are added below the Dynamic Report.

Note: The dimension that is in the master row definition determines the subsets that you can choose to
insert as a Dynamic Report section. If you would like to select subsets from a different dimension, you
need to update the TMIRPTROW formula of the Dynamic Report.

Refresh, rebuild, or recreate
You can refresh, rebuild, or recreate a Dynamic Report.

Refresh

You can refresh a cell, the worksheet, or the workbook. When you refresh a Dynamic Report, the
following actions occur:

« The existing query is run and the physical rows on-screen are refreshed. Transient states, such as

toggles, are preserved.

« The data is refreshed from the TM1 server.
« The headers are updated.

- If the number of rows in the data area has changed, or if a value in the ID column of the format

range has changed, the formatting is updated.

Changes that you have made, such as drilling down or changing function parameters, are preserved.
Rebuild

When you rebuild a Dynamic Report, the following actions occur:

The row set computations from the TM1RPTROW functions are rebuilt.

The physical rows on-screen are refreshed. Transient states, such as toggles, are not preserved.
The data is refreshed from the TM1 server.

The headers are updated.

The formatting is updated.

The state of the TM1RPTROW functions in the Dynamic Report is updated. For example, if you
change the TM1RPTROW functions to point to a different named set, rebuilding the Dynamic Report
drops the existing row set, reevaluates the TM1RPTROW function against the set, and updates the
Dynamic Report rows with the result.
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Recreate
When you recreate a Dynamic Report, the following actions occur:

« All content across the physical row area is recreated.

« The row set computations from the TM1IRPTROW functions are rebuilt.

- The physical rows on-screen are refreshed. Transient states, such as toggles, are not preserved.
- Any updates to the formatting area are fully reapplied.

You need to recreate a Dynamic Report, for example, if you change the format function of the Dynamic
Report.

Refresh, rebuild, or recreate from the source tree
You can refresh, rebuild, or recreate your Dynamic Reports from the source tree.

Procedure

1. In the source tree, Workbook tab, expand Dynamic Reports.
2. Do one of the following actions:

- To refresh the Dynamic Report, select the Dynamic Report, and then click Refresh.
« To rebuild the Dynamic Report, right-click the Dynamic Report in the tree, and then click Rebuild.

Tip: You can also rebuild all Dynamic Reports in a workbook by pressing ALT+F9.
« To recreate the Dynamic Report, right-click the Dynamic Report in the tree, and then click Repair.

Tip: You can also recreate a Dynamic Report by deleting all rows except the first row, and then
rebuilding the form.

Refresh, rebuild, or recreate from the IBM Planning Analytics ribbon
You can refresh, rebuild, or recreate your Dynamic Reports from the IBM Planning Analytics ribbon.

Procedure
1. In the IBM Planning Analytics ribbon, Dynamic Reports section, do one of the following actions:

 To rebuild the Dynamic Report, click Rebuild Book.
» Torecreated the Dynamic Report, click Recreate Book.

2. To refresh the Dynamic Report, click the Refresh icon in the IBM Planning Analytics ribbon, Data
section, and select one of the options.

Expand and collapse rows
You can expand a consolidated member in a row to view its children.

About this task

Consolidated members that are collapsed have a plus sign (+) to the left of the member name. To expand
the row to view the child members, double-click the member name.

Consolidated members that are expanded have a minus sign (-) to the left of the member name. To
collapse a consolidated member to hide the child members, double-click the name of the consolidated
member.

When you expand or collapse a member, all instances of that member are expanded or collapsed.
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Suppress or display zeros
You can selectively suppress or display rows that contain only zero values in a Dynamic Report.

About this task

Zero suppression is controlled by the value of the ZeroSuppression argument to the TM1RPTVIEW
function. If this argument value is 1, zeros are suppressed in the Dynamic Report; if the argument value is
0, zeros are not suppressed in the Dynamic Report.

Procedure

1. Unhide the rows above the Dynamic Report until you see the cell that contains the TM1RPTVIEW
function.

2. To suppress zeros, change the second parameter to 1. To show zeros, change the second parameter to
0.

Edit the row set
You can use the Set Editor to modify the row set in a Dynamic Report.

About this task

The rows in a Dynamic Report are defined by a TMARPTROW function, which is defined when the Dynamic
Report is created. When you modify the row set by using the Set Editor, the TM1IRPTROW function is
updated to reflect your changes.

Procedure

1. Right-click the first (top) row member in the Dynamic Report.
2. Select IBM Planning Analytics > Edit Set.

3. Define a set by using the options available in the Set Editor. For more information, see “Sets for TM1”
on page 92.

4. Click Apply and close.

Change context members
You can access a different view of cube data by changing a member in the context area.

Procedure

1. Double-click a member in the context area.
The Set Editor is displayed.

2. Select a member.
3. Click Apply and close.

Insert columns
You can insert columns in a Dynamic Report.

You can insert a column in any of the following locations.

« Directly within the Dynamic Report
- To the right of the Dynamic Report
 To the left of the Dynamic Report

Do not insert a column between two row dimensions in a Dynamic Report.

Inserted columns persist when you refresh or rebuild (ALT+F9) the Dynamic Report.
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Insert rows
You can insert rows in a worksheet that contains a Dynamic Report.

You can insert a row in any of the following locations.
« Within the Dynamic Report, outside the data area

« Above the Dynamic Report

 Below the Dynamic Report

Do not insert a row between existing rows in the data area, because this disrupts the row set of the
Dynamic Report.

Inserted rows persist when you refresh or rebuild (ALT+F9) the Dynamic Report.

Display the data source or package of a formula

When working in Dynamic Reports and Custom Reports, you can use more than one data source or
package. You can synchronize the source tree when moving from cells of one data source or package to
another. Synchronizing the source tree enables you to see accurately the dimensional data used to
populate the cells.

Right-click a formula cell and click IBM Planning Analytics > Display Package. The Task Pane displays
the package or data source that was used to create the selected cell.

Change the model and cube used by a Dynamic Report

Update the cube and datasource of a Dynamic Report to switch from a test to a production environment,
for example, or to access information from a different set of financial data, such as a submission.

You need to update the formulas in the Dynamic Report to reference a new cube or datasource. If your
formulas reference cells to obtain the cube and datasource name, you will need to update the referenced
cells.

You need to modify the following formulas:

« TM1RPTVIEW

- SUBNM formulas for context members
TM1RPTROW for the first row title member
- DBRW formulas for the cells in the data area

Note: You may need to unhide the rows to reveal the format range.

The first parameter of the TM1RPTVIEW formula specifies the model and cube name to use in the
Dynamic Report. Make the TM1RPTVIEW formula visible by revealing the format range above the Dynamic
Report so that you see the server name and data source name. Edit the TM1RPTVIEW formula to use a
different server and data source. For more information on revealing the format range, see “Report format”
on page 87.

Context members are defined by SUBNM formulas. The first parameter of each SUBNM formula specifies
the model and cube name. Modify the SUBNM formulas to use the new model and cube.

Row title members are defined by a TM1RPTROW formula in the first row title. The second parameter of
the TM1RPTROW formula specifies the model and cube name. Modify the TM1RPTROW formula to use
the model and cube.

Cells in the data area are populated by DBRW formulas. The first parameter of a DBRW formula specifies
the model and cube name. Modify the formulas to use the new model and cube name. Or, if the DBRW
formulas reference a cell containing the model and cube name, update the referenced cell.

Tip: You can modify DBRW formulas in a range of cell by using the Function Editor. For more information,
see “Modify a range of DBR and DBRW functions” on page 141.

Alternatively, return to the Exploration View that you used to create the Dynamic Report, change the
model and cube name, and then convert the Exploration View to a Dynamic Report.
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Report format

The formatting in a Dynamic Report is specified by format definitions within a format range. You can
change the formatting of a Dynamic Report by changing the cell formatting of format definitions and by
adding new format definitions.

You can also follow along by watching this video: https://youtu.be/Rm4PR34LCx4

The format range is hidden by default. You must reveal the format range before you can modify the
default formatting or create new format definitions. To reveal the format range, press Ctrl-A. On the Home
tab, under Cells, click Format > Hide and Unhide > Unhide Columns. Click Format > Hide and Unhide >
Unhide Rows. Repeat and select Unhide Columns. Cell A1 will now be visible. For more information
about hiding and unhiding rows and columns, see the Microsoft Excel online help.

The format range can also be revealed and hidden by clicking Show Format Areas and Hide Format
Areas from the IBM Planning Analytics ribbon, in the Dynamic Reports section.

BF Rebuild Sheet = Show Format Areas
8 Rebuild Book = Hide Format Areas

£¥ Recreate Book

aamic Benorts

Row 1 contains the Begin Format Range label. The last row of the format range contains the End
Format Range label. All formatting for the Dynamic Report must be defined between these labels.

The rows between the Begin Format Range label and the End Format Range label contain the default
format definitions for the Dynamic Report.

The format label column (typically column A) in the format range contains the format definition labels for
each format definition. Format definition labels can be numbers, letters, or strings.

For each data row in the Dynamic Report, the format label column (typically column A) contains a format
definition label, which determines the format definition to apply to the row. When you first generate a
Dynamic Report, the format definition corresponding to the level of each row set member is applied. Leaf
indicates a leaf level member, while Default indicates a consolidation level greater than the number of
level format definitions defined in the format range. For example, if you define format definitions for levels
0 - 5, Default defines the formatting for all other levels.

Example
For example, suppose that you have the following row set.
« World (Level 0)
— North America (Level 1)
— South America (Level 1)
- Argentina (Leaf)
- Brazil (Leaf)
- Uruguay (Leaf)

World is a level 0 member in the row set, so the 0 format definition is applied to the World row. South
America is a level 1 member, so the 1 format definition is applied. Uruguay is a leaf member of the row
set, so the Leaf format definition is applied.

Format definitions
The format definitions in a Dynamic Report are applied based on the return value of an IF function in the
format label column (typically column A) for each row in the Dynamic Report.

The IF function uses several worksheet functions. The basic logic of the IF function is as follows:

1. Determine whether the row member is a consolidation.
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2. If the row member is a consolidation, determine whether the subset member level of the consolidation
is less than or equal to the last level format definition defined in the format range.

« If the subset member level of the consolidation is less than or equal to the defined format definitions
for levels, return the subset member level.

« If the subset member level of the consolidation is greater than the last format definition for levels,
return Default.

3. If the row member is not a consolidation, return Leaf.

The following is an example of the default IF function that is created when you convert an Exploration
View to a Dynamic Report. The function TM1RPTELISCONSOLIDATED determines if the member is
consolidated or not. The function TM1RPTELLEV returns the level of the member. If the level is 6 or
greater, the functions returns Default. If the member is not consolidated, the function returns Leaf.

=IF (TM1RPTELISCONSOLIDATED ($B$22,$B22) ,IF (TM1RPTELLEV ($B$22,$B22)<=5,
TM1RPTELLEV ($B$22,$B22), "Default"),"Leaf")

You can change the IF function. The function must return a value that can be matched to an ID in the
defined format range area. After you modify the IF function, repair the Dynamic Report to apply the
formatting. For more information, see “Apply format definitions” on page 89.

Modify formatting
You can modify the formatting of a Dynamic Report by modifying the cell formatting of format definitions.

When you modify the formatting of a cell in the format range, all cells in the Dynamic Report that use the
corresponding format definition are updated when you rebuild or repair the form. You can use the
standard Microsoft Excel cell formatting options to change format definitions.

You can also follow along by watching this video: https://youtu.be/0YQAtVoXdEk

For example, if you modify format definition 1 by applying an orange background to cell C3 and then
rebuild the Dynamic Report, all Dynamic Report rows that use format definition 1 display the orange
background color in column C.

You can also modify the formatting of Dynamic Reports by modifying the named styles that are used in
Dynamic Reports. When you modify a named style, all cells in a workbook that use the named style are
updated. You do not need to refresh, rebuild, or repair the Dynamic Reports to apply the change.

For example, the named style that is applied by default to the first row of data in a Dynamic Report is AF
Data O - IBM Cognos. If you change the fill color of this style to green, the change is reflected in all of the
cells in your workbook that use the AF Data 0 - IBM Cognos style.

You can apply different formatting to each cell in a format definition. For example, you can apply a
different background to each cell for format definition 1. You can apply an orange background to cell C3, a
blue background to cell D3, and a green background to cell E3. When you rebuild the form, cells with
format definition 1 display an orange background in column C, a blue background in column D, and a
green background in column E.

Any text or numbers you enter in a format definition row, other than in the format label column (typically
column A), are ignored. You can safely enter notes or characters to make it easy to identify the format of
any cell in the format range. For example, you can add a note in cell C3 as a reminder that this cell
determines the formatting for row title members.

To modify format definitions, reveal the format range, and then apply cell formatting to the cells in the
format range.

Note: To reveal the format range, unhide all rows and columns in the worksheet.

To see your changes, rebuild or repair the Dynamic Report.
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Create format definitions
You can create format definitions for a Dynamic Report.

About this task

Each format definition must be assigned a unique label, and all format definitions must be inserted
between the Begin Format Range and End Format Range labels.

Procedure

1. Right-click the End Format Range label and select Insert.

2. Click Entire Row and then click OK.
A new row is inserted in the format range, inheriting the formatting of the preceding row.

3. In the first column of the format range (typically column A), enter a label for the format definition.
The label must be unique within the format range.

4. Apply formatting to the cells in the new format definition row.
Tip: You can enter notes or characters in columns other than the label column (typically column A) to
make it easy to identify the format of cells in the format definition.

5. Apply the format definition to the Dynamic Report. For more information, see “Apply format
definitions” on page 89.

6. Rebuild the Dynamic Report by pressing ALT+F9.

Apply format definitions
You can apply format definitions to rows in a Dynamic Report. Apply format definitions if you have
changed the label of a format definition or if you have created new format definitions.

About this task

If your Dynamic Report uses more than one format definition, the format label column (typically column
A) of the first row in the Dynamic Report must contain a function that resolves to one of the format
definition labels in the format range. The format label column is set in the TM1RPTVIEW function by using
a cell reference or a named range.

To maintain dynamic formatting, do not use hardcoded values when you specify format definition labels in
the format label formula.

Procedure

1. Click the cell at the intersection of column A and the first data row in the Dynamic Report.
2. Modify the IF function to resolve to the format definition labels set in the format range.
3. Repair the Dynamic Report and view the formatting.

For more information, see “Refresh, rebuild, or recreate” on page 83.

Note: If the function in column A resolves to a value that is not used as a format definition label, no
formatting is applied to the Dynamic Report row.

Publish

You can share Dynamic Reports with other IBM TM1 users by publishing the workbook to a TM1 Server
Application Folder.

When you open a Dynamic Report in IBM Planning Analytics Workspace or in TM1 Web, the Dynamic
Report is displayed as a websheet. You can refresh or rebuild the Dynamic Report or the workbook by
using the buttons on the Websheet toolbar.

For more information, see “Publish a workbook to a TM1 Server Application Folder” on page 54.
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Usage notes
Be aware of conditions and limitations when you use Dynamic Reports.

« Worksheet names must not include the dash (-) character.

Do not use a dash in the name of the worksheet that contains the Exploration View that you use to
generate a Dynamic Report. Also, do not use a dash in a worksheet that contains a Dynamic Report.

« The Sort feature of Microsoft Excel is not supported for Dynamic Reports.
- Dynamic Reports require at least one row dimension.

The Exploration View or list view from which you generate a Dynamic Report must contain at least one
row dimension. If the Exploration View or list view does not contain a row dimension, the Convert to
Dynamic Report option is disabled.

Create a Custom Report

You can create reports by using TM1 worksheet functions to populate the cells of the report.
You can create a Custom Report by using the following methods:

 Converting an Exploration View to a Custom Report
« Converting a view in the source tree to a Custom Report
- Manually entering formulas to build a report

The context members of a Custom Report can be defined by using SUBNM formulas. The data cells can be
defined by using DBRW formulas.

If you want to combine TM1 worksheet functions with automatic formatting, consider using a Dynamic
Report. For more information, see “Dynamic Reports” on page 80.

Convert a TM1 Exploration View to a Custom Report

Convert a TM1 Exploration View to a Custom Report when you want to manipulate individual cells. You
can use data from multiple data sources in a Custom Report.

You can also create a Custom Report completely from scratch using the cell-based method.

About this task

When you convert an Exploration View, you have the option of converting data on the current worksheet,
copying and moving the data to a new worksheet, or specifying the location for the converted data.

The Exploration View must have at least one row or column dimension.

In the converted report, context members are defined by SUBNM formulas. Data cells are defined by
DBRW formulas. You can modify these formulas by double-clicking the cells.

Text values in formulas are limited to 255 characters. To create text values longer than 255 characters in
a formula, use the CONCATENATE function or the concatenation operator ( &).

Procedure

1. Go to the worksheet that contains the Exploration View that you want to convert.
2. Click Convert to > Custom Report and select an option.

« To convert the Exploration View to formulas and place the result on the current worksheet, select On
This Sheet.

« To convert the Exploration View to formulas and place the result on a new worksheet, On New
Sheet. By placing the results on a new worksheet, you preserve the original Exploration View.

- To convert the Exploration View to formulas and specify the location, which is a cell in an existing
spreadsheet, select At Specified Location.
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Results

The drop zones disappear. The formatting remains the same, but the cells of the Exploration View contain
TM1 formulas, which link the individual cells to data in the cube. An information area above the Custom
Report shows the context members of the report.

You can continue to modify the worksheet by editing formulas and applying formatting.

Create Custom Reports by using a view
You can create a Custom Report from a view. Views are listed in the source tree in the Views folder.

Before you begin

You have access to a TM1 data source. The data source includes views. The administrator has configured
your access privileges.

Procedure

1. Select a TM1 system.
2. Log onto a TM1 server.
3. Select a data source.
The source tree displays the cube and related items of the data source, such as views.
4. Expand the Views folder.

5. Right-click a view, click Custom Report and choose an option.

What to do next

You can also create Custom Reports from a view opened in the cube viewer. See “Create a report” on page
180.

Create Custom Report manually

You can create a Custom Report by entering formulas in cells and by dragging members from the source
tree.

For example, you can drag members from the source tree for the rows and columns, and then use DBRW
formulas to get data from the cube. You can define context members by using SUBNM formulas, and then
reference the SUBNM cells in the DBRW formulas.

You can also copy formulas from other worksheets to build the report. For example, if the context
members you need are defined on another worksheet, you can copy the cells to the formula-based report,
modify the context members as needed, and reference them in the DBRW formulas.

Change the cube and datasource of Custom Reports

Update the cube or datasource that formulas reference to switch from a test to a production environment.

For example, you can update the cube or datasource to access information from a different set of financial
data, such as a submission.

Procedure

1. From the worksheet you want to update, log on to the datasource and select the datasource.
2. To update all formulas in the report, do one of the following steps.
- If you are working with a Custom Report that you created from an Exploration View, edit the Cube in

the information area above the report. Use the format server:cube. server represents the name
datasource containing the cube and cube is the name of the cube.

Note: You may need to unhide the rows to reveal the format range. For more information on
revealing the format range, see “Report format” on page 87.
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- If you are working with a Custom Report that you created manually, modify the cells where you
defined the server name and the cube name.

3. To update specific formulas, locate the formulas and modify the server:name parameter.

Tip: Use the Microsoft Excel search and replace function to update embedded references in the text of
cell formulas.

Sets for TM1

Use sets to select, group, and save lists of members that identify the data you want to analyze.

Use sets when you work with IBM Planning Analytics data sources.

When you use IBM Cognos Analytics data sources, you use custom sets. For more information about
custom sets, see “Custom sets” on page 163.

A dimension can have thousands of members. It is unlikely, however, that any report requires all members
from all dimensions. Use sets to narrow the list of members that you see in a report. For example, you can
use sets to focus on the following:

Product groups that you track.

« Top-producing salespeople.

« Lagging sales regions.

« Stores that have common attributes, such as square footage and the number of employees.

You create sets using the set editor. You can then save the set to either a public or a private folder. Public

sets are available to other users. Private sets are available only to you. When you use a private set in a
report, the only save option for the report is private view.

A set is either static or dynamic.

- Static set - Contains a user-defined list of members that does not change unless you manually edit the
set.

For example, you are responsible for budget planning for departments 405, 410, and 415. You create a
set based on the Department dimension that includes the members 405, 410, and 415. If your
responsibilities change and you need to add department 210, you must manually edit the set to include
the 210 member of the Department dimension.

« Dynamic set - Uses filters to determine the members to include in the set.

For example, your company sells golf equipment that includes a product line called Course Pro. You
create a set based on the Golf Equipment dimension using a filter where Name contains Course Pro.
When a new product is introduced in the Course Pro line, the new product is automatically included in
reports that use the set.

View members
You can customize how you view members in the Set Editor.

You have several options to use to customize how you view members in the Set Editor.

All members W

Set - Use this option to define which set you want to view members
from, or if you want to view all members from a hierarchy.

Display alias ™= - Use this option to define a display alias that you want to show, or if you want to show
the Member ID.
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n
Attributes d - Use this option to define up to two attributes that you want to show. The sequence in
which you select the attributes determines the order that they're shown in.

=

Totals === - Use this option to define whether leading or trailing totals are shown.

View type E- Use this option to define whether members in the Current Set pane are shown in
Hierarchy view or Definition view .

Create sets
You can create sets from the members in an Exploration View or list view.

This video demonstrates how to create sets: https://youtu.be/xJtdwrDzvYU

Procedure

1.
2.
3.

Open the Exploration View or list view.
In the Overview area, click the arrow in Rows, Columns, or Context and then click Edit Set.

To quickly apply selected members back to the view, select the members that you want to be in the
set in the Available Members pane, and click Replace and close.

The set editor closes and you return to the view.

Follow these steps for more advanced options.

4.

10.

. To overwrite the Current Set to include all members in the Available Members list, click
. To append the members in the Available Members list to the members in the Current Set, click

To add a member from the Available Members list to the Current Set, click the member, and then

click E .

If the list of Available Members is large, or you are unsure of an exact member name, or if you want
to add members that match specific criteria, you can search the list of members. You can also paste
members from an external source into the Set Editor. See Searching for members in a set and Pasting

members into the set editor

, and then click + .

. To change the position of a member within the Current Set, right-click the member, then click one of

the Move options.

. To keep only selected members in the Current Set, select the members, then right-click any member,

then click Keep.

. You can choose to display the alias for a member instead of the caption name. An alias is an alternate

@,

name for a member. Click ™ and select the alias that you want to display in the view.

You can view up to two attributes for a member. Click , select up to two attributes in the order

in which you want to view them, and then click OK.

Applying and Saving your changes

11.
12.

To apply the changes to your view without saving the new set configuration, click Apply and close.
To save your changes as a new set that can be reused in other views, click Save.
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13. Give the new set a name.

14. Select Share public if you want to share the set with other users. Clear this option if you want the set
to be yours alone.

Search for members in a set

Use the search feature of the Set Editor when the list of Available Members is large, or you are unsure of
an exact member name, or if you want your set to include members that match specific criteria.

This video demonstrates how to search in the Set Editor: https://youtu.be/idLV-x5upws

When you search for members and save a set that includes the search results, a dynamic set is created
which contains a query that is run every time the set is opened. If the parent dimension for the set
contains a new member that matches the search, the new member will be included in the set the next
time the set is used and the dynamic query is run.

Use the filter feature in the Set Editor to specify the search parameters and narrow down your search
results. The following are filters you can use in the Set Editor:

« Name - Use this filter to narrow your searches to available member names that contain specific
characters.

« Level - Use this drop-down filter to narrow your searches to available members in a specific hierarchy
level.

Note: The Level filter is only available with the filter operator set as "=".

« Attributes - Use this drop-down filter to narrow your searches to available members that contain
specific attributes. You can filter by selecting an attribute from the drop-down list or by searching within
the drop-down and selecting an attribute.

Procedure

1. To search for members whose names contain a specific series of characters, enter the characters in

the Search available members box, then click O\.

The Available Members list shows all current members that contain the characters you searched for,
and a member named Search that indicates the search criteria. For example, if you search for the
characters "en" in a set of the Region dimension, you get something like this:

Available Members

v | en|

Search results (region)

@, Search - (Name Contains en)
® Denmark

® Sweden

@® Benelux

@ Central Europe

When you add the member Search - (Name Contains en) to your set, the set includes all current
members that contain "en". Additionally, the set will include any future dimension members that
contain "en", such as Greenland or Venezuela.

2. To search on other criteria, click o
3. Select the type of criteria you want to search for: Name, Level, or Attribute.
4. Select a search operator (Contains, =, or <>), then enter the keyword or value you want to search for.
5. If you want to add criteria, click Add filter, then specify the additional search parameters.
You can search on up to three distinct criteria.
6. Click Search.

94 IBM Planning Analytics: Planning Analytics for Microsoft Excel


https://youtu.be/idLV-x5upws

The Available Members list shows all current members that satisfy the criteria that you used, and a
member named Search that clearly identifies the search criteria.

Related tasks

“Convert a dynamic set to static” on page 97

You can convert a dynamic set to a static set. When you convert to a static set, the MDX expression that
generated the dynamic set is deleted and the set contains only the members that are present at the time
of conversion.

Paste members into the Set Editor
You can paste member names from an external source into the Current Set area of the Set Editor.

About this task

You can paste both member names and aliases into the Set Editor, in any combination. When you paste an
alias, the associated member name is inserted into the Current Set, and the alias is displayed only if
aliases are enabled in the Set Editor.

You can paste only member names that already exist in the parent dimension. If you attempt to paste any
names that are not members of the parent dimension, an error message indicates that the names cannot
be pasted and displays a list of those names.

Procedure

1. Copy the member names to the clipboard (CTRL+C) from an external application such as a word
processor, or email.

In a spreadsheet application, names can be aligned on a single row or column, or on a contiguous
rectangular range, but there can be no empty cells within the copied selection. Empty cells will cause
an error when you paste into the Set Editor.

In other applications, such as a word processor or email, each member names should appear on a
separate line or be on a single line separated by tabs. You can also copy member names from a table.
However, there cannot be any empty strings (a line without a member, a table cell without a member, a
tab location without a member) within the copied selection.

2. Use CTRL+V to paste the member names into the Current Set.
If you paste into an empty Current Set, the pasted names become the Current Set.

If you paste into an existing Current Set without selecting an existing member as an insertion point, the
pasted names are appended to the end of the existing Current Set.

If you select a member in an existing Current Set as an insertion point and then paste into the set:

- the pasted names are inserted immediately following the selected member, provided the selected
member is a regular dimension member (leaf or consolidation)

« if the selected member is part of a group of members returned by a dynamic query (or MDX
statement), the pasted names are inserted after the last group member

Add a display alias

When member names are long or cryptic, use a display alias to more easily identify your members.

About this task

Caption
The Caption option uses the dimension's caption attribute name as the display alias. This display alias
is available only if the member's dimension has the caption attribute set. The Caption option is used
by default if the caption attribute exists in the dimension.
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Member ID
The Member ID option uses the member's ID as the display alias. The Member ID option is used by
default if the caption attribute does not exist in the dimension.

Alias list
The Alias list is a list of alias attributes (not including Caption or Member ID). The Alias list is
available only if alias attributes, besides Caption or Member ID, exist for the members.

Note:

« To add or use display aliases, you must have TM1 Server version 2.0.3 or later installed.

- Caption names for views, sets, and Turbo Integrator processes are not supported in Planning Analytics
for Microsoft Excel.

Procedure
1. Open the Set Editor.

2. Click the Display alias icon 2 .
3. Click a display alias option.

Change members in a view by using advanced features

You can use Multidimensional Expression (MDX) code to determine which members appear in a view. This
feature is for advanced users only. For information on TM1 supported MDX functions, see the IBM Cognos
TM1 Reference Guide.

Procedure

1. In the Exploration View or list view, go to the Overview area, click the down arrow in Rows, Columns,
or Context and then click Edit Set.

2. Click Hierarchy view IE, next to Current Set.

3. Click Edit MDX.
MDX code is displayed.

4. Modify the MDX as required.
5. Click OK, and then click Apply and close to return to the Exploration View.

Example

This example takes you through the steps to find car models that constitute the top 20% of sales in a
particular region, using the SData2 server.

1. Create an Exploration view using the sample TM1 server called SData2.

2. In the task pane, navigate to SalesCube cube, and create an Exploration View from the All view onto
the sheet.

3. Click the arrow next to the model tile and click Edit set.

4. Click Hierarchy view IZI, next to Current Set.
5. Click Edit MDX and replace the existing MDX expression with this code:

TOPPERCENT (TM1FILTERBYLEVEL (DESCENDANTS({ [model]. [model].[Total]l}) , 0),
20.000000 , [SalesCube]. ([actvsbud].[actvsbud].[Budget], [region].[region].CURRENTMEMBER,
[accountl]. [accountl]. [Units], [month].[month].[Year]))

6. Click Apply and close to return to the view.

7. Drag the models tile onto the columns. The models shown will be ones whose sales are at least 20% of
the total.
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Convert a dynamic set to static

You can convert a dynamic set to a static set. When you convert to a static set, the MDX expression that
generated the dynamic set is deleted and the set contains only the members that are present at the time
of conversion.

About this task

Converting a dynamic set to a static set is useful when you have added a calculation to a dynamic set, but
want to control the positioning of the calculation in the set. When you add a calculation to a dynamic set,
the position of the calculation in the set is determined by the MDX expression and the position cannot be
changed. When you convert to a static set, you can move the calculation to any location in the set.

Procedure

1. Open the dynamic set in the Set Editor.
2. Click the Members bar, then click Convert to snapshot.

© Members (Selection)

Convert to
snapshot

3. Click Save to save the set as static.

Remove members in a set
You can remove members from a set in an Exploration View or list view.

Procedure

1. Open an Exploration View or list view.
2. In the Overview area, click the arrow in Rows, Columns, or Context and then click Edit Set.
3. To remove a member from the Current Set, right-click the member, then click Remove.

4. To remove all members from the Current Set, click X
5. Click Apply and close.

Results
The set is saved with the member(s) removed.

Modify TM1 data

You can modify data in reports that use an IBM Planning Analytics data source.

For example, when your TM1 Server Application Folder administrator distributes an enterprise-wide plan,
you can use IBM Planning Analytics for Microsoft Excel to create an exploration to review, analyze, and
update the portion of the plan that is assigned to you.

You can edit TM1 data using the following methods:

« You can edit data in the cells of Exploration Views and Quick Reports.
« You can use data spreading in Exploration Views and Quick Reports to distribute numeric values.
« You can add comments to cells

You can also write back data using TM1 worksheet functions, such as DBRW.

IBM Planning Analytics for Microsoft Excel offers different ways to work with IBM TM1 data changes. The
Writeback mode and the Sandbox settings determine how changes to the server data are managed.
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Writeback mode

IBM Planning Analytics for Microsoft Excel offers different ways to work with IBM TM1 data changes. The
Writeback mode in combination with the Sandbox determines how changes to the server data are
managed. Options allow the administrator to mix and match a variety of capabilities so that every
installation and every user group can work in the way that is best for them. In IBM Planning Analytics for
Microsoft Excel you can hold changes in a private workspace so that you can decide when to write the
data changes back to the server and make your changes available to others. This private workspace is
called a sandbox. When you commit the data changes that were in your private workspace to the base
data, the changed values are written to the server.

If you prefer to work directly with the base data without a private workspace, you can choose a direct
writeback method. Another option your administrator can offer is the ability to name and store data
changes in a named sandbox.

When you work in a sandbox IBM Planning Analytics for Microsoft Excel uses a change in cell coloring to
remind you when your data is not yet merged with the base. Once you commit the sandbox, the cell color
is restored to black. For more information, see “Cell coloring for changed data values” on page 101.

Your administrator assigns the capabilities for each user group using the administration tools in IBM TM1.
Since you could be a member of more than one group, your workspace options can be different depending
on your login, the client you use, and the combination of settings. Only administrators have access to the
Capability Assignments.

Ask your administrator for details about how your system is designed to operate. To learn how to
determine your writeback mode and sandbox setting using the toolbar, see “Toolbar options” on page
99. For details about Capability Assignments, see the IBM Cognos TM1 Operation Guide.

Writeback mode settings

The Personal Workspace Writeback Mode capability determines how data is written back to the server.
Writeback mode is determined by whether a user has the Personal Workspace Writeback Mode capability
on or off.

To have the sandbox capability in IBM Planning Analytics for Microsoft Excel, an administrator must
assign you rights in IBM TM1.

Table 11: Personal workspace writeback mode capabilities

Description Capability
Changes are made directly to the base. Off
Changes are held in a temporary area and are manually written to the base On

using the Commit button or option. Cell coloring changes when data is
changed but not yet committed.

The Sandbox capability determines if you can name sandboxes or if you have one default sandbox:

Table 12: Sandbox capabilities

Description Capability
You can name the sandbox and manage multiple sandboxes. On
Only one default sandbox is available. Off

The combination of these settings determines how your data changes are stored and processed.

For example, your user group might offer direct writeback with named sandboxes. This is the default work
design used by TM1. It means that you do not have a personal workspace (instead you have direct
writeback to the server), but you also have the option of naming a set of changes and manually submitting
them. With this setting, when you first open a view, you are in the base and any changes you make are
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written directly to the base. But, if you decide to save your changes in a named sandbox, you can use the
Commit button when you are ready to manually send those changes to update the base.

Consider the case where you usually want to send the data directly to the server. Then you have a set of
changes that you want to gather in a group before you update the server. You can use the Create Sandbox
options to save the current data changes in a private sandbox called Best Case. When you are in the Best
Case sandbox, you use the Commit button to send the changes to the base and make the changes
available to others. After Best Case is committed, those changes merge with the base so that others can
see the changes and you are now in the newly updated base.

If you are working in a sandboyx, it is important to remember that you must manually commit the sandbox
for others to see your changes. Be sure that you are ready to make those changes public and that those
changes should be merged into the base.

If you move back to the base, you are back to using direct writeback. This setting offers flexibility. Users
with this setting need to remember when they are updating the base and when the Commit button is
needed to make changes available to others.

Your administrator may decide that you would like the flexibility to work in a personal workspace
writeback mode, but you do not want the complexity of creating named sandboxes. In this case, your
administrator can grant you the Personal Workspace Writeback Mode capability but deny the Sandbox
capability.

Toolbar options

You can determine how your user group is designed to operate based on the options presented on the
toolbar. For example, if you have been granted Sandbox capability, you have access to the Sandbox part
of the toolbar. When you do not see a sandbox list, work with data in Microsoft Excel and then commit
changes directly to the IBM TM1 server.

Direct writeback and named sandboxes
By default, IBM TM1 is set to use a direct writeback with named sandboxes. Your administrator might
have set your work options to something different.

Table 13: Personal workspace mode and sandbox options

You want to Personal Workspace | Sandbox
Mode
Have data changes update the server immediately. Occasionally, | Off On

you want to save a set of changes and name them before
committing them to the server.

The New icon indicates that you can create and delete sandboxes. Until you create a sandbox, you are
operating in the base.

Direct writeback without sandboxes
In direct writeback mode you do not have access to named sandboxes. You work with data in Microsoft
Excel and then click the Commit Changed Values icon to commit changes directly to the IBM TM1 server.

To use direct writeback across the entire installation, you can set DisableSandboxing=T in the TM1
server configuration file. When sandbox mode is disabled for a server, the Capability Assignments are
ignored.

The toolbar in this case does not have any of the sandbox icons, such as New Sandbox or Merge
Sandbox. You have no access to any kind of sandbox.

Sandboxes

With the sandbox feature you can create your own personal workspace or sandbox where you can enter
and store data value changes separate from base data.
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A sandbox is not a copy of the base data, but a separate overlay or layer of your own data values on top of
the base data. The distinction between base data and sandbox data is important to understand as you
make changes to your data.

« Base data is the data that all users can access. Any edits made to base data are written directly back to
the database.

- Sandbox data is the data in your own personal work area where you can edit the data values as many
times as you want and keep the changed data separate from the base data. Sandboxes are private to
each user and cannot be seen by other users. Your data values are viewable to others only when you
merge them back with the base data.

Sandboxes are not stored on the client. They consist of a separate and private area of the server. When
you make a change to data in the sandbox, it is as if the base model data value is temporarily blocked by
the value you entered in the sandbox. To make the base model take on the values in the sandbox, you
must merge the sandbox values with the base values. After the sandbox data values are committed, they
are merged with the base so that the changed values then update and become the base values.

Sandboxes include the following features:
« Private data changes

Sandboxes let you try out different changes to the data before making those changes public to other
users and before committing those changes to the base data.

- Cell coloring

Changes to cell values in a sandbox are identified by a change in cell content colors. The cells change
color to remind you that the change has not yet been committed to the base data. After data is
committed and processing is complete, the cell coloring turns to black again.

Cell coloring is also applied to any dependent cells, such as consolidated or rule calculated cells, that
your edits affect.

« Manual commit

When working in a sandbox, the Merge button becomes available so you can decide when to commit
changes to the base. When you commit the data, your changes become available to other users.

« Discard changed values

In a sandbox, the Discard icon becomes available and lets you reset the values that you have changed
but not committed. When you discard changed values, the values you have not committed are reset to
the values in the base data.

« Named sandboxes let you create what-if scenarios

Depending on your configuration settings, you can name multiple sandboxes, such as Best Case or
Worst Case and then compare the impact of your edits by switching between them.

Remember: Your administrator might have disabled sandboxes for your environment or changed the
writeback mode for your user group.

To work in a sandbox, you must first open a view and then either create a new sandbox or select an
existing sandbox. When working in a sandbox, the selected sandbox applies to all the other views in your
current user session.

Sandbox limitations

You can add sandboxes as a dimension in the Cube Viewer. However, if you generate a report from the
Cube Viewer, the sandbox dimension will not be present in the generated report.

Data values for leaf and consolidated cells in a sandbox
The data values for leaf and consolidated cells in a sandbox are calculated.
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Leaf cell values in a sandbox are a combination of the values in the base and sandbox cells. The user-
entered values in sandbox leaf cells override the values in the base. If the values are entered over a
consolidated cell, the data will be automatically spread and immediately recalculated. Any leaf cell that
has not been changed in a sandbox still shows the base data.

Consolidated cells in a sandbox contain values that are the sum of the leaf cells displayed in the sandbox.

Reset data values in a sandbox
Resetting a sandbox clears the data values that you have changed but not committed and resets them
back to the current values in the base data.

About this task

For example, suppose you enter values in two cells and commit the changes to the server. You then enter
avalue in a third cell, but do not commit the change. When you click Discard Changed Values, the values
you entered in the first two cells are unchanged, but the third cell changes back to the value in the base
data.

Procedure

1. From the IBM Planning Analytics tab, click the Discard icon.
2. Click OK.

Results
The data values in the sandbox that you have changed but not committed are set to the current values in
the base data. Any cell coloring is cleared and set to black.

Cell coloring for changed data values

When you enter a new value in a sandbox, a visual indicator is applied to the cell to remind you that the
new value is different from the base values. The color of the data changes to blue after you press the
Enter key. The number changes back to black when you commit changes. Any dependent cells, such as
consolidated or rule calculated cells, also change in appearance if your edits cause them to be
recalculated.

The following table summarizes the default cell coloring that is applied in Planning Analytics for Microsoft
Excel when you enter new data values in a sandbox. These color attributes can be changed.

Table 14: Cell coloring attributes

Cell or font color Description
Black font and orange background Committed sandbox data that differs from the base.
Blue bold font. Newly input data.

After you type the value and press the Enter key the font turns
bold and blue. Other cells that turn blue because of this are
formula cells that reference this cell and adopt this change in
color as well.

Edited cells, dependent or consolidated cells, recalculated cells

White cell background Leaf input cell
Blue cell background Consolidated input cell
Gray cell background Locked cell
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Commit changed data from a sandbox to base
You can merge all of the committed data values in your sandbox to the base data. You cannot use the
undo command to undo a merge action.

When you have multiple sandboxes and commit one of them to base, the new base values are
automatically applied to all the unchanged cells in your other sandboxes. If you entered new data values
in any other sandbox, those data values remain and do not show the new values that were committed to
the base data.

Procedure

1. On the toolbar, click Sandbox and select the sandbox whose data you want to merge with the base
data.

2. Click Merge Sandbox with Base.

Results

« The changed data values in the current sandbox are saved to the base data.

 The cell coloring for any changed data in the current sandbox is cleared and set to black.
« The new base data values are applied to all the unchanged cells in your other sandboxes.

When you have multiple sandboxes, you can use the toolbar to create, delete and select the different
sandboxes available to you.

Edit TM1 data in reports
In areport that is based on a TM1 data source, you can edit values directly in the cells.
You can edit TM1 data using the following methods:
 You can edit data in the cells of Exploration Views and Quick Reports.
« You can use data spreading in Exploration Views and Quick Reports to distribute numeric values.
 You can add comments to cells
You can also write back data using TM1 worksheet functions, such as DBRW.
Edit data by typing values in cells
You can edit data in the cells of an Exploration View or IBM Planning Analytics for Microsoft Excel, if you

have Write access to those cells. The Exploration View interface identifies the cells that are writable by
using a special cell format that is customizable.

Procedure

1. To edit a value in a cell, click the cell and type the new value.
2. After entering a new number, press Enter or click another cell.

The new number displays in bold and blue, which indicates that there is a new value in this cell. You
must commit the data changes to the IBM TM1 server for the change that you made to persist.

3. To save the changes to the TM1 server, click Commit .

After you click Commit, you have the option to preview information about the changes that will be
saved to the TM1 server. You cannot undo changes after saving to the TM1 server.

Results

After committing the changes, the report displays the updated values in a normal font, indicating that you
saved the changes.
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Edit TM1 data by using data spreading
You can use data spreading to enter or edit numeric data using a predefined distribution method, called a
data spread method.

Data spreading is available when you are working with TM1 data. Your administrator must also give you
capability assignments on the TM1 server for data spreading. For more information about capability
assignments, see the IBM Cognos TM1 Operation Guide.

Use data spreading in Exploration Views and Quick Reports

You can use data spreading to enter or edit numeric data in an Exploration View or Quick Report by using
a predefined distribution method, called a data spread method. For example, you can evenly distribute a
value across a range of cells or increment all values in a range of cells by a percentage.

Procedure

1.

Select a cell or range from which you want to initiate data spreading.

You can initiate spreading from a single cell or a single linear range of cells. You cannot initiate
spreading from a non-contiguous range of cells, nor can you spread data across multiple individually
selected cells or ranges in a worksheet.

. Right-click the cell or range and click IBM Planning Analytics > Spread.

Note: If the Spread command is not available, data spreading might be restricted on the server. Ask
your administrator to check the capability assignments configured in the data model.

. Select a data spreading method.

The methods that are available in the Spreading dialog box depend on the cells that you selected for
data spreading. For example, some methods, such as Equal Across Leaves, are applicable to
consolidated cells only.

. Select an Update action.
. Specify the required values.

For example, if you selected the Growth % method, enter the growth percentage.

. Click OK.

Note: You can also apply data spreading by typing data spreading syntax in a cell.

Exclude cells from data spreading
You can apply a hold to a cell, or a range of cells, to exclude cells from data spreading operations.

About this task

You can apply a hold to consolidation cells and leaf cells.

When a consolidation hold is applied, you can initiate data spreading from a single leaf cell. Based on the
data spreading value you apply to the selected leaf cell, the remaining leaf values are updated so that the
consolidation value remains unchanged.

For example, you apply a hold on the consolidated cell at the intersection of S Series 1.8L Sedan and 1
Quarter. This consolidation hold keeps the value in the cell constant at 1,000.

1 Quarter Jan Feb Mar
S Series 1.8 L Sedan 1000 200 300 S00
S Series 2.0 LSedan &, 000 1,000 2,000 3,000
S Series 2.5 L Sedan 4,520 1,310 1,420 1,750

Figure 7: Example hold applied to a consolidation cell

If you initiate proportional data spreading from the cell at the intersection of S Series 1.8L Sedan and Mar
and specify a value of 700, the Jan and Feb leaf values are changed proportional to their existing values.
Jan has a value of 120 and Feb has a value of 180. The consolidation of the leaves remains 1,000.
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1 Quarter Jan Feb Mar

S Series 1.8 L Sedan 1000 120 180 700
S Series 2.0 L Sedan &,000 1,000 2,000 3,000
S Series 2.5 L Sedan 4,520 1,310 1,420 1,790

Figure 8: View of unchanged consolidation value

You can apply a hold to both the consolidated cell and one or more leaf cells. Using the original values in
the example, you apply a hold to the consolidated cell and a single leaf cell, Jan. When you change Mar
from 500 to 700, proportional spreading affects only the Feb cell. The value for Feb changes to 100. The
consolidation of the leaves remains 1,000.

Procedure

Right-click a cell and click IBM Planning Analytics > Set Hold.
To apply a hold to a range of cells, you must set a hold for each cell in the range separately.

Results

The formatting of the cell changes to show a hold is applied. To change the formatting, modify the Hold
Values - IBM Cognos style.

To remove a hold, select a cell with a hold applied and click IBM Planning Analytics > Remove Hold.
Data spreading methods

IBM Planning Analytics for Microsoft Excel provides a variety of data spreading methods that you can use
to distribute numeric data to cells in an exploration. For example, you can use data spreading to evenly

distribute a value across a range of cells or to increment all values in a range of cells by a desired
percentage.

The methods that are available in the Spreading dialog box depend on the cells that you select for data
spreading. For example, some methods, such as Equal Across Leaves, are applicable to consolidated cells
only.

Proportional

The proportional spread method distributes a specified value among cells proportional to existing cell
values.

For example, consider a view in which the values for Argentina in the months January, February, and
March are 10, 30, and 60, respectively.

The sum of these values is 100, with the value in January accounting for 10% of the sum, the value in
February accounting for 30%, and the value in March accounting for 60%.

When you proportionally spread the value 300 across these cells and select the Replace update action,
the result is as follows.

« January contains the value 30, which is 10% of 300
« February contains the value 90, which is 30% of 300
« March contains the value 180, which is 60% of 300

These values are proportionally equivalent to the cube values that existed before you apply data
spreading.

Repeat

The repeat method repeats a specified value across cells in a view.
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The value you enter repeats across the range of cells that you selected. When you apply the repeat
spreading method to a single consolidated cell, the value being spread is distributed proportionally to all
leaves of the consolidated cell.

Repeat Across Leaves

The repeat leaves method copies a specified value to the leaves of a consolidation. When you apply this
method, you can copy the value to all leaves of the consolidation or only to those leaves that already
contain non-zero values.

For example, assume that there are several leaves of Year, Argentina with values.

If you use the repeat leaves method to copy the value 400 to the leaves of Year, Argentina currently
populated with non-zero values, the value 400 is copied to all leaves that contained non-zero values.

If you initiate the repeat leaves method from a cell identified by more than one consolidated member, the
specified value is copied to all leaves associated with the cell.

Table 15: Options for the repeat leaves data-spreading method

Option Description

Populated Leaf Cells The specified value is copied only to leaf cells currently containing
non-zero values.

All Leaf Cells The specified value is copied to all leaf cells regardless of current
values.

You can apply the Repeat Across Leaves method only to consolidated cells.

Straight

The straight line method populates cube cells by linear interpolation between two specified endpoints. It
requires both a start value and an end value.

For example, with the start value of 100 and the end value of 200, the option populates the intervening
cells with values at equal intervals between the two endpoints.

You can apply straight line spreading only across single rows or columns, not across rectangular ranges.

% change

The percent change method multiplies the current cell values by a specified percentage. The product of
that multiplication can then replace, be added to, or be subtracted from the existing cell values.

When you apply the percent change method and specify a % Change value of 10, the system multiplies
each cell value by 10% (or .10). If you select the Add update action, the product of multiplication is added
to the existing cell values. The result is that each cell value is increased by 10%. The percentage change is
applied across the range of cells that you selected.

Equal
The equal spread method distributes a specified value equally across the cells in a view.
For example, consider a view where a range of 12 cells is selected.

When you equally spread the value 60 to these cells and select the Add update action, the value is
equally spread across the range and added to the existing cell values. The result is that each cell value is
increased by 5 (60/12=5).

The value you entered spreads equally across the range of cells that you selected. When you apply the
equal spread method to a single consolidated cell, the value being spread is distributed proportionally to
all leaves of the consolidated cell.
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Equal Across Leaves

The equal spread across leaves method distributes a specified value equally across all leaves of a
consolidated cell. When you apply this method, you can choose to distribute the value to all leaves of the
consolidation or only to those leaves that already contain non-zero values.

If you initiate the equal spread across leaves method from a cell identified by more than one consolidated
member, the specified value is distributed to all leaves associated with the cell.

Table 16: Options for the equal spread leaves method

Value Description

Populated Leaf Cells The specified value is copied only to leaf cells currently containing
non-zero values.

All Leaf Cells The specified value is copied to all leaf cells regardless of current
values.

You can apply the Equal Across Leaves method only to consolidated cells.

Growth %

The growth % method accepts an initial value and a growth percentage. By using the initial value as a
starting point, this method sequentially increments all values in a range by the specified growth
percentage.

You can apply growth % spreading across single rows or columns, not across rectangular ranges.

Clear

The clear method clears values from cells in a view. You can apply this method to either leaf cells or
consolidated cells. When you apply the clear method to a consolidated cell, all leaves of the consolidation
are set to zero.

Data spreading and hold syntax
You can apply most data spreading and hold methods using a syntax that you enter directly in cells.

You must use the user interface to apply the repeat leaves and equal spread across leaves methods. You
must use the user interface to spread across a selected range of cells.

Each data spreading syntax expression consists of a method code, a data action (optional), and method
parameters.

For example: s+100
The method code is s, the data action is +, and the method parameter is 100.

The method code is a one- or two-character code for a data spreading method. For example, S is the
method code for the equal spread method. For more information, see “Data spreading and hold syntax
reference table” on page 107.

The data action indicates whether spread values will replace, be added to, or be subtracted from the
existing cell values.

Replace
If you do not specify an action, the existing cell values are replaced with the spread values.

Add
Plus sign (+) adds spread values to the existing cell values

Subtract
Tilde (~) subtracts spread values from the existing cell values.
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The method parameters supply all parameters required to execute a given spreading method. Most
methods require only a parameter indicating the value to be spread. The required method parameters for
each spreading method are listed in “Data spreading and hold syntax reference table” on page 107.

Data spreading and hold syntax reference table
The following table describes the data spreading and hold methods that you can apply with the syntax.

Table 17: Data spreading and hold syntax

Method

Code

Required Method
Parameters

Data Action
(Optional) *

Example

Proportional
Spread

Value to be spread

P<>100

Proportionally spreads the
value 100 to all leaf cells,
and replaces the existing
cell values.

Equal Spread

Value to be spread

+ ~

S+200

Equally spreads the value
200 to all leaf cells, and
adds the product of
spreading to the existing
cell values.

Repeat

Value to be spread

+ ~

R~50

Subtracts the value 50
from all leaf cells.

Percent Change

P%

Percentage

+. ~

P%+10

Applies a percent change
of 10% to all leaf values,
adds the product to the
existing cell values, and
increments all leaves by
10%.

Straight Line

SL

Start Value and End
Value

SL100:200

Replaces all leaf values,
with a start value of 100
and an end value of 200.

Growth %

GR

Start Value and
Growth Percentage

GR300:25

Applies a 25% growth
percentage to the starting
value of 300 and replaces
all leaf values below the
point of insertion.

Clear

N/A

N/A

C

Clears values from all
cells.
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Table 17: Data spreading and hold syntax (continued)

Method Code Required Method Data. Action Example
Parameters (Optional) *
Leaf Hold H N/A N/A H

Holds all leaf cells.

Release Leaf Hold [RH N/A N/A RH

Releases all leaf holds.

Consolidation Hold |HC N/A N/A HC
Holds all consolidated
cells.

Release RC N/A N/A RC

Consolidation Hold Releases all holds of

consolidated cells.

Release All Holds | RA N/A N/A RA

Releases all holds on the
cells.

* The default data action is Replace. The spreading syntax uses a tilde (~) to denote the Subtract data
action, and a plus sign (+) to denote the Add data action.

Add and view comments in cells
You can add and view comments in TM1 Exploration Views and Quick Reports.

Before you begin

In Microsoft Excel 2013, click File > Options, and then click Advanced. Under Display, select how you
want comments to be displayed in workbooks.

About this task

Use comments to indicate the significance of the cell value. For example, state why the variance between
forecast revenue and actual revenue for a product is high. You can view all comments that were added to
a cell. Use the Annotations dialog box to create, view, update, or delete comments.

Hover over a cell with a comment marker to see the comment, the user who entered the comment, and a
time stamp.

Procedure

1. To work with comments, right-click a cell, click IBM Planning Analytics > Annotations.
2. Use the Annotations dialog box to add, view, update, or delete comments.

Resolve errors when committing data to a TM1 server
When you commit data to an IBM TM1 server, the Error Report dialog box displays any errors.

For each error, the Error Report dialog box displays an error description and the intersection of members
where the error is located. When you click a row of error information, the cursor moves to the related cell,
enabling you to correct the error.

Error messages include the following:
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» Consolidated: The member is a consolidated member. The cell is read-only.
« Hold: A hold has been placed on the cell. The cell is read-only.

« Incorrect Type: The value you entered does not match the data type of the member. This error occurs,
for example, if you enter text in a cell that requires a numeric value.

» Locked: The cellis locked. The cell is read-only.
« Rule Derived: The cell contains a calculated value or a value derived from other cells. The cell is read-
only.

Set options for committing data
You can choose to skip the commit confirmation step when committing data. You can also choose to
commit valid intersections automatically.

You can hide the confirmation dialog box.

- If you are working with an Exploration View, click Options, and then click IBM Planning Analytics.
Select the Hide commit confirmation check box.

« If you are working with a Quick Report, in the Commit Changes dialog box, select Hide commit
confirmation. When you commit data, the Commit Changes dialog box is not displayed and valid values
are sent to the TM1 server. If any errors are found, the Error Report dialog box is displayed.

To turn confirmation back on, click Options, and then click IBM Planning Analytics. Clear the Hide
commit confirmation check box. You can also turn confirmation on or off using the
CommitWithoutConfirmation settingin the CognosOfficeReportingSettings.xml file:

<setting name="CommitWithoutConfirmation">False</setting>

You can choose to commit valid values automatically. In the Error Report dialog box, select Automatically
Commiit Valid Intersections.

To turn this feature off, change the BulkUploadAutoCommitValid setting to False in the
CognosOfficeReportingSettings.xml file:

<setting name="BulkUploadAutoCommitValid">False</setting>

On Windows 7, the CognosOfficeReportingSettings.xml configuration file is installed in c: \Users
\[user_name] \AppData\Local\Cognos\Office Connection.

IBM TM1 functions

You can add formulas that use IBM TM1 functions to reports. You can also convert Exploration Views that
use TM1 data to formulas. For advanced analysis, you can create reports that use formulas to populate
the cells of a worksheet.

For information about formulas in IBM Cognos Analytics reports, see “Create a Custom Report” on page
165.

TM1 worksheet functions in IBM Planning Analytics for Microsoft Excel
You can use TM1 worksheet functions in IBM Planning Analytics for Microsoft Excel.

You can work with TM1 worksheet functions in the following ways:

« Create an Exploration View and convert it to a Dynamic Report or a Custom Report

« Open a workbook that was created from a slice in TM1 Perspectives.

- Open a workbook that was created using the Slice to Excel export option in TM1 Web Cube Viewer.
« Manually add the TM1 worksheet functions to a worksheet.

A worksheet can contain only TM1 worksheet functions, or you can add TM1 worksheet functions to a
worksheet that contains other explorations or Quick Reports.
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Note: You need to be connected to a TM1 server when refreshing a report. If you are not connected to a
TM1 server, your TM1 worksheet functions will return a #N/A value upon refresh.

If a worksheet function references an object on a remote server, you must prefix the object with the
server name and a colon. For example, to refer to the SalesCube cube on the SData server, use
SData:SalesCube. To refer to the Region dimension on the SData server, use SData:Region. You must
be connected to the server referenced by the function to receive accurate values in your worksheet. If you
are not connected to the server, TM1 worksheet functions return *KEY_ERR.

Note: In IBM Planning Analytics for Microsoft Excel, parameter values are case sensitive, unlike in TM1
Perspectives. If a parameter value is not found, the function returns RECALC_0_O.

Due to a limitation with Microsoft Excel, worksheet functions can contain no more than 30 arguments.
When you construct a cube reference, one argument must be the cube name, which leaves 29 arguments
for specifying the cube dimensions.

Some TM1 worksheet function capabilities are not supported at this time. For example, you cannot access
pick lists for dimensions and writeback capability is limited.

The IBM Cognos Office Reporting TM1 add-in provides access to the TM1 worksheet functions. The add-in
is enabled by default when you install IBM Planning Analytics for Microsoft Excel.

Modify functions by using the Function Editor
You can modify the members that are used in a function by using the Function Editor. You can also modify
functions directly, but the Function Editor can be easier to use.

Before you begin
You must be connected to the data source referenced in the server: cube parameter.

Tip: To open the data source, right-click the cell and selectIBM Planning Analytics > Display Package.
The source tree displays the data source.

Procedure

1. Click a cell that contains a function and click the Microsoft Excel function button.
The Function Editor is displayed. The Arguments list shows the parameter values currently used by
the function. The Formula Result field shows the value that is currently returned by the function.

2. Modify the members that are used in the parameters by using any of the following techniques:
« To specify a value directly, type a member name into the field. For example, to change the member
for the first dimension in the cube, type a member name into the first field.
- To use a cell reference, click ®:. Click a cell and then click OK.
« To use the set editor, right-click the dimension, select IBM Planning Analytics > Edit set. Use the
set editor to select a member, and then click Apply and close.
Note: You might need to scroll down in the Function Editor to see all of the parameters.

3. Click OK.
The function is updated in the worksheet.

Enable and configure TM1 functions

Enable the add-in required to work with TM1 worksheet functions

To work with TM1 worksheet functions in IBM Planning Analytics for Microsoft Excel, the IBM Cognos
Office Reporting TM1 add-in must be enabled. The add-in is enabled by default when you install IBM
Planning Analytics for Microsoft Excel. If the add-in is disabled, however, you can enable it.

The IBM Cognos Office Reporting TM1 add-in is installed in [installation_location]\IBM for
Microsoft Office. The file nameis CognosOfficeTM1.x11.

You can also follow along by watching this video: https://youtu.be/ztGg4kUsAPM
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For information about enabling add-ins, see the Microsoft Excel Help.

Before you begin

If installed, disable the IBM TM1 Perspectives add-in. The IBM TM1 Perspectives add-in and the IBM
Cognos Office Reporting TM1 add-in cannot be active at the same time.

Configuration settings for working with TM1 worksheet functions
You can configure server connection information and specify the sandbox to use when working with TM1
worksheet functions.

If IBM Planning Analytics for Microsoft Excel does not recognize the TM1 server required by TM1
worksheet functions, you are prompted to select the host and server. The server connection information is
saved to the CognosOfficeXLLSettings.xml file. On Windows 7, this configuration file is installed to
Users\ [user name]\AppData\Local\Cognos\Office Connection.

When you create a connection to a TM1 server to support working with TM1 worksheet functions, the
default connection information does not identify a sandbox. To specify a sandbox, you must edit the
connection information in the CognosOfficeXLLSettings.xml file to change the default sandbox
setting from null to the sandbox name. The following is an example of a connection string showing the
default sandbox setting.

<userSettings>

<setting name="ServerMap">{"Servers":[{"Name":"SData", "RESTuri":null,
"Sandbox":nullt]?

</setting>

</userSettings>

Troubleshoot TM1 worksheet functions
Use the information in this topic to help troubleshoot TM1 worksheet functions.

#NAME!
Check that the IBM Cognos Office Reporting TM1 add-in is enabled. For more information, see
“Enable the add-in required to work with TM1 worksheet functions” on page 110.

#VALUE!
The formula could not be solved. Check the syntax. Make sure that you have specified a value for all
required parameters and in the required order. Next, verify each parameter value with the objects
available on the TM1 server and cube. Make sure that object names match exactly—parameter values
are case-sensitive.

*KEY_ERR
Check that you are connected and logged in to the TM1 server referenced in the formula.

RECALC_0_0
A parameter value could not be found or you are not connected to the TM1 server referenced in the
formula. Log in to the TM1 server. Next, check that the parameter values used in the formula match
the names on the TM1 server and cube. Parameter values are case-sensitive.

Blank cell or 0 when a value is expected
One or more objects could not be found.

Check that the objects you specified in the formula are available.

« If the formula references a dimension, verify that the dimension is available on the TM1 Server
Application Folder.

« If the formula references a member, make sure that the member exists in the dimension you
specified.

« If the formula references an attribute, make sure that the attribute exists for the member you
specified.

- If the function has an index argument, verify that the value you are using is in range. For example,
DIMNM returns a blank cell if the index parameter is O or if the index value is greater than the
number of members in the dimension.
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For example, if a DBRA formula returns an empty cell, perform the following checks:

» Check that the dimension is available on the TM1 Server Application Folder.
« Check that the member exists in the dimension.
« Check that the attribute exists for the member.

« Check that the names you are using in the formula match the names on the TM1 Server Application
Folder and cube exactly.

Tip: To see the attributes of a member, right-click the member in the tree and select Search
Metadata. The Name list contains the available attributes for the member.

Supported IBM TM1 worksheet functions
IBM Planning Analytics for Microsoft Excel supports most TM1 worksheet functions.

DBR
DBR retrieves a value from a specified TM1 cube.

In IBM Planning Analytics for Microsoft Excel, the DBR function is equivalent to the DBRW function. Both
functions are optimized to reduce network traffic and improve performance on wide area networks.

When all member arguments (m1, m2, etc.) to the function are leaf members, you can use the DBR
function to write values to the specified cube, provided that you have the appropriate access privileges to
the relevant cube, dimensions, members, and/or cells.

You can modify the members used in a DBR or DBRW function using the DBR Function Editor. For more
information, see “Modify functions by using the Function Editor” on page 110.

Syntax

DBR(server:cube, ml, m2,[...mn])

Argument Description Required/Optional

server:cube The name of a TM1 Server Application Folder and | Required
the name of a cube that is available on the server.

ml,..mn Dimension member names that define the Required
intersection of the cube containing the value to be
retrieved.

Arguments m1 through mn are sequence-sensitive.
m1 must be a member from the first dimension of
the cube, m2 must be a member from the second
dimension, and so on. These arguments can also
be the names of aliases for dimension members.

Numeric member names must be enclosed in
double quotation marks.

Example

In this example, the TM1 Server Application Folder name is GO_New_Stores and the cube name is Base
Sales Forecast. The function returns the value at the intersection of Americas, Department Store, Freight,
Corporate Store, Budget version 1, and Jan.

DBR("GO_New_Stores:Base Sales Forecast", "Americas", "Department Store",
"Freight", "Corporate Store", "Budget version 1", "Jan")
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DBRA
DBRA retrieves the value of a specified member attribute.

The value returned can be either a string or numeric value, depending on the attribute type.

Syntax

DBRA(server:dimension, element, attribute)

Argument Description Required/Optional

server:dimension The name of the TM1 Server Application Folder and | Required
the name of a dimension.

element A member of the dimension. Required

attribute The attribute for which you want to retrieve a value. | Required
This argument must be an attribute of the member.

Example

In this example, the TM1 Server Application Folder name is GO_New_Stores and the dimension name is
Month. The function retrieves the value of the startdate attribute for Jan.

DBRA("GO_New_Stores:Month", "Jan", "startdate")

Example

In this example, the TM1 Server Application Folder name is SData and the dimension name is Model. The
function returns the value of the Engine Size attribute of the L Series 1.6 L Sedan member.

DBRA("SData:Model", "L Series 1.6 L Sedan", "Engine Size")

DBRW
DBRW retrieves a value from a specified TM1 cube.

In IBM Planning Analytics for Microsoft Excel, the DBRW function is equivalent to the DBR function. Both
functions are optimized to reduce network traffic and improve performance on wide area networks. For
more information, see “DBR” on page 112.

Example

In this example, the TM1 server name is GO_New_Stores and the cube name is Base Sales Forecast. The
function returns the value at the intersection of Americas, Department Store, Freight, Corporate Store,
Budget version 1, and Jan.

DBRW("GO_New_Stores:Base Sales Forecast", "Americas",
"Department Store", "Freight", "Corporate Store", "Budget version 1", "Jan")
DBS

DBS sends a numeric value to a TM1 cube.
This function cannot send a string to a cube. To send strings, use the DBSS function.

In IBM Planning Analytics for Microsoft Excel, the DBS function is equivalent to the DBSW function. Both
functions are optimized to reduce network traffic and improve performance on wide area networks.
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Syntax

DBS(value, server:cube,

ml, m2[,...mn])

Argument

Description

Required/Optional

value

The value being sent.

Required

server:cube

The name of the TM1 server and the cube to which
the value is sent.

Required

ml,..mn

The names of members defining the intersection in
the cube to which the value is sent.

Arguments m1 through mn are sequence-sensitive.

m1 must be a member from the first dimension of
the cube, m2 must be a member from the second
dimension of the cube, and so on. These
arguments can also be the names of aliases for
dimension members.

Numeric member names must be enclosed in
double quotation marks.

Required

Example

In this example, the TM1 server name is GO_New_Stores and the cube name is Base Sales Forecast. The
function writes the value 5342 to the intersection of Americas, Department Store, Freight, Corporate
Store, Budget version 1, and Feb.

DBS (5342, "GO_New_Stores:Base Sales Forecast","Americas",

"Department Store","Freight", "Corporate Store", "Budget version 1","Feb")

DBSA

DBSA sends a value to a specified member attribute.

The value sent can be either a string or numeric value, depending on the attribute type.

Syntax

DBSA(att_value, server:dimension, member, att_name)

Argument Description Required/Optional
att_value The value you want to send. To send the value asa |Required
string, use double quotation marks. For example
"1.8" is sent as a string value while 1.8 is sent as a
numeric value.
server:dimension The name of the TM1 server and a dimension Required
name.
member A member of the dimension. Required
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Argument Description Required/Optional

att_name The attribute to which you want to send a value. Required
att_name must be an attribute of the member
specified by the member argument.

Example

In this example, the TM1 server name is Planning Sample. The function writes Jane Smithers to the
Manager attribute of the UK member of the business_unit dimension.

DBSA("1.8", "SData:Model", "L Series 1.8 L Sedan", "Engine Size")

Example

In this example, the TM1 server name is SData. The function writes 1.8 to the Engine Size attribute of the
L Series 1.8 L Sedan member of the Model dimension. The value, 1.8, is in double quotation marks
because the Engine Size attribute is a text attribute. If the data type of the Engine Size parameter was
Numeric, the function would be:

DBSA(1.8, "SData:model", "L Series 1.8 L Sedan", "Engine Size")

DBSS
DBSS sends a string to a cube of any number of dimensions.

This function cannot send a numeric value to a cube. Use the DBS function to send numeric values.

Syntax
DBSS(string, server:cube, ml, m2,...mn)
Argument Description Required/Optional
string The string being sent. Required
server:cube The name of the TM1 server and the cube to which | Required
the string is sent.
ml, ...mn The names of members defining the intersection in Required
the cube to which the string is sent.
Arguments m1 through mn are sequence-sensitive.
m1 must be a member from the first dimension of
the cube, m2 must be a member from the second
dimension of the cube, and so on. These
arguments can also be the names of aliases for
dimension members.
Numeric member names must be enclosed in
double quotation marks.
Example

Explore TM1 data 115



In this example, the TM1 server name is GO_New_Stores and the cube name is New Store Plan. The
function writes the value Department Store to the intersection of Americas, 1 (a member in the ID number
dimension), Budget version 1, and Retailer Type.

DBSS ("Department Store", "GO_New_Stores:New Store Plan",
"Americas","1","Budget version 1", "Retailer Type")

DBSW
DBSW sends a numeric value to a TM1 cube.

This function cannot send a string to a cube. To send strings, use the DBSS function.

In IBM Planning Analytics for Microsoft Excel, the DBSW function is equivalent to the DBS function. Both
functions are optimized to reduce network traffic and improve performance on wide area networks. For
more information, see “DBS” on page 113.

Example

In this example, the TM1 server name is GO_New_Stores and the cube name is Base Sales Forecast. The
function writes the value 6342 to the intersection of Americas, Department Store, Freight, Corporate
Store, Budget version 1, and Feb.

DBSW (6342, "GO_New_Stores:Base Sales Forecast","Americas",
"Department Store","Freight","Corporate Store", "Budget version 1","Feb")

DFRST
DFRST returns the first member of a specified dimension. The first member in a dimension is the member
with an index number of 1.

The member with an index number of 1 might not be listed first in the tree. Index numbers are assigned to
members when they are added to a dimension. For example, if members were added and then reordered,
the first member listed in the tree might not have an index of 1.

To determine the index number of a member use the “DIMIX” on page 116 function.

Syntax

DFRST (server:dimension)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
Example

In this example, the TM1 server name is GO_New_Stores. The function returns the first member in the
Retailers dimension, All Retailers. The function returns All Retailers because this member has an index
number of 1 in the Retailers dimension.

DFRST("GO_New_Stores:Retailers")

DIMIX
DIMIX returns the index number of a member within a dimension.

Syntax

DIMIX(server:dimension, element)
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Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required
name.
element The name of a member within the dimension. Required
If the member is not a member of the dimension
specified, the function returns 0.
This argument can also be the name of an alias for
a dimension member.
Example

In this example, the TM1 server name is GO_New_Stores. The function returns the index number of the
Tents member in the Products dimension. If Tents has an index number of 7, for example, the function

returns 7.

DIMIX("GO_New_Stores:Products", "Tents")

DIMNM

DIMNM returns the member of a dimension that corresponds to the index argument.

Syntax

DIMNM(server:dimension,

index, [Alias])

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required
name.
index A value less than or equal to the number of Required
members in the dimension.
The functions returns a blank cell if you enter O or if
you enter a value greater than the number of
members in the dimension.
Example

In this example, the TM1 server name is GO_New_Stores. The function returns the name of the member
with an index of 7 in the Products dimension. If the Tents member has an index number of 7, for example,

the function returns Tents.

DIMNM("GO_New_Stores:Products",7)

DIMSIZ

DIMSIZ returns the number of members within a specified dimension.

Syntax

DIMSIZ (server:dimension)
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Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension Required
name.

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the number of members in
the Budget version dimension. For example, if the Budget version dimension contains two members, the
function returns 2.

DIMSIZ("GO_New_Stores:Budget version")
DNEXT

DNEXT returns the member name that follows the member specified as an argument to the function.

Syntax

DNEXT (server:dimension, element)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
element The name of a member within the dimension. This | Required

argument can also be the name of an alias for a

dimension member.

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the name of the member
after Cooking Gear in the Products dimension.

DNEXT ("GO_New_Stores:Products", "Cooking Gear")
DNLEV

DNLEV returns the number of hierarchy levels in a dimension.

Syntax

DNLEV (server:dimension)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
Example
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This example uses the TM1 server SData and a dimension called Region. In the Region dimension, the
various nations (Level 0) add up to regions (Level 1). The regions then add up to super-regions (Level 2),
which in turn add up to the world (Level 3).

DNLEV ("SData:Region")

Lawed 0 Lawwml 1 Lol 2
Denmark -

Eweden —- Scandinaia —

Huonvay -
Germany —|

France = Cantral Eureps —

— Americas —

Eumpe —

Lewwal 3

|—— Wierd

The region dimension has four hierarchy levels (0, 1, 2, and 3). Therefore, in this example the function

returns 4.

DTYPE

DTYPE returns information about the specified member. The function returns "C" if the memberis a
consolidated member, "N" if the member is a numeric member, and "S" if the member is a string member.

Syntax

DTYPE (server:dimension, element)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
element The name of a member within the dimension. This | Required

argument can also be the name of an alias for a

dimension member.

Example

In this example, the TM1 server name is SData. The member Europe in the dimension Region is a

consolidated member, so the example returns "C".

DTYPE("SData:Region", "Europe")

In this example, the TM1 server name is GO_New_Stores. If the Tents member contains numeric data,
such as product numbers, the function returns N. If the Tents member contains text, such as model

names, the function returns S.

DTYPE ("GO_New_Stores:Products",

ELCOMP

"Tents")

ELCOMP returns the name of a child of a consolidated member in a specified dimension.

Syntax

ELCOMP (server:dimension, element, index)
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Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
element The name of a consolidated member within the Required

dimension. This argument can also be the name of
an alias for a dimension member.

If the member is not a consolidated member, the
function returns 0.

index A positive value less than or equal to the total Required
number of children in the specified member.

If you enter a value greater than the number of
children in the member or if you enter 0, the
function returns a blank cell.

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the second child member
under Europe. If Europe is a consolidated member with the children Central Europe, Northern Europe, and
Southern Europe, the function returns Northern Europe.

« Europe

— Central Europe
— Northern Europe
— Southern Europe

ELCOMP ("GO_New_Stores:Country and Region", "Europe",2)
ELCOMPN

ELCOMPN returns the number of children of a specified member.

Syntax

ELCOMPN (server:dimension, element)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
element The name of a consolidated member within the Required

dimension. This argument can also be the name of
an alias for a dimension member.

If the member is not a consolidated member, the
function returns O.

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the number of child
members under Europe.
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If Europe is a consolidated member with the children Central Europe, Northern Europe, and Southern
Europe, the function returns 3.

ELCOMPN ("GO_New_Stores:Country and Region", "Europe")
Canada is not a consolidated member in the Country and Region dimension, so the function returns 0.

ELCOMPN ("GO_New_Stores:Country and Region", "Canada")

ELISCOMP
ELISCOMP determines whether elementl is an immediate child of element2 in the specified dimension.

The function returns TRUE if elementl is an immediate child of element2, otherwise the function returns
FALSE.

Syntax

ELISCOMP (server:dimension, elementl, element2)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
elementl The name of a member within the dimension. This | Required

argument can also be the name of an alias for a
dimension member.

element? The name of a member within the dimension. This | Required
argument can also be the name of an alias for a
dimension member.

Example

The following examples use the GO_New_Stores TM1 server and a dimension called Products with the
following structure:

- Total Products
— Camping Equipment
- Tents
- Lanterns
— Golfing Equipment
- Putters
- Golf Accessories

ELISCOMP ("GO_New_Stores:Products", "Tents", "Golf Equipment")

In this example, the function returns FALSE because Tents is not a child of the Golf Equipment member in
the Products dimension.

ELISCOMP ("GO_New_Stores:Products", "Tents", "Camping Equipment")

In this example, the function returns TRUE because Tents is a child of the Camping Equipment member.
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Note that the ELISCOMP function returns TRUE only for immediate children. In the above example, Tents
is a child of Camping Equipment. Further, Camping Equipment is a child of Total Products. However,
because the function returns TRUE only for immediate children, the following example returns FALSE:

ELISCOMP ("GO_New_Stores:Products", "Tents","Total Products")

ELISPAR
ELISPAR determines whether memberl is an immediate parent of member2 in the specified dimension.

The function returns TRUE if memberl is an immediate parent of member2, otherwise the function
returns FALSE.

Syntax

ELISPAR(server:dimension, memberl, member2)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
memberl The name of a member within the dimension. This | Required

argument can also be the name of an alias for a
dimension member.

member2 The name of a member within the dimension. This | Required
argument can also be the name of an alias for a
dimension member.

Example

The following examples use the GO_New_Stores TM1 server and a dimension called Products with the
following structure:

- Total Products

— Camping Equipment
- Tents
- Lanterns

— Golfing Equipment
- Putters
- Golf Accessories

— Mountaineering Equipment

- Rope
ELISPAR("GO_New_Stores:Products", "Mountaineering Equipment", "Tents")

In this example, the function returns FALSE because Mountaineering Equipment is not a parent member
of Tents in the Products dimension.

ELISPAR("GO_New_Stores:Products", "Camping Equipment", "Tents")

In this example, the function returns TRUE because Camping Equipment is a parent member of Tents in
the Products dimension.
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Note that the ELISPAR function returns TRUE only for immediate parents. In the above example, Total
Products is a parent of Camping Equipment. Further, Camping Equipment is a parent of Tents. However,
because Total Products is not an immediate parent of Tents, the following example returns FALSE:

ELISPAR("GO_New_Stores:Products","Total Products", "Tents")
ELLEV

ELLEV returns the level of a member within a dimension.

Syntax

ELLEV(server:dimension, element)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
element The name of a member within the dimension. This | Required

argument can also be the name of an alias for a

dimension member.

Example

These examples use the TM1 server SData and a dimension called Region. In the Region dimension,
individual nations (Level 0) add up to regions (Level 1). The regions then add up to super-regions (Level 2),
which in turn add up to the world (Level 3).

Lawed 0 Lawwml 1 Lol 2 Lavwal 3
Denmark -

Eweden —- Scandinaia —

Huonvay -
Germany —|

Francs = Cantral Europs —

Eurnpe —
——— wers

|
ELLEV("SData:region", "Norway")

In this example, the function returns O because Norway is a leaf level member of the Region dimension.
ELLEV("SData:region ", "Scandinavia")

In this example, the function returns 1 because Scandinavia is a Level 1 member of the Region dimension.
ELLEV("SData:Region", "Europe")

In this example, the function returns 2 because Europe is a Level 2 member of the Region dimension.

ELPAR
ELPAR returns the parent of a member in a specified dimension
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Syntax

ELPAR(server:dimension, element, index)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
element The name of a member within the dimension. This | Required

argument can also be the name of an alias for a
dimension member.

index A positive value less than or equal to the total Required
number of unique consolidated members (parents)
that use the member argument as a child.

Tip: You can use the ELPARN function to find out
how many unique parents a member has.

Example

The following examples use the SData TM1 server and a dimension called model with the following
structure:

« L Series 2WD

— L Series 4WD
— L Series

- L Series Sedan
- L Series Wagon
- S Series 2WD
« Total
— L Series
- L Series Sedan
- L Series Wagon
— S Series
— T Series

ELPAR("SData:model","L Series 4WD",1)
In this example, the function returns L Series 2WD, the parent of L Series 4WD.
ELPAR("SData:model", "L Series",2)

In this example, the function returns Total. L Series is a child of two unique parents: L Series 2WD and
Total. In the structure of the model dimension, Total appears second, so this is the member returned by
the function.

ELPAR("SData:model","L Series Wagon",b2)

In this example, the function returns a blank cell. L Series Wagon appears twice, but in both cases the
parent is L Series. Since L Series Wagon does not have a second unique parent, the function returns a
blank cell.

ELPARN
ELPARN returns the number of unique parents of a member in a specified dimension.
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Syntax

ELPARN (server:dimension, element)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
element The name of a member within the dimension. This | Required

argument can also be the name of an alias for a

dimension member.

Example

The following examples use the SData TM1 server and a dimension called model with the following
structure:

L Series 2WD
— L Series 4WD
— L Series
- L Series Sedan
- L Series Wagon
- S Series 2WD
« Total
— L Series
- L Series Sedan
- L Series Wagon
— S Series
— T Series

ELPARN("SData:model", "L Series")

In this example, the function returns 2. In the model dimension, L Series has two unique parents: L Series
2WD and Total.

ELPARN("SData:model","L Series Wagon")

In this example, the function returns 1. In the model dimension, L Series Wagon has one unique parent, L
Series.

ELSLEN
ELSLEN returns the length of a member name within a dimension, if the member name is a string.

If the member specified is not a member of the dimension specified, or is not a string member, the
function returns 0.

If you use an alias in the member argument, the function returns the length of the member name
corresponding to the alias.

Explore TM1 data 125



Syntax

ELSLEN(server:dimension, element)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required
name.
element The name of a string member within the Required
dimension. This argument can also be the name of
an alias for a dimension member.

Example

In this example, the TM1 server name is GO_New_Stores. The function returns 6. The member Europe is a
string with a length of six characters.

ELSLEN("GO_New_Stores:Country and Region", "Europe")

In this example, the function returns 15. Nordeuropa is an alias of the Northern Europe member. The
Northern Europe member is a string with a length of 15 characters.

ELSLEN("GO_New_Stores:Country and Region", "Nordeuropa")
ELWEIGHT

ELWEIGHT returns the weight of a child in a consolidated member.

Syntax

ELWEIGHT (server:dimension, elementl, element2)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension Required
name.

elementl The name of a consolidated member within the Required
dimension. This argument can also be the name of
an alias for a dimension member.

If memberl is not a consolidated member, the
function returns O.

element?2 The name of a child of the consolidated member. Required
This argument can also be the name of an alias for
a dimension member.

If memberl is not a parent of member2, the
function returns 0.

Example

The following examples use the SData TM1 server and a member called Gross Margin with two child
members.
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Children of 'Grosz margin'

Mame Twpe
11 Sales Simple
11 Variable Costs  Simple

Wigight
1
-1

ELWEIGHT ("SData:Accountl", "Gross Margin",6 "Sales")

In this example, the function returns 1. The member Sales, which is a child of Gross Margin, has a weight

of 1.

ELWEIGHT ("SData:Accountl", "Gross Margin", "Variable Costs")

In this example, the function returns -1. The member Variable Costs, which is a child of Gross Margin, has

a weight of -1.

SUBNM

SUBNM returns the member of a set corresponding to the IndexOrName argument.

If you include the optional alias parameter to this function, the function returns the alias for the selected

member.

When you double-click a cell containing a SUBNM function and the data source that contains the SUBNM
function dimension is selected, the Set Editor opens.

When you click a cell containing a SUBNM function that references a set, a drop-down arrow is displayed.
Click the down arrow to select a different member from the set. This feature is available when you are
logged on to a data source that contains the dimension.

Syntax

SUBNM(server:dimension,

set, IndexOrName, [alias])

Argument

Description

Required/Optional

server:dimension

The name of the TM1 server and a dimension
name.

Required

set

The name of a set in the dimension. If the value of
the set argument is an empty string, the value is
considered subset all.

Required

IndexOrName

An index into the set or the name of a member in
the set.

If an index, a positive integer less than or equal to
the total number of members in the specified set.
If a name, a string representing the name of a
member of the set. You can also use the alias of a
member.

Required

alias

The name of an alias that exists for the set. If it is
used, the specified alias is applied when the Set
Editor opens and the function returns the alias for
the selected member.

Optional

Example
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The following examples use the GO_New_Stores TM1 server, a dimension called Country and Region, and
a set called Countries Only.

« Countries Only

Americas

Central Europe

Northern Europe

Southern Europe
Asia-Pacific

SUBNM("GO_New_Stores:Country and Region", "Countries Only",
"Americas")

In this example, the function returns Americas.
SUBNM("GO_New_Stores:Country and Region", "Countries Only",2)

In this example, the function returns Central Europe, which is the second member in the Countries Only
set of the Country and Region dimension.

The following examples use the Planning Sample TM1 server, a dimension called plan_department, and a
set called All Departments. The members in this dimension are named with department ID numbers. The
Department alias contains the department names.

The following table lists the members in the All Departments set. The first column lists the member
names. The second column shows the Department alias of each member.

member name Department
1000 Total Organization
100 Sales

200 Marketing

300 Engineering

SUBNM("Planning Sample:plan_department","All Departments",
"300", "Department")

In this example, the function returns Engineering. The third argument is the member name, 300, and the
fourth argument, Department, is the name of the alias to retrieve. The Department alias for 300 is
Engineering.

SUBNM("Planning Sample:plan_department","All Departments",
"100", "Department_Spanish")

Suppose another alias, Department_Spanish, contains department names in Spanish. In this example, the
function returns Ventas. The third argument is the member name, 100, and the fourth argument,
Department_Spanish, is the name of the alias to retrieve. The Department_Spanish alias for 100 is
Ventas.

When you double-click the cell containing this example, the Set Editor opens. The Available Members list
displays the Spanish aliases for the plan_department dimension and its members.

SuUBSIZ
SUBSIZ returns the number of members in a dimension set.
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Syntax

SUBSIZ (server:dimension, set)

Argument Description Required/Optional
server:dimension The name of the TM1 server and a dimension Required

name.
set The name of a set in the dimension. If the value of |Required

the set argument is an empty string, the value is

considered subset all.

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the number of members in
the Countries Only set of the Country and Region dimension. If the set contains six members, for example,
the function returns 6.

SUBSIZ("GO_New_Stores:Country and Region", "Countries Only")
TABDIM

TABDIM returns the dimension name that corresponds to a given index argument.

Syntax

TABDIM(server:cube, index)

Argument Description Required/Optional
server:cube The name of the TM1 server and a cube name. Required
index A positive value less than or equal to the total Required

number of dimensions in the cube.

The functions returns a blank cell if you enter O or if
you enter a value greater than the number of
dimensions in the cube.

Example

In this example, the TM1 server name is GO_New_Stores and the cube name is Base Sales Forecast. The
Base Sales Forecast cube has the following dimensions: Country and Region, Retailers, Existing Stores
Revenue, Store Type, Budget version, and Month. The function returns Store Type, the fourth dimension in
the Base Sales Forecast cube with an index number of 4.

TABDIM("GO_New_Stores:Base Sales Forecast",64)

TMI1ELLIST
TM1ELLIST returns a downwards array vector of values. It is useful because you can get a set of element
values from a TM1 model by using a single formula.

Note

« TM1ELLIST does not overwrite or insert into any non-formula space like a Dynamic Report. It is up the
workbook designer to consume the plural value response correctly.
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e TM1ELLIST returns an array of values, but only the first element will be displayed.

Syntax

TM1ELLIST(ServerDimension, [SetName], [ElementList],

[AliasOverride],

[ExpandAbove], [MDXOverride], [IndentRate], [IndentCharacter])

Argument

Description

Required/Optional

ServerDimension

A dimension, specified using the format
server:dimension.

Required

SetName

A named set. If this argument is empty, all
elements of the dimension are used.

Optional

Elementlist

An array of values that specifies a list of elements
to constitute a set. For example, ElementList can
reference a cell range.

When this argument is supplied, the named set
specified by the SetName argument is ignored.

If this argument is empty, the elements from the
set specified by the SetName argument are used.

Optional

AliasOverride

A string that defines the alias used for the set.

When this argument is supplied, it overrides the
default alias property defined by the subset
specified by the SetName argument.

If this argument is empty, the alias from the set
specified by the SubsetName argument is used.

Optional

ExpandAbove

A Boolean flag to turn on or off the set Expand
Above property.

When this argument is supplied, it overrides the
default Expand Above property defined by the
subset specified by the Set argument.

If the argument value is 1, consolidated members
expand upward when drilling.

If the argument value is 0, consolidated members
expand downward when drilling.If this argument is
empty, the Expand Above property from the subset
specified by the Subset argument is used.

Optional
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Argument

Description

Required/Optional

MDXOverride

An MDX statement that applies to the subset
specified by the SubsetName/ElementList
argument.

When this argument is supplied, it overrides the
default MDX filter defined by the subset specified
by the SetName argument.

If this argument is empty or omitted, the members
from the set specified by the SetName argument
are used.

Optional

IndentRate

An integer value to indicate how many indentations
are applied to each level when drilling down on a
consolidated member.

If the argument value is 0, no auto-indentation is
performed. IndentRate is relative to the set level of
the set elements.

If this argument is empty or omitted, one
indentation is applied to each level as you drill
down on a consolidated member.

Optional

IndentCharacter

IndentChar sets the symbol used to provide in-
string indentation, the default is the en-space
character (the normal space symbol).

Optional

Example

TM1ELLIST("PlanSamp:plan_currency","All currencies")

TM1ELLIST returns an array of elements based on given arguments.

To retrieve all the returned values, a named range can be created in Excel, referring to the formula. To do
this, create a named range and enter the TM1ELLIST formula in the Refers To column.

?

Mame Manager I_-

(e ] [ |
Mame Refers To Scope Comment
‘=l BusinessUnits =TM1ELLIST["PlanSamp:plan_business_unit”,"All Business Units”,,,,,1,”-7) Warkbook

L=l CurrencylList
‘=l Timelist

=TM1ELLIST["PlanSamp:plan_currency”, "All currencies’} Workbook
=TM1ELLIST["PlanSamp:plan_time","2004 Total with Qrts’) Warkbook

Select desired number of cells (based on the return array size) in Excel, type =[namedrange], and hit

Ctrl+Shift+Enter.

Explore TM1 data 131



Al - F || {=CurrencylList}

A E C D E F
1 |JPY l
2 |EUR
3 |USD
4 |GBP
5 |AUD
&

The Excel INDEX function can then be used to extract a single element for the range.

B2 - £ | =INDEX(CurrencyList,2)
A B C D E F G
1 |spy
2 leur  [ewr ]
3 |usp
4 |Gep
5 |aup
A
TM1GLOBALSANDBOX

TM1GLOBALSANDBOX returns the current global active sandbox for the user.

This function is valid only in Planning Analytics for Microsoft Excel and in Planning Analytics websheets. It
is not supported in IBM® TM1° Perspectives.

Syntax

TM1GLOBALSANDBOX (SERVER)

Argument Description Required/Optional
Server The name of the TM1 server. Required
Example

TM1GLOBALSANDBOX("Planning Sample")

TM1INFO
TM1INFO returns information about the current TM1 version and client.

This function is valid only in Planning Analytics for Microsoft Excel and in Planning Analytics websheets. It
is not supported in IBM® TM1°® Perspectives.

Syntax

TM1INFO("Property Name")
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Argument

Description

Required/Optional

Property Name

The property name can be one of the following:

clientversion
Returns the full client version number. For
example, 10.2.10000

clientversionmajor
Returns the major client version number.

clientversionminor
Returns the minor client version number.

clientversionpatch
Returns fix pack and hotfix number.

client
Returns the name of the client. For example,
cor or websheet.

Required

Example

TM1INFO("clientversion")

TM1PRIMARYDBNAME

TM1PRIMARYDBNAME returns the primary TM1 server name that the user is authenticated through, even
if the user is implicitly logged into multiple TM1 servers. This function doesn't accept any arguments.

This function is valid only in Planning Analytics for Microsoft Excel and in Planning Analytics websheets. It
is not supported in IBM® TM1° Perspectives.

Syntax

TM1PRIMARYDBNAME ()

TM1RPTELISCONSOLIDATED
TM1RPTELISCONSOLIDATED returns a Boolean value to indicate whether a member in a Dynamic Report

is consolidated.

Syntax

TM1RPTELISCONSOLIDATED (RptRowFormula, RowHeaderCell)

Argument Description Required/Optional
RptRowFormula An absolute reference to a cell that contains a Required
TM1RPTROW formula.
RowHeaderCell A relative reference to a cell that contains a Required
member from the TM1RPTROW formula.
Example

TM1RPTELISCONSOLIDATED ($B$25, $B25)
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TM1RPTELLSEXPANDED
TM1RPTELLSEXPANDED returns a Boolean value to indicate whether or not a member is expanded in a
Dynamic Report row set.

Syntax

TM1RptElIsExpanded (RptRowFormula, RowHeaderCell)

Argument Description Required/Optional

RptRowFormula An absolute reference to a cell that contains a Required
TM1RPTROW formula.

RowHeaderCell A relative reference to a cell that contains a Required
member from the TM1RPTROW formula.

Example

TM1RPTELLSEXPANDED ($B$25, $B25)

TMI1RPTELLEV
TM1RPTELLEV returns an integer value representing a member level within a hierarchy. This function is
used in Dynamic Reports.

Syntax

TM1RPTELLEV (RptRowFormula, RowHeaderCell)

Argument Description Required/Optional

RptRowFormula An absolute reference to a cell that contains a Required
TM1RPTROW formula.

RowHeaderCell A relative reference to a cell that contains a Required
member from the TM1RPTROW formula.

Note: In the current release, TM1RPTELLEV and ELLEV are equivalent. Both functions return the level of a
member based on the dimension.

Example

TMIRPTELLEV($B$25, $B25)

TMI1RPTFILTER
TM1RPTFILTER defines the filter applied to a Dynamic Report column dimension.

Syntax

TM1RPTFILTER(ReportView, Tuple, FilterFunction, FilterValue, SortOrder)
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Argument Description Required/Optional

ReportView A cell reference to a cell that contains a Required
TM1RPTVIEW formula. The filter applies to the
view specified by the TM1RPTVIEW formula.

Tuple A tuple string specifying the member in the column | Required
dimension to which the filter applies. For example,
[month].[Feb].

FilterFunction One of the following filter function names: Required

» TOPCOUNT

« BOTTOMCOUNT
TOPPERCENT

« BOTTOMPERCENT
« TOPSUM
BOTTOMSUM

FilterValue A filter value. Required

SortOrder One of the following sort orders: Required

« asc: Ascending
» desc: Descending
» nbasc: Ascending without breaking the hierarchy

« nbdesc: Descending without breaking the
hierarchy

Example

TM1RPTFILTER($B$4, " [month].[Jan]","TOPCOUNT",5, "asc")

TM1RPTROW
TM1RPTROW sets the Dynamic Report master row definition. The master row definition governs the
behavior of all rows in the Dynamic Report.

Syntax

TM1RPTROW(SAFID, ServerDimension, [SetName], [ElementList],
[AliasOverride], [ExpandAbove], [MDXOverride], [IndentRate], [AllowDrilling])

Argument Description Required/Optional
SAFID A reference to a cell that contains a TM1IRPTVIEW | Required
formula.
ServerDimension A dimension, specified using the format Required
server:dimension.
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Argument

Description

Required/Optional

SetName

A named set. If this argument is empty, all
elements of the dimension are used.

Optional

ElementList

An array of values that specifies a list of members
to constitute a set. For example, ElementList can
reference a cell range.

When this argument is supplied, the named set
specified by the SetName is ignored.

If this argument is empty, the members from the
set specified by the SetName are used.

Optional

AliasOverride

A string that defines the alias used for the set.

When this argument is supplied, it overrides the
default alias property defined by the set specified
by the Set argument.

If this argument is empty, the alias from the set
specified by the set argument is used.

Optional

ExpandAbove

A Boolean flag to turn on or off the subset Expand
Above property. When this argument is supplied, it
overrides the default ExpandAbove property
defined by the subset specified by the Subset
argument.

If the argument value is 1, consolidated members
expand upward when drilling.

If the argument value is 0, consolidated members
expand downward when drilling,.

If this argument is empty or omitted, the Expand
Above property from the subset specified by the
Subset argument is used.

Optional

MDXOverride

An MDX statement that applies to the set specified
by the Set/SetMembers argument.

When this argument is supplied, it overrides the
default MDX filter defined by the set specified by
the set argument.

If this argument is empty or omitted, the members
from the set specified by the set argument are
used.

Optional

IndentRate

An integer value to indicate how many indentations
are applied to each level when drilling down on a
consolidated member. If the argument value is 0,
no auto-indentation is performed.

If this argument is empty or omitted, one
indentation is applied to each level as you drill
down on a consolidated member.

Optional
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Argument Description Required/Optional
AllowDrilling A Boolean flag to turn on or off drilling on Optional
consolidated members.
When this argument value is 1, you can drill down
on consolidated members in the Dynamic Report.
When this argument value is 0, you cannot drill
down on consolidated members in the Dynamic
Report.
If this argument is empty or omitted, the default
behavior is to allow drilling on consolidated
members.
Example
TM1RPTROW ($B$9, "SData:region", , "$B$17:$B$18",,1,"",5, 0)
TM1RPTROW($B$16, "GO_New_Stores:Retailers",,,,,B$15)
TMI1RPTTITLE
TM1RPTTITLE defines a Dynamic Report title dimension.
Syntax
TMIRPTTITLE (server:dimension,Element)
Argument Description Required/Optional
server:dimension A dimension, specified using the format Required
server:dimension.
Element A cell reference to a cell that contains a SUBNM Required

function that returns a member name.

Example
TM1RPTTITLE ("SData:model", $C$7)
TM1RPTVIEW
TM1RPTVIEW defines the view displayed in a Dynamic Report.

Syntax

TM1RPTVIEW(ViewID,ZeroSuppression, TMIRPTTITLE,...)
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Argument Description Required/Optional

ViewID A name for the view using the format Required
server:cube:unique_id.

ZeroSuppression A Boolean flag to turn on or off the zero Required
suppression property for the view. 1 = on, 0 = off

TM1RPTTITLE For each title dimension in the Dynamic Report, Required
include a reference to a TM1RPTTITLE function as
an argument to TM1RPTVIEW.

FormatRange The formatting range for the Dynamic Report. You | Required
can use a cell reference or a named range for this
parameter.

When you create a Dynamic Report, a named range
called TM1RPTFMTRNG is created to include all
formatting range cells. You can use this named
range as an argument.

IDColumn The column in the Dynamic Report that contains Required
format IDs. You can use a cell reference or a
named range for this parameter.

When you create a Dynamic Report, a named range
called TM1RPTFMTIDCOL is created to include all
formatting range cells. You can use this named
range as an argument.

Example

TMA1RPTVIEW("SData:SalesCube:6", O, TMIRPTTITLE("SData:actvsbud",6 $C$6),
TM1RPTTITLE("SData:model",$C$7), TMARPTTITLE("SData:accountl",6$C$8),
TM1RPTFMTRNG, TM1IRPTFMTIDCOL)

TM1USER
TM1USER returns the user name of the user currently logged in to TM1 and using the TM1USER function.

If the current user is not connected to a TM1 server, or if the specified server is not running, TM1USER
returns an empty string.

Note: If you run TM1USER against a TM1 server that is configured to use Cognos security, the function
returns the user name, not the internal user name/CAMID. (In TM1 Perspectives, this function returns the
internal user name/CAMID.)

Syntax

TM1USER("server")

Argument Description Required/Optional

server The name of a TM1 server. Required
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Example

If a user named BrianT is logged in to the GO_New_Stores server, and BrianT runs the TM1USER function,
this example returns BrianT.

TM1USER("GO_New_Stores")

VIEW

VIEW is primarily used for compatibility with IBM TM1 Perspectives worksheets. For example, when you
create a slice from a TM1 Perspectives worksheet and open it in IBM Planning Analytics for Microsoft
Excel, you might see a VIEW function. The VIEW function defines a view of the cube specified by the
server:cube argument.

DBR and DBRW formulas can refer to a VIEW function.

A workbook can contain multiple VIEW functions.

Syntax

VIEW(server:cube, ml,m2[,...mn])

Argument Description Required/Optional

server:cube The name of the TM1 server and the name of the Required
cube from which to retrieve data.

mi,..mn Either specific members in the slice to be used as | Required
titles, or the string "!".

The string "!" indicates that the corresponding
dimension is a row or column in the view.

Arguments m1 through mn are sequence-sensitive.
m1 must be a member from the first dimension of
the cube, m2 must be a member from the second
dimension, and so on. These arguments can also
be the names of aliases for dimension members.

Example
The following examples use the GO_New_Stores TM1 server. The dimensions in this cube are:

Retailers

Countries_currency
 Products

- Month

« Budget version
Store Sales Plan

VIEW("GO_New_Stores:Store Sales Plan")

In this example, the function defines a view for the Store Sales Plan cube. The cell containing the VIEW
function displays GO_New_Stores:Store Sales Plan.

VIEW("GO_New_Stores:Store Sales Plan","Department Store",
"Americas","!", "!", "Budget version 1","Quantity")

In this example, the function defines a view as follows:
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- Title members: Department Store, Americas, Budget version 1, Quantity
« Rows: Products
« Columns: Month

The cell containing the VIEW function displays GO_New_Stores:Store Sales Plan.

You can also use cell references in a VIEW function:

VIEW("GO_New_Stores:Store Sales Plan",$B$20,"$B$21","!", "I",
$B%$23,$B$24)

Suppose that cell B5 contains the VIEW function shown above. You can display data from the view by
using a DBR or DBRW function that references the view.

DBR(B5, "Department Store","Americas","Tents", "Total Year",
"Budget version 1","Quantity")

In this example, the DBR function returns the value at the intersection of Department Store, Americas,
Tents, Total Year, Budget version 1, and Quantity in the view that is defined in cell B5.

You can also use cell references for some or all of the arguments:

DBR(B5,D55,D56,D57,D58,D59, "Quantity”)

Display the data source or package of a formula

When working in Dynamic Reports and Custom Reports, you can use more than one data source or
package. You can synchronize the source tree when moving from cells of one data source or package to
another. Synchronizing the source tree enables you to see accurately the dimensional data used to
populate the cells.

Right-click a formula cell and click IBM Planning Analytics > Display Package. The Task Pane displays
the package or data source that was used to create the selected cell.

DBR and DBRW formulas

DBRW formulas are created, for example, when you create a Dynamic Report by converting an Exploration
View or Quick Report and when you convert an Exploration View to a Custom Report. DBRW formulas
define the data cells. You can also create your own DBR and DBRW formulas.

You can use several techniques to modify DBR and DBRW formulas.

You can modify the members that are used as arguments in DBR and DBRW formulas by using the
following methods:

- Drag a member from the source tree onto a cell that contains a DBR or DBRW formula

 Use the Function Editor to modify the members that are used by a formula in a cell.

 Use the Function Editor to modify the members that are used by the formulas in a range of cells.
Modify DBR and DBRW functions by dragging members from the source tree

You can change the members that are used in a DBR or DBRW function by dragging members from the
source tree.

Before you begin

You can drag members from the source to modify a DBR or DBRW function when the following conditions
are met:

« The DBR or DBRW function includes a value for the sexver:cube parameter.
« You are connected to the data source referenced in the server: cube parameter.

Tip: To open the data source, right-click the cell and select IBM Planning Analytics > Display Package.
The source tree displays the data source.
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Procedure

1. In the source tree, expand a dimension and locate the member that you want to use in the formula.

2. Click and drag the member onto the cell that contains the DBR or DBRW formula that you want to
modify.

Results
The formula is updated in the worksheet.

Modify a range of DBR and DBRW functions
You can modify the DBR or DBRW functions that are used in a range of cells by using the DBR Function
Editor.

Before you begin

The DBR Function Editor is available when the following conditions are met:

« The first cell in the range contain a DBR or DBRW function.

« All DBR or DBRW functions in the range have the same value for the server: cube parameter.
« You are connected to the data source referenced in the sexver:cube parameter.

Tip: To open the data source, right-click the cell and select IBM Planning Analytics > Display Package.
The source tree displays the data source.

About this task

You can select a range of cells that contain DBRW functions and change one or more members that are
used by all of the DBRW functions in the range. Dimensions that have multiple members within the range
are not available for editing.

For example, if all DBRW functions in a column use Jan for the Month dimension and Europe for the
Region dimension, you can change Jan to Feb and Europe to France. If the member used for the Account
dimension varies within the column, the Account field is disabled in the DBR Function Editor. When you
click OK, the DBRW functions in the column are updated with Feb and France. All other members that are
used by the DBRW functions remain unchanged.

Procedure

1. Select a range of cells.

2. Select the range and select the Insert Function button.
The Excel Function Editor is displayed. The Arguments list shows the parameter values that are used
by the functions. The members that are common to all of the cells in the range are available for editing.

3. Modify the members that are used in the parameters by using any of the following techniques:

« To specify a value directly, type a member name into the field. For example, to change the member
for the first dimension in the cube, type a member name into the first field.

- To use a cell reference, click ®:, Click a cell and then click OK.

Note: You might need to scroll down in the Function Editor to see all of the parameters.

4. Click OK.
The functions are updated in the worksheet.

SUBNM formulas

SUBNM formulas are created, for example, when you create a Dynamic Report by converting an
Exploration View or Quick Report and when you convert an Exploration View to a formula-based report.
SUBNM formulas define the context members.

You can modify SUBNM formulas by using the set editor or by editing the formula.

Explore TM1 data 141



You can also create your own SUBNM formulas.

To modify a SUBNM formula, double-click the cell. The set editor opens. Use the set editor to select
members, and then click OK. The formula is updated.

You can also edit SUBNM formulas manually.

Drill through to detailed data

A TM1 modeler can define drill processes and drill assignment rules for a data source. If the TM1 cube,
view, or relational table that you are working on contains drill processes or drill assignment rules, you can
drill through certain cells to detailed data.

About this task

If your TM1 modeler has defined drill processes or drill assignment rules for a TM1 cube, view, or
relational table that you're working with, you can drill through on certain cells in your report. Drilling
through on a cell provides detailed data on the cell, and shows you information from the data source. You
can drill through on cells in Exploration Views, Custom Reports, Quick Reports, and Dynamic Reports.

Note: Non-admin users require the installation of IBM Planning Analytics 2.0.3 IF4 or later to use the
drill-through feature.

Depending on the data source, you can perform either a cube drill through or a relational drill through.

A cube drill through is a drill through on a TM1 cube or TM1 view data source. The Drill Through Viewer
opens when you drill through a cube or view. The Drill Through Viewer is interactive.

Drill Through: CUBE_SalesByQuarter ol @ =
e < Wi ™M v

actvsbud region . account! O Quarter
Actual Mexico o Variable Costs 3 Quarter
model
il

o )

L Series 1.6L C...
L Series 1.6L S...
L Series 1.8LC...
L Series 1.8L S...
L Series 1.8 L W... To get started

L Series 1.8 L W...
Open the lﬂer.:hn and drag

L Series20LC... into the open data are

L Series 20L S...
g Use the tree to add g hierarchies. B sets,

Lisenes 20LW-. £ levels, or @ members

L Series 2.0 L W...

L Series 25L C...

L Series 2.5L S...

§ Series 1.8L S...

S Series 1.8 L W...

Figure 9: Cube drill through

A relational drill through is a drill through on a relational table, such as an ODBC or flat file data source. A
table viewer opens when you drill through a relational table. The table viewer is non-interactive.
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Drill Through: RELATIONALTABLE SalesAllModel (=R =R =
ActvsBud Region Model Account1 Month Data s
T | Actual Mexico L Series 1.6... | Variable Co... |Aug 6255.121 &
2 | Actual Mexico L Series 1.8... | Variable Co... | Aug 66.487
3 | Actual Mexico L Series 1.5... | Variable Co... | Aug 6107.641
4 | Actual Mexico L Series 2.0...  Variable Co... Aug 157.811
5 Actual Mexico L Series 2.0... | Variable Co. Aug 8013225
6 Actual Mexico S Series 1 Variable Co Aug 4130258
7 Actual Mexico S Series 2 Variable Co Aug 3419.149
8 Actual Mexico 8 Series 2 Variable Co Aug 4780.411 |
9 | Actual Mexico T Series 4 Variable Co... | Aug 1530.469 1
10 | Actual Mexico T Series 4. | Variable Co._. | Aug 3051.435
11 | Actual Mexico L Series 1.6... | Variable Co... | Jul £945.183
12 | Actual Mexico L Series 18 Variable Co_ | Jul 61744
13 | Actual Mexico L Series 1.8... | Variable Co... |Jul 6634.935
14 | Actual Mexico L Series 2.0... Variable Co... Jul 144.586
15 | Actual Mexico L Series 2.0... Variable Co... | Jul 7526.122
16 | Actual Mexico S Series 1 Variable Co... | Jul 3851.026
17 | Actual Mexico S Series 2 Variable Co... | Jul 3723.904
18 | actual Mexico S Series 2 Variable Co... | Jul 4362173
19 | Actual Mexico T Series 4 Variable Co... | Jul 1637.543
20 | Actual Mexico T Series 4 Variable Co... | Jul 3105.642
21 | Actual Mexico L Series 1.6...  Variable Co. Sep 8299.545
22 | Actual Mexico L Series 1.8_ Variable Co__ Sep 90.268 =i}

Figure 10: Relational drill through

Procedure

1. Highlight a cell and check to see whether the cell can be drilled on. In the IBM Planning Analytics
ribbon, in the data section, there is an icon for Drill Through.

7y Commit & Clear~

X Discard @Snap;hot'
Refresh L
Sheet ~ w Drill Through ~

Data

If the Drill Through icon is enabled, you can drill through on the highlighted cell.

& Drill Through -
2. Click the Drill Through icon .

3. Click the data source that you want to view the detailed data for.

= Drill Through= | [7 © ~ C(&] Use Serve
t BB CUBE_SalesByQuarter i
E= RELATIONALTABLE_SalesAllModel

Results
A drill through view of the data source for the selected cell appears.

Cascading drill through

If your TM1 modeler defined multiple levels of drill processes or drill assignment rules for a TM1 cube,
view, or relational table that you're working with, you can successively drill through multiple levels in your
report.

About this task

You can successively drill through multiple levels from the Drill Through Viewer or the Cube Viewer.
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Procedure

1. Open the Drill Through Viewer or the Cube Viewer.
2. Right-click a drill through capable cell.

me
utt Orill Through: test3 - O X
B F® O wiee o tine 12004
. Current value 60000
S :
plan_versien plan_ plan_deparment pl alad
| @ FY 2004 Budget Gem oW Administration @ R iy
Release hold
E| = = plan_tines [1] ™ e
T R R | =
= ceecion = plal  pejease all holds | ]
.. | Description Spread data
Spr
w— Mar-2004 | @ 022004 |, 0004
Drill through
“ Entry 1 | su.uuai & > o 5,000 15,000 5,000
line 2 Adj To Line 1 4,200 Show cell values as o 350 1.050 350
line 3 Mew Office 45,000 Comments. 0 i} 15,000 5.000
line 4 0 Clear 0 0 0 0
line &
of| o 0 0 0 0
© All Lines fos200 o 0 5,350 31,080 10,350
Pasle
Trace cel
£ >

Figure 11: Drill through menu

3. Click Drill through.
Note: If the Drill through option is disabled, the cell that you right-clicked on does not have drill
processes or drill assignment rules set for it.

4. Click the drill process that you want to use.

=
i Drill Through: test3 = O X
= — e 7 - -
|B ¥ ® © wile= N v
E o plan_version @ plan_business_unit plan_gxchange_rates O plan_department @ pl
| FY 2004 Budget Germany local Administration R
| = £ plan_lines []] E=  plan_time
— = Salsction = plan_time_2004_with_gesc
Description 1
_ I & 012004 A Mar-2008 | © 022008 | Lo o004
< Drill through
m Entry 1 | Gu.uoo; 0 5,000 15,000 5,000
line 2 Adj To Line 1 4,200 testd 0 350 1,060 350
line 3 New Office 45,000 0 0 0 0 15,000 5,000
line 4 0 0 0 0 0 [ 0
line & ] 0 0 0 0 0 0
© All Lines 109,200 16,050 5,350 5,350 5,250 31,050 10,350
< >

Figure 12: Drill through process

Results
An additional Drill Through Viewer appears.
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Figure 13: Multiple Drill Through Viewers

What to do next

If your TM1 modeler has more levels defined, you can repeat these steps in new Drill Through Viewers to
continue drilling. You can also generate reports from any of the Drill Through Viewers.

Save a drill through

You can save data in a relational drill through as a CSV file.

Procedure

1. Open the drill through table viewer.

o LEnes S Drill Through ~ " Recreate Book
n  Sheet~
Data Quick Report Sandbox Dynamic Reports
. G| Drill Through: RELATIONALTABLE_SalesAliModel = O X P Q =
= ||l | ActvsBud Region Model Account1 Month Data -
| Actual Mexico L Series 1.6... | Units Apr 1353 I
uarter 2 Actual Mexico L Series 1.8... | Units Apr 8
17,947 3 Actual Mexico L Series 1.8... | Units Apr 1040
1,760 4 Actual Mexico L Series 2.0... | Units Apr 16
=518 5 Actual Mexico L Series 2.0... | Units Apr 983
6 Actual Mexico S Series 1.8... | Units Apr 457
0 Actual Mexico S Series 2.0... | Units Apr 377
8 Actual Mexico S Series 2.5... | Units Apr 420
9 Actual Mexico T Series 4.0... | Units Apr 80
10 Actual Mexico T Series 4.0... | Units Apr 173
" Actual Mexico L Series 1.6... | Units Aug 948
12 Actual Mevien I Seriec 18 | Linite Aunn 7
2

" Click the Download CSV button.

Explore TM1 data 145



File Download X

Do you want to open or save this file?

Name: RELATIOMALTABLE SalesAllModel.csv
u Type: Microsoft Excel Comma Separated Values File, 6.26 KB
From:

1 While files from the Internet can be useful, some files can potentially harm
a your computer. if you do not trustthe source. do not open or save this file.
What's the nisk?

3.
A prompt appears, asking if you want to open or save the file. Click Save.

Results
The data in your relational drill through is saved as a CSV file.
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Chapter 7. Explore Cognos Analytics data

Exploration Views and lists

Create an exploration

Create explorations of IBM Cognos Analytics data to help you make more effective business decisions by
exploring significant company data. To explore IBM Cognos Analytics data, select a package and choose
items from that package to place in the rows and columns of the Microsoft Excel worksheet.

Before you begin

Before you can create an Exploration View or list view, the administrator must create a package and
publish it to a location to which you have access.

The administrator must create a package in Framework Manager and publish it to a location in the IBM
Cognos Connection portal to which you have access. For full access to IBM Planning Analytics for
Microsoft Excel, you should be a member of the Express® Authors or Report Administrators role in IBM
Cognos Analytics. An administrator must configure these privileges using IBM Cognos Administration.

Procedure

1. Specify the package.
2. Add data items to rows and columns.
3. Add a measure.

4. Optionally, nest and filter data. For more information, see “Nest rows or columns” on page 153 and
“Creating custom filters” on page 161.

Results

To format cells in your Exploration View or list view, you can use the IBM Cognos custom styles, such as
Measure - IBM Cognos or Calculated Column - IBM Cognos, in addition to the pre-built Microsoft Excel
styles.

You can access the IBM Cognos styles by clicking Home > Cell Styles. The IBM Cognos styles are listed
along with the pre-built Excel styles. You can modify attributes, such as font and alignment, and then save
the changes to a template for re-use.

In Microsoft Excel 2010, a background color that is set using the Format Cells command overrides the
background color that is set for the cell styles.

To preserve formatting you applied to the exploration, from the IBM Planning Analytics tab, click the Use
Server formats dropdown and select Use Excel formats. If you select Use Server formats, all custom
formatting is removed.

Create a list

Work with lists that use IBM Cognos Analytics data
You can explore IBM Cognos Analytics data with lists.

Use list explorations to show detailed information from your database, such as customer lists or product
lists. Data sources can be relational, OLAP, or dimensionally modeled relational (DMR).
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A list exploration is a report that shows data in rows and columns. Each column shows all the values for a
data item in the database or a calculation based on data items in the database. You can create a list to

look up the value of an item from the database. It can then supply the value to another worksheet where
it can be used for setting a parameter. For more information, see the section on use cases and examples.

Related concepts

“Insert blank columns” on page 61

Insert a blank column into a list to create white space or to add cell-based calculations. You can use the
new column to insert any Microsoft Excel calculation, such as AVG, MIN, or MAX and you can reference
cells both inside and outside the list.

Related tasks

“Create an exploration” on page 147

“Insert items” on page 155

“Suppress empty cells” on page 61

“Insert Microsoft Excel calculations” on page 73

“Add calculated columns in a list” on page 148

“Nest rows or columns” on page 153

“Rename rows or columns” on page 158

“Reorder columns or rows” on page 159

“Sort a column by nhames in a list” on page 148

“Change the cube or datasource used by an exploration” on page 73
You can change the cube or datasource that is used by an exploration.

Sort a column by names in a list
Sorting a column by names makes it easier for you to organize data.

Procedure

1. In the overview area, click the down-arrow of a column box.
2. Click Sort by names and select a sort option.

Results

In the overview area, a symbol appears in the column box to indicate a sort is applied. To remove a sort,
click the down-arrow and select Sort by names > Remove.

Insert blank columns

Insert a blank column into a list to create white space or to add cell-based calculations. You can use the
new column to insert any Microsoft Excel calculation, such as AVG, MIN, or MAX and you can reference
cells both inside and outside the list.

Right-click a column header in the list where you want to insert a column, and click IBM Planning
Analytics > Insert user row/column.

A blank column is added next to the selected column.

Add calculated columns in a list
Insert a calculation to make your list more meaningful by deriving additional information from the data
source. You can insert calculations in lists that use IBM Cognos Analytics data.

About this task

The list must include a measure. For example, the first column displays Products and the second column
displays Revenue.

In addition to simple arithmetic calculations, you can perform the following calculations.
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% Of
Calculates the value of a selected member as a percentage of another member, for example, fourth
quarter as a percentage of the whole year or actual as a percentage of target.

% Change
Calculates the change in value of a selected member as a percentage, for example, growth from year
to year or variance from target.

For information about adding Microsoft Excel calculations, see “Insert Microsoft Excel calculations” on
page 73.

Procedure

1. Select the headers of the measure columns that you want to use in the calculation.
2. On the list toolbar, click Insert Calculation and select the calculation that you want to perform.

Note: Calculations that are not applicable to the items you selected are grayed out.

Results
The calculated column is displayed in the list. You can rename the calculated column. You can also move
the calculated column.

Note: To delete a calculation, right-click the calculated column, click IBM Planning Analytics > Delete.

Suppress empty cells
Sparse data can result in lists showing empty cells. To remove sparse data in a list, you can suppress
empty cells that contain a null or zero value.

Procedure

1. On the IBM Planning Analytics tab, click '=' Suppression type.
2. Click Suppress Rows Only.

Results
Suppressed items are hidden.

Note: To remove suppression, repeat step 1 and click No Suppression.

Create an Exploration View

Work with IBM Cognos Analytics data
You can explore IBM Cognos Analytics data with Exploration Views.

Use Exploration Views to quickly change how you view performance measures, such as revenue or
budgeted production costs.

OLAP (online analytical processing) exploration uses the term slicing and dicing to describe the ease with
which you can change context and view details. For example, you look at revenue for the years 2012 to
2015 by sales region. You notice a dip in the revenue for 2014. By clicking 2014, you can drill down to
show revenue results by quarter for 2014. You can easily change the view from quarters for 2014 to sales
personnel by replacing quarters with sales personnel.

You can compare and manipulate data so that you can better understand relationships between data and
the relative importance of individual data items. Whether you want to assess revenue growth or to identify
top performers, IBM Planning Analytics for Microsoft Excel provides the filtering and sorting support you
need for exploration.

To extend the example of reviewing revenue by sales region and sales personnel, you can add sales
targets and then calculate the percentage difference between the sales target and actual revenue for each
salesperson. The result indicates who achieved their sales quota as well as who is eligible for a bonus.
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For an example about creating a basic Exploration View, see “Example - evaluate revenue from specific
order methods” on page 253.

If you are already comfortable with exploration fundamentals, you may want to refine your Exploration
View by using tasks such as filtering data, nesting rows and columns, and inserting calculations.

Select measures

Each Exploration View based on DMR or OLAP packages must contain at least one measure. Only one
measure can be dragged to the measure drop zone. If you select more than one measure by placing a
measure in a row or column, the measure that is in the measure drop zone becomes the default measure.

Tip: To drag more than one measure to a row or column, you can use Shift+click or Ctrl+click.

Sometimes, when you add measures to columns or rows, you may notice that other items get re-ordered.
This is a query framework behavior. Unlike an OLAP data source, DMR data is not returned in a specified
order. If a specified order is required, you must edit the specifications in Framework Manager.

Procedure
1. In the source tree, select and drag a measure to the Measure drop zone.

Unlike the Rows or Columns drop zone, the Measure drop zone is available only on the grid and not in
the header area. The selected measure appears.

2. Save your workbook.

Results
After you save your workbook, you can publish it to IBM Cognos Connection.

Remove measures

To remove measures from an Exploration View that uses IBM Cognos Analytics data, you must have an
active worksheet. After removing a measure from the Measure drop zone, you are able to add back a
measure. In addition to the Measure drop zone, which can contain only a single measure, you can add
multiple measures to other drop zones.

To replace a measure, you can drag a new measure to any of the drop zones where the measure has been
placed. This includes the measure drop zone.

Procedure

To remove a measure from an Exploration View, right-click the cell that displays the measure name, click
IBM Planning Analytics, and then click Hide.

Results
The measures are removed from the measure drop zone in the Exploration View. You can now add one or
more measures to the Exploration View.

Insert a hierarchy
You can use a dynamic expression to insert a hierarchy in an Exploration View based on the structure of
the metadata tree.

You do this by selecting an insert member option that creates a dynamic expression, such as the Insert
Member With Children option, and then dragging a node item to either the rows or columns drop zone.

Alternate hierarchies of the same dimension can only be stacked in the same Exploration View. They
cannot be nested or used on opposite axes. Alternate hierarchies of the same dimension, for example,
Retailers by Geography and Retailers by Type, do not produce logical results when combined on the
same Exploration View as nested items or on opposite dimensions. To combine two alternate views of the
same hierarchy, you must model them as separate dimensions. If they are available as separate
dimensions, they can be combined on the same Exploration View. For example, it would be possible to
place Retailers by Type on rows with Retailers by Geography on columns, and Retailers by Type on
rows with Retailers by Geography nested on rows.
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Procedure

1. In the task pane, click and select Insert member with children .
2. In the source tree, drag the hierarchy that you want to insert to the Rows or Columns drop zone.

Results

Note: If by using one of the multiple selection techniques, you dragged an item and one of its children to
Rows or Columns, you may notice that it appears twice. If this was accidental, you can delete the
repeated item. To remove an item, in the work area, right-click the item and then click Delete.

The items appear in the Exploration View in their expanded format.

Add calculated rows and columns

Insert a calculation to make your Exploration View more meaningful by deriving additional information
from the data source. For example, you create an invoice, and you want to see the total sales amount for
each product ordered. Create a calculated column that multiplies the product price by the quantity
ordered.

About this task
In addition to simple arithmetic calculations, you can perform the following calculations:

% Of
Calculates the value of a selected member as a percentage of another member, for example, fourth
quarter as a percentage of the whole year or actual as a percentage of target.

% Change
Calculates the change in value of a selected member as a percentage, for example, growth from year
to year or variance from target.

% Of Base
This calculation is available only if you select two members from different hierarchies, one on rows
and the other on columns, for example, each region's contribution (on rows) to a yearly total (on
columns).

% Of Parent
This calculation is available only for TM1 data. The % of Parent calculation is available only if you
select two members from different dimensions, one on rows and the other on columns. % Of Parent
calculates the value of a selected member as a percentage of its parent, for example, January sales as
a percentage of sales for the whole year.

After you insert a calculation into an Exploration View, the rows or columns are separated into two distinct
blocks of items before or after the inserted row or column. If you want to use the Expand level / Collapse
level feature, you must do so for each block separately.

When calculations in the rows and columns of an Exploration View intersect, calculations are performed
in the following order:

« Addition or subtraction
« Multiplication or division

If both calculations have the same precedence, for example, if they are both functions, then the row
calculation takes precedence.

For information about adding Microsoft Excel calculations, see “Insert Microsoft Excel calculations” on
page 73.

Procedure

1. Right-click the columns or row headers that you want to use in the calculation.

2. Click IBM Planning Analytics > Insert calculation and select the calculation that you want to
perform.
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Note: Calculations that are not applicable to the items you selected are grayed out.

Results
The calculated row or columns appears in the Exploration View. You can rename the calculated column or
row. You can also move the calculated column or row.

Note: To remove a calculation, right-click the calculated row or column, click IBM Planning Analytics >
Hide.

Filtering values using context
You can use one or more items to quickly focus your Exploration View on a particular view of the data.
This technique is known as filtering using context.

For example, you have an Exploration View showing products in the rows and revenue for different
quarters in the columns. To change the context to Asia, you drag Asia from the source tree to the Context
section of the overview area. The Exploration View then shows only the values for Asia.

Changing context changes the values that appear. It does not limit or change the items in the rows or
columns.

You can filter using multiple values in the context area, however, multiple filters are lost when you convert
the Exploration View to formulas and start to use cell-based methods. Some context filters cannot be
converted to formulas, such as multiple filters from the same dimension and filters from dimensions that
are already displayed in the Exploration View.

Procedure

1. In the source tree, select or search for one or more items to filter on.
2. Drag the item that you want to filter on into the Context section of the overview area.

A drop-down list box appears under Context.
3. Click the item that you want.

The Exploration View shows the results only for the selected item.

Tip: To change context, select a new item from the drop-down list under Context.

4. If you want to use a custom set as a filter, drag the custom set from the Source Tree to the Context
section of the overview area.

Insert blank columns or rows

Insert a blank column or row into an Exploration View to create white space or to add cell-based
calculations. You can use the new row or column to insert any Microsoft Excel calculation, such as AVG,
MIN, or MAX.

About this task

Depending on the type of data, such as relational or asymmetric you experience very different results.
Experiment with different approaches to see what makes sense in your environment.

After you insert a row or column into an Exploration View, the rows or columns are separated into two
distinct blocks of items before and after the inserted row or column. If you want to use the Expand level /
Collapse level feature, you must do so for each block separately.

Procedure
1. Right-click a column or row header in the Exploration View where you want to insert a column or row.

If the Exploration View area expands, make sure that it does not overwrite items.
2. Click IBM Planning Analytics > Insert user row/column.

A blank column or row appears next to or under the selected column or row.
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Results
The blank row or column is added to the Exploration View.

You can leave the row or column blank. You can also populate the blank column or row with a Microsoft
Excel calculation. For more information, see “Insert Microsoft Excel calculations” on page 73.

Nest rows or columns

You can nest items in an Exploration View to compare information by using more than one itemin a
column or row. For example, an Exploration View shows the sales by product line for the past fiscal year.
You can add an item to further break down the sales by order method. You can also nest rows in a list.

In the overview area, you can drag the boxes that represent the nested items to quickly change the
nesting order.

If you nest a row or column, the context menu for Expand, Drill, and Explore does not appear for the
outer item when you convert to formulas and use cell-based methods.

Procedure
1. In the source tree, click the item that you want to insert.

Tip: When selecting multiple items, the selected items are placed in the exploration in the order that
you click them. To avoid rearranging items after you drag and drop them into the exploration, click the
items in the order of placement that you want.

2. Drag the item to the location that you want in the rows or columns.

A highlight bar indicates where you can drop the item.

3. If you are working with a list, to merge cells with the same data, right-click items in the column you
want to group, and then click IBM Planning Analytics > Group/Ungroup.

Rearrange nested items
You can rearrange nested items by dragging one item next to another item in a drop zone.

For example, if Products and Regions are nested, you can move Regions to the outside edge.

Procedure
1. Drag an item next to another item within a drop zone or next to a different drop zone.

A highlight bar indicates where you can drop the item.

2. If you are creating a list, to merge cells with the same data, Right-click items in the column you want to
group, and then select IBM Planning Analytics > Group/Ungroup .

Results
Nested items appear next to each other with nested items replicated for each of the preceding items.

Suppress empty cells

Sparse data can result in Exploration Views showing empty cells. For example, an Exploration View that
matches employees with products, results in many rows of empty values for the revenue measure if the
employee does not sell those products. To remove sparse data in an Exploration View, you can suppress
empty cells that contain a null or zero value.

When you are working with IBM Cognos Analytics data, totals-based suppression is applied. Totals-based
suppression removes rows or columns where the total results in a null or zero value throughout the
Exploration View. You cannot remove sparse data from individual rows or columns.

Procedure

1. On the IBM Planning Analytics tab, click '=' Suppression type.
2. Choose where to apply the suppression:

« Suppress Rows Only
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« Suppress Columns Only
« Suppress Rows and Columns

Results
Suppressed items are hidden.

Note: To remove suppression, repeat step 1 and click No Suppression.

Best practices
Exploration Views provide many automatic features so that you can focus on your main purpose, which is
to analyze and explore your company data.

This topic applies to Exploration Views that use IBM Cognos Analytics data.

Any charts, cells, or cell-formatting that you introduce onto the worksheet might be overwritten when
refreshed data changes the size or the content of the Exploration View. Create headings and charts where
expanding data in the cells of the Exploration View do not overwrite items.

In general, use Exploration Views for dimensional data sources. For more information, see “Work with
items in an Exploration View” on page 251.

If you are pulling large quantities of data while you are working on the layout of your Exploration View, you
may find that there is a delay. The following techniques help you to eliminate or at least mitigate
performance delays.

&
« On the IBM Planning Analytics toolbar, click "~ and select Preview with No Data. Refresh the data
after you have finished designing your worksheet.

- If you are working with dimensional data in an Exploration View, select a measure first. This limits the
amount of data and gives you much faster results.

« Lower the maximum number of rows or columns to pull into an Exploration View or list by using the
Data Display Row Limit option. When you finish the layout, you can set the Data Display Row Limit
number higher or double-click More or All to see the remaining rows or columns of data.

Set properties
You can set properties for an Exploration View or a list that are specific to a worksheet.

About this task

The settings in the Properties dialog box are specific to a worksheet. For information about setting global
options, see Chapter 4, “Settings,” on page 21.

In addition to changing settings, the Properties dialog box enables you to view information about the
worksheet including server and package information, and the date the worksheet was created.

Procedure

1. On the IBM Planning Analytics tab, click = Properties.

2. To change the starting location of your Exploration View or list, type a new row number in the Row
start box and a new column number in the Column start box.

3. If you are working with a TM1 Exploration View, you can choose whether to process data in either CSV
or raw XML format.
« To choose CSV format for faster processing of large data sets, in the Request format drop-down box,

click Unformatted Values.

« To choose raw XML format, in the Request format drop-down box, click Formatted Values.

4. If you are working with a IBM Cognos Analytics List, you can choose whether to process data in either
CSV or raw XML format.
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- To choose CSV format for faster processing of large data sets, in the Request format drop-down box,
click Unformatted Values.

« To choose raw XML format, in the Request format drop-down box, click Formatted Values.

5. To control how labels appear in nested cells, set the Default grouping option.
Note: The Default grouping option controls how the Group / Ungroup feature works. For Exploration
Views, this is the automatic setting for presentation of metadata in nested rows and columns. For lists,
this determines how the Group /Ungroup menu items and buttons work.These settings override the
settings in the Options dialog box and affect only the current worksheet. You can leave cells
ungrouped when you need to use Microsoft Excel lookup functions or you can group cells to provide for
greater readability. Changes to the Grouping option will be reflected in the worksheet immediately,
whereas changes in the Options dialog box will only be reflected when a new Exploration View is
created.
- To merge metadata into cells that span nested items and allow for full grouping, click Merge Cells.

« To repeat metadata in individual cells that span nested items, click Repeat Labels.

Use this option when you want to use other Microsoft Excel functions on the data.
« To limit cell metadata and merging to minimize labels, click Label Top Cell.
« To turn grouping off, click None.
6. To limit the number of rows displayed, set the Data Display Row Limit property.

7. After you are done setting options, click OK.

Insert items

You insert items from the source tree as rows and columns in an Exploration View or list to create sets for
exploration. A set is a collection of like data. For example, you can have a set of data named years that
includes quarters as details.

You can control how items are inserted by setting the insert option on the exploration bar. For an IBM
Cognos Analytics data source, you can use the following insert options.

« Insert Single Member, which inserts the selected member.

« Insert Member With Children, which inserts the selected member and its components to one level as a
static set.

« Insert Member With Dynamic Children, which inserts the selected member and its components to one
level as a dynamic set.

In addition to items from the source tree, you can insert items retrieved in a search.

Note: The default measure specifies the measure to use for an Exploration View if the measure is not set
by one of the existing axes. For example, you create an Exploration View with Products in the rows and
Quantity Sold in the columns. You add Revenue to the Measure drop zone to make it the default
measure, but the values in the rows do not change because they refer to the measure Quantity Sold in
the column axis. However, if you replace the measure Quantity Sold with the non-measure Order
Method, the values now refer to Revenue as the default measure.

You can also simultaneously insert all the items of a level “Insert all the items of a level” on page 156,
insert some items from a level, or insert items from different levels of the same dimension “Insert items
from multiple levels of a dimension” on page 156.

Procedure

1. Select the insert option you want to use.
2. In the source tree, select the items that you want to insert.

3. Drag the items to the desired location in the Exploration View or list.

To add an item to items that already exist in the Exploration View or list, hold down the Ctrl key when
dropping items into the drop zones.
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A highlighted bar indicates where you can drop the item.

Note: Sometimes, when you add measures to columns or rows, you may notice that other items get re-
ordered. This is a query framework behavior. Unlike an OLAP data source, DMR data is not returned in a
specified order. If a specified order is required, you must edit the specifications in Framework

Manager.

A detail-based set appears in the Exploration View or list.

You can insert items as a selection-based set by pressing Shift+click or Ctrl+click to select multiple
items in a dimension and then dragging them to the Exploration View or list. When selecting multiple
items, the selected items are placed in the Exploration View in the order that you click them. To avoid
rearranging items after you drag and drop them into the Exploration View, click the items in the desired
order of placement.

Insert items from multiple levels of a dimension
For a mixed comparison, use selection-based sets to position items adjacent to each other in an
Exploration View.

For example, you can select items from a single dimension in the source tree. You can select both
contiguous and noncontiguous items from different levels.

After you select items, you can drag the items to the Exploration View.

For groups of items that you use frequently, you can create a custom set to make selection of them easier.
For more information, see “Custom sets” on page 163.

Procedure

1. In the source tree, expand the dimension to locate the items that you want to insert.
2. Press Shift+click or Ctrl+click to select multiple items in a dimension and then drag them to the
Exploration View.

Tip: When selecting multiple items, the selected items are placed in the Exploration View in the order
that you click them. To avoid rearranging items after you drag and drop them into the Exploration View,
click the items in the desired order of placement.

Results
A selection-based set appears in the Exploration View.

Insert all the items of a level
You can simultaneously insert all the items of a level into an IBM Cognos Analytics exploration. Levels
define the way data is grouped in dimensions.

For example, a geographical dimension in a source tree might contain levels for region, country or region,
and city. You can click a single region and instantly insert every country or region that belongs to that
region into the Exploration View. By expanding the region item, you can display all of the countries or
regions within that region. Use this technique to insert members of a single node item.

You can also choose to display all of the countries or regions across regions by inserting a special Level
item. Use this technique to insert members at the same level from multiple node items.

Procedure

1. In the source tree, click a single item that contains the detail that you want in the exploration.
2. Optionally, insert members from a single node item.

« Drag the item to the drop zone in the overview area, such as the Rows drop zone.

- Expand the item.

Tip: To expand or collapse items, right-click the item, click IBM Planning Analytics, and then click
Expand / Collapse or Expand Level / Collapse Level. Expand Level expands items from the highest
level member.
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3. Optionally, insert members at the same level from multiple node items

- Inthe source tree, click a single item that contains the detail that you want in the Exploration View.
« From the command area, drag the Level item to the drop zone or work area.

Limit items
You can limit the items in an Exploration View or list using a variety of techniques.

You can use the following options with Exploration Views:

« Use zero-suppression to hide rows or columns that contain only missing values.

- From either rows or columns, select the items you want to show in the Exploration View, right-click the
cells and select IBM Planning Analytics > Keep. The Keep option is also available in the set editor.

« Use the Data Display Row Limit option to limit the number of rows displayed in the Exploration View.
On the IBM Planning Analytics toolbar, click Options. Set the number of rows to display in the Data
display row limit field.

You can use zero-suppression to hide rows that contain only missing values in Lists.

Drill down and drill up

You can drill down and drill up to change the focus of your analysis by moving between levels of
information.

Drill down to see more detail. For example, you can drill down to the lowest-level item to examine the
impact of a single aspect of your business.

Drill up to compare results. For example, you can examine revenue for a single product and then drill up to
see revenue for the entire product line for comparison.

Note: When you drill back up after drilling down, you may lose filters that are applied. For example, you
create a filter to include the data for sales regions of the USA and Canada. You drill down on Florida. When
you drill up again, the analysis no longer includes Canada in its scope.

Procedure

1. To drill down or up in a single row or column, right-click a cell and then click IBM Planning Analytics >
Drill Down or IBM Planning Analytics > Drill Up.

2. To drill down or up in both a row and column simultaneously, double-click the value at the intersection
of the row and the column.

Rows and columns

Add objects to rows and columns

Select the data items that you want to appear in the Exploration View or list view. When selecting multiple
items, the selected items are placed in the exploration in the order that you click them. To avoid
rearranging items after you drag and drop them into the Exploration View, click the items in the desired
order of placement. To add an item to a multiple set, hold down the Ctrl key while dragging the item. This
appends the new item to the items already in the Exploration View.

You may frequently use items from different query subjects or dimensions in the same reports. Ask your
modeler to organize these items into a folder or model query subject and then to republish the relevant
package. For example, if you use the product code item in sales reports, the modeler can create a folder
that contains the product code item and the sales items you need.

Procedure

1. In the IBM Planning Analytics toolbar, click Exploration or list.
2. If the Select Start Location dialog box appears, type a cell address, such as $L$20 and click OK.
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You can also click a cell to populate the Start Address. For example, you can change the start location
to accommodate graphs or other worksheet items.

3. In the source tree, drag each data item to the location in the work area where you want it to appear.

For an Exploration View, drag objects to the Rows and Columns drop zones, which are located in the
header area of the worksheet. Use the Context area, to further refine or filter your report.

For a list, drag objects to the Columns drop zone, which is located in the header area of the worksheet.

Note:
« To drag more than one item, you can use Shift+click or Ctrl+click to select multiple items.
« To add an item to items that are already on Columns, hold down the Ctrl key and drop the item onto
the existing items.
4. Save your workbook.

Results
Selected items appear in the rows and columns of the report.

After you edit your workbook, you can publish it to IBM Cognos Connection.

Rename rows or columns

You can rename columns or rows, including calculated columns or rows. The item in the underlying
database does not change, however, for presentation purposes you can change the name of the column or
row heading of an Exploration View or list.

For relational data sources, only measures and summary items can be renamed.

Procedure

1. Right-click the item you want to rename, click IBM Planning Analytics, and then click Reorder /
Rename.
The Reorder / Rename dialog box is displayed.

2. Click the item that you want to rename.

3. Click the highlighted item again so that the name is able to be edited, type the new name, and then
press Enter.

4. Click OK.

Results
The displayed name of the row or column heading is changed.

Note: To reset all renamed items, click Reset Captions. This option is available in the Reorder / Rename
dialog box.

Sort rows by values or names
Sorting rows by values or names makes it easier for you to organize and analyze your data.

Sort options differ depending on the type of data source and the type of exploration. For example, in an
Exploration View that uses a multidimensional data source, you can sort rows by row name.

Procedure

1. Select a sort option.

a) To sort rows based on the values in a column, right-click the column header cell then click IBM
Planning Analytics > Sort by values.

b) To sort rows by row name, right-click a row header cell then click IBM Planning Analytics > Sort by
names.
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You can also sort rows by name using the context-menu from a row or column box in the overview
area.

2. Select a sort option.

Results

In the overview area, a symbol appears in the rows or columns box to indicate a sort is applied. To remove
a sort, right-click the header cell then click IBM Planning Analytics > Sort by values or Sort by names >
Remove.

Swap rows and columns

You can swap rows and columns for a different view of your data. For example, the rows contain quarters
of the fiscal year and the columns contain products. To track trends over time more easily, you can swap
them so that the rows contain products and the columns contain quarters.

Note: When you swap rows and columns in a TM1 Exploration View, sorting and top or bottom filters are
removed.

Procedure

Click Swap Rows and Columns [~ on the toolbar.

Tip: You can also use the overview area to swap individual items on rows and columns by dragging the
items from one area to the other.

Reorder columns or rows
You can move columns or rows, including calculated columns or rows, in an Exploration View. You can
reorder columns in a list.

For relational data sources, only measures and summary items can be reordered.

Procedure

1. Right-click the row or column heading and then click IBM Planning Analytics > Reorder / Rename.
2. Change the order of the items using the arrows.
3. Click OK.

Results
The row or column is moved in relation to the other rows or columns in the exploration.

Change the system and data source used by an exploration
You can change the IBM Cognos system that is used by an exploration. You can also change the data
source that is used by an exploration.

Before you begin

The information area must be displayed above the Exploration View or list to complete this task. The
information area is displayed when Show system and package information in Exploration View or list

&

sheet in the Options dialog box is enabled. Then click Refresh A

Procedure

1. Click the worksheet that contains the exploration.
2. In the information area above the exploration, double-click the cell that displays the System.

Or, if you want to change only the data source or package, double-click the cell that displays the
Package.

3. In the Select Package dialog box, select a system.
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4. Select a data source, and then click OK.

Custom filters

For IBM Cognos Analytics data sources, you can filter data so that only the data you require appears in the
analysis. Add a filter expression to focus a report and minimize processing time by excluding unwanted
data. For example, you can filter data to show customers who placed purchase orders that were valued at
over one thousand dollars during the past year. When you run the report, you see only the filtered data.
Depending on your data, you can specify a filter by using measures, attributes, fields, and calculations and
using comparison and logical operators to compare them with a constant, a measure, an attribute, a field,
or a cell reference, including a date.

When you define a filter rule by using a label or an attribute, the text is case sensitive. These detalil filters,
which are applied to the data source, are Boolean expressions used to exclude items based on values.

Use cell references

Cell references can be used anywhere a constant could be used. Cells are read at the time the query is
initiated. You can use a text box for typing values or you can use cell ranges, such as 37, $K$9 for cells or
H3:H20, $3$5:$M$15 for ranges. Cells can be on another sheet, for example, Sheet2! :B4, Sheet3!
D2R2, or even a nhamed range, such as Sheetl!RangeName. Blank cells are ighored and invalid numeric
values are converted to zero (0). You can create Exploration Views and lists on one worksheet to be used
as part of a filter expression in another worksheet. A cell reference used in a numeric or date comparison
that does contain a valid value will result in the use of 0 and the current date respectively.

Match data types

If you create a filter for a particular data type, such as a numeric data type, but enter criteria for another
data type, such as a string, you receive an error. In general, you must enter values that are consistent with
the data type of the item for which you are creating criteria. For example, if you create a filter for a
monetary amount, which is numeric, but enter a string value, such as "Yen" you receive the following
error:

Error 901: QE-DEF-0260 Parsing error before or near position: position of:
"filter (MUN)"

The following operators are an exception to the data type rule: IS NULL, IS NOT NULL, LAST N DAYS, and
IS IN. In the case of these operators, the target, or second, argument is not a type match with the field, or
first argument. In the first two, IS NULL and IS NOT NULL, there are no target arguments. None of these
operators can use a database reference as a target argument.

OLAP and DMR data sources

For OLAP and DMR data sources in a list report, criteria are limited to the items that you add to the list
itself. To enhance filter capabilities, use lists for relational data sources and use Exploration Views for
dimensional sources. Be cautious when mixing context dimensions with filters because they may not yield
the result you expect.

In nested explorations using OLAP or DMR data sources, you must apply the filter to the dimension on
rows or columns that defined the measure value in the Exploration View. For example, you might have an
Exploration View with products and order method on rows, years on columns and quantity sold on
measures. Because order method is the inside edge of the nested rows (it appears after products in the
Rows drop zone), you must create the filter using order method.

Focus relational data

You can limit the data in your report with filters or query parameters. The method you choose should
depend on the capabilities of the data source, the performance requirements, the persistence of the
dataset, and how complex you want the report to be. In IBM Planning Analytics for Microsoft Excel, you
must use detail filters for list reports in the relational reporting style. These filters remove rows and
columns from your reports.
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Before aggregation

For relational data sources, you may also have the option of applying filters before aggregation. Select the
Before aggregation check box if the field is a measure, however this check box is disabled for non-
measures or if the condition is at or below a logical OR operator. In that case, the default is enforced
where non-measures are automatically before aggregation and all others are after aggregation.

Combine filters

You can combine filters to create custom AND and OR conditions. When you filter your data based on a
number of criteria, there may be filter rules that are optional and filter rules that are required. You use
AND to group rules that are mandatory. You use OR to group filter rules that are optional. For example,
customers filtered by Revenue > 1000000 AND Discount >.15 gives different results from Customers
filtered by Revenue > 1000000 OR Discount > .15. A more complex scenario might require combining
both mandatory and optional filter rules.

Filters and calculations

Filters cannot use calculations that reference the set being filtered because this creates a circular
reference. Depending on how ranking functions (such as rank or quartile) or percentage functions (such as
percent of total) are customized, they may not be available when defining a filter.

IS IN operator

Based on the SQL IN operator, the IS IN operator reduces the need for multiple OR clauses. Use the IS IN
operator for numeric and text fields. For numeric fields it would normally be non-measures, such as Year.
You can use a text box for typing values or you can use cell ranges, such as 37, $K$9 for cells or H3: H20,
$3$5:$M$15 for ranges. Cells can be on another sheet, for example, Sheet2! :B4, Sheet3!D2R2, or
even a named range, such as Sheetl!RangeName. Blank cells are ignored and invalid numeric values are
converted to zero (0). You can create Exploration Views and lists to be used as part of a filter expression in
another worksheet. For more information, see the topics on use cases.

Promote filters to a studio

When you promote an Exploration View or a list to a studio, such as Report Studio, the custom filter that
used a dimensional data source is recognized as a set expression. Set expressions are calculated sets of
members. For example, children ([2015]) is a set expression that displays the child members of 2015. To
edit the custom filter in a studio, you must edit it as a set expression using the Query Calculation editor.
For more information about set expressions, see the user guide for the studio.

Creating custom filters

In IBM Cognos Analysis for Microsoft Excel you can filter data so that only the data you require appears in
the analysis. Specifically, you can add a filter expression using measures, attributes, fields, and
calculations and using comparison and logical operators to compare them with a constant, a measure, an
attribute, a field, or a cell reference, including a date.

If you are working with a dimensional data source, you can also use context filters. For more information,
see “Filtering values using context” on page 152.

Procedure

1. In the drop zone, click the drop-down box of the item you want to filter and then click Filter >
Edit/Add Filter.

The Filter window appears. Based on your selection you are able to select or enter items for Item,
Operator, or Value. Criteria for filters are not limited to the items shown on the report.
2. Edit the filter expression and click OK.

3. After you have created all the criteria for the custom filter, click OK.
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Results

After you close the filter window, all cells used in references are selected. This is useful if you want to
format these cells to indicate their importance. The filter is applied to the applicable item. If you are
working with the Preview with No Data option selected, the effects of the filter show when you run the
data. The filter tag is displayed next to the item. In the drop-down box, on the Filter menu, Apply filter is
selected.

Tip: To remove a filter, click the drop-down box of the filtered item, and then click Filter > Apply Filter to
clear the check mark.

Adding a filter line
In the Filter window, add filter lines to create criteria for your filter. Each line represents a unique criterion
or filter expression.

Before you begin

You must create your filter and be in the Filter window to add a filter line.

Procedure

1. Click the Add a Filter Line icon.
The Edit Filter window appears.
2. Edit the expression.

Click a data item, then click a Boolean operator, and then enter a constant or enter the cell reference
that contains the value you want to use in this expression.

3. Click OK.

Applying filter criteria before aggregation
If you use a relational data source, to apply the filter criteria before items are summed, you can select the
Before Aggregation check box in the Edit Filter window.

Before you begin

You must create or edit a filter line from a relational data source.

Procedure

1. From the Filter window, click the filter line, or if you are creating a new filter, click the Add a Filter Line
icon.

2. Select the Before aggregation check box.

3. Click OK.

Grouping filter criteria

To combine filter criteria, group the filter lines. This enables you to create complex filter expressions that
rely on multiple data items and values. You can use complex criteria to display ranges of items based on
minimum and maximum values that you set in the Filter editor or in the cells of the Microsoft Excel
worksheet.

Procedure
1. Ctrl+click the items you want to group.
2. Click the Group Selected Filter Lines icon.

Deleting filter criteria
To remove criteria from your filter, you must delete the filter line or group that has that expression in the
Filter window. If more than one criterion has been grouped, you can delete the entire group.
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Procedure

1. To open the Filter window, from the toolbar or drop zone, click the Filter icon and then click Edit/Add
Filter.
The Filter window appears.

2. Click the line or group you want to remove.

3. Click the Delete Selected Filter Line icon.

This deletes the highlighted line or group.

Ungrouping filter criteria
Ungroup filter criteria if you want to change the order of the criteria, change the Boolean operators, or if
you want to delete specific lines from a complex filter.

Procedure

1. To open the Filter window, from the toolbar or drop zone, click the Filter icon and then click Edit/Add
Filter.
The Filter window appears.

2. Click the grouped items.
To select multiple items, Ctrl-click each item.

3. Click the Remove the Group Containing Selected Filter Lines icon.

Custom sets
When you work with IBM Cognos Analytics data sources, use custom sets to select, group, order, and save
members from a single hierarchical or node item in the source tree.

When you use IBM Planning Analytics data sources, use the set editor. For more information about sets,
see “Sets for TM1” on page 92.

If you select the members of a node item, the custom set retains only the members that you selected at
the time the set was created. You must update the custom set as members change in the node item.

You can save custom sets. You can specify a name and description for a custom set of data that you may
want to reuse later. Multiple custom sets may be available in a single saved exploration.

Custom sets can be used in an Exploration View using dimensionally modeled relational packages or
OLAP data sources. They are not available for relational packages. Levels cannot be saved as a custom
set.

After exporting or importing a deployment in Cognos Connection, you may need to update the storelD to
see your custom sets. This may happen when you change or upgrade the servers that deliver packages to
IBM Planning Analytics for Microsoft Excel. For information on updating storelDs, see the IBM Planning
Analytics for Microsoft Excel Tech Notes on the IBM Cognos support site.

Creating a custom set by using items in a drop zone

You can specify a name and description for a custom set of data that you may want to reuse later. You can
create a custom set using items in a drop zone. Multiple custom sets may be available in a single saved
exploration.

You can save custom sets. IBM Planning Analytics for Microsoft Excel creates a folder in your personal
folder, My Folders, in the IBM Cognos Connections portal with the same name as the package and saves
the custom set information in that folder. The custom set information is not shared among different users,
even when they are using the same package. You only have access to your own custom sets.

Custom sets can be used in an Exploration View using dimensionally modeled relational packages or
OLAP data sources. They are not available for relational packages. Levels cannot be saved as a custom
set.
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Procedure
1. When creating a new exploration, select items from a dimension or node in the source tree.

Note: Order of selection is the order in which the items appear in the drop zone and in the custom set.
2. Drag the items to a drop zone.
For an Exploration View, the drop zones are Columns, Rows, or Context. For a list, the drop zone is
Columns.
3. From the drop zone, click the item drop-down box and then click Edit Set.

The Selection window is displayed.

To edit custom sets, use the dialog box to move items to or from the Available Members pane to the
Selection pane. To limit items in the Available Members pane, click ‘&, type a string in the box, and
click &. To reorder items in the Selection pane, right-click an item to access move options.

4. To save the custom set, click the Save or Save as icon.
The Save window appears.
5. In the Name box, type a name for the custom set and click Save.

Results
The custom set is saved and is displayed in the source tree in the Custom Sets node item. It is saved as
part of your workspace and is not available to other users.

Creating a custom set using items in the source tree

You can specify a name and description for a custom set of data that you may want to reuse later. You can
create a custom set using items in the source tree. Multiple custom sets may be available in a single saved
exploration.

You can save custom sets. IBM Planning Analytics for Microsoft Excel creates a folder in your personal
folder, My Folders, in the IBM Cognos Connections portal with the same name as the package and saves
the custom set information in that folder. The custom set information is not shared among different users,
even when they are using the same package. You only have access to your own custom sets.

Custom sets can be used in an Exploration View using dimensionally modeled relational packages or
OLAP data sources. They are not available for relational packages. Levels cannot be saved as a custom
set.

Procedure

1. When creating a new Exploration View or list, Ctrl+click items from a dimension or node in the source
tree.
Note: Order of selection is the order that the items appear in the drop zone and in the custom set.

2. Right-click a selected item and then click New Set.

The Selection dialog box appears.

To edit custom sets, use the dialog box to move items to or from the Available Members pane to the
Selection pane. To limit items in the Available Members pane, click &, type a string in the box, and
click &. To reorder items in the Selection pane, right-click an item to access move options.

3. To save the custom set, click the Save or Save as icon.
The Save window appears.
4. In the Name box, type a name for the custom set and click Save.

Results
The custom set is saved and is displayed in the source tree in the Custom Sets node item. It is saved as

part of your workspace and is not available to other users.
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Insert Microsoft Excel calculations

You can insert any Microsoft Excel calculation, such as AVG, MIN, or MAX into an Exploration View or list.
You can reference cells both inside and outside the exploration.

Procedure

1. Insert a blank column or row.

2. Create the calculation in the first cell that applies to the inserted column or row.
You must create the formula for the calculation in the cell closest to cell Al (the upper left most cell) of
the inserted group.

3. After you have created the calculation for a single cell, from the toolbar, click Use Server formats to
remove custom formatting.

Results
The calculation is propagated to all the inserted cells.

Tip: You can apply conditional formatting to the calculated column or row. Select the column or row. Click
Home and then click Conditional formatting. Use the conditional formatting menu to choose the styles
for the cells.

Create a Custom Report

To take full advantage of the features that Microsoft Excel offers when you work with IBM Cognos
Analytics data, you can convert an Exploration View to a Custom Report or drag items directly to the cells
of a worksheet.

Using Custom Reports

When you use the cells of the worksheet to create a new analysis, you drag labels and items to adjoining
cells, either in rows or columns to create a Custom Report. Like Exploration Views, the intersecting cells
are used for measures, which will be populated with the actual data.

Note: Cell-based analysis is available for dimensionally modeled relational (DMR) and OLAP data sources
only. It does not work with relational data sources and cannot be generated from a list even when using
DMR or OLAP packages.

You can also convert an Exploration View to a Custom Report. You can create an Exploration View by using
the exploration toolbar and the drop zones and then convert it to formulas. For an example using both
methods, see “Example - evaluate revenue from specific order methods” on page 253.

Formulas

With IBM Cognos Analytics packages, when you drag items from the source tree directly to the cells of a
worksheet you create a COGNAME or COGVAL formula. The formula references the item in the database.
Because IBM Planning Analytics for Microsoft Excel uses COGNAME and COGVAL as part of its internal
processing, do not use either of these strings to name any part of a worksheet or in any part of a cell
formula.

COGNAME formulas

COGNAME formulas are used to supply the server, package, and member names to the cells of a
worksheet. The COGNAME formula takes three objects: server, package, and member unique name (MUN).

Depending on your server version and type of cube, in addition to the system and package, you may have
other information, such as the date of the last cube update available to you.

The syntax for the COGNAME formula is as follows:
=COGNAME ("server", "package", "MUN")
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The arguments in the formula are described as follows.

server
The server object can reference a cell, such as B4, use a named range, or use a literal value with the
full path to a gateway, such as http://sampleserver/ibmcognos/cgi-bin/cognos.cgi. It can also
reference a COGNAME formula that contains the server information.

package
The package object is derived from the package search path, which you can find in IBM Cognos
Connection. Because this argument is a literal string, you can embed this information. Or, you can put
this information in a cell and reference that cell in the argument. This enables you to switch over from
a test system to a production system or to change your package easily. It can also reference a
COGNAME formula that contains the package information you want to use.

member unique name
The member unique name supplies information about a particular name you want to display in your
workbook, such as Years. You can obtain this information from IBM Cognos Report Studio by right-
clicking an object and recording the string, which includes schema.

The following is a sample COGNAME formula from the IBM Cognos sample database

=COGNAME ("http://sampleserver/ibmcognos/cgi-bin/cognos.cgi", "/content/
package[@name="'Great Outdoors Company']", "[great_outdoors_company].[Years].
[Years].[Years]->:[PC].[@MEMBER]. [Years]")

COGVAL formulas

COGVAL formulas are used to supply data to the cells of a worksheet. The COGVAL formula takes three
objects: server, package, and member unique names of members or measures (MUNs(X)).

The syntax for the COGVAL formula is as follows:

=COGNAME ("server", "package", MUN1,MUN2,MUN3,MUNx)

The arguments in the COGVAL formula are the same as in the COGNAME formulas.
The following is a sample COGVAL formula from the IBM Cognos sample database

=COGVAL("http://sampleserver/ibmcognos/cgi-bin/cognos.cgi", "/content/
package[@name="'Great Outdoors Company']", $A2, C$1, $A%$1 )

In this example, the cell references supply Products, Revenue, and 2004.

The COGVAL formula does not allow members from the same dimension to be supplied more than once.

Convert from an Exploration View

Convert an Exploration View to a Custom Report when you want to manipulate individual cells or place
columns or rows in between the imported data.

You can also create a Custom Report completely from scratch.

About this task

When you convert an Exploration View, you have the option of converting data on the current worksheet,
copying and moving the data to a new worksheet, or specifying the location for the converted data.

You cannot convert data from relational sources to a cell-based analysis.

Text values in formulas are limited to 255 characters. To create text values longer than 255 characters in
a formula, use the CONCATENATE function or the concatenation operator ( &).

It is also possible to convert your Custom Report to an Exploration View. Click a cell and then click IBM
Planning Analytics > Explore. Depending on how your columns and rows are set up and how many items
are in each, you may notice that certain objects are added to the context drop zone instead of being
placed in a row or column.
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If the default measure is also on columns, you cannot convert an Exploration View to formulas. You must
first remove the default measure. For more information, see “Remove measures” on page 150.

Procedure

1. Open the workbook with the Exploration View you want to convert.
2. In the IBM Planning Analytics tab, click Convert to.
3. Choose where to place the converted data:

« To convert the Exploration View to formulas and place the result on the current worksheet, click On
This Sheet .

« To convert the Exploration View to formulas and place the result on a new worksheet, from the
exploration bar, click Convert to Formulas > On New Sheet . By placing the results on a new
worksheet, you preserve the original Exploration View used to create the analysis and can use it
again to change parameters for another analysis.

« To convert the Exploration View to formulas and specify the location, which is a cell in an existing
spreadsheet, from the exploration bar, click Convert to Formulas > At Specified Location .

Results

The drop zones disappear. The formatting remains the same, but the cells of the report contain formulas,
which link the individual cells to data items in the database.

You can continue to modify the worksheet by editing formulas and applying formatting. By default, data is
updated when you edit a formula. To edit formulas without data updates, right-click the worksheet and
select IBM Planning Analytics > Pause formula resolution. When you are ready to show data, right-click
the worksheet and select IBM Planning Analytics > Run formula resolution.

Create from scratch

You can create a Custom Report without using an Exploration View. This advanced technique is referred to
as cell-based mode. In cell-based mode you drag metadata from the source tree to the cells of the
worksheet.

Because there are no drop zones, you must drag objects in such a way that they appear horizontally or
vertically to form the rows and columns of the worksheet. In general you must start by building the rows
and columns by dragging and dropping headings and then individual or groups of items along the vertical
(for example, in the diagram, cells numbered 1.1, 1.2, 1.3, and 1.4) or horizontal (in the diagram, cells
numbered 2.1 and 2.2) axis. After you have created this framework, you can drag a measure to the
intersecting cell where the row heading and column heading meet (in the diagram, the cell numbered 3).
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Figure 14: Drop zones for cell-based analysis

You can continue to modify the worksheet by editing formulas and applying formatting. By default, data is
updated when you edit a formula. To edit formulas without data updates, right-click the worksheet and
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select IBM Planning Analytics > Pause formula resolution. Placeholder symbols (~ ~) appear in data
cells when Pause formula resolution is selected. When you are ready to show data, right-click the
worksheet and select V > Run formula resolution.

Some of the techniques that you need to remember when working in cell-based mode include the
following:

« Leaving blank rows or columns when you create a cell-based analysis disconnects one part of the
exploration from another. This leaves cells without data. Only insert a blank row or column after you
have created your analysis and initially populated the cells with data. You are then able to insert a single
blank row or column for calculations or formatting purposes. Inserting more than one blank row or
column disconnects cells when expanding items.

- To change the orientation of items, from vertical to horizontal, while dragging the items, hold down the
Ctrl key while dropping items into cells.

Before you can create a cell-based analysis, the administrator must have created a package in IBM
Cognos Framework Manager and published it to a location in the IBM Cognos Connection portal to which
you have access. For full access to IBM Planning Analytics for Microsoft Excel, you should be a member of
the Express Authors or Report Administrators role in IBM Cognos Analytics. An administrator must
configure these privileges using IBM Cognos Administration.

For more information on using cell-based mode, see “Example - using cell-based analysis to create an
Exploration View of order method revenue” on page 168.

Example - using cell-based analysis to create an Exploration View of order method revenue

You are a business analyst at the Sample Outdoors Company, which sells sporting equipment. You are
asked to analyze the consequences of discontinuing the fax and mail order methods, which are expensive
to process.

First you get the items you need and insert them into an Exploration View for further exploration.

Before you can try this example, you must set up the sample packages that come with IBM Cognos
Analytics. For more information, see the IBM Cognos Analytics Administration and Security Guide.

Procedure

1. Start Planning Analytics for Microsoft Excel
2. In the IBM Planning Analytics, click Open .
3. Select the Great Outdoors Company package and click OK.

Data from the Great Outdoors Company package appears in the source tree.
4. Expand the Retailer level.
. From the list of retailers, click Department Store and then Shift+click Warehouse Store.
6. In a new worksheet, drag the highlighted items to cell D5.

6]

While dragging the items hold down the Ctrl key to reorient the list of items horizontally.

7. Drag the Order Method item to cell Cé.

8. Right-click cell C6, click IBM Planning Analytics > Expand > Expand up.
The Order Method total item shifts down to cell C13. The cells before Order Method populate with
the components that make up Order Method in the hierarchy.

9. Drag Revenue from the Measures folder to cell C5.

The worksheet is populated with the revenue data.

10. Apply Excel formats to the cells to reflect column and row headings, total fields, and revenue
numbers.

11. Click File and Save.
12. In the Name box, type Order Methods Revenue.
13. Save the workbook.
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Expand items
Expand items to add component members to the Custom Report from hierarchical items that have been
placed in the cells of the worksheet.

For an example of using this feature, see “Example - using cell-based analysis to create an Exploration
View of order method revenue” on page 168.

Procedure

1. Right-click the heading cell that contains the item you want to expand, and click IBM Planning
Analytics > Expand.

2. Choose whether to expand before or after.

« To expand items before a row, which puts the node item after the expanded items, click Expand Up.

« To expand items after a row, which puts the node item before the expanded items, click Expand
Down.

 To expand items before a column, which puts the node item after the expanded items, click Expand
Left.

- To expand items after a column, which puts the node item before the expanded items, click Expand
Right.

Results
Expanded items appear in the rows or columns of the worksheet. Cells are automatically shifted to
accommodate the component values.

Drill down
Use the drill down feature to analyze details in a separate drill window.

Procedure
1. Right-click a data cell and click IBM Planning Analytics > Drill Down.

The result of the drill appears in a separate drill down window.
2. Click OK.

Tip: Alternatively, you can create a new Exploration View that displays the drill results. In the Custom
Report, right-click a data cell and click IBM Planning Analytics > Explore.

Display the data source or package of a formula

When working in Dynamic Reports and Custom Reports, you can use more than one data source or
package. You can synchronize the source tree when moving from cells of one data source or package to
another. Synchronizing the source tree enables you to see accurately the dimensional data used to
populate the cells.

Right-click a formula cell and click IBM Planning Analytics > Display Package. The Task Pane displays
the package or data source that was used to create the selected cell.

Change the server and package used by a Custom Report

Update the server and package designation in a worksheet to switch from a test to a production
environment or to access information from a different set of financial data, such as a submission. You can
update information in cell references and in embedded text.

Procedure

1. From the worksheet you want to update, open the new server and package.

2. From the Information folder, drag the updated server and package metadata to the server or package
cell.
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3. Optionally, use the Microsoft Excel search and replace function to update embedded references in the
text of cell formulas.

Troubleshoot

A problem with Custom Reports occurs when you have one or more COGVALs or COGNAMEs that do not
return a result (usually because of a bad reference to a COGNAME with a MUN that does not exist). This
can cause not only the incorrect item to fail, but also items that were retrieved in the same batch.

To resolve COGVAL and COGNAME errors, from the IBM Planning Analytics tab on the ribbon, click
Refresh Sheet. The MUN that is causing any errors becomes a text cell and any cells that use that MUN in
a calculation display #ERROR. Use the Microsoft Excel trace feature to locate the bad MUN. Then you can
correct the MUN by dragging a new item from the source tree to the cell.

Best practices

The main benefit of working in IBM Planning Analytics for Microsoft Excel in cell-based mode is that the
features of Microsoft Excel become more readily available to you during your analysis. You are able to use
features, such as formatting, sorting, and creating formulas using individual cells. This section describes
some of the ways that IBM Planning Analytics for Microsoft Excel interacts with frequently-used Microsoft
Excel features and functions.

Creating a chart

Charts update with new data as long as the data is after the current first cell and before the current last
cell.

Cutting and pasting

Copy and paste from the cell, so that other cells that refer to it are updated to point to the new location.

Copying
To copy the exact formula without changing its cell references, copy from the formula bar, not the cell.

Creating formulas

Consider labeling measure and dimension cells so that you can refer to them by name rather than cell
location.

If you are building a multisheet report with shared filters, such as date, consider creating a single page
with the filters and referring to those shared filters from each sheet.

Prompted metadata in IBM Cognos Analytics packages

Prompts help you to find the information that you need. It is a way for you to define the scope and limit
large amounts of data. You can change the behavior of prompts in IBM Planning Analytics for Microsoft
Excel by modifying the definition of dimensions or query subjects in the model or other data source.

IBM Planning Analytics for Microsoft Excel uses prompts that are saved in the model or other data source.
Prompting is useful for query items, such as ProductTypeCode, whose values are not shown in a report
but can be used for filtering data. For these variables, use IBM Cognos Framework Manager to define
type-in prompts. The Prompt Info properties in Framework Manager give you the ability to control default
filtering and prompting. The properties are used by IBM Planning Analytics for Microsoft Excel to create a
filter expression and set the use and display items in a prompt and prompt query.

If you expand an item in the source tree that contains a prompt, input for that item is requested before
the item can be added to the work area. Depending on the type of prompt, you must give the response, or,
if it is a prompt with a default, accept the default, before dragging the item into the Exploration View, list,
or cells of the workbook. The prompt values persist in the report and are saved as part of the query for
future use.
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Set options for IBM Cognos Analytics data

System optimization with large data sets

For lists based on IBM Cognos Analytics packages, Planning Analytics for Microsoft Excel can retrieve
large data sets in CSV format. This enables Planning Analytics for Microsoft Excel to retrieve these data
sets much faster than the standard fully formatted XML results. The CSV request format removes data
formatting from the model.

Control data compression for data

Automatic data compression is one way that Planning Analytics for Microsoft Excel decreases processing
time for large data transfers from the IBM Cognos Analytics server.

Data compression should be turned on under normal circumstances.

Although compression is turned on by default, you can turn it off by setting the UseGzipCompression
property to false in the CommManagerSettings. xml file. By default, the file is located in the Office
Connection directory, C: \Documents and Settings\[user name]\Local Settings
\Application Data\Cognos\Office ConnectionorC:\Users\[user name]\AppDatal\Local
\Cognos\Office Connection.

Turn compression off if you need to run tests or perform troubleshooting. To turn compression off, set the
following attribute:

<setting name="UseGzipCompression">False</setting>

To turn compression on, set the following attribute:

<setting name="UseGzipCompression">True</setting>

Compression is turned on automatically when you change from RawXML format to CSV format for lists.
The global property is not changed, which means that if you turned compression off, that setting is
retained for other types of data transfer.

For example, if you have compression turned off and you create a new exploration after making a CSV list
request, then your exploration data is still uncompressed.
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Chapter 8. Cube viewer

You can work with data using the cube viewer rather than the Microsoft Excel grid. You can compare
multiple cube views alongside reports.

You can also generate reports from a cube view. See “Create a report” on page 180 for more information.

You can also follow along by watching this video: https://youtu.be/JTIJUvfnAdgA

Procedure

1. Log on to a TM1 system and select a data source.

For more information, see “Open a model or package ” on page 17.

The source tree in the task pane displays the cube and related items of the data source, such as views.
2. In the source tree, navigate to the cube that you want to view, and expand Views.

3. Right-click a view and select Open in viewer.
A separate cube viewer opens. You can position it where you want in the window so that you can view
it along side other objects.

Data entry

You can enter data by typing in editable cells.

Cells that are grayed out and have data in italics in them, are read only. Cells can be read-only if you are a
viewer, or if the version that you are looking at is locked.

To enter dates, tap in a date cell and select the date.
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Some cells have picklists that you can select from. The following image shows a picklist where you can
select a performance rating of Good, Average, or Poor.
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Job Description Average
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https://youtu.be/JTJUvfnAdgA

Aggregated data is shown in bold. If you type data into an aggregated cell, the data is spread to the cells
that make up the aggregated cells.

Calculated cells at detail level are colored green. You can't directly update calculated cells by typing data
in them.

Note: If all of the descendent detail cells are calculated, then you can't type data into the aggregated cell.

Q1-2016 | Q2-2016 Q3-2016

Division-. 9,382,000 2,100,000 2,200,000 2,420,000

@ 2016

Product.. 9,527,294 2,195,294 2,250,000 2,420,000

Region -- 9 294 2,195, 2,250,000 2,420,000

The following describes the areas that are referenced in the previous image:

1. Data can be entered in the Division row and in the 2016 column.
2. Aggregate data is bold. You can type data here.
3. Calculated cells are shaded green. You can't type data into calculated cells.

Symbols in cells, such as currency and percentages

In cells that expect numbers, you cannot enter a symbol. For example, in a cell that expects currency in
dollars, you enter the dollar amount in numbers, for example, for $10, enter 10.

If a cell is formatted as a percent %, the value is displayed as a proportion of 1. To enter 5%, you can
either type 5% or type 0.05. Both display as 0. 05.

Preventing data from changing when data is spread

You can place a hold on a cell if you want to keep the value from changing when data is spread. Right-click
the cell, then select Hold and Release > Hold. You can still edit the cell directly. Two vertical bars indicate
that a hold is active on a cell.

When you place a hold on an aggregated cell, the aggregated value remains constant when you change
any of the children. When a hold is in place and you change the value of a child, proportional spreading is
automatically applied to the remaining children so that the consolidated value remains unchanged.

To remove holds, right-click any cell, then select Hold and release > Release all holds. You can also
right-click a cell with an active hold, then select Hold and release > Release hold to release a specific
hold.

Zeroing data

You can replace data in a book view with zeros by going to a detail cell in the upper right corner and typing
0>|. This copies 0 across rows (>) and columns (|).
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Data display

You can change the position of dimensions in the cube viewer.

Dimensions can appear in several positions: on the row axis, on the column axis, or as context.

Procedure
1. To swap the position of dimensions in a cube, drop one dimension directly on top of another
dimension.

| |

[ A
2. To swap the position of the row and column dimensions, click o

3. To have two or more dimensions on a row, column, or the context area, drop one dimension next to
another dimension.

4. Dimensions that are used as context can be visible in the view or can be placed on the bench to save
space and to simplify the appearance of the view.

Other dimensions

Drag individual dimensions 1o the
owerview, or tap Add all.

Medified dimensions

accountl
Gross Margins

Add Al

Sort rows and columns

You can sort labels or values in ascending or descending order. You can choose to sort by hierarchy, or to
sort breaking the hierarchy.

Procedure
1. To sort by label, right-click either the row selector , or the column
selector , and select the sort option.

2. To sort by value, right-click in the row or column and select the sort option.

3. To sort values within a hierarchy, right-click on the hierarchy label, select Sort hierarchical, then
choose your option.
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Show and hide totals

You can show and hide totals in a view, and choose whether totals are leading or trailing.

Procedure

Right-click either the row selector, or the column selector, and
select one of the Show totals options.

Suppress zeros

You can hide rows and columns in a view that contain only zeros.
Procedure

Click @ and choose either rows or columns.

Expand levels

You can expand levels in a hierarchy to a specific depth.

You can expand levels manually by tapping B, or by selecting a specific level from the menu.

Procedure

1. To select a specific level to expand from the menu, right-click the member in the row or column that
you want to expand.
A member that can be expanded has this icon: E.

2. Select Expand to level, then select the level.

Display cell values as percentages

You can change the way values are displayed so that values are displayed as percentages of the total.

Procedure

1. Right-click in a cell, and select Show cell value as.
2. Select the appropriate option from one of the following:

% row total
Displays all the values in each row as a percentage of the total for the row.
% column total
Displays all the values in each column as a percentage of the total for the column.
% grand total
Displays values as a percentage of the total of all the values or data points in the report.

Advanced - % parent row total
Displays the values in each row as a percentage of the parent.
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Advanced - % parent column total
Displays the values in each column as a percentage of the parent

The cells that display a percentage are shaded. This shading indicates that the values in these cells are
calculated.

3. To return to the actual cell values, in the Show cell value window, select As-is.

Drill up or down on members

You can drill down on a consolidated member in a view to view the members of the consolidation and to
hide other members by double-clicking on the member.

Procedure

1. To drill up to next level, right-click and select Drill up.
2. To remove the drills, right-click and select View all.

Hide rows and columns

You can hide rows and columns that are not needed in a view.

Procedure
1. Right-click the columns or rows that you want to hide and select Hide.

2. Instead of hiding a member, you can select and right-click rows or columns that you want to keep, and
select Keep. All other rows or columns are hidden.

3. To unhide columns or rows that are hidden, right-click and select Unhide all.

Add a calculation to a view

Member calculations apply to one or more members on either the row or column axis of a view.

About this task
You can create the following calculations with one member selected:

« Rank: ranks the value of the cell, with rank 1 being the highest. This applies to visible numeric values
only.

Absolute value: the non-negative value of the cell.

Percentage (%) of total: the value as a percentage of the total.

Percentage (%) of parent: the value as a percentage of the immediate parent.
« Selected member + (plus), -(minus), / (divided by) or * multiplied by a numeric value (or the reverse)

You can calculate the following calculations with two or more members selected,
« Average

e Minimum

« Maximum

« Median

With just two members selected, you can create the following calculations:

« Member 1 * member 2

« Member 1 + member 2
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Member 1 - member 2

Member 1 / member 2

Member 1 % change member 2
Member 1 % of member 2

I
You can reverse the members in calculations by tapping &=’

Procedure

1. Right-click the row or column label of the member for which you want to create a calculation.
To create a calculation on multiple members, use CTRL+click or SHIFT+click to select the member
labels, and then right-click on one of the selected member labels.

2. Click Calculations, then Create.

3. Optionally, enter a name for the calculation. This is the name that will appear as a row or column label
in your view. If you don't enter a name, a name is assigned.

4. Click the calculation you want to create.
5. If you are creating an arithmetic calculation on a single member, enter the required numeric value.
6. Click OK.

Sandboxes

Sandboxes let you try out different changes to the data before making those changes public to other users
and before committing those changes to the base data. Sandboxes are visible only to you.

Procedure

1. To create a sandbox, click
2. Name the sandbox.

and tap Create sandbox.

3. Choose whether you want to create a sandbox from the base data or to create a copy of an existing
sandbox, and then click OK.

You can now work in the sandbox. You can move between different sandboxes by selecting them from

i; I version 2 -

the drop-down list.

4. When you are satisfied with the data in a sandbox, and you want to commit it to the base, click V
Commit data.

5. To delete a sandbox, follow these steps.

a) Click i‘ .

b) Select Delete sandbox, select the sandbox that you want to remove, and tap Delete.

Copy and paste

You can paste values from external applications, or from such as Microsoft Excel.
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User interface

Support for the right-click user interface varies by browser. Some browsers display cut, copy, and paste
options when you right-click a cell or range of cells; others do not. However, all browsers support
keyboard shortcuts:

« CTRL+x - cut
« CTRL+c - copy
« CTRL+vV - paste

Paste behavior

When you paste to a single cell, the contents of the clipboard are pasted with the selected cell as the
initial insertion point, and the paste operation expands to other cells as required.

When you paste to a selected range of cells, and that range is smaller than contents of the clipboard, you
are notified that the paste operation will modify cells beyond the selected range. You have the option of
accepting or canceling the paste operation.

There is a 60,000 cell limit for pasting into the cube viewer. If you try to paste more than 60,000 cells an
error will be displayed.

Data spreading

You can use data spreading options to detail cells to distribute numbers in cells in a grid. For example, you
can evenly distribute a value across a range of cells.

You can use data spreading options with copy and paste shortcuts and data entry commands. To find out
more, see “Copy and paste” on page 178 and “Quick data entry commands” on page 181.

By default, the spreading options replace data, but you can specify + or ~ to add or subtract data instead.

Proportionally spread a value
P

Example: P<>100

Proportionally spreads the value 100 to all detail cells on the row of insertion and replaces the
existing cell values.

Equally spread a value
S

Example: S+["200

Equally spreads the value 200 to all detail cells on the column of insertion, and adds the product of
spreading to the existing cell values

Repeat a value
R

Example: R~<50
Subtracts the value 50 from all detail cells to the left of the insertion point.
Apply a percent change
P%
Example: P%+<>10
Takes 10 percent of the cell values and adds it to the existing cell values across the row.

Populate cells by specifying a start and end value (Straight-line)
SL

You specify a start and end value, choose the direction of the spread, and the update action.
Example: SL>100:200
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Replaces all detail cell values to the right of insertion with a start value of 100 and an end value of
200. Across 5 detail cells, the values would be:

100, 125, 150, 175, 200.

Apply a linear growth percentage
GR

You specify a start value and a growth percentage.
Example: GR [300:25

Applies a 25 % growth percentage to the starting value of 300 and replaces all detail values below the
point of insertion.

Create a report

You can create an Exploration View, Dynamic Report, Quick Report and a Custom Report from a View in
the cube view.

Procedure

1. Open the cube view, and click |LE .

2. Select the kind of report you want to create: Exploration View, Dynamic Report, Quick Report, or
Custom Report.
The report is created in an Excel worksheet.

Multiple hierarchies

IBM TM1 dimensions can include one or more hierarchies. Currently, multiple hierarchies can be
implemented by using TurboIntegrator or Planning Analytics Workspace.

Exploration Views and Quick Reports can display more than one hierarchy in a dimension.

If you are working in an IBM Planning Analytics data source where multiple hierarchies are enabled, and
are in use, you can do the following tasks in the Cube viewer.

- Remove hierarchies

« Hide a hierarchy control from view and add to the bench.

« Add a new related hierarchy from the same parent dimension to the view
« Replace a hierarchy with a different hierarchy.

Note: Do not create Dynamic Reports, or Custom Reports containing multiple hierarchies, as you will get
errors.

Procedure

1. In the source tree, navigate to the cube that you want to view, and expand Views.
2. Right-click a view and select Open in viewer.
3. In the overview, right-click the dimension member, and select one of these options:

Remove this hierarchy
Remove this hierarchy from the view.

Hide from view
Hide this hierarchy control from the view and add to the bench.

Add related hierarchy
Adds a new related hierarchy from the same parent dimension to the view. Select the hierarchy
and click Insert.
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Replace this hierarchy

Replace this hierarchy with a different hierarchy. Choose the hierarchy that you want to replace it

with.

Quick data entry commands

You can type a data entry command into a cell in a grid.

You can combine most of these commands with the copy and paste commands and with data spreading
techniques. To find out more, see “Copy and paste” on page 178, and “Data spreading” on page 179.

Enter the value in thousands
K

Example: 5K
Enters 5,000

Enter the value in millions
M

Example: 10M
Enters 10,000,000.

Add a number to a cell value
Add, +

Example: Add50
Adds 50 to the cell value.

Subtract a number from the cell value
Subtract, Sub, ~

Important: A minus sign (-) can't be used for subtract because it indicates a negative number.

Example: sub8
Subtracts 8 from the cell value.

Multiply the cell value by a percentage
Percent, Per

Example: pex5
Gives 5% of the original cell value

Increase the cell value by a percentage
Increase, Inc

Example: inc10
Increases the cell value by 10%

Decrease the cell value by a percentage
Decrease, Dec

Example: Dec6
Decreases the cell value by 6%

Grow cells by a percentage
Gr

Example:Gr>150:10

Increase the value by 10 percent starting with a value of 150.

Hold the cell value from breakback calculations
Hold, Hol, H, Hc

Hc holds aggregated cells.
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Release held cells
Release, Rel, Rh, Rc

Rc releases aggregated cells.

Release all held cells
RA
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Chapter 9. Action buttons

You can create action buttons to run processes, navigate between worksheets, and recalculate
worksheets.

Users can access these buttons when working in IBM Planning Analytics for Microsoft Excel or with
websheets in TM1 Web.

You can use an action button to perform any of the following tasks:

« Run a Turbolntegrator process.
« Navigate to another worksheet.

Run a Turbolntegrator process and then navigate to another worksheet.

Recalculate a worksheet or rebuild a TM1 Dynamic Report in a worksheet.

For example, suppose that you have a workbook containing many worksheets. The workbook is large and
you want to make it easier to use and to maintain.

You can place action buttons on the first sheet to enable users to navigate quickly to the worksheets
within the book. You can also configure the action buttons to navigate to a worksheet and then recalculate
it.

You can also create a worksheet with action buttons to run the TurboIntegrator processes you use to
maintain the reports in the workbook, for example.

You can also use an action button on a worksheet with a Dynamic Report to rebuild the report.

What action buttons do

When you click an action button, the steps that are performed depend on how the action button was
configured.

When an action button runs a TurboIntegrator process only, IBM Planning Analytics for Microsoft Excel
performs the following steps:

1. If you selected a calculation operation on the Calculate tab, the calculation operation is performed.
2. The Turbolntegrator process is run.
3. The calculation operation that you selected in the Options dialog box for the process is performed.

4. The status message is evaluated and presented.

When an action button navigates to a worksheet only, IBM Planning Analytics for Microsoft Excel performs
the following steps:

1. If you selected a calculation operation on the Calculate tab, the calculation operation is performed.
2. The navigation action begins.

3. Context transfers are set into the target workbook. If you specified mappings in the Advanced Options
dialog box, the mappings are applied.

4. The target sheet is navigated to.

5. The calculation operation that you selected on the Worksheet tab of the Action Button Properties
dialog box is performed on the target worksheet.

When an action button runs a TurboIntegrator process and then navigates to a worksheet, IBM Planning
Analytics for Microsoft Excel performs the following steps:

1. If you selected a calculation operation on the Calculate tab, the calculation operation is performed.
2. The Turbolntegrator process is run.
3. The calculation operation that you selected in the Options dialog box for the process is performed.
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4. The status message is evaluated and presented.
5. The navigation action begins. The target workbook is opened.

6. Context transfers are set into the target workbook. If you specified mappings in the Advanced Options
dialog box, the mappings are applied.

7. The calculation operation that you selected in the Worksheet tab of the Action Button Properties dialog
box is performed on the target worksheet.

When an action button recalculates a worksheet or rebuilds a Dynamic Report only, IBM Planning
Analytics for Microsoft Excel performs the following steps:

1. The calculation operation that you selected in the Calculate tab of the Action Button Properties dialog
box is performed on the worksheet.

Add to a worksheet

You can insert an action button into a worksheet.

Before you begin
You must enable the following Microsoft Excel setting: Trust access to the VBA project object model. This
setting is found in Options, Trust Center Settings, Macro Settings.

About this task
When you insert an action button, you configure the action button and set its appearance properties.
The action buttons that you create are listed in the source tree under Action Buttons.

You can modify an action button. In the source tree, expand Action Buttons. Right-click an action button
and select Edit.

Procedure

1. Go to the worksheet where you want to add the action button.

2. On the IBM Planning Analytics toolbar, click the Action Button -

The Action Button Properties dialog box is displayed.
3. Select the TM1 Server Application Folder where your data is located and connect to the server.

a) Select the TM1 Server.
For example, if you want to run a TurboIntegrator process that is stored on a different TM1 server,
select the server.

You can use a cell reference or a named range to retrieve the TM1 server name dynamically. Click
the Use Reference check box and then enter a cell or named-range reference.

To select a cell reference, click and then specify the cell where the server name is located.

To retrieve the server name by referencing a named range, use the following format:
=NameOfRange

The named range must point to a single cell that contains text for the server name.
b) If you are not connected to the server that you want to use, click Connect and log in.
4. Click the action that you want the action button to perform.
5. Configure the action button.
For more information, see the following topics:

« “Run a process” on page 185
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6.
7.

« “Navigate to another worksheet” on page 186

« “Run a process and navigate to a worksheet” on page 189

« “Recalculate or rebuild a worksheet” on page 189
Set the appearance of the action button. For more information, see “Set the appearance” on page 189.
Click OK.

What to do next

Action buttons can be saved in a workbook. If the saved workbook has Protected View enabled, the user
opening the workbook must select the Enable all macros option under File > Options > Trust Center >
Trust Center Settings... > Macro Settings.

Run a process
You can use an action button to run a TurboIntegrator process.

Procedure

1.
2.

10.

11.

Create an action button. For more information, see “Add to a worksheet” on page 184.
In the Action Button Properties dialog box, click Run a TurboIntegrator Process.

The Process tab is displayed.

. Select the process that you want to run.

a) To select a process from the server that is displayed in the TM1 Server list, click the Process list
and select a process.

b) To select a process from the current workbook, click the Process list and select Get Process info
from Worksheet. In the Process Name box, enter the process name or click E and specify a
cell reference or a named range.

. Specify parameters, if any, for the process. The Parameters table shows the available parameters for
the process you selected.

To specify a value for a parameter directly, enter the value in the Value cell and then press Enter.

To use a cell reference or a named range, click the Value cell and then click IE Specify the cell
reference or a named range, and then click OK.

. Click Options. The Options dialog box is displayed.
. Select the calculation operation that you want to occur after the process runs.

« Automatically Recalculate Sheet - Refreshes the data in the current worksheet.

» Rebuild Sheet - Equivalent to Automatically Recalculate Sheet. Rebuilds the TM1 Dynamic
Report to its original report definition configuration.

» None - Do not recalculation or rebuild the worksheet.
. Select and type the messages that you want the action button to display.

- Show Success Message - Displays a message after the process runs successfully.
« Show Failure Message - Displays a message if the process does not run successfully.

- Show Confirmation - Displays a confirmation message before the process is run. The user can click
Yes or No.

. Click OK. The Action Button Properties dialog box is displayed.

. If you want to recalculate or rebuild the worksheet before the TurboIntegrator process runs, click the
Calculate tab and select an option.

Set the appearance of the action button. For more information, see “Set the appearance” on page
189.

Click OK.
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Navigate to another worksheet

You can use an action button to navigate to another worksheet in the same workbook, or to a worksheet in
another workbook.

Procedure

1. Create an action button. For more information, see “Add to a worksheet” on page 184.
2. In the Action Button Properties dialog box, click Go to another Worksheet.

The Worksheet tab is displayed.
3. Specify the target workbook.

 To select a workbook on a TM1 server, click TM1 Applications. Click Browse and select the
workbook.

Or, to use a cell reference or a named range for the workbook name, click E The referenced cell
or named range must contain the path to the workbook. Start with the first folder name under
Applications and use a back-slash \ character to separate folders. Do not include the Applications
folder in the path. For example: Planning Sample\Bottom Up Input\Budget Input.

» To select a workbook that is stored on your computer or on the network, click Files. Click Browse
and select the workbook.

Note: If you plan to share your workbook with TM1 Web or IBM Planning Analytics Workspace
users, place the target workbook in a shared network location. The location that you specify must
be accessible by the server where TM1 Web or IBM Planning Analytics Workspace is running.

4. Specify the target worksheet.
You can use any of the following techniques.
« Click the Sheet list and select a worksheet.
« Enter the worksheet name in the Sheet field. Use the following format: =SheetName!Cell

» Use a cell reference or a named range, click IE Specify the cell reference or a named range, and
then click OK.

5. Set the following options.
« Match Title Elements - Automatically matches and sets the text of the title dimensions in the

target worksheet when a user clicks the action button. For more information, see “Match Title
Elements option” on page 188.

- Replace Current Workbook - Determines whether the target worksheet opens in a new window or
in the same window, replacing the source worksheet. For more information, see “Replace Current
Workbook option” on page 188.

6. Select the calculation operation that you want performed on the target worksheet.

« Automatically Recalculate Sheet - Refreshes the data in the current worksheet.

» Rebuild Sheet - Equivalent to Automatically Recalculate Sheet. Rebuilds the TM1 Dynamic
Report to its original report definition configuration.

» None - Do not recalculation or rebuild the worksheet.
7. To map items, click Advanced Options.
For more information, see “Map fields” on page 187.

8. If you want to recalculate or rebuild the worksheet before navigating to the target worksheet, click
the Calculate tab and select an option.

9. Set the appearance of the action button. For more information, see “Set the appearance” on page
189.

10. Click OK.
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Map fields

When you create an action button that navigates to another worksheet, you can manually map fields
between the source worksheet and the target worksheet. You can map dimensions, cells, and values from
the source worksheet to the target worksheet.

Note: Manual mapping is applied after any automatic mapping has been applied by the Match Title
Elements option.

To map fields, click Advanced Options on the Worksheet tab in the Action Button Properties dialog box.

The Advanced Options dialog box includes a grid where you define the mapping of fields between the
source and target worksheets. Use the Add and Delete buttons to manage the rows in the grid.

You map the source worksheet to the target worksheet by setting values for the source type, source
object, target type, and target object in the Advanced Mapping grid.

Use the following steps to configure advanced mapping:

1. Indicate the type of object to map by setting the Source Type.

2. Determine the value for the type of object you are using by setting the Source Object.
3. Indicate the type of cell to map by setting the Target Type.

4. Indicate where to insert the value from the source object by setting the Target Object.
5. Repeat these steps to create more mapping configurations.

Source Type
The Source Type field represents the type of object for the value you want to map.

« SUBNM - Indicates that you are mapping from a cell that contains a title dimension in the source
worksheet.

- Selected DBRW - Indicates that you are mapping from a cell that contains a DBRW formula in the
source worksheet.

« Value - Indicates that you will enter a string or numeric value to send to the target worksheet.

Source Object
The Source Object field takes a value, or a Microsoft Excel expression that evaluates to a value,
depending on what you selected in the Source Type field.

« If Source Type is set to SUBNM, specify the name of the title dimension that exists in the source
worksheet.

- If Source Type is set to Selected DBRW, specify the name of a row or column title dimension that
exists in the source worksheet.

- If Source Type is set to Value, enter a string or numeric value to send to the target worksheet.

Note: You can also retrieve these values from the source worksheet by using a cell reference or a
named range.

Target Type
The Target Type field specifies the type of cell in the target worksheet where the value from the
Source Object field will be inserted.

- SUBNM - Indicates that the target is a title dimension in the target worksheet.
- Named Range - Indicates that the target is a named range in the target worksheet.

- Range - Indicates that the target location is a cell in the target worksheet.
Note: If you set Target Type to either Named Range or Range, any pre-existing data or formula in the
target cell will be overwritten when you click the action button. If the target cell contains a DBRW

function, then the function will be lost and the cell will not be able to connect to, read from, or write to
the IBM TM1 server.
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Target Object
The Target Object specifies the location in the target worksheet where the value from the source
object will be inserted. This location can be the name of a title dimension, a specific cell location, or a
named range in the target worksheet, depending on what you selected for Target Type.

- If Target Type is set to SUBNM, specify the name of the title dimension in the target worksheet.
When Target Type is set to SUBNM, you must also enter a value for the Subset and Alias fields.

- If Target Type is set to Named Range, specify the name of the range in the target worksheet.
- If Target Type is set to Range, specify the cell location in the target worksheet.

You can enter a value for the target object by entering the location value directly. Or, you can use a cell
reference or a named range to retrieve the location.

« Entering a value directly: To identify a location in the target worksheet, enter the value directly into
the Target Object field without the equal sign =. For example, enter C3 to identify the location of the
target object as the cell C3 of the target worksheet.

 Using a cell reference or a named range: To reference a cell in the source worksheet that contains a
location for the target object, include the equal sign =. For example, the cell Al in the source
worksheet might contain the value C3 to represent the cell location for the target object in the target
worksheet.

Match Title Elements option
The Match Title Elements option automatically matches and sets the text of the title dimensions in the
target worksheet when a user clicks an action button to navigate to the target worksheet.

The Match Title Elements option is displayed on the Worksheet tab of the Action Button Properties dialog
box.

When the Match Title Elements option is enabled, the dimensions in the source and target worksheets
are automatically matched by the SUBNM and DBRW functions as follows:

« TM1 automatically matches title dimensions in the source and target worksheets based on the SUBNM
formulain a cell.

For example, when the same dimension exists in both the source and target worksheets, the member
selected in the source worksheet is set for the same dimension in the target worksheet. When a column
is selected in the source worksheet, it matches to the column with the same title dimensions in the
target worksheet.

« TM1 automatically matches the row and column dimensions of the currently selected DBRW cell in the
source worksheet to the matching title dimensions in the target worksheet, if they exist.

For example, if Operating Expense and Feb-2015 are the row and column dimension members for the
currently selected member in the source worksheet, when navigating, these dimension members are
matched to the title dimensions in the target worksheet. If the row Operating Expense and the column
Feb-2015 are both selected in the source worksheet, the DBRW cell is the cell that exists in both the
Operating Expense row and the Feb-2015 column. The row and column dimensions of the DBRW cell
are matched to title dimensions in the target worksheet.

Replace Current Workbook option
The Replace Current Workbook option determines whether the target worksheet is opened in a new
window or in the same window, replacing the source worksheet.

The Replace Current Workbook option is displayed on the Worksheet tab of the Action Button Properties
dialog box.

For example:

- If Replace Current Workbook is not selected (default) and you are working in TM1 Web, then the
source worksheet remains open and the target worksheet opens in a new tab.

« If Replace Current Workbook is selected and you are working in TM1 Web, then the source worksheet
is replaced by the target worksheet on the same tab and a new tab does not open.
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Important: If you enable the Replace Current Workbook option, remember to save your workbook
before you test the new button. You could lose your changes if you click the button and cause the current
workbook to close.

Run a process and navigate to a worksheet

You can configure an action button to run a TurboIntegrator process and then navigate to another
worksheet.

Procedure

1. Create an action button. For more information, see “Add to a worksheet” on page 184.

2. In the Action Button Properties dialog box, click Run a Process, then go to another Worksheet.
The Process tab is displayed.

3. Select the process that the action button will run. See “Run a process” on page 185.

4. Select the worksheet to which the action button will navigate. See “Navigate to another worksheet” on
page 186.

5. Set the appearance of the action button. For more information, see “Set the appearance” on page 189.

6. Click OK.

Recalculate or rebuild a worksheet

You can use an action button to recalculate or rebuild a worksheet, without running a TurbolIntegrator
process or navigating to a new worksheet. You can also use the Calculate tab to select the calculation
operation that you want the action button to perform before running a Turbolntegrator process or
navigating to another worksheet.

Procedure

1. Create an action button. For more information, see “Add to a worksheet” on page 184.
2. In the Action Button Properties dialog box, click Calculate/Rebuild Only.

The Calculate tab is displayed.
3. Select the calculation option that you want to use.

« Automatically Recalculate Sheet - Refreshes the data in the current worksheet.

» Rebuild Sheet - Equivalent to Automatically Recalculate Sheet. Rebuilds the TM1 Dynamic Report
to its original report definition configuration.

« None - Do not recalculate or rebuild the worksheet.

4. Set the appearance of the action button. For more information, see “Set the appearance” on page 189.
5. Click OK.

Set the appearance

You can set the appearance of action buttons. You can set the caption, background picture, and other
visual features for the action button.

In the Action Button Properties dialog box, click the Appearance tab to adjust the appearance of the
button.

The Appearance tab has the following options:
- Caption - Sets the caption text that displays on the button.

Tip: Use a single space character if you want to have a blank caption. Leaving the caption empty may
result in the action button caption appearing as "Run" when opened in other applications.

- Resize Button to Caption — Adjusts the size of the button to fit the caption.
 Font - Displays a font dialog box where you can change the font type and size of the button caption.
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- Show Background Image - Use this option to select a background image for the button. Click Browse
to select an image file (bmp, gif, or jpg format). The image will be stretched to fit the size of the button.

- Display as Hyperlink - When enabled, this option displays the button as a hyperlink with blue,
underlined text instead of as a standard button. This option is not available if Show Background Image
is selected.

« Preview - This area shows an example of what the button will look like.

- Colors - Use these options to set text and background colors for the button. Click the color sample to
display a Color dialog box where you can select a standard color or define a custom color. If you select
Display as Hyperlink, the color options do not apply.

Edit, copy, rename, or delete

You can modify, copy, rename, or delete an action button.

In the source tree, click the Workbook tab, and expand Action buttons.

To modify an action button, right-click the action button in the source tree and select Edit.

To copy an action button, drag and drop the action button from the source tree onto the worksheet.

Note: Action buttons cannot be copied to another workbook. Copying an action button will not copy the
visual formatting of the action button.

To rename an action button, right-click the action button and type the new name. To refresh the name in
the Action buttons list, right-click Action buttons and then click Refresh list.

To delete an action button, right-click the action button in the source tree and select Delete.

Tip: To see where an action button is located in a workbook, right-click the action button and select
Select.

If you do not see your action button in the source tree, right-click Action buttons and then click Refresh
list.

190 IBM Planning Analytics: Planning Analytics for Microsoft Excel



Chapter 10. IBM API

Using an application programming interface (API), you can automate the refreshing or publishing of
content.

You can use the API to create a scheduled batch program to refresh content on a daily, weekly, or monthly
basis so that, as your period data changes, the affected files are kept up-to-date.

You can call the API within Microsoft Excel workbooks using VBA or using VBS and a command line
interface. For these types of automation to work, you must register one or more macros within the
workbook.

If you have IBM Cognos Office installed, you can also use the API in Microsoft Word and Microsoft
PowerPoint.

When using sample macros and script files as part of your own processing functions, remember that the
API is accessible only as user defined functions (UDFs). UDFs are functions created in Visual Basic for
Applications (VBA). In this case, however, the UDFs are created within the IBM Cognos solution and are
called from VBA.

To help you understand what is possible using this API, several samples are provided. You can use the
samples to help you create your own solutions.

- Creating VBA macros
 Passing parameters, leveraging VBS and the command line interface

In addition to these capabilities, you can schedule scripts, either ones that you create or the samples, to
run as a batch process at a set time.

To use automation, you must set your macro security to an appropriate level in your Microsoft application.
You can set the macro security level using one of the following options depending on your version of
Microsoft Office.

« Change the security level of your Microsoft application to medium or low.

« Change the trusted publishers setting of your Microsoft application so that installed add-ins or
templates are trusted.

Set up

The quickest way to set up automation is to import the CognosOfficeAutomationExample.bas file
into the Microsoft application.

These files contain all the necessary macros, including the CognosOfficeAutomationObject macro.
Alternatively, you can create templates that already contain this imported .bas file that supply the code
for logging on to IBM Cognos application, refreshing the content of specified workbooks, documents, or
presentations, and logging off.

After the reference to IBM Cognos automation is established, any macro in VBA can call the functions
exposed in the IBM Cognos automation APL.

Note: You need to manually add and execute the “Logon” on page 196 function before using any
functions that require a session, even if you have single sign-on enabled.

If the Microsoft application is open when a command is executing, the command executes in interactive
mode. If the Microsoft application is closed when the command is executing, the command executes in
batch mode. Executing in batch mode means that all display alerts are turned off.

Because the object is obtained at run time and there is no type library installed on the client machine, you
cannot use IntelliSense to determine what properties and methods are available on the object.
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Before you begin

To use the IBM Cognos automation macro files, you must import the CognosOfficeMessageSuppressor.cls
file. The .cls file contains the SuppressMessages function that allows you to disable the standard alerts
and messages.

Procedure

1. Open a new Office document, workbook, or presentation.

2. Customize the ribbon to display the Developer tab.

3. Click the Developer tab, and then click Visual Basic.

4. Do the following based on the Microsoft Office application you are using;:

« For Microsoft Excel and Microsoft PowerPoint, right-click VBAProject and click Import File.
- For Microsoft Word, right-click Project and click Import File.

The Import File dialog box appears.
5. Browse to the location where the IBM Cognos Automation macro files are installed.

The default location is client_installation_directory\Automation.

6. For Microsoft Excel or Microsoft Word click the CognosOfficeAutomationExample. bas file or for
Microsoft PowerPoint click the CognosOfficeAutomationPPExample.bas file and import it into
the VBA project.

Do not edit this code module. Do not import both files, which are application specific. This will cause
problems for the Open routine.

7. Repeat steps 3 to 5 to import the CognosOfficeMessageSuppressor.cls file.

8. Close the Visual Basic Editor and return to the IBM Cognos application.

9. Save the file as a template, close it, and then reopen the template file.

Results
You can now call the macros contained in the Cognos automation macro files from the VBA code that you
write in Excel, Word, or PowerPoint.

Log automation activities and errors

Use the automation log to track automation activities and troubleshoot problems with automation tools
and scripts. The automation log is automatically generated when you run an automation script.

The automation log is returned using a call to the Automation API function TraceLog. For information
about the TracelLog function, see “TracelLog ” on page 201.

Necessary IBM Cognos automation API references

The references mentioned in this topic can be imported via the CognosOfficeAutomationExample.bas
file. It is good practice to double-check that the file contains all of references. If the
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CognosOfficeAutomationExample.bas file is missing any references, you can add these references to
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m_o Cafe object reference

D

im m_oCAFE As Object

m_oCOAutomation

P
Cogn

rivate m_oCOAutomation As Object

osOfficeAutomationObject() Property Get statement

'Returns the instance of the Cognos Office Automation Object.
Public Property Get CognosOfficeAutomationObject()
On Error GoTo Handler:

'Fetch the object if we don't have it yet.
If m_oCOAutomation Is Nothing Then
Set m_oCOAutomation =
Application.COMAddIns("CognosOfficel2.Connect").0Object.AutomationServer
End If

Set CognosOfficeAutomationObject = m_oCOAutomation

Exit Property
Handler:

'<Place error handling here. Remember you may not want to display a message box if you
are running in a scheduled task>
End Property

Reporting() Property Get statement

'Returns the instance of the Cognos Office Automation Object.
Public Property Get Reporting()
On Error GoTo Handler:

'Fetch the object if we don't have it yet.
If m_oCAFE Is Nothing Then

Set m_oCAFE = CognosOfficeAutomationObject.Application("COR", "1.1")
End If

Set Reporting = m_oCAFE

Exit Property
Handler:
MsgBox "Error"
'<Place error handling here. Remember you may not want to display a message box if you
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are running in a scheduled task>
End Property

Global API functions

Global API functions can be used to interact with any IBM Planning Analytics for Microsoft Excel
worksheets.

The global functions that are exposed through the IBM Cognos automation objects are:

ClearAllData

ClearAllData clears all data values in the opened workbooks.

Syntax
ClearAllData()
Example

The following syntax is an example:

CognosOfficeAutomationObject.ClearAllData

ClearBook

ClearBook clears IBM Planning Analytics for Microsoft Excel data in the active book.

Syntax
ClearBook ()
Example

The following syntax is an example:

Application.COMAddIns("CognosOfficel2.Connect").0bject.AutomationServer.Application("COR",
"1.1").ClearBook

ClearCache

ClearCache reduces the size of an IBM Planning Analytics for Microsoft Excel workbook by clearing
metadata and data from formulas.

Syntax
ClearCache()
Example

The following is an example of the syntax:

CognosOfficeAutomationObject.ClearCache()

ClearSelection
ClearSelection clears IBM Planning Analytics for Microsoft Excel data in the active selection.

Syntax
ClearSelection()
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Example

The following syntax is an example:

Application.COMAddIns("CognosOfficel2.Connect").0Object.AutomationServer.Application("COR",
"1.1").ClearSelection

ClearSheet

ClearSheet clears IBM Planning Analytics for Microsoft Excel data in the active sheet.

Syntax
ClearSheet ()
Example

The following syntax is an example:

Application.COMAddIns("CognosOfficel2.Connect").0bject.AutomationServer.Application("COR",
"1.1").ClearSheet

GetConnection
GetConnection is a method exposed by the top level reporting API object. If you want to use the REST
APIs, you'll need to use the GetConnection method to return the connection object that implements the
REST request methods.
Syntax

The following string is the syntax for the GetConnection method. To use the method, you must know the
URL of the host that you want to send REST requests to.

Reporting.GetConnection (<CURRENT>)

Table 18: Arguments for GetConnection

Argument Description Data type

CURRENT The URL of the host that you String
want to send REST requests to.

HttpLogonCredentials

The HttpLogonCredentials function authenticates a user to a Web site that requires new authentication
credentials, such as Basic, Kerberos, and SiteMinder. HttpLogonCredentials takes the URL, user name,
and password that are used for authentication on the Web site.

IBM Cognos does not support SiteMinder form-based authentication. You must use the IBM Cognos menu
commands and options instead of the API to automate the refreshing and publishing of content.

Syntax

HttpLogonCredentials (url, user name, password)
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Table 19: Arguments for HttpLogonCredentials

Argument Description Data type
url The URL for the Web site against | String
which you want to authenticate
user name The user name for authentication | String
password The password for authentication | String
Logoff
Logoff logs off all the IBM Cognos servers to which users are currently logged on.
Syntax
Logoff()
Example

The following syntax is an example:

CognosOfficeAutomationObject.Logoff

Logon

The Logon function takes the URL of the server and the credential elements required by IBM Planning
Analytics for Microsoft Excel to perform a logon: user ID, password, and namespace. The namespace
parameter is case-sensitive; therefore, you must match the namespace exactly. Planning Analytics for
Microsoft Excel uses the Logon function, whether you're logging into an IBM Cognos Analytics system or
an IBM TM1 system.

IBM Cognos Office stores user credentials only in memory. For this reason, users are responsible for
storing their credentials in a secured area and passing them to the logon methods at run time.

If you use the Logon function with incorrect credentials, the system raises a CAMException error, however,
no exception is written to the log file indicating a failure. To avoid this situation, remember that strings are
case-sensitive and ensure that you use valid user IDs, passwords, and namespaces.

Logon does not appear in the macro list in the Microsoft application because the macro receives an
argument. Any macro with parameters is by definition private and private macros are not shown in the
macro options by default.

Note: The Logon function cannot be used to log into a cloud-based system.

Syntax

Boolean Logon (url, user name, password, namespace)

Parameters

Table 20: Arguments for Logon

Argument Description Data type

url The URL for the IBM Cognos Analytics or IBM | String
TM1 system, which you want to log on to.

user name The user name for authentication. String
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Table 20: Arguments for Logon (continued)

Argument Description Data type
password The password for authentication. String
namespace The specific namespace for authentication. String

Note: Mode 1 authentication requires the
combination of the PM Hub host and the TM1
Server as the namespace, separated by a
forward slash (/). If your namespace contains
a forward slash, the logon is interpreted as a
Mode 1 authentication attempt.

Return value
Data type: Boolean

The Boolean value that is true if successful

Example

Here is an example of this syntax for logging into an IBM Cognos Analytics system:

Dim bResult As Boolean

bResult = CognosOfficeAutomationObject.Logon
("http://localhost/ibmcognos/cgi-bin/cognos.cgi",
"Administrator", "CognosAdmin", "Production")

Example

Here is an example of this syntax for logging into an IBM TM1 system:

Dim bResult As Boolean

bResult = CognosOfficeAutomationObject.Logon
("http://localhost/pmhub/pm/tml/api/Planning Sample/v1.1",
"admin", "peaches", "localhost/Planning Sample")

Publish
Use Publish to publish content to IBM Cognos Connection or to a TM1 Server Application Folder.

The arguments mirror the entry boxes in the dialog box that is used in the user interface.

Publish does not appear in the macro list in the Microsoft application because the macro receives an
argument. Any macro with parameters is by definition private and private macros are not shown in the
macro options by default.

Syntax

Publish (URL, document path, server path, name, description, screenTip)
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Parameters

Table 21: Parameters for the Publish macro

Argument Description Data
type

URL The server to which you are publishing. String

document path The location of the document to be published. It is the local path of the |String

file that you want to publish. If the path of your folder is not correct
when you publish using automation, you are again prompted to log on.
This is because IBM Cognos does not distinguish between non-existing
folders and folders for which the user does not have permissions. This
security feature helps to prevent the discovery of the folder path by
trial and error.

In IBM Cognos Analytics, the folder path is a search path. For more
information, see the IBM Cognos Analytics Administration Guide.

server path The path in the content store where the document is saved. String

hame The document name that will appear in IBM Cognos. String

description The document description that will appear in IBM Cognos. String

screenTip The text that users see when they point to the document in IBM String
Cognos.

Example

Following is an example of this syntax:

Publish("CAMID('::Anonymous')/folder[@name="My
Folders']", "Description of 'My Folders'", "")

RefreshAllData

RefreshAllData fetches the most current data values from the IBM TM1 server and updates those values
in the current document.

The system must be successfully logged on to the IBM TM1 server.

If you are using IBM Cognos Office with IBM Cognos Analytics data, ensure that the Prompt Update
Method property on the Manage Data tab in the IBM Cognos pane is set to Use=Display or Do Not
Update to complete the operation. Otherwise, the report cannot be refreshed without user intervention
and generates errors.

Syntax
RefreshAllData()
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Example
The following is an example of this syntax:

Dim bResult as Boolean

bResult = CognosOfficeAutomationObject.Logon
("http://localhost/ibmcognos/cgi-bin/cognos.cgi",
"Administrator", "CognosAdmin", "Production")

'Refresh the data if we successfully logged on to the
IBM Cognos server.

If bResult Then
CognosOfficeAutomationObject.RefreshAllData

End If

RefreshAllDataAndFormat

RefreshAllDataAndFormat retrieves the most current data values and formatting from the IBM Cognos
server and updates those values and formats in the current document.

The system must be successfully logged on to the IBM Cognos server.

If you are using IBM Cognos Office with IBM Cognos Analytics data, ensure that the Prompt Update
Method property on the Manage Data tab in the IBM Cognos pane is set to Use=Display or Do Not
Update to complete the operation. Otherwise, the report cannot be refreshed without user intervention
and generates errors.

Syntax
RefreshAllDataAndFormat ()

Example

The following example shows how the RefreshAllDataAndFormat method is used:

Dim bResult as Boolean

bResult = CognosOfficeAutomationObject.Logon
("http://localhost/ibmcognos/cgi-bin/cognos.cgi",
"Administrator", "CognosAdmin", "Production")

'Refresh the data and formatting if we successfully logged on to the
IBM Cognos server.

If bResult Then
CognosOfficeAutomationObject.RefreshAllDataAndFormat

End If

RefreshSelection
RefreshSelection refreshes IBM Planning Analytics for Microsoft Excel data in the active selection.
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Syntax
RefreshSelection()
Example

The following syntax is an example:

Application.COMAddIns("CognosOfficel2.Connect").0Object.AutomationServer.Application("COR",
"1.1") .RefreshSelection

RefreshSheet

RefreshSheet refreshes IBM Planning Analytics for Microsoft Excel data in the active sheet.

Syntax
RefreshSheet ()
Example

The following syntax is an example:

Application.COMAddIns("CognosOfficel2.Connect").0bject.AutomationServer.Application("COR",
"1.1") .RefreshSheet

Settings

The Settings function can be used to enable, disable, or define settings in Planning Analytics for
Microsoft Excel.

Syntax

SetValue is used to set a value in a setting.
Reporting.Settings.SetValue (<setting name>,<setting value>)
GetValue is used to retrieve a value of a setting.

Reporting.Settings.GetValue (<setting name>)

Parameters

Table 22: Arguments for Settings

Argument Description Data type

setting name The name of the setting that you want to Alphabetic
enable, disable, or define.

setting value The value that you want to use to enable, Alphabetic, alphanumeric,
disable, or define in the setting. boolean, integer

View “Settings in the CognosOfficeReportingSettings.xml file” on page 37 for a list of the possible settings
and values that you can use.

Example
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The following syntax is an example using SetValue:
Reporting.Settings.SetValue ("GroupingOption, Full")
The following syntax is an example using GetValue:

Reporting.Settings.GetValue ("ShowServerInExploration")

SuppressMessages

SuppressMessages suppresses the standard alerts and messages that are shown during the normal
operations of IBM Cognos applications.

Syntax
SuppressMessages ()

Example

The following is an example of the syntax:

Private Sub Class_Initialize()
CognosOfficeAutomationObject.SuppressMessages True

End Sub

Private Sub Class_Terminate()
CognosOfficeAutomationObject.SuppressMessages False

End Sub

TraceError

TraceError appends error information into the IBM Planning Analytics for Microsoft Excel log file. The user
defines the error information they wish to append to the log file for errors.

Syntax
TraceError("<user defined error information>")
Example

The following syntax is an example:

Application.COMAddIns("CognosOfficel2.Connect").0bject.AutomationServer.TraceError("VBA method
failed")

Example

The following is an example of the appended error information in the IBM Planning Analytics for Microsoft
Excel log file:

[Severity=Error]

[Exception] TraceError(String error)

[Thread=6, Background=True, Pool=True, Domain=]
[System.Exception] VBA API ERROR: VBA method failed

Tracelog
Tracelog returns all the automation activities and errors.
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Syntax
String TracelLog()

Return value

Data type: String

The value of the logging item as string
Example

The following is an example of the syntax:

Dim strTracelog as String
strTraceLog = CognosOfficeAutomationObject.TracelLog

MsgBox strTracelog

UnlinkAllData

UnlinkAllData disconnects all the IBM Cognos data values in the current document. The values are no
longer updated with subsequent calls to RefreshAllData. The values become static.

For IBM Cognos Office, any IBM Cognos data values that are imported into the current document after
UnlinkAllData is called will continue to be linked to the IBM Cognos data source.

The values can be updated with new server data using the RefreshAllData call.

Syntax
UnlinkAllData()

Example

The following is an example of the syntax:

CognosOfficeAutomationObject.UnlinkAllData

UnlinkBook
UnlinkBook unlinks the active book from the connection.

Syntax
UnlinkBook ()
Example

The following syntax is an example:

Application.COMAddIns("CognosOfficel2.Connect").0bject.AutomationServer.Application("COR",
"1.1") .UnlinkBook

UnlinkSelection

UnlinkSelection disconnects the selected data values. The values are no longer updated with subsequent
calls to Refreshable. The values become static.
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Syntax
UnlinkSelection()
Example

The following syntax is an example:

Application.COMAddIns("CognosOfficel2.Connect").0Object.AutomationServer.Application("COR",
"1.1").UnlinkSelection

UnlinkSheet

UnlinkSheet unlinks the active sheet from the connection.

Syntax
UnlinkSheet ()
Example

The following syntax is an example:

Application.COMAddIns("CognosOfficel2.Connect").0bject.AutomationServer.Application("COR",
"1.1").UnlinkSheet

UpdateServerUrl
Use UpdateServerUrl to update the IBM Cognos server information for existing reports and formulas.

The UpdateServerUrl method takes two arguments: the old server URL and the new server URL. These
arguments mirror the entry boxes in the Update System dialog box. To gain access to this control from
IBM Cognos, click the Options button on the IBM Cognos ribbon, then click Update System Utility.

The UpdateServerUrl method replaces the server information for existing reports. When running this
command, the name of the package or data source remains the same. You can use this method to change
only one server, such as a test server to a production server. The URL arguments can be full or partial
URLs. If any argument is empty, this command does nothing, however, running this command with empty
arguments has the potential to corrupt the report. Server information is stored in both the server property
and the serialized report property. Running an empty command could cause these two instances to get
out of sync.

Because the UpdateServerUrl method searches and replaces strings, it is possible to use only part of the
URL, provided it is a unique substring.

Note: The UpdateServerUrl search looks at all data in the workbook and updates data that matches the
search string, not just report properties containing the URL string. Therefore, when you use only part or all
of the original URL string with the UpdateServerUrl method, you will change all data that matches the
search string

Syntax

UpdateServerUrl "old server URL string" "new server URL string"
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Parameters

Table 23: Parameters for the UpdateServerUrl method

Argument Description Data
type
old server URL string | Indicates the URL of the source or current system. String
new server URL Indicates the URL of the target system. String
string
Example

The following example uses the complete URL:

UpdateServerUrl "http://testserverl/cgi-bin/cognos.cgi"
"http://prodserverl/cgi-bin/cognos.cgi"

The following example uses only the part of the URL that is changing:

UpdateServerUrl "testserverl" "prodserverl"

Wait

Wait holds the VBA thread until all prior IBM Planning Analytics for Microsoft Excel background tasks are
complete.

Syntax
Wait ()
Example

The following syntax is an example:

Application.COMAddIns("CognosOfficel2.Connect").0bject.AutomationServer.Application("COR",
"1.1").Wait

Usage example

The following are examples of the usage:

Sub Wait()
Reporting.GetCurrentReport (ActiveCell) .Commit
Reporting.Wait
Reporting.GetCurrentReport (ActiveCell) .Refresh

End Sub

Sub Wait()

Application.COMAddIns("CognosOfficel2.Connect").0bject.AutomationServer.Application("COR",
"1.1") .RefreshBook

Application.COMAddIns("CognosOfficel2.Connect").0Object.AutomationServer.Application("COR",
"1.1").Wait

MsgBox "Refresh complete!"
End Sub

Exploration API functions

Exploration functions can be used to interact with exploration worksheets.

The exploration functions that are exposed through the IBM Cognos automation objects are:
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Clear
Clearis used to clear all of the data values in the exploration.

Syntax
Reporting.Explorations.GetAt().Clear
Example

The following syntax is an example:

Public Sub Cleazx()
Reporting.Explorations.GetAt(Application.ActiveSheet.Name).Clear

End Sub
Create
Create generates an Exploration View based on the host system URL, server name, cube name, and view
name.
Syntax
Explorations.Create "<host system URL>", "<server name>", "<cube name>",

"<view name>"

Parameters

Table 24: Arguments for Create

Argument Description Data type

host system URL URL of the host system which the Exploration |Alphanumeric string
View is to be created from

server name Name of the server which the Exploration Alphanumeric string
View is to be created from

cube name Name of the cube which the Exploration View | Alphanumeric string
is to be created from

view name Name of the view which the Exploration View | Alphanumeric string
is to be created from

Example

The following syntax is an example:

Public Sub Create()

Reporting.Explorations.create "http://computername", "Planning Sample",
"plan_BudgetPlan", "Goal Input"
End Sub
CreateFromMDX
CreateFromMDX generates an Exploration View based on the host system URL, server name, and MDX
string.
Syntax
Reporting.Explorations.CreateFromMDX “<host system URL>", “<server name>",
“<MDX>"
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Parameters

Table 25: Arguments for CreateFromMDX

Argument Description Data type

host system URL URL of the host system which the Exploration | Alphanumeric string
View is to be created from

server name Name of the server which the Exploration Alphanumeric string
View is to be created from

MDX MDX statement which the Exploration View is | Alphanumeric string
to be created from

Example

The following syntax is an example:

Public Sub CreateFromMDX()
Reporting.Explorations.CreateFromMDX "http://vottepps06.canlab.ibm.com:9510/",
"Planning Sample", "SELECT {[plan_chart_of_accounts].[plan_chart_of_accounts].
[Revenue]} ON 0, {[plan_time].[plan_time].[2004]% ON 1 FROM [plan_BudgetPlan]"
End Sub

GetColumnSuppression

GetColumnSuppression is used to return whether or not zero-suppression is applied to columns in the
exploration.

Syntax
Reporting.Explorations.GetAt () .GetColumnSuppression
Example

The following syntax is an example:

Public Sub AreColumnsSuppressed()
MsgBox Reporting.Explorations.GetAt(Application.ActiveSheet.Name).
GetColumnSuppression

End Sub

GetRowSuppression

GetRowSuppression is used to return whether or not zero-suppression is applied to rows in the
exploration.

Syntax
Reporting.Explorations.GetAt () .GetRowSuppression
Example

The following syntax is an example:

Public Sub AreRowsSuppressed()
MsgBox Reporting.Explorations.GetAt(Application.ActiveSheet.Name).
GetRowSuppression

End Sub

GetSpecification
GetSpecificationis used to return the MDX string that is used to build the current Exploration.
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Syntax
Reporting.Explorations.GetAt () .GetSpecification
Example

The following syntax is an example:

Public Sub GetSpecification()

Msgbox
Reporting.Explorations.GetAt (Application.ActiveSheet.Name).GetSpecification
End Sub

GetValue
GetValue is used to retrieve the value of a particular setting in a session.

Syntax
Reporting.Settings.GetValue("<Setting>")

Parameters

Table 26: Arguments for GetValue

Argument Description Data type

Setting The name of the setting whose value you String
want to retrieve.

Example

The following is an example using the syntax:

Public Sub ToggleSetEditorPreview()
Dim x
x = Reporting.Settings.GetValue("SetEditorPreviewOn")
If "True" = x Then
Reporting.Settings.SetValue "SetEditorPreviewOn", "False"
Else
Reporting.Settings.SetValue "SetEditorPreviewOn", "True"
End If
End Sub

Refresh

Refresh is used to refresh the exploration.

Syntax
Reporting.Explorations.GetAt() .Refresh
Example

The following syntax is an example:

Public Sub Refresh()
Reporting.Explorations.GetAt (Application.ActiveSheet.Name).Refresh
End Sub

SwapRowsAndColumns
SwapRowsAndColumns is used to swap the rows and columns in an exploration.
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Syntax
Reporting.Explorations.GetAt () .SwapRowsAndColumns
Example

The following syntax is an example:

Public Sub SwapsRowsAndColumns ()
Reporting.Explorations.GetAt(Application.ActiveSheet.Name) .SwapsRowsAndColumns

End Sub

SetRowSuppression
SetRowSuppression is used to enable and disable zero-suppression for rows in an exploration.

Syntax
Reporting.Explorations.GetAt () .SetRowSuppression <True/False value>

Parameters
Table 27: Arguments for SetRowSuppression
Argument Description Data type
True Enables zero-suppression Boolean
False Disables zero-suppression Boolean
Example

The following syntax is an example:

Public Sub SetRowSuppressions()
Reporting.Explorations.GetAt(Application.ActiveSheet.Name) .SetRowSuppression

True
End Sub

SetColumnSuppression
SetColumnSuppression is used to enable and disable zero-suppression for columns in an exploration.

Syntax
Reporting.Explorations.GetAt().SetColumnSuppression <True/False value>

Parameters
Table 28: Arguments for SetColumnSuppression
Argument Description Data type
True Enables zero-suppression Boolean
False Disables zero-suppression Boolean
Example

The following syntax is an example:

Public Sub SetColumnSuppressions()
Reporting.Explorations.GetAt (Application.ActiveSheet.Name) .SetColumnSuppression
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True
End Sub

Unlink

Unlink is used to convert an exploration to a static worksheet.

Syntax
Reporting.Explorations.GetAt().Unlink
Example

The following syntax is an example:

Public Sub Unlink()
Reporting.Explorations.GetAt (Application.ActiveSheet.Name).Unlink
End Sub

SetSpecification
SetSpecificationis used to define the subset and dimension properties of an existing exploration.

Syntax
Reporting.Explorations.GetAt().SetSpecification “<MDX>"

Parameters

Table 29: Arguments for SetSpecification

Argument Description Data type

MDX MDX statement used to define the subset and | String
dimension properties of the exploration.

Example

The following syntax is an example:

Public Sub SetSpecifications()
Reporting.Explorations.GetAt (Application.ActiveSheet.Name).SetSpecification
"SELECT TM1SubsetToSet([plan_time], ""current_year_and_qtrs"") DIMENSION
PROPERTIES MEMBER_UNIQUE_NAME, MEMBER_NAME, MEMBER_CAPTION, LEVEL_NUMBER,
CHILDREN_CARDINALITY, [plan_time].[Time] ON ©, TM1TOGGLEDRILLSTATE
(TM1SubsetToSet ([plan_chart_of_accounts], ""Default"")
i[plan_chart_of_accounts].[Revenue], [plan_chart_of_accounts].
[Operating Expense]} , EXPAND_BELOW , RECURSIVE) DIMENSION PROPERTIES
MEMBER_UNIQUE_NAME, MEMBER_NAME, MEMBER_CAPTION, LEVEL_NUMBER,
CHILDREN_CARDINALITY, [plan_chart_of_accounts].[AccountName] ON 1 FROM
[plan_BudgetPlan] WHERE ([plan_version].[FY 2004 Budget] ,
[plan_business_unit].[10000] , [plan_department].[1000] ,
[plan_exchange_rates].[actual] , [plan_souzce].[goal]) DIMENSION PROPERTIES
MEMBER_UNIQUE_NAME, MEMBER_NAME, MEMBER_CAPTION, LEVEL_NUMBER,
CHILDREN_CARDINALITY , [plan_version].[VersionName] , [plan_business_unit].
[BusinessUnit] , [plan_department].[Department] , [plan_source].[Source]"

End Sub

SetValue
SetValue is used to set a new value for a specific setting and save the changes to the settings file.

Syntax
Reporting.Settings.SetValue "<Setting>", "<Value>"
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Parameters

Table 30: Arguments for SetValue

Argument Description Data type

Setting The name of the setting whose value you String
want to set.

Value The boolean value you want to set for the True/False boolean
specified setting.

Example

The following is an example using the syntax:

Public Sub ToggleSetEditorPreview()
Dim x
x = Reporting.Settings.GetValue("SetEditorPreviewOn")
If "True" = x Then
Reporting.Settings.SetValue "SetEditorPreviewOn", "False"
Else
Reporting.Settings.SetValue "SetEditorPreviewOn", "True"
End If
End Sub

Quick Report API functions

Quick Report functions can be used to interact with Quick Report worksheets.

The Quick Report functions that are exposed through the IBM Cognos automation objects are:

Clear
Clear is used to clear data from the Quick Report.

Syntax
Reporting.GetCurrentReport().Clear
Example

The following syntax is an example:

Public Sub Clear()
Reporting.GetCurrentReport (ActiveCell).Clear
End Sub

ColumnHierarchies
ColumnHierarchies is used to return the hierarchies that exist in the columns of a Quick Report report.

Syntax

cafe.QuickReports.Get("<Quick Report ID").ColumnDimensions

Parameters
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Table 31: Arguments for ColumnHierarchies

Argument Description

Data type

Quick Report ID The ID of the Quick Report that the column
hierarchies are being returned from

Integer

Example

The following syntax is an example:

Sub ColumnHierarchies()
Dim columns As String
For Each Column In cafe.QuickReports.Get("0").ColumnDimensions

If columns <> "" Then
columns = columns & ", " & vbNewlLine
End If

columns = columns & Column
MsgBox "Columns:" columns
End Sub

Commit
Commit is used to commit the Quick Report report.

Syntax
Reporting.GetCurrentReport().Commit <True>
Example

The following syntax is an example:

Public Sub Commit ()
Reporting.GetCurrentReport (ActiveCell).Commit True

End Sub
Create
Create generates a Quick Report based on the host system URL, server name, cube name, and view
name.
Syntax
Reporting.QuickReports.Create "<host system URL>", "<server name>", "<cube name>",

"<view name>"

Parameters

Table 32: Arguments for Create

Argument Description

Data type

host system URL URL of the host system which the Quick
Report is to be created from

Alphanumeric string

server name Name of the server which the Quick Report is
to be created from

Alphanumeric string

cube name Name of the cube which the Quick Report is
to be created from

Alphanumeric string
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Table 32: Arguments for Create (continued)

Argument Description Data type

view name Name of the view which the Quick Report is to | Alphanumeric string
be created from

Example

The following syntax is an example:

Public Sub Create()
Reporting.QuickReports.Create "http://computername/", "Planning Sample",
"plan_BudgetPlan", "Goal Input"

End Sub

CreateFromMDX

CreateFromMDX generates a Quick Report based on the host system URL, server name, and MDX string.

Syntax
Reporting.QuickReports.CreateFromMDX “<host system URL>", “<server name>",
“<MDX>"

Parameters

Table 33: Arguments for CreateFromMDX

Argument Description Data type

host system URL URL of the host system which the Quick Alphanumeric string
Report is to be created from

server name Name of the server which the Quick Report is | Alphanumeric string
to be created from

MDX MDX statement which the Quick Reportisto | Alphanumeric string
be created from

Example

The following syntax is an example:

Public Sub CreateFromMDX()
Reporting.QuickReports.CreateFromMDX "http://vottepps06.canlab.ibm.com:9510/",
"Planning Sample", "SELECT {[plan_chart_of_accounts].[plan_chart_of_accounts].
[Revenue]} ON 0, {[plan_time].[plan_time].[2004]% ON 1 FROM [plan_BudgetPlan]"
End Sub

Cube

Cube returns the search path of the Quick Report. For example, if the Quick Report is located in the
plan_BudgetPlan cube, in the Planning Sample server, the Cube function would return:

“i"server”:Planning Sample, “cube”:plan_BudgetPlant"”

Syntax
Reporting.GetCurrentReport().Cube

Example
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The following syntax is an example:

Public Sub Cube()
MsgBox Reporting.GetCurrentReport(ActiveCell).Cube

End Sub

DataSource
DataSouzrce is used to return the Quick Report host URL.

Syntax
Reporting.GetCurrentReport () .DataSource
Example

The following syntax is an example:

Public Sub DataSouzrce()
MsgBox Reporting.GetCurrentReport(ActiveCell).DataSource

End Sub

EnableIndents
EnableIndents is used to enable level based indents in your Quick Report reports.

Syntax
Reporting.GetCurrentReport() .EnableIndents <True/False value>

Parameters
Table 34: Arguments for EnableIndents
Argument Description Data type
True Enables indents in Quick Reports Boolean
False Disables indents in Quick Reports Boolean

Example The following syntax is an example:

Public Sub EnableIndents()
Reporting.GetCurrentReport (ActiveCell) .EnableIndents True

End Sub

ExecuteQuery
ExecuteQuery is a method used to execute selected MDX statements in your Quick Report reports.

Syntax
Reporting.ExecuteQuery("<data source URL>", "<server name>", <MDX query>)

Parameters
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Table 35: Arguments for ExecuteQuery

Argument Description Data type

<data source URL> The data source URL used in the Quick String
Report.

<server name> The server name used in the Quick Report. String

<MDX query> The MDX query string to be executed by the String
method.

Example The following syntax is an example of the ExecuteQuery method stored in a VBA module:

Public Property Get GetRowsAxis(query As String) As Collection
Set c = Reporting.ExecuteQuery("http://pa.exampletml.ibmcloud.com", "SData", <MDX query>)
Dim result As New Collection
For i = 0 To (c.GetAxes().Item(1l).GetProperties().Item("tuples").GetMembers().Count - 1)
result.Add
(c.GetAxes().Item(1).GetProperties().Item("tuples").GetMembers().Item(i).GetMembers().Item(3).Ge
tValue())
Next i
Set GetRowsAxis = result
End Property

Example The following syntax is an example of the ExecuteQuery method being called in a worksheet:

Private Sub Worksheet_Change ()

Dim ¢ As Collection

Set ¢ = RefreshAPIExample.GetRowsAxis(Cells(20, 4).Value2)
End Sub

ExecuteQuery is triggered from a worksheet change event on cell D20. If an MDX query string exists in
cell D20, and is modified, the selected MDX will be executed through the ExecuteQuexzy call and will
return a CellSet object. This CellSet object can then be traversed in a similar way to a JSON object.

GetTuple

GetTuple is used to return the tuple of a Quick Report at a given range. This function will return the tuple
at the ActiveCell if no range is specified.

Syntax
cafe.QuickReports.Get("<Quick Report ID>").GetTuple(ActiveCell)

Parameters

Table 36: Arguments for GetTuple

Argument Description Data type

Quick Report ID The ID of the Quick Report that the tuple is Integer
being returned from.

Example

The following syntax is an example:

Sub PrintTuple()
Set tupleObject = cafe.QuickReports.Get("0").GetTuple(ActiveCell)
Dim tuple As String
For tupleldx = 0@ To tupleObject.Count - 1
If tuple <> "" Then
tuple = tuple & ", " & vbNewLine
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End If
tuple = tuple & tupleObject.Item(tupleIdx)
Next
MsgBox "Tuple: " & vbNewlLine & tuple
End Sub

GetSpecification
GetSpecificationis used to return the MDX string that is used to build the current Quick Report.

Syntax
Reporting.GetCurrentReport () .GetSpecification
Example

The following syntax is an example:

Public Sub GetSpecification()
MsgBox Reporting.GetCurrentReport(ActiveCell).GetSpecification
End Sub

GetReport
GetReport is used to return a specific Quick Report based on the Quick Report ID.

ID

Syntax
Reporting.QuickReports.Get ("<report ID>")

Parameters

Table 37: Arguments for GetReport

Argument Description Data type

report ID ID of the Quick Report which the function is to | Integer
return

Example

The following syntax is an example:

Public Sub GetReport()
Reporting.QuickReports.Get ("5")
End Sub

ID is used to return the Quick Report ID.

Syntax
Reporting.GetCurrentRepoxrt().ID
Example

The following syntax is an example:

Public Sub ID()
MsgBox Reporting.GetCurrentReport(ActiveCell).ID
End Sub
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Name
Name is used to return the cube name and view name which the Quick Report is created from.

Syntax
Reporting.GetCurrentReport () .Name
Example

The following syntax is an example:

Public Sub Name()
MsgBox Reporting.GetCurrentReport(ActiveCell).Name
End Sub

RebuildSpecification
RebuildSpecification is used to return the MDX string that is used when rebuilding the Quick Report.

Syntax
Reporting.GetCurrentReport () .RebuildSpecification
Example

The following syntax is an example:

Public Sub RebuildSpecification()
MsgBox Reporting.GetCurrentReport(ActiveCell).RebuildSpecification
End Sub

Rebuild
Rebuild is used to rebuild a Quick Report.

Syntax
Reporting.GetCurrentReport () .Rebuild
Example

The following syntax is an example:

Public Sub Rebuild()
Reporting.GetCurrentReport (ActiveCell) .Rebuild
End Sub

Refresh
Refresh is used to refresh a Quick Report.

Syntax
Reporting.GetCurrentReport () .Refresh
Example

The following syntax is an example:

Public Sub Refresh()
Reporting.GetCurrentReport (ActiveCell) .Refresh
End Sub

Replace
Replace is used to replace the MDX statement in the Quick Report with another MDX statement.
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Syntax

Reporting.QuickReports.Replace Reporting.GetCurrentReport(ActiveCell).<Quick
Report ID>, <MDX statement>

Table 38: Arguments for Replace

Argument Description Data type

Quick Report ID The ID of the Quick Report that will have its Integer
MDX statement replaced

MDX statement The MDX statement that will be replacing the | String
current MDX statement in the Quick Report

Example

The following syntax is an example:

Public Sub Replace()
Reporting.QuickReports.Replace Reporting.GetCurrentReport(ActiveCell) .4,
"SELECT {[plan_chart_of_accounts].[plan_chart_of_accounts].[Revenue]$ ON O,
i[plan_time].[plan_time].[2004]% ON 1 FROM [plan_BudgetPlan]"

End Sub

ReplaceWithFormats
ReplaceWithFormats is used to replace the MDX statement in the Quick Report with another MDX
statement. ReplaceWithFoxrmats also has the option to preserve or destroy the existing sheet
formatting in the Quick Report.

Syntax

Reporting.QuickReports.ReplaceWithFormats
Reporting.GetCurrentReport (ActiveCell) .<Quick Report ID>, <MDX statement>,
<ReFormat>

Table 39: Arguments for ReplaceWithFormats

Argument Description Data type

Quick Report ID The ID of the Quick Report that will have its Integer
MDX statement replaced

MDX statement The MDX statement that will be replacing the | String
current MDX statement in the Quick Report

ReFormat Defines whether or not to preserve or destroy | Boolean
the sheet formatting in the existing Quick
Report.

True = Preserves

False = Destroys

Example
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The following syntax is an example:

Public Sub ReplaceWithFormats()
Reporting.QuickReports.ReplaceWithFormats Reporting.GetCurrentReport(ActiveCell) .4,
"SELECT {[plan_chart_of_accounts].[plan_chart_of_accounts].[Revenue]} ON O,
i[plan_time].[plan_time].[2004]% ON 1 FROM [plan_BudgetPlan]", True

End Sub

RowHierarchies
RowHierarchies is used to return the hierarchies that exist in the rows of a Quick Report.

Syntax

cafe.QuickReports.Get("<Quick Report ID").RowDimensions

Parameters

Table 40: Arguments for RowHierarchies

Argument Description Data type

Quick Report ID The ID of the Quick Report that the row Integer
hierarchies are being returned from

Example

The following syntax is an example:

Sub RowHierarchies()
Dim slicers As String
For Each Slicer In cafe.QuickReports.Get("0").SlicerDimensions
If slicers <> "" Then
slicers = slicers & ", " & vbNewLine
End If
slicers = slicers & Slicer
Next
MsgBox "Rows:
End Sub

Irows

Select
Select is used to select and highlight the current active Quick Report.

Syntax
Reporting.GetCurrentReport () .Select
Example

The following syntax is an example:

Public Sub SelectReport()
Reporting.GetCurrentReport (ActiveCell) .Select
End Sub

SetSlicer
SetSlicer is used to set the values for a slicer dimension in the Quick Report.

Syntax

Reporting.GetCurrentReport().SetSlicer “<dimensions>, <name>"
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Parameters

Table 41: Arguments for SetSlicer

Argument Description Data type
dimensions The dimensions to set the slicer to String
name The name to set the slicer to String
Example

The following syntax is an example:

Public Sub SetSlicer()
Reporting.GetCurrentReport (ActiveCell) .SetSlicer "[plan_business_unit].
[plan_business_unit]", "10100"

End Sub

SlicerHierarchies
SlicerHierarchies is used to return the hierarchies that exist in the slicers of a Quick Report.

Syntax

cafe.QuickReports.Get("<Quick Report ID").SlicerDimensions

Parameters

Table 42: Arguments for SlicerHierarchies

Argument Description Data type

Quick Report ID The ID of the Quick Report that the slicer Integer
hierarchies are being returned from

Example

The following syntax is an example:

Sub RowHierarchies()
Dim slicers As String
For Each Slicer In cafe.QuickReports.Get("0").SlicerDimensions

If slicers <> "" Then
slicers = slicers & ", " & vbNewLine
End If
slicers = slicers & Slicer
Next
MsgBox "Slicers:" slicers
End Sub
UseServerFormats

UseServerFormats clears any user applied formatting and applies server based formatting after a Quick
Report is refreshed.

Syntax
Reporting.GetCurrentReport () .UseServerFormats = <True/False>

Example
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The following syntax is an example:

Public Sub ToggleServerFormats(r As Range)
r.Worksheet.Activate
Set fView = Reporting.GetCurrentReport(r)
If Not (fView Is Nothing) Then
fView.UseServerFormats = Not fView.UseServerFormats
fView.Refresh
End If
End Sub

Dynamic Report API functions

Dynamic Report functions can be used to interact with Dynamic Report worksheets.

The Dynamic Report functions that are exposed through the IBM Cognos automation objects are

Create

Create generates an Dynamic Report based on the host system URL, server name, cube name, and view
name.

Syntax

Reporting.DynamicReports.create "<host system URL>", "<server name>", "<cube
name>", "<view name>"

Parameters

Table 43: Arguments for Create

Argument Description Data type

host system URL URL of the host system, which the Dynamic Alphanumeric string
Report is to be created from.

server name Name of the server, which the Dynamic Alphanumeric string
Report is to be created from.

cube name Name of the cube, which the Dynamic Report | Alphanumeric string
is to be created from.

view name Name of the view, which the Dynamic Report | Alphanumeric string
is to be created from.

Example

The following syntax is an example:

Public Sub Create()

Reporting.DynamicReports.create "http://computername", "Planning Sample",
"plan_BudgetPlan", "Goal Input"
End Sub
CreatefromMDX

CreateFromMDX generates a Dynamic Report based on a host system URL, server name, and MDX string.
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Syntax

Reporting.DynamicReports.CreatefromMDX "<host system URL>", "<server name>",

"<MDX statement>"

Parameters

Table 44: Arguments for CreateFromMDX

Argument

Description

Data type

host system URL

URL of the host system which the Dynamic
Report is to be created from.

Alphanumeric string

server name

Name of the server which the Dynamic Report
is to be created from.

Alphanumeric string

MDX statement

MDX statement which the Dynamic Report is
to be created from.

Alphanumeric string

Example

The following syntax is an example:

Public Sub CreateFromMDX()
Reporting.DynamicReports.CreateFromMDX "http://vottepps06.canlab.ibm.com:9510/",

"SELECT {[plan_chart_of_accounts].[plan_chart_of_accounts].

[Revenue]? ON 0, {[plan_time].[plan_time].[2004]% ON 1 FROM [plan_BudgetPlan]"

"Planning Sample",

End Sub

GetMDX

This API call is used to return the MDX for theDynamic Report row.

Syntax

Reporting.DynamicReports.GetAt (Application.ActiveSheet.name).Item(0) .GetMDX

Example

The following syntax is an example:

MsgBox Reporting.DynamicReports.GetAt(Application.ActiveSheet.name).Item(0Q) .GetMDX

FormatAreaVisible

This API call is used to show and hide the formatting area in a Dynamic Report.

Syntax

Reporting.DynamicReports.GetAt(Application.ActiveSheet.name).Item(0).FormatArea
Visible (<true/false>)

Parameters
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Table 45: Arguments for Create

Argument Description Data type

<true/false> Set the argument to either of the following: Boolean

true: Shows the formatting area in the
Dynamic Report.

false: Hides the formatting area in the
Dynamic Report.

Example

The following syntax is an example:

Public Sub Create()
Reporting.DynamicReports.GetAt (Application.ActiveSheet.name).Item(0).FormatAreaVisible

(true)
End Sub

Refresh
This API call is used to refresh a Dynamic Report.

Syntax
Reporting.DynamicReports.GetAt().Item(<Dynamic Report ID>).Refresh

Parameters
Table 46: Arguments for Refresh
Argument Description Data type
Dynamic Report ID The ID of the Dynamic Report that is to be Integer
refreshed
Example

The following syntax is an example:

Reporting.DynamicReports.GetAt(DynamicReports.Worksheet.Name).Item(0).Refresh

Rebuild
This API call is used to rebuild a Dynamic Report.

Syntax
Reporting.DynamicReports.GetAt().Item(<Dynamic Report ID>).Rebuild

Parameters

Table 47: Arguments for Rebuild

Argument Description Data type
Dynamic Report ID The ID of the Dynamic Report that is to be Integer
rebuilt
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Example

The following syntax is an example:

Reporting.DynamicReports.GetAt (ActiveCell.Worksheet.Name).Item(0).Rebuild

Custom Report API functions

Custom Report functions can be used to interact with Custom Report worksheets.

The Custom Report functions that are exposed through the IBM Cognos automation objects are

Create

Create generates an Custom Report based on the host system URL, server name, cube name, and view
name.

Syntax

Reporting.CustomReports.create "<host system URL>", "<sexrver name>", "<cube
name>", "<view name>"

Parameters

Table 48: Arguments for Create

Argument Description Data type

host system URL URL of the host system, which the Custom Alphanumeric string
Report is to be created from.

server name Name of the server, which the Custom Report | Alphanumeric string
is to be created from.

cube name Name of the cube, which the Custom Report | Alphanumeric string
is to be created from.

view name Name of the view, which the Custom Report is | Alphanumeric string
to be created from.

Example

The following syntax is an example:

Public Sub Create()

Reporting.CustomReports.create "http://computername", "Planning Sample", "plan_BudgetPlan",
"Goal Input"
End Sub

CreatefromMDX
CreateFromMDX generates a Custom Report based on a host system URL, server name, and MDX string.

Syntax

Reporting.CustomReports.createfromMDX "<host system URL>", "<server name>",
"<MDX statement>"
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Parameters

Table 49: Arguments for CreateFromMDX

Argument Description Data type

host system URL URL of the host system which the Custom Alphanumeric string
Report is to be created from.

server name Name of the server which the Custom Report | Alphanumeric string
is to be created from.

MDX statement MDX statement which the Custom Report is to | Alphanumeric string
be created from.

Example

The following syntax is an example:

Public Sub CreateFromMDX()
Reporting.CustomReports.createfromMDX "http://vottepps06.canlab.ibm.com:9510/",
"Planning Sample", "SELECT {[plan_chart_of_accounts].[plan_chart_of_accounts].
[Revenue]} ON 0, {[plan_time].[plan_time].[2004]% ON 1 FROM [plan_BudgetPlan]"
End Sub

TurbolIntegrator functions

You can create a command button to run a TM1 TurboIntegrator process.

To run a TM1 TurbolIntegrator process from Planning Analytics for Microsoft Excel, you need to create a
command button with an ExecuteFunction function.

Before you begin

You must use Microsoft Excel 2007 or a later version to have the option to create ActiveX command
button controls.

Procedure

1. In Microsoft Excel, customize the ribbon to show the Developer tab.
2. Add an ActiveX command button control to the worksheet.
For more information about creating a command button, see the Microsoft web site.
3. Right-click the command button and click View Code.
4. Add ExecuteFunction to the command button.

Results

To use the command button, you must be logged into the TM1 system specified in the
ExecuteFunction call. You can use an automation function to log into the TM1 system. To learn more
about ExecuteFunction, see “ExecuteFunction” on page 224.

Tip: The installation_location\Automation\COAutomationExample.x1ls sample file contains
code for ExecuteFunction. The ExecuteFunction code demonstrates how to use the IBM Cognos
automation API to execute Turbolntegrator scripts. For information about TurboIntegrator functions, see
the TM1 Turbolntegrator guide.

ExecuteFunction

ExecuteFunction is a method used to execute a specified Turbolntegrator (TI) process from your
report.
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Syntax

Reporting.ExecuteFunction(<data source URL>, <server name>, <TI process name>,
<Optional TI process parameter>)

Note: You can specify multiple TI process parameters by separating them with commas.

Parameters

Table 50: Arguments for ExecuteFunction

Argument Description Data type
<data source URL> The data source URL used in the report. String
<server name> The server name used in the report. String
<TI process name> The name of the TI process to be executed. String
<Optional TI process The parameter of the TI process. String array
parameter> Note: You can include an array of TI process

parameters by separating them with commas.

Example: The following is an example of an ExecuteFunction method, which creates a subset called
"TITest" in the "plan_version" dimension.

Note: Line breaks have been added for formatting purposes. Do not add line breaks in your commands.

Public Sub ExecuteFunction "http://<host_address>:<host_port>",
"Planning Sample", "CreateSubset", "plan_version", "TITest"

On Error GoTo Handler:

Dim oMessageSuppressor As CognosOfficeMessageSuppressor

'"Use the message suppressor to turn off all Cognos Office messages.
Set oMessageSuppressor = New CognosOfficeMessageSuppressor

Dim s As String

If Not IsMissing(argl) Then s = argl

If Not IsMissing(arg2) Then s = s + "," + arg2
If Not IsMissing(arg3) Then s = s + "," + arg3
If Not IsMissing(argd) Then s = s + "," + argd

'Call the Cognos Office Automation object to refresh the data.
CognosOfficeAutomationObject.ExecuteFunction host, server,
processName, s

Exit Sub
End Sub

REST API

You can use REST APIs to communicate with the TM1 Server.

Before you begin, make sure that you've returned the connection object. The connection object will allow
you to implement the REST request methods (GET, POST, DELETE, PATCH) and communicate with the
TM1 Server.

To learn more about the connection object, see “GetConnection” on page 195.
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GET requests
Use GET requests to return data from the TM1 Server.

Syntax
The following string is the syntax for the GET request.

Reporting.GetConnection (<CURRENT>) .Get (<PATH>)

Table 51: Arguments for GET requests

Argument Description Data type

CURRENT The URL of the host that you are | String
using the GET request on.

PATH The full (absolute) path that you | String
are using the GET request on.

Example

The following text is an example of how you can use a GET request in a VBA module to return a JSON
object.

Public Property Get OData(Server As String) As String
'OData endpoint
OData = HubEndpoint + "server(
End Property

+ Server + "')/api/v1"

Public Property Get Current() As String
Current = Reporting.Settings.GetValue("MruServer")
End Property

Public Function GetCurrentServer() As String
Dim sServerCubeMRU As String
Dim sServerCube As Variant
Dim sServer As String
sServerCubeMRU = Reporting.Settings.GetValue("MruPackage")
sServerCubeMRU = Mid(sServerCubeMRU, 2, Len(sServerCubeMRU) - 2)
sServerCube = Split(sServerCubeMRU, ",")
sServer = Split(sServerCube(0), ":") (1)
GetCurrentServer = Mid(sServer, 3, Len(sServer) - 3)
End Function

Public Function oDataGet(path As String) As JSONObjectWrapper
Dim result As New JSONParser
Dim response As Object

Set response = Reporting.GetConnection(Current).Get(OData(GetCurrentServer) & "/" & path)
End Function

POST requests
Use POST requests to store or update components in the TM1 Server.

Syntax
The following string is the syntax for the POST request.

Reporting.GetConnection (<CURRENT>) .Post (<PATH>, <PAYLOAD>)
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Table 52: Arguments for POST requests
Argument Description Data type
CURRENT The URL of the host that you String
want to store or update on.
PATH The full (absolute) path of the String
component that you want to
store to or update.
PAYLOAD The JSON payload that you are String
storing or updating to the TM1
Server.
Example

The following text is an example of how you can use a POST request in a VBA module to update a

component.

Public Property Get HubEndpoint() As String
"Endpoint that CAFE connects to
HubEndpoint = "pmhub/pm/tm1/"

End Property

Public Property Get OData(Server As String) As String
'OData endpoint
OData = HubEndpoint + "server(
End Property

+ Server + "')/api/v1"

Public Property Get Current() As String
Current = Reporting.Settings.GetValue("MruServer")
End Property

Public Function GetCurrentServer() As String
Dim sServerCubeMRU As String
Dim sServerCube As Variant
Dim sServer As String
sServerCubeMRU = Reporting.Settings.GetValue("MruPackage")

sServerCubeMRU = Mid(sServerCubeMRU, 2, Len(sServerCubeMRU)

sServerCube = Split(sServerCubeMRU, ",")
sServer = Split(sServerCube(0), ":") (1)

GetCurrentServer = Mid(sServer, 3, Len(sServer) - 3)
End Function

= 2)

Public Function oDataPost(path As String, payload As String) As JSONObjectWrapper

Dim result As New JSONParser
Dim response As Object

Set response = Reporting.GetConnection(Current).Post(OData(GetCurrentServer) & "/" & path,

payload)
End Function

DELETE requests

Use DELETE requests to delete components or data in the TM1 Server.

Syntax
The following string is the syntax for the DELETE request.

Reporting.GetConnection (<CURRENT>) .Delete (<PATH>)
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Table 53: Arguments for DELETE requests

Argument Description Data type

CURRENT The URL of the host that you String
want to delete.

PATH The full (absolute) path of the String
component that you want to
delete.

Example

The following text is an example of how you can use a DELETE request in a VBA module to delete data.

Public Property Get HubEndpoint() As String
"Endpoint that CAFE connects to
HubEndpoint = "pmhub/pm/tm1/"

End Property

Public Property Get OData(Server As String) As String
'OData endpoint
OData = HubEndpoint + "server('" + Server + "')/api/v1"
End Property

Public Property Get Current() As String
Current = Reporting.Settings.GetValue("MruServer")
End Property

Public Function GetCurrentServer() As String
Dim sServerCubeMRU As String
Dim sServerCube As Variant
Dim sServer As String
sServerCubeMRU = Reporting.Settings.GetValue("MruPackage")
sServerCubeMRU = Mid(sServerCubeMRU, 2, Len(sServerCubeMRU) - 2)
sServerCube = Split(sServerCubeMRU, ",")
sServer = Split(sServerCube(0), ":")(1)

GetCurrentServer = Mid(sServer, 3, Len(sServer) - 3)
End Function

Public Function oDataDelete(path As String) As JSONObjectWrapper
Dim result As New JSONParser
Dim response As Object

Reporting.GetConnection(Current) .Delete(OData(GetCurrentServer) & "/" & path)
End Function

PATCH requests
Use PATCH requests to update components in the TM1 Server at a target location.

Syntax
The following string is the syntax for making PATCH requests.

Reporting.GetConnection (<CURRENT>) .PATCH (<PATH>, <PAYLOAD>)

Table 54: Arguments for PATCH requests

Argument Description Data type

CURRENT The URL of the host that you String

want to update on.
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Table 54: Arguments for PATCH requests (continued)

Argument Description Data type

PATH The full (absolute) path of the String
component that you want to
update.

PAYLOAD The JSON payload that you are String
storing in the TM1 Server.

PUT requests

Use PUT requests to place components in the TM1 Server at a target location.

Syntax

The following string is the syntax for making PUT requests.

Reporting.GetConnection (<CURRENT>) .PUT(<PATH>, <PAYLOAD>)

Table 55: Arguments for PUT requests

Argument Description Data type

CURRENT The URL of the host that you String
want to update on.

PATH The full (absolute) path of the String
component that you want to
place.

PAYLOAD The JSON payload that you are String
storing in the TM1 Server.
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Example - processing within VBA

The following example demonstrates how to call the Logon method within VBA:

Dim bResult as Boolean

bResult = CognosOfficeAutomationObject.Logon
("http://localhost/ibmcognos/cgi-bin/cognos.cgi", "Administratoxr",
"CognosAdmin", "Production")

If bResult Then
CognosOfficeAutomationObject.ClearAllData()
CognosOfficeAutomationObject.RefreshAllData()
CognosOfficeAutomationObject.Logoff()

Dim sTracelog as String

sTraceLog = CognosOfficeAutomationObject.TracelLog
'Here is where you could write the trace log to file.
MsgBox sTracelog

End If

Example - processing outside VBA

If you want to use IBM Cognos Office Automation outside VBA, you cannot call the APIs directly. This
topic describes how you can call the APIs outside of VBA.

To use IBM Cognos Office Automation outside VBA, you must create wrapper macros in the Microsoft
Office document for each API. You can then call these macros from your code. The module

CognosOfficeAutomationExample.bas is an example of a wrapper macro that you can call from outside
VBA.
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The following Visual Basic Script opens Microsoft Office Excel, logs on to IBM Cognos Analytics, refreshes
the content, and logs off.

' Start Excel in batch mode

Set objExcel = CreateObject("Excel.Application")
objExcel.Visible = False
objExcel.ScreenUpdating = False
objExcel.DisplayAlerts = False

'Open a workbook that has IBM Cognos data
in it.

Set objWorkbook = objExcel.Workbooks.Open("C:\workbookl.x1ls")
' Call the wrapper macros

bResult = CognosOfficeAutomationObject.Logon
("http://localhost/ibmcognos/cgi-bin/cognos.cgi",
"Administrator", "CognosAdmin", "Production")

objExcel.Run "RefreshAllData"

objExcel.Run "Logoff"

objExcel.Run "TracelLog", "C:\AutomationLog.log"
objWorkbook.Save

objWorkbook.Close

objExcel.Quit

Macro files

The macro files for Cognos Office are written in Microsoft Visual Basic for Applications (VBA).

The files are installed with IBM Cognos Office in the automation folder. The default location is
[installation_directory]\Automation.

The following macro files are installed.
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Table 56: Sample macros

File

Description

CognosOfficeAutomationExample.bas

Because it is a BASIC file created using VBA, this
file has the extension .bas. It contains the
CognosOfficeAutomationObject property that
enables IBM Cognos Office automation in the
current document. It also contains wrapper
functions that call the API exposed by IBM Cognos
Office.

CognosOfficeMessageSuppressor.cls

This file shows how to use the SuppressMessages
API function.

Script files

The installation includes sample script files that you can use to automate functions. The samples include
script files for scheduling the refresh of documents. Also, there is a script file to update the server URL.

You must modify the script files to meet your particular needs or use them as a reference to create your
own programs. For more information, see the comments in the file.

These Visual Basic Scripts (VBS) are provided as sample programs and are located in

installation_directory\Automation:
« Automate_COI.vbs

« Automate_COI_Excel.vbs

« AutomateServerURLSample.vbs
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Chapter 11. Tutorials

Getting started in Planning Analytics for Microsoft Excel is easy. Going through these tutorials will help
you make sense of the features that are offered in Planning Analytics for Microsoft Excel and how you
might use them in your work.

In this tutorial, you are a new hire and you're just starting your job as a business analyst at an automotive
company. Your position requires you to analyze existing data, edit reports and create new reports by using
Planning Analytics for Microsoft Excel. You are familiar with Microsoft Excel, but you never used Planning
Analytics for Microsoft Excel before and have little data modeling knowledge. This series of tutorials will
guide you through the basics of Planning Analytics for Microsoft Excel and help to on your way to
becoming a star business analyst.

Get started

You sit down at your desk with your morning coffee. You're the new business analyst. Excited to make a
good first impression, you immediately turn on your computer and open Microsoft Excel; the emails from
Mom can wait. The user interface is familiar but there's a new tab. Let's get started.

Procedure

1. Open Microsoft Excel.
2. Click the IBM Planning Analytics tab.

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER IEM®& Planning Analytics
t- 8% Options ] F O Commit & Clear~ EH Rebuild Sheet
(7) Help~ Discard % Snapshot - [ Rebuild Book

Connect Task Open Publish  Exploration List Action = Refresh "
- Pane Button  Sheet= £+ Recreate Book

Getting Started Content Add Data Dynamic Reports

The Planning Analytics for Microsoft Excel ribbon displays commands for starting Planning Analytics
for Microsoft Excel, logging on to IBM TM1 systems, setting options, opening reports that are published
to an IBM TM1 server, and so on. Report-specific sections might appear here as well when you're
working in them.

What to do next
It is difficult to analyze data and create reports when you have no data to analyze. Continue by adding a
system with data sources to connect to.

Add a system

To get started with Planning Analytics for Microsoft Excel, you need to add a system and connect to a data
source. The data source is where the data you'll be importing to analyze will come from.

Procedure
1. Click Connect.
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= £

.:_ ¢ Options

Connect Task
F Pane

7 Help -

Getting Started

2. Click New Connection .

[l >
b Options
-

'Help~
Connect Task
v Pane
-+ Mew Connection
4% Refresh

u "
Disconnect

Unless a data source was already configured by your administrator, you need to add a data source

before you can connect to one.

what your data sources are for.

Add/Edit Connection

Datasource type
BM Cognos TM1

Connection URL

Friendly name

. Define the Datasource type, the Connection URL, and a Friendly name to help you easily remember

x|

If you're not sure of the Datasource type and Connection URL, ask your administrator.

4. Click Test connection .

This step ensures that the connection to the data source is accurate and live.

5. Click Save .

Connect to a data source

Now that you have your connection set up, it's time to connect to a data source.

Procedure

1. Click Connect.

% Options

(7) Help -
Connect Task

¥ Pane

Getting Started

2. Hover your cursor over the connection.
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{@}Optinns
".:'"Help'

Open Publish | Explora

Connect Task
i Pane

-+ Mew Connection Content

¥ Refresh ﬁ
% Tutorial L % ActionButton

*  Disconnect % GO_Mew_Stores

z—l £ 2Retail

3 % GO _scorecards
A o [

3. Click SDataHierarchies.
{@} Options
= i ':? | HEIFI * )
Connect Task Open Publish | Explora
i Pane

=+ MNew Connection Content

i¥ Refresh ﬁ
% Tutorial L % ActionButton

* Disconnect % GO _Mew_Stores

2| E  2Retail

3 E GO_scorecards
A e

4. Log in to the data source by using your credentials.

Signin to IBM

Enter IBMid or email Forgot your IBMid?

New? Create an IBMid.

Results
You are now connected to a data source and the IBM task pane is opened on the right of the screen.

The IBM task pane opens when you connect to a data source in Planning Analytics for Microsoft Excel.
You can change the position of the IBM task pane by clicking near the top of the task pane and dragging it
to another area on the screen.
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[BM v

Tutorial TvO =T E-

24Retail | Workbook |

@=- ﬁ Allocation Calculation
E-W# Allocation Source Definition
[-RF AssetLife

E-R# Benefit Assumptions
W# Calendar

E-R# Capital

E-R# Compensation

Wi Depreciation

E-RF Employee

E-R# Exchange Rates

W# ExternalFactors

The IBM task pane is where your workbooks are organized and where you can find a tree for all of your
views, cubes, dimensions, measures, and members. If you're unfamiliar with these terms, watch this
video on the basics to modeling and modeling concepts: https://youtu.be/OnE9MBUHfNO

First assighment: Create and customize an Exploration View

You receive an email from your manager. It's your first assignment!

Hi,

Welcome to the team! As you know, this company sells vehicles world-wide. We are currently
reviewing our sales for 2014.

Please send a report that shows the following:

- Only sales for convertibles and sedans

- Only sales in Europe

- Only the actuals

- The quarters in the columns

- Data from 2014

You can find the data you need in the SDataHierarchies data source.
Regards,

Your manager

Now that you have your assighment, it's time to get to work.

You can also follow along by watching this video

Views

Check for existing views
You have your first assignment. Your manager asked you to check for a report that analyzes sales in 2014.
Start by checking whether such a view already exists.

Procedure
1. The top of the IBM task pane contains two tabs; SDataHierarchies and Workbook. Click the
Workbook tab.

The Workbook tab shows all of the Dynamic reports, Action buttons, Explorations, and Quick reports
that you have in your workbook. As you can see, no reports are currently in your workbook. No
problem, you can create one yourself.

2. Click the SDataHierarchies tab.
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That's a lot of content. The cube icon ™ indicates that the item is a cube, and the dimension icon o™
indicates that the item is a dimension. Notice that there's a cube that is named "WorldSales". That
looks like it might have what you need.

What to do next
Impress your manager by creating an Exploration View from the 2014F view.

Create a new view

Procedure

1. Expand WorldSales.

Notice that there's a new type of icon. This icon is the views icon’ B¥ This item contains views that are
in this particular cube. You want to see whether there's already an existing view that has the report
you're looking for.

2. Expand Views.

]
Another new type of icon! This is the icon for individual views LU you expand an individual view, you
can see the content inside of the view. The 2014F view looks like it's just what you need. Now how do
you create a report from it?

3. Drag 2014F and drop it into the workspace area.
Dragging a view into the workspace area creates a list view.

Results

Congratulations on creating your first list view. List views are good for showing data with little formatting.
List views are good for simple analyzes with simple data. But you didn't get hired for simple reports. And
you sure aren't going to show a list view to your manager as your first report! You're going to re-create this
report as an Exploration View.

Create an Exploration View from an existing view

Exploration views are great for exploring data in a pivot table style format. They're easy to manipulate and
can be changed dynamically.

In the last tutorial, you created a list view. But you want something more powerful. Something that more
closely resembles a pivot table. The Exploration View is perfect for that.

Procedure

1. Under the SDataHierarchies tab, expand WorldSales > Views.
E-&8 WorldSales

Elﬁ Views

G-d 2013F

el 2014F

G4 2015F

ﬁ All

(&4 Big Market Sales

2. Right-click 2014F.

3. Hover your cursor over Exploration view.
4. Click On new sheet.
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o WorldSales

Bl Views
B-i8 2013F

m Open in viewer
2m
All Delete
E-Rf Big Rename
e Do
On this sheet Exploration »
On new sheet Quick report »
HE-SH- Dynamic report 3
g \L:\lillt Custom report 3
Results
An Exploration View is created from the 2014F view.

2 ¥ & Commit & Ci
Disca
sh Exploration List A

‘‘‘‘‘‘‘‘‘‘

Sheet2 | sheett

What to do next
Your Exploration View is great, but it does not meet the requirements from your manager. Next, you will
customize the Exploration View to meet your manager's needs.

Customize Exploration Views

Exploration Views are flexible reports. Exploration Views allow for exploring data in a pivot style format.
Perfect for quickly customizing your Exploration View for the manager.

Have a look at the Exploration View you created from the 2014F view. It is huge. Scroll down the report
and you see that the report contains a number of things that your manager did not ask for: sales for
wagons, the budget, sales for Canada, and so on. A summary of the report's content is presented in the
overview bar below the ribbon:

1BM v X

= [Version model gion Saleshleasures = [Tme
=  Adual(ist) ” |zeros ~ | Leaves |7 ﬂﬂﬂ Units: list) il I 2014 ~

The rows drop zone = contains sets that are found in the rows of the Exploration View. The columns drop

zone [l contains sets that are found in the columns of the Exploration View. The context drop zone )
contains sets that make up the context of the report. From the overview bar, you can edit the sets that are
contained in the Exploration View.

Insert and replace members into a set
Your Exploration Views looks great, but it shows all model types instead of just convertibles and sedans.
Change that now by inserting and replacing members in the model set.

Procedure

1. Right-click the model set in the rows drop zone.
2. Click Edit Set.
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model reqior
zerns il leaves ¥
. Delete

EI Reorder/Rename...

& Edit Set

»

The set editor opens for the model set. You use the set editor to customize which members are
displayed in your Exploration View.

Note: Your manager wants to see data for convertibles and sedans.
3. Input convertible in the search bar and then press enter.

convertible Q,

The search results now contains only members with the word convertible in their names.
Available Members

v | convertible
Search results (model)
@ Search - (Name Contains convertible)
@ L Series 1.6 L Convertible
@ L Series 1.8 L Convertible
@ L Series 2.0 L Convertible
@ L Series 2.5 L Convertible

@ L Series Convertible

4. Click Search - (Name Contains convertible)
This member contains every search result member and dynamically updates if the set changes.

5. Click the replace set icon O .
The replace set icon replaces the entire current set with the member that you selected from the
available members section.

Current Set E

¥ Members (zeros) ’E

@ L Series 1.6 L Convertible

@ L Series 1.8 L Convertible

@ L Series 2.0 L Convertible

@ L Series 2.5 L Convertible
© © L Series Convertible

6. Input sedan in the search bar and then press enter.
|5edan| Q,

~

The search results now contains only members with the word sedan in their names.

v ‘ sedan
Search results (model)

Search - (Name Contains sedan) =

L Series 1.6 L Sedan

L Series 1.8 L Sedan

L Series 2.0 L Sedan

L Series 2.5 L Sedan

S Series 1.8 L Sedan

§ Series 2.0 L Sedan

$ Series 2.5 L Sedan

S Series 2.5 L Sedan 4WD

S Series 3.0 L Sedan

S Series 3.0 L Sedan 4WD Ll

P OO OOOEO©O®O®O®O®S®

S Series 3.4 L Sedan

7. Click Search - (Name Contains sedan)
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8. Click the insert icon =
The insert icon inserts the selected members into the current set.

Current Set |2
v Members (zeros)

L Series 1.6 L Convertible =)
L Series 1.8 L Convertible
L Series 2.0 L Convertible
L Series 2.5 L Convertible
L Series Convertible
L Series 1.6 L Sedan
L Series 1.8 L Sedan

L Series 2.0 L Sedan
L Series 2.5 L Sedan
S Series 1.8 L Sedan
S Series 2.0 L Sedan
S Series 2.5 L Sedan

PO EeEEOEO@EOOPGOO®EO@E®E®

S Series 2.5 L Sedan 4WD |
§ Series 3.0 L Sedan

9. Click Apply and close.

Results
Your Exploration View contains only data for convertibles and sedans.

A |

What to do next

Your Exploration View contains data for the actuals and the budget. Your manager wants to see data for
the actuals. In the next tutorial, you will be removing a member from the set editor.

Remove members from a set
Your manager wants to see just the data for the actuals, but your Exploration Views contains both the
actuals and the budget. You need to remove the budget member from the Version set in the set editor.

Procedure

1. Right-click the Version set in the rows drop zone.
2. Click Edit Set.

Version model
Actual list) | | model (list)

W Delete

EI Recrder/Rename...

& Edt Set

at

Wersion alias b

w Ly

3. Right-click Budget under Current Set
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v Members (Selection)
@ Actual
Remove
Keep
Move to top

Move up

4. Click Remove.
5. Click Apply and close.

Results

Your Exploration View contains only data for the actuals.

What to do next

Your Exploration Views looks good, but you still need to show only Europe. In the next tutorial, you will be

expanding a set to show specific levels in a set.

Expand levels in a set

Your Exploration Views contains both the actuals and the budget. Remove the budget member from the

Version set in the set editor.

Procedure

1. Right-click the regions set in the rows drop zone.

2. Click Edit Set.

region
leaves T

1% Delkete

EI Recrder/Rename...

& Edit Set

¥

3. Expand the World member under Available Members.
4. Click Europe.

Available Members

v ‘ Search available members O‘

All members (region)
© © Word

+ (I) Europe

© © Americas
© © BigBluelLand

5. Click the replace set icon O .

v Members (Leaves)
© © Europe

I[N

6. Click Apply and close .

7. Right-click any Europe cells in the workspace.

8. Click IBM Planning Analytics .
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L Series 1.6 L Convertible | Eurc

L Series 1.8 L Convertible | Eurg| o' "[103 | A" A $-% 0 H

= M. A~ Le0 00 o
L Series 2.0 L Convertible | Eurc B I = O A~ -8 08
L Series 2.5 L Convertible | Europe| 2,655
L Series Convertible Eurc IBM& Planning Analytics ~ » Refresh »
L Series 1.6 L Sedan Eurc % cut Cleardata N
L Series 1.8 L Sedan Eurd .
: Em Copy Convert to snapshot »
L Series 2.0 L Sedan Eurc _ .
L Series 2.5 L Sedan Eurd 1D | Paste Options: °%8 Drillup
.
S Series 1.8 L Sedan Eurc A 22 Drill down
$ Series 2.0 Sedan EUrG  paste Special.. Q@ Expand / Collapse
S Series 2.5 L Sedan Eurc - s
Actual * Expand level / Collapse level
S Series 2.5 L Sedan 4WD Eurc
S Series 3.0 L Sedan Eurc Keep
S Series 3.0 L Sedan 4WD Eurc Clear Contents Hide
S Series 3.4 L Sedan Eurg 4= Insert user row / column
Sseresdlseamawn. | BNl e , Insert calculation ,
T Series 2.8 L Sedan Eurc
T Series 3.2 L Sedan Eurg sort ' Memberpropeiies.
T Series 4.0 L Sedan Eurc
T Series 5.0 L Sedan Eurc Eormat Cells...

9. Click Expand / Collapse .

Results
Your Exploration View shows data for only the Europe member with the member expanded.

Europe 457

Scandinavia 34

Benelux 27

L Series 1.6 L Convertible | Islands | 0
Central Europe 1 273

Iberia a0

Southern Europe 83

Europe 747

Scandinavia [i]

Benelux 60

L Series 1.8 L Convertible Islands 151
Central Europe 536

Iberia [i]

Southern Europe [i]

Europe 1,212

Scandinavia 0

Benelux 126

L Series 2.0 L Convertible Islands [i]
Central Europe 1,087

Iberia [i]

Southern Europe [i]

What to do next
Your Exploration Views is almost complete. Next, add quarters to the columns.

Use the drop zones
Your Exploration Views is almost complete. Add the quarters for 2014 to the columns.

Procedure

1. Drag the Time set from the context drop zone into the columns drop zone.
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E= \;39‘\?; Ly m Ly region L DD SalesMeasures 3 L Time: ;. L a
= ist) Europe SalesMeasures (ist) 2013 ist)
£13 = Jx || units
A8 & o E F s H ' ) K L ™ N o [

1

2

3

14 2015 |2015-Q1|2015-Jan 2015 - Feb 2015 - Mar 2015 -Q2 2015- Apr 2015 - May 2015 - Jun | 2015-Q3 2015-Jul 2015 - Aug

15 Europe 5 1 [ 0 0 1 0 ) 0 1 0 0

16 Scandinavia 0 0 [ 0 0 o 0 0 0 0 0 0

7 Benelux 0 0 0 0 0 0 0 0 o [} o 0

18 LSeries 1.6 L Convertible | _Islands o o o 0 0 0 0 0 0 o o 3

19 Central Europe 3 1 0 0 0 1 0 ) 0 1 0 0

2 theria 0 0 0 0 0 0 0 0 0 o 0 0

n Southem Europe 1 0 0 0 0 0 ) ) 0 0 ) 0

2 Europe 9 2 1 1 1 2 1 1 1 2 1 1

B Scandinavia o 0 o 0 0 0 0 0 0 0 o 0

24 Benelux 1 0 o 0 0| o 0 0 0 0 0 0

] Lseries 1.8 L Convertible | _Islands 2 o 0 0 0 0 0 0 0 o 0 0

% central Europe 6 % 1 1 1 2 1 1 1 2 1 1

7 tberia 0 0 0 0 0 0 0 0 0 [} o 0

28 Southern Europe 0 0 o 0 0 o 0 0 0 0 0 0

2 Europe 11 1 1 1 1 a 1 1 1 2 i 1

EY) Scandinavia 0 0 0 0 0 0 0 0 0 0 0 0

31 Benelux 1 0 L 0 0 o 0 0 0| 0 0 0

32 L Series 2.0 L Convertible Islands 0 0 0o 0 0 0 0 0 0 0 0 0
Central Europe 13 3 1 1 1 3 1 1 1 3 1 1

. Right-click the Time set.

. Click Edit Set.

. Expand 2014 from the Available Members section.

. Select 2014 - Q1, 2014 - Q2, 2014 - Q3, 2014 - Q4.

o o1 b W N

. Click the replace set icon O .

~ Members (Selection)
@ 2014-Q1
@® 2014-Q2
@® 2014-Q3
@® 2014-Q4

AN

7. Click Apply and close .

Results
Your Exploration View contains the quarters for 2014 in the columns.

What to do next
Your Exploration View is complete. Time to share it with your manager.

Share your work

About this task

Now that you have your first report created, it is time to share it with your manager. You can either save
the workbook as an Excel file and send that, or you can publish it to the server you are connected to.

Share your report by publishing it to the server

About this task

Publishing your reports to a server is easy and is a great way to share your analysis with colleagues!

Procedure

1. Click Publish.

2. Select a TM1 connection.

3. Select a TM1 Server Application folder.
4. Select a folder.

5. Type a name for the workbook.

6. Select Make public
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7. Click Publish.

Results
Your workbook is ready to be viewed by your manager and colleagues. They can view the workbook and
contribute to it as well.

Automate your work by using the IBM Planning Analytics for Microsoft Excel

API

You're a few weeks into your new job, using Planning Analytics for Microsoft Excel and you're noticing that
you're creating countless reports and repeating the same multi-step tasks over and over. Fortunately,
Planning Analytics for Microsoft Excel features an IBM Cognos automation API, which helps users
automate many of their tasks.

You log onto you computer and notice an email from your boss:

Hello,

Good work on the 2014 sales report! I now need you to create some reports for me.
Every year we send out a report to the sales, marketing, and engineering departments.
Can you create a report based on the Goal Input view for each of these departments?

You can find the Goal Input view in the plan_BudgetPlan cube, located inside of the Planning
Sample server.

Thanks,
Your manager.

This is the perfect time to use the IBM Cognos automation API. Let's get started.

Setting up for the API

Before you can use the IBM Cognos automation API, you need to add a reference, which connects to IBM
Cognos automation. You need to open the Visual Basic Editor, add a reference to IBM Cognos
automation, and then access the IBM Cognos automation API.

About this task
https://youtu.be/eP8wg8b1Bpl

Adjusting the Trust Center settings
Some settings in the Microsoft Excel Trust Center may need to be adjusted in order to use the IBM
Cognos automation APL.

Procedure

1. Open a new Microsoft Excel workbook.
2. Click File > Options > Trust Center > Trust Center Settings... > Macro Settings.
3. Select Enable all macros and enable Trust access to the VBA project object model.
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Trust Center =

Macro Settings

Disable all macres without notification
Disable all macros with notificaticn
g Dizable all macros except digitally signed macrnos

@ Enable all macros (not recommended; potentially dangerous code can run)
Developer Macro Settings

Macro Settings
| Trust access to the VBA project object model

0K ] Cancel

4. Click OK
Results
Your Trust Center settings are now optimized for the IBM Cognos automation APL.

Note: Remain on the Options dialog as you'll need it for the next step.

Opening the Visual Basic Editor
IBM Cognos automation and the IBM Cognos automation API functions are called by using macros in VBA.
The following steps show you how you can open the Visual Basic Editor and start by using VBA macros.

Procedure

1. From the Options dialog box, click Customize Ribbon.
2. If it is not already, select the check box for the Developer tab, in the Main Tabs pane.
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Excel Options |I|[E

General [ 3 2

=] Customize the Ribbon.
Formulas )

Choose commands from: (i Customize the Ribbon:
Proofi

i Popular Commands El Main Tabs El
Save
Language All Chart Types... - Main Tabs
Borders LaF | E [¥|Home

Advanced Caleulate Now [ Clipboard

Center # Font

Customize Ribbon ) Conditional Formatting 3 & Alignment
Quick Access Toolbar E Connectices T' Mumber
53 Copy B Styles
Add-Ins E Custom Sort.., B Cells
X;. Cut 3 i Editing
Trust Center A  Decrease Font Size E | Insert
;‘J Delete Cells... [ 7] Page Layout
» Delete Sheet Columns = ] Formulas
3% Delete Sheet Rows =
09 Email SR
D F ¥ ] Review i)
™ Fill Color 8 @ =)
Y Filter & V] View
Font 114 [caRe| Developer
A E“‘“: g_"'” I’ ™ @] Add-Tns
ont Size h{ ; : =
D Format Cells [ ¥|IBM& Planning Analytics
¥ Format Painter # V] Background Removal
E5] Freeze Panes L4
A Increase Font Size
= Insert Cells... .
?x Insert Function... New Tab ] New Group ] Rename...
"1 Insert Sheet Columns
g_ Insert Sheet Rows Customizations: ¥
P Macros ST |
Bl Moo & Croie - (importExport ¥
4 (1] »

0K Cancel

3. Click OK.
A new tab titled DEVELOPER is shown in the Microsoft Excel ribbon.

4. Click DEVELOPER > Visual Basics.

g
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER IEM® Planning Analytics

'i _-'! 27 Record Macro & =] = [£] Properties = b ; £ Import ™
: - L= 5
e E Use Relative References b -H ._""n View Code e +j Expansion Packs

Document

Visual Macros Add-Ins  COM Insert Source
Basic 1. Macro Security Add-Ins - ) [4] Run Dialog Panel
Code Add-Ins Controls XML Modity
H3 - fr
A B C D E F G H I J K L M

In & w e
D ‘

Results
The Visual Basic Editor opens.

Adding a reference to IBM Cognos automation and accessing the IBM Cognos automation API
Now that you have the Visual Basic Editor open, you can establish a reference to IBM Cognos automation
and access the IBM Cognos automation API.

Procedure

1. Right-click VBAProject and then click Import File....
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b i DR U fronet Fonmt Debug Run Tools Add-Ins  Window
EE-" Lm0k SR 2@
Project - VBAPrgject  X|
| = = oo |
f <5 VBAProject (Bookes

B Sheet1 (Sheet1) B View Code
-3¢ ThisWorkbook |

Help

Wiew Ohject

3 Toggle Folders
VBAProject Propegrties...
Insert 3
Import File...
Export File...
Remove
Print...
Dockable
Hide

A @

2. Browse to the IBM Planning Analytics for Microsoft Excel installation directory.

. Browse to the /Automation folder.
. Highlight CognosOfficeAutomationExample.bas and click Open.

A~ W

() [ Pragom Fas 6] » 184 » <ognos » I8 fr NcrosftOfce » Automation
et

MNew folder

B0 BT —

g~ 0 B“.

H Favorites = Mame Date modified Type Size

B BoxSyne || CognosOffices icn /2018 3:57 AM__BAS File k8|
B Desktop _| CognesOfficedutomationPPExsmplebas  10/01/2008 &:57 AN BAS File 11KB
; i 8 Dowmloads _| CognesOfficeMessageSuppressor.cls 10/00/2018 %:57 AM  CLS File 1KB
[ & Onedive
fiect [ % Recent Places
Jegorized |
= | & Libraries L
¥ Documents

o Musie
] Pictures
B videos

1 Computer
& Local Disk (C)
oL €D Drive (D)

File name:  CognosOfficefutomationExamplebas

. Repeat steps 1-3.

. Highlight CognosOfficeMessageSuppressor.cls and click Open.
. Close the Visual Basic Editor.

. Save the workbook as an Excel Macro-Enabled Template.

0 3 0o O

What to do next
Add IBM Cognos automation API functions to automate your tasks.

- [VBFils et
-
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Add and execute IBM Cognos automation API functions

Now that you have set up your environment for the IBM Cognos automation API, it's time to add and

execute some API functions.

About this task
https://youtu.be/tWzQ_xee9Gw

Double-check the references to the IBM Cognos automation API

You might run into some trouble if you're missing some references to the IBM Cognos automation API.

Let's double check those first.

Procedure

1. Open the template file that you created in the last tutorial.

2. Log into the Planning Sample server. This is the server/datasource which contains the view that you'll

be creating multiple Exploration Views from.
. Click the DEVELOPER tab.
. Click Visual Basic.
. Double-click CognosOfficeAutomationExample.bas in the Project pane to open it.
. Check for the following:

o o1 bW

sl e Applicatior - (& ecl] = |

N o Bl Bt few et Fgewat Debug Ben ook Addiw  fiedos  Hep

f BE-d @ M P oA EFY 5@ L

o Prejoct - WBAPsspect 2l [ Tveeren +] [mcumanty
- Y — - [l

B VRAFrapeal (AF]] ewsplate shon]
T Cogreefionk st weps
e —— I;:.

el -irg

o

P
Bttt | Catogorond Eog
riame] CogrosCficr mmator e

Prepeties  Cognnfintutemationbumsls |

a) m_oCOAutomation is defined as an object.

b) m_oCAFE is defined as an object.

c) Thereis a Property Get statement for CognosOfficeAutomationObject().
d) There is a Property Get statement for Reporting().

7. If you have all of the above in your CognosOfficeAutomationExample.bas, you can start adding your

own API functions. If you're missing one or more items, head over to “Necessary IBM Cognos

automation API references” on page 192 and supplement the file with what you're missing.

Add your own API functions

You will choose different API functions depending on the tasks that you need to automate. Fortunately,

there are plenty to choose from.
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Procedure

1. Right-click inside of the Project pane, click Insert > Module. This new module is where you will be

adding your own API functions.

2. Go to Chapter 10, “IBM APIL,” on page 191. This is where you can find IBM Cognos automation API

functions.
. Click Exploration API functions.

A W

0 3 0o O

. Click Create. This Create API function allows you to generate Exploration Views from a combination
of host system URL, server name, cube name, and view name.

. Copy the example that is in this topic.
. Paste the example into the new module. You may have to adjust the formatting.
. Replace the example host system URL with the one that you are using.

. Replace Goal Input withBudget Input Total.

2| - 1 (Coael]

oM Fie Edt Yiew Jnsem Format Debug Bun Took  hddins  Window Meip
E&-- a9 @ tna.Coll
Project - VEAPragect x|

-]

#i CogrosOifficeAutomatonExampie
ST A —————

= | v
[ & VBAPropect (AT complate.bm} cporting.Explorations,Create ~http://vattwangcld, canlab.ibw.con”, “Flanning Semple”, "plan_BudgesFlen=, "Budget Input Tatal®
End Sub

9. Save the template.

Results

You have just added your first API function! Next you'll be executing this API function.

Execute your API functions

Now that you have your API function added, it's time to execute them.

Procedure
1. Click the DEVELOPER tab.

2. Click Macros.
3. Click Create.

4. Click Run.
= =
| Macro ]
Macre name:
Create ) [fn
ClearAliData &
ClearDatalache Step Into
Logote Ediit
RefreshANData
RefreshANDatasndFormat
UnlankaliData
[eelete
Options...
Macres in: | All Open Workbooks ﬂ
Dezeription
Cancel
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Results

Congratulations! You have just automated creating an Exploration View from a view. Create two more
Exploration Views for a total of three. In each Exploration View, change the department to sales,
marketing, or engineering. Once you have one of each, go ahead and send those reports out to your
manager. Task accomplished (and mostly automated).
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Chapter 12. Examples and use cases

Using IBM Planning Analytics for Microsoft Excel you can create an Exploration View. Use Exploration
Views to show information in a more compact form than in a grouped list. For example, create an
Exploration View to show total sales by product line generated by each sales representative.

Like list reports, Exploration Views are reports that show data in rows and columns. However, the values
at the intersection points of rows and columns show summarized information rather than detailed
information.

You can also create list reports from relational data sources.

Work with items in an Exploration View

You can manipulate the way rows and columns appear in an Exploration View for more effective
comparison.

You can do this by

« nesting rows or columns “Nest rows or columns” on page 153

« swapping rows and columns “Swap rows and columns” on page 67

« showing or hiding rows or columns “Limit items” on page 157

Exploration is a process in which you explore the relationships between items to help understand your
business. The Exploration View helps you discover whether the value of one item is associated with that
of another.

Comparisons are key elements of nearly every exploration. The following table shows examples of
different types of comparisons.

Table 57: Examples of comparisons

Comparison Example

Simple comparison Tents versus sleeping bags

Multiple comparison Tents versus golf clubs, tees, and golf balls

Multidimensional comparison Products versus territories, this year-to-date
versus last year-to-date

Mixed comparison Tents versus similar camping products, this year
versus last year, and the last quarter versus last
year

Summaries of measures at different levels Tents as a share of camping products, as a share of

European sales

Explorations and relational sources

Explorations can be used to transform relational sources into an Exploration View that allows dimensional
style layout. Filters for relational explorations are, however, detail filters as opposed to dimensional. If
dimensional style layout and filtering are common requirements, we recommend that you create a DMR
model for this data source to simplify report creation.

Explorations and dimensional sources

We recommend that you use explorations for dimensional sources. Even if the report has a simple layout
with no nesting and measures as columns, the query supports precise filtering if created as an Exploration
View.
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Work with relational Exploration Views

Sets

Relational data in Exploration Views has limitations and differences from dimensional data. One such
instance is replacing measures on columns. Measures derived from relational data are stacked blocks.
Replacement of the entire stacked block on the grid is not permitted. You would need to do this on the
summary bar. This behavior is consistent with query items that are not measures. You may also notice
that expand, collapse and totals do not work with relational data sources.

Sets are the basic building blocks of IBM Planning Analytics for Microsoft Excel. A set identifies a group of
items from a single hierarchy. You can manipulate the individual sets in the Exploration View.

Sets may be

- nested or stacked in the Exploration View
- used as filters
The following list describes the different kinds of sets you can use.
Simple
A single member and its direct dependents one level down.

Selection-based set
A collection of individual items that you have explicitly selected. The items or members may be
selected from one or more levels from the same hierarchy and are not aggregated.

Combination set
A set consisting of more than one simple or selection-based set.

Nest columns or rows in an Exploration View

Nest data in an Exploration View to compare information by using more than one data item in a column or
row. For example, an Exploration View shows the number of sales by product line for the past fiscal year.
You decide to add a data item to further break down the number of sales by quarter.

When nesting columns in an Exploration View, there are four distinct drop zones where you can insert a
new data item. The drop zone you choose defines the relationship between the data item and the column.

The following relationships are created when you insert a data item as a row:

- Inserting a data item before or after a column creates a parent-child relationship between the data
items.

When you insert a data item before a column, the data item becomes a parent to the row. When you
insert a data item after a column, the data item becomes a child of the row.

- Inserting a data item before or after a column creates a union relationship between the data items.
The following relationships are created when you insert a data item as a column:

- Inserting a data item before or after a column creates a union relationship between the data item and
the column.

- Inserting a data item before or after a row creates a parent-child relationship between the data items.

When you insert a data item before a column, the data item becomes a parent to the column. When you
insert a data item after a column, the data item becomes a child of the column.

For example, you have an Exploration View with Product line as rows and Quantity and Revenue as nested
rows. For columns, you have Order method with Country or Region as a nested column.

« Product line is a parent to Quantity and Revenue.
« Quantity and Revenue are peers.
« Order method is a parent to Country or Region.
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Procedure

1. In the source tree, click the data item you want to add to the report.
2. Drag the data item to the location where you want it to appear as a nested column or nested row.

A highlight bar indicates where you can drop the data item.
3. Repeat step 2 to add other nested columns or rows.
Tip: If you add more than one measure to an Exploration View to the same axis, you must add them as

a set. Ctrl+click the items or, to add a measure to another measure already in the Exploration View,
press the Ctrl key while dragging the item to the other measure.

Example - evaluate revenue from specific order methods

You are a business analyst at the Sample Outdoors Company, which sells sporting equipment. You are
asked to analyze the consequences of discontinuing the fax and mail order methods, which are expensive
to process.

First you get the items you need and insert them into an Exploration View for further exploration.

Before you can try this example, you must have access to the sample packages that come with IBM
Cognos Analytics. For more information, see the IBM Cognos Analytics Administration and Security Guide.

Procedure

1. In Microsoft Excel, click the IBM Planning Analytics tab.

2. To connect to the IBM Cognos Analytics system to access the sample package, click Connect and
select the server.

. Select the Sales and Marketing package and click OK.

. Expand the Order Method folder.

. Press Ctrl and click Fax and Mail.

. With Fax and Mail selected, right-click Mail and click New Set.

N o o AW

. In the Selection on Dimension dialog box, click Save |2’ and save the set using the default name,
Order method.

. On the IBM Planning Analytics tab, click Exploration.

. Expand the Custom Sets folder and drag the Order method set to the Rows area in the Exploration
View.

10. Expand the Sales measures folder and drag Revenue to the Measure area in the Exploration View.
11. Drag Retailers to the Columns area in the Exploration View.
12. Expand the Time folder and drag Time beside the order methods to nest years in the rows.

O

Results

You now have the data required to analyze if revenues for the fax and mail order methods are growing or
declining over time.
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A B C D E F G H I 1
1
2
3 System: Bl
4 Package: Sales and Marketing [cube]
5 Created: H2N2013 2:50:47 PHM
] Modified: H2N2013 2:56:37 PM
7 Rows: Order method: Order method, Time: Time
) Columns: Retailers: Retailers
9 Contert:
10 Filter Rows:
11 Filter Columns:
12
13 Revenue Americas |Asia Pacific| Northern Europe | Central Europe | Southern Europe| Retailers
14 2010 | 4.548,265.80( 7,320,722.31 4,153,371.36 4,565,652.77 2,178,838.27 22,766,850.51
15 2011 | &.297,360.82| 2,502,32053 2,395,516.35 3,345,619.36 872,362.43| 16,013,779.49
16 Mail 2012 562,121.32| 2,340,124.81 616,014 57 2,787,469.74 £,305,730.44
17 2013 404,978.53 404,978.53
18 Time | 12,008,347.94| 12,763,167.65 7,569,880.81 10,698,741.87 3,051,200.70 46,091,338.97
19 2010 | 8,074,598.38| 8,584,265.93 2,827,013.03 €,505,403.69 2,648,191.11( 28,639,472.14
20 2011 | #.131,867.09| 667111839 1,987,522.91 5,229,586.14 1,876,093.23 19,896,187.7¢
21 Fax 2012 | 3,753,159.17| 5,169,640.15 175,517.78 1,864,091.34 2,483,151.49( 13,445,559.93
32 2013 | 1.940,318.06| 1,435,57437 1,458,455.90 3,256,269.85( 2,082,322.18
23 Time | 17,300,542.70| 21,860,598.84 4,990,053.72 15,058,541.07 10,263,805.68| 70,073,542.01
24

Figure 15: Exploration View

Work with items in a list

Use lists to show detailed information from your database, such as customer lists or product lists.

A list is a report that shows data in rows and columns. Each column shows all the values for a data item in
the database or a calculation based on data items in the database. Lists are useful for very large reports
that require minimal filtering.

Lists and relational sources

Use lists for relational sources.

Lists and dimensional sources

Avoid using lists with dimensional sources. It is preferable to use Exploration Views with dimensional
sources whenever possible, because it will provide much richer filtering capability. However, lists are
useful against dimensional sources if there is no measure in the report. Such a report cannot be created
as an Exploration View and can only be created as a list.

Example - create a list report

In this topic, you will use the GO Data Warehouse model. It contains data about human resources, sales
and marketing, and finance, grouped into business areas.

You will learn how to
« create a list report

The report shows revenue for each product for the last quarter of the current year.
« group items in the list report
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You group data items in a list report to remove duplicate values. For example, you have a report that
shows products purchased. For each product, the product type is also shown. You group the Product
type column to show only one instance of each product type in the list.

Procedure
1. Open the GO Data Warehouse (query) package.

2. On the IBM Planning Analytics, click List.

3. Expand Sales and Marketing (query), Sales (query) and then drag items to the worksheet to create
the report.

You can also add an item to the report by selecting the item, opening the item's context menu, and
selecting Add to columns.

« Expand Products and drag Product type to the drop zone.
- Expand Time dimension, and drag Quarter beside Product type.
« Expand Sales orders, and drag Order number beside Quarter.
- Expand Product, and drag Product name beside Order number.
- Expand Sales fact, and drag Quantity beside Product name.
« From Sales fact, drag Unit cost beside Quantity.
4. Create the calculation Quantity * Unit price.
5. Rename the calculation to Revenue.
6. Group the Product type column and then group the Quarter column.

Results

Your report will look like the following:

A B = D E F G H |
1
2
3 System: Bl
4 Packnge: GO Data Warehousze [query]
5 Created: H2WZ013 1:40:23 PM
6 Modified: H2WZ013 1:51:37 PM
7 Columns: Product type, Guarter. Order number, Product name, Guantity, Unit price, Revenue
8 Filter Columns:
9
10 Product type | Quarter | Order number| Product name |Quantity | Unit price |Revenue
11 Binoculars a1 100003 Seeker 50 88|1134.11 11,801.68
12 100005 Seeker Extreme 65|182.67 11,873.55
13 100006 Seeker Mini %6|85.50 8,213.76
14 100008 Seeker Extreme 93|182.67 15,084.33
15 100013 Seeker 35 205|105.29 21,584.45
16 100019 Seeker 35 2361105.29 31,165.84
17 100023 Seeker Mini 133|85.56 11,892.84
18 100025 Seeker 30 1581134.11 21,1858.38
19 100025 Seeker Extreme 20|1182.67 16,440.30

Figure 16: List report

If you need more help, see the following:
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« “Exploration Views and lists” on page 59

« Nest rows or columns
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Chapter 13. Try it yourself exercises

If you have some experience with IBM Planning Analytics for Microsoft Excel and want to improve your
skills in creating workbooks, this chapter is for you. Each topic gives you some guidelines on how to create
each sample worksheet. If you need help, links to more detailed instructions are available. Answers can
be found in the sample workbooks.

Before you can try these exercises, the sample packages must be set up on the IBM Cognos Analytics and
IBM TM1 systems. You access the sample workbooks from installation location of the IBM Cognos
Analytics samples. Sample workbooks are available from [samples_installation_location]
\webcontent\samples\datasources\ workbooks\performance_management
\business_intelligence.

Contact your administrator for the location of the samples installation.

Create an Exploration View that uses an indirect filter to update data and
charts

When you are working with a time dimension, you can use a cell reference to control a series of reports for
a specific year. In this topic, you learn how to create a dynamic report that retrieves year-to-date revenue
for each product line.

It should take 15-20 minutes to complete this topic. To view the completed report, download the
IndirectFilter.x1ls sample workbook.

Procedure

1. Begin by creating an Exploration View that uses the sample package named Great Outdoor Sales
(cube).

2. Add the following data items to the Exploration View:

 Products level (in Products) to the Rows drop zone

« Revenue, Gross Profit, Quantity sold, Unit cost, and Profit margin% (in Measures) to the Columns
drop zone

« Americas (in Sales Regions) and 2012 (in Years) to the Context drop zone

3. On the IBM Planning Analytics tab, click Convert to > Custom Report > On New Sheet .

4. From the original Exploration View, change the retailer by dropping a different retailer in the Context
drop zone and then convert it to formulas on a new sheet.
Complete this step for each retailer.

5. Using your knowledge of Microsoft Excel, chart Revenue, Gross profit, and Quantity for each of the
newly created worksheets.

6. To create an indirect filter, on a separate worksheet, drag 2012 (in Years) to a cell.

Tip: In an adjacent cell, label the cell with Select the Date Here.

7. For each of the worksheets you created, change the year in the Context cell to reference the filter cell
you created in step 6.

For example, for a worksheet named Filters with the filter in cell C3, type =Filters!C3.
8. From the source tree, drag 2013 (in Years) to the cell where you placed 2012.

Notice that the cell references are updated throughout the workbook and the charts reflect the 2013
data.
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Analyze data in an Exploration View

In IBM Planning Analytics for Microsoft Excel, you can manipulate items in your data interactively so that
you can identify and understand the problems and issues in your business.

In this topic, you learn how to create an Exploration View and use Excel's Moving Average analysis tool for
charting and reviewing the IBM Cognos data to help you spot trends and patterns that may warrant
further attention. To use this feature, you must have the Excel Analysis Toolpak installed on your
computer.

For this exercise, you are a business analyst for the Sample Outdoors Company. You want to further
analyze the historical return levels to predict future demand for the eye wear product line, enabling you to
better plan quality controls.

It should take 10 to 15 minutes to complete this topic. To view the completed report, download the
MovingAverage.xls sample workbook.

Procedure
1. To create the report, create a new Exploration View that uses the Sales and Marketing (cube)
package.
2. Insert data in the Exploration View:
- In Measures, drag Returns to the Measure drop zone.
« In Products, Personal Accessories, drag Eyewear to the Rows drop zone.
 In Time, drag Time to the Columns drop zone.

You have now created the report. You must now create an analysis.
. To create the analysis, from the Tools menu, click Data Analysis.
. In the Data Analysis dialog box, click Moving Average, and then click OK.
. In the Input Range box, enter the single row for the Inferno brand eyewear.
. In the Interval box, enter 2 as the number of data points used to calculate the moving average.

o O bW

The smaller the interval, the more the moving average is affected by individual data point
fluctuations.

7. In the Output Range box, enter the cell address so that the results start outside the cell range of the
Exploration View.

8. Select the Chart Output check box to see a graph comparing the actual and forecasted return levels,
and then click OK.

9. Set the chart options as follows:
» Add text to the y-axis to show Returns.
« Add text to the x-axis to show Years.
« Change the chart title to indicate that this is a moving average for the Inferno line in eyewear.
« Ensure that the legend keys are shown to the side of the chart.
 Add value labels to the chart.
10. Set the value for the Z-axis scale to 25 as the major unit.

Results
The chart now shows your forecasted return levels and identifies each year's ending returns.

If you need more help, see Creating a New Exploration.
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Balance sheet reports

In this topic, you will create a Balance Sheet report that shows assets, liabilities, and equity for the
Sample Outdoors Company in 2013.

To create this report, you will use a package that was published from MSAS cubes containing financial
data. Use the GO Finance Fact cube derived from the GOSALESDW database. This cube contains year-to-
date and monthly financial data for all accounts. The data is in actual US dollars submissions for 2010,
2011, 2012, or 2013 (7 months actual data only).

You will use a Microsoft Office accounting template, available for download from the Microsoft Web site,
to create the balance sheet. For this exercise, the Balance Sheet with Ratios and Working Capital template
is used.

You will also apply cell-based analysis to populate your balance sheet with IBM Cognos data for Current
Assets, Other Assets, Current Liabilities, and Other Liabilities. In Excel, you will leverage the power of
formatting by applying background color, font styles and characteristics, and cell formatting for a
professional presentation of your report.

It should take 20 to 30 minutes to complete this exercise.

Create the balance sheet

You will create a Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. You must first create the balance sheet.

To view the completed report, download the BalanceSheet template.xls sample workbook.

Procedure
1. Download the Balance Sheet with Ratios and Working Capital template from the Microsoft Web site:

http://office.microsoft.com/en-us/templates/CT101445641033.aspx (opens in new window)

2. Clear the content in the template, except for the calculated cells and balance sheet categories, such as
Current Assets and Other Liabilities.

3. Insert a line under each balance sheet category.

The line is used to build the rows and columns necessary for dragging and dropping headings and
groups of items along the vertical or horizontal axis.

4. Continue with populating current assets.

Populate current assets

You are creating a Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. You must now populate current assets.

Procedure

1. Open the GOFinanceFact_EN_MSAS2011 package.

2. From the source tree, expand Accounts, Balance sheet (total), Assets (total).

3. Drag Current assets (total) to the cell after the Current assets category.

4. Right-click Current assets (total), click IBM Planning Analytics, Expand, Expand up.
The cells before Current Assets (total) fill in with the components that make up Current assets (total)
in the hierarchy.

5. From the source tree, expand Time, and then drag 2013 to the column area of the cell-based
framework.

6. From the source tree, expand Measures, and then drag Stmt Year to the measures area where the row
heading and column heading adjoin.

7. Convert the dynamic data to static data.
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8.

Continue with populating other assets.

Populate other assets

You are creating a Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. You must now populate other assets.

Procedure

1.
2.
3.

6.
7.

From the Source tree, expand Accounts, Balance sheet (total), Assets (total).
Drag Other assets (total) to the cell after the Other assets category.
Right-click Other assets (total), click IBM Cognos Analysis, Expand, Expand up.

The cells before Other assets (total) populate with the components that make up Other assets (total)
in the hierarchy.

. From the source tree, expand Time, and then drag 2013 to the column area within your cell-based

framework.

. From the source tree, expand Measures, and then drag Stmt Year to the measures area where the row

heading and column heading adjoin.
Convert the dynamic data to static data.
Continue with populating current liabilities.

Populate current liabilities

You are creating a Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. You must now populate current liabilities.

Procedure

1.

2.
3.

6.
7.

From the Source tree, expand Accounts, Balance sheet (total), Liabilities & equities (total),
Liabilities (total).

Drag Current Liabilities (total) to the cell after the Current liabilities category.
Right-click Current liabilities (total), click IBM Cognos Analysis, Expand, Expand up.

The cells before Current liabilities (total) populate with the components that make up Current
liabilities (total) in the hierarchy.

. From the source tree, expand Time, and then drag 2013 to the column area within your cell-based

framework.

. From the source tree, expand Measures, and then drag Stmt Year to the measures area where the row

heading and column heading adjoin.
Convert the dynamic data to static data.
Continue with populating other liabilities.

Populate other liabilities

You are creating a Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. You must now populate other liabilities.

Procedure

1.

2.
3.

From the Source tree, expand Accounts, Balance sheet (total), Liabilities & equities (total),
Liabilities (total).

Drag Long-term and other liabilities (total) to the cell after the Other liabilities category.
Right-click Long-term and other liabilities (total), click IBM Cognos Analysis, Expand, Expand up.

The cells before Long-term and other liabilities (total) populate with the components that make up
Long-term and other liabilities (total) in the hierarchy.
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4. From the source tree, expand Time, and then drag 2013 to the column area within your cell-based
framework.

5. From the source tree, expand Measures, and then drag Stmt Year to the measure area where the row
heading and column heading adjoin.

6. Convert the dynamic data to static data.
7. Continue with cleaning up the balance sheet.

Clean up the balance sheet

You have created Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. Finally, you must now clean it up.

Procedure

1. Under each balance sheet category, remove the row that contains the labels for the dimensions that
were used in the cell-based analysis.

2. Ensure that empty rows are deleted so that the balance sheet maintains its form.

3. After converting the data to static data, the summary items, such as Other assets (total) and Current
liabilities (total), are static values. Remove these rows so that the balance sheet template formulas
calculate the data accurately.

4. In a cell where you would like the heading of the balance sheet, type Great Outdoor Company
Balance Sheet and 2013.

Results
You have used your Excel knowledge to augment IBM Cognos data. If you need more help, see “Create
from scratch” on page 167.

Explorations using filters

When working with dimensional data, you can use context filters to quickly focus your report on a
particular view of the data. You can also use custom filters to refine your view.

In this topic, you will learn how to

- create context filters by dropping members or sets in the context filter area
- create a custom filter by creating an expression that you use to retrieve a specific subset of records

It should take 10-25 minutes to complete this topic. To view the completed report, download the
CustomFilter.x1s sample workbook.

The Exploration View contains product lines in the rows, years in the columns, and returns as the
measure. The values are filtered to show returns for only Web orders from the Americas. We use a custom
filter to narrow the focus of this report to show only those product lines that have generated over 5000
returns in 2013.

Create context filters

In this topic, you will learn how to create context filters by dropping members or sets in the context filter
area.

It should take 15 to 20 minutes to complete this topic. To view the completed report, download the
CustompFilter.xls sample workbook.

Procedure

1. Create a new Exploration View that uses the Sales and Marketing (cube) package.
2. Insert data in the Exploration View:

- In Measures, drag Returns to the Measure drop zone.
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 Drag Products to the Rows drop zone.
« In Time, drag Time to the Columns drop zone.
. Change the label in the Time column to Total.
. Show all the members in the levels.
. In Retailers, drag Americas to the Context drop zone.
. In Order method, drag Web to the Context drop zone.

o U1 bW

You see the returns only for the Web in the Americas territory for all the product brands over a four-
year span. The total number of returns is visible in the Total column.

7. Continue with creating custom filters.

Create custom filters

In this topic, you will learn how to create a custom filter by creating an expression that you use to retrieve
a specific subset of records.

Procedure

1. In the Rows drop zone, for Products, click the drop-down menu to select the Filter, Edit/Add filter
option.

2. In the Filter window, create an expression that will show only the product lines that generated more
than 5000 returns in 2013.

Results
If you need more help, see the following;:

« Creating a New Exploration View

« Insert and Display All the Items of a Level

« Filter Values Using Context

» Create a Custom Set

Creating a custom filter from a list exploration

Create filters to limit the number of items that display in your exploration sheet.You can reference cells
from your Microsoft Excel workbook as part of your filter expressions.

By following the steps in this tutorial you learn how to:

« Create filters
« Combine filter lines
 Use cell values as part of your filter

This tutorial uses the sample package GO Sales (query).

Use sample relational data to create a complex list exploration with a calculated column
Create a list exploration with several columns of data and then add a calculated column.

By following the steps in this portion of the tutorial you learn how to:

« Load a specific data package
« Create a complex list exploration
« Add a calculated column to use as part of your analysis
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Start IBM Planning Analytics for Microsoft Excel and open the sample package

To access data, you must start IBM Planning Analytics for Microsoft Excel and then select a data package.
Depending on how your server and data have been set up, you might have to expand several node items
to access the sample data set.

Procedure

1. Start IBM Planning Analytics for Microsoft Excel.

2. From the IBM Planning Analytics tab, click Connect and select the server that has the IBM Cognos
Analytics sample data.

3. From the list of packages, click GO Sales (query) and then click OK.

Create a list exploration with several columns of data from the GO Sales (query) package
As part of your analysis, you must create a list exploration with product data from the sample sales cube.

Procedure

1. To create a list exploration, on the IBM Planning Analytics tab, click List.
2. In the source tree, expand the Sales (query) folder.
3. Expand the Product item.

4. To create columns, drag the following items to the exploration: Product name, Introduction date,
Unit price, and Unit cost.

Add a calculated column
Create a calculated column to use as part of your analysis.

Procedure

1. Select the Unit price and Unit cost columns.
2. From the exploration bar, click the Insert Calculation icon, and then click Unit price - Unit cost.
The calculated column, Unit price - Unit cost, appears after the Unit cost column.

Add values to the worksheet and create filter expressions
You can use values from the Microsoft Excel worksheet or workbook as part of the filter expression.
In the tutorial, these values are static. In your scenarios, they can be calculated values from other IBM

Planning Analytics for Microsoft Excel exploration sheets or the results of Microsoft Excel cell
calculations.

Add values to the Microsoft Excel worksheet to use in filter calculation
Create minimum and maximum values in the cells of the exploration sheet to use in the filter expression.

Procedure

1. Click cell I4 and type Minimum.

This cell serves as the label for the minimum value you use in the filter calculation.
2. Click cell I5 and type Maximum.

This cell serves as the label for the maximum value you use in the filter calculation.
3. Click cell 34 and type 10.

This cell serves as the minimum value you use in the filter calculation.
4. Click cell 35 and type 15.

This cell serves as the maximum value you use in the filter calculation.
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Create a filter expression based on minimum and maximum values
Create minimum and maximum values in the cells of the exploration sheet to use in the filter expression.

Procedure

1. From the exploration bar, click Filter and then click Edit/Add filter.
The Filter window appears.
2. Click Edit/Add filter.
The Edit Filter window appears.
. Click Enter a cell reference.
. In the GO Sales (query) pane, click Unit price - Unit cost.
. In the operator box, click > (Greater Than).
. In the cell reference box, which appears after the operator, type J4, and then click OK.
The Edit Filter window closes.
7. Click the Add a Filter Line icon.
The Edit Filter window appears.
8. Click Enter a cell reference.
9. In the GO Sales (query) pane, click Unit price - Unit cost.
10. In the operator box, click <(Less Than).
11. In the cell reference box, which appears after the operator, type 35, and then click OK.
The Edit Filter window closes.
12. Click OK.
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Results

You observe that the results of the list exploration change because of the filter expressions you create.
You limit items in the list exploration because of the minimum and maximum values that you control as
static values in the cells of the exploration sheet.

By limiting the data in your exploration, you are better able to focus on key performance indicators. You
can add filter expressions to limit data to specific dates by adding filter lines that use the Introduction
date.

Create an Exploration View using a custom set of members

In this topic, you learn how to create an Exploration View that includes a custom set that you design.

You use custom sets to group members for specific reporting requirements. For example, you want to
focus the results from sales visits in a set of countries from the Asia Pacific region. You create a custom
set that includes the required countries and then add the custom set to a report.

It should take 15 to 20 minutes to complete this topic. To view the completed report, download the
CustomSet.x1ls sample workbook. The sample workbook has formatting applied in Microsoft Excel and
will not exactly match the worksheet you create.

Before you begin

The sample package must be set up on the IBM Cognos Analytics system. You access the sample
workbooks from the installation location of the IBM Cognos Analytics samples. Contact your administrator
for the URL required to connect to the IBM Cognos Analytics system and the location of the sample
workbooks.

Procedure

1. Connect to the IBM Cognos Analytics system and open the Sales and Marketing (cube) package.
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The default location for the sample package is Public Folders>Samples_Office>Cubes.
2. Create an Exploration View.
3. Ensure that the Insert Member with Children option is enabled.
4. Add the following data items to the report:
 Products to the Rows drop zone
« Time to the Columns drop zone
« Revenue to the Measures drop zone
5. Expand Order Method, and then drag Sales Visit to the Context area.
6. Create a custom set from the Asia Pacific dimension.

Select Japan, Korea, China, and Singapore. Right-click a selected member and click New Set. Save
the set as East Asia.
7. From the Custom Sets folder, drag East Asia to the rows area after Products.

Note that the Exploration View reflects only the retailers in East Asia. That means Australia, which was
an original member of the Asia Pacific dimension, is not a member of the East Asia custom set.

Results

A custom set is associated with the user that creates the custom set. The next time you open the Sales
and Marketing package, the custom set will be available for use in other reports. The custom set is not
available when a different user opens the package.

To edit a custom set, right-click the custom set and click Edit Set. If you edit a custom set, or if there are
changes to the members used in the custom set, the change is not applied to a report when you refresh
data. To update a report, delete the original custom set from the report and then add the changed custom
set.

If you need more help, see the following topics:

 “Create an exploration” on page 147

« “Custom sets” on page 163

Create sets in Exploration Views and Quick Reports

Use the set editor to create dynamic expressions that allow you to refresh reports to show the latest data.
The learning objectives for this tutorial are:

« Learn the features of the set editor
« Learn how to create dynamic expressions
« Learn how to use the set editor with Quick Reports

This tutorial uses the sample package plan_BudgetPlan.

Create an Exploration View
Create an Exploration View as part of your budget analysis. Use Exploration Views to show information in
a compact form where intersecting rows and columns show summarized information.

The Exploration View that you create contains data from the Planning Sample model, which contains
budget information. You learn how to create an Exploration View from a chart of accounts with net
operating income.
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Start IBM Planning Analytics for Microsoft Excel and load the sample budget plan
Load the IBM TM1 budget plan so that you can work with it during the tutorial.

Procedure

1. Start IBM Planning Analytics for Microsoft Excel.

2. From the IBM Planning Analytics tab, click Connect and select the server that has the IBM TM1
sample data.

3. From the list of packages, click Planning Sample, and then click OK.

Create a budget Exploration View
Create an Exploration View from the sample budget plan.

Procedure

1. From the IBM Planning Analytics tab, click Exploration.
2. Drag the following items to the Context drop zone from the source tree:
a) Click plan_version > plan_version > Members and then drag the FY 2004 Budget member to the
Context area.

b) Click plan_business_unit > plan_business_unit > Members > 10000 > 10100 and then drag the
10110 member to the Context area.

c) Click plan_department > plan_department > Members > 1000 > 100 and then drag the 105
member to the Context area.

d) Click plan_exchange_rates > plan_exchange_rates > Members and then drag the local member
to the Context area.

e) Click plan_source > plan_source > Members > budget and then drag the input member to the
Context area.

3. Add the year 2004 to the Columns drop zone.
Click plan_time > plan_time > Members and then drag the 2004 member to the Columns drip zone.
4. Add net operating income to the Rows drop zone.

Click plan_chart_of_accounts > plan_chart_of_accounts > Members and then drag the Net
Operating Income member to the Rows drop zone.

Work in the set editor

After you create a basic Exploration View, use the set editor to create a more complex Exploration View by
using more advanced features of the set editor.

Insert the 2004 members dynamically from the set editor
The first example is to make the year, 2004, dynamic and bring in its children.

Procedure

1. From the Columns drop zone, click the drop-down menu that is associated with the 2004 member,
and then click Edit Set.
The set editor opens.

2. In the Selection pane, right-click 2004, and click Insert Options > Insert Member With Children.

3. To inspect the dynamic expression that you created, from the set editor toolbar, click m Show MDX.

The Edit MDX window opens and you can see that the expression displays: 13 [plan_time].
[2004], [plan_time].[2004] .CHILDREN%}?

4. To save the MDX expression and close the Edit MDX window, click OK.
5. To save your work in the set editor and close the set editor window, click OK.
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Replace the Net Operating Income item with its component items from the set editor window
Work with the plan_chart_of_accounts dimension on the rows axis. Work with the Net Operating Income
item in the set editor.

Procedure

1. From the Rows drop zone, click the drop-down menu that is associated with the Net Operating
Income item, and then click Edit Set.
The subset editor window opens.

2. In the Selection pane, click the Net Operating Income item, and then press the Delete key.

3. In the Available Members pane, expand plan_chart_of accounts and then expand Net Operating
Income.

You see the three component items, Revenue, COS, and Operating Expense.
4. From the toolbar, click the Insert Type icon, and then click Insert Single Member.
5. Select Revenue, COS, and Operating Expense, and then click the add arrow.

The selected items display in the Selection pane. To select multiple items, press Shift and click the
items.

6. To make the COS item dynamic, right-click the COS item, click Insert Options, and then click Insert
Member With Children.

7. To save your work in the subset editor and close the subset editor window, click OK.

Notice that the item names after the COS item display as account IDs. Use the subset editor again to
change the appearance.

8. From the Rows drop zone, click the drop-down menu that is associated with the Net Operating
Income item, click Set Alias, and then click AccountName.

Notice that the item names after the COS item display as account names instead of account IDs.

Create Quick Reports
Convert the Exploration View to a Quick Report. A Quick Report is useful when you present data or send
workbooks to other team members who do not have IBM Planning Analytics for Microsoft Excel.

You can work with the set editor to add items to a Quick Report.

Convert the Exploration View to a Quick Report
Use the subset editor with Quick Reports to add or remove items on the column or row axis.

You can also use it to create a data validation cell on a context member. While in a Quick Report, you can
add items by typing item names into the cells within the named range or by using the subset editor. To
remove items, you can delete columns or rows by using Microsoft Excel commands or by using the subset
editor. When you use the subset editor with a Quick Report, you can interact with it the same way as with
explorations. The only exception is that any dynamic members are converted to static members after you
exit the editor and apply it to a Quick Report.

Procedure

1. On the Exploration toolbar, click % and click Convert to Quick Report > On New Sheet.
2. Right-click Q1-2010, click IBM Cognos Analysis, and then click Replace Members.
The subset editor opens.
3. From the toolbar, click the Filter icon.
The filter controls and filter box display after the toolbar.
4. In the filter box, type Q1 and press the Enter key.
All the items in the plan_time dimension that contain Q1 display.

5. In the Search Results pane, click Q1-2011 and then click the Add icon to add these items to the
Selection pane.

6. Click the Insert Type icon and then click Insert Member With Children.
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7. Click OK.
After Q1-2010, the Q1-2011 component items display.

8. In cell A3, right-click the 10110 item, click IBM Cognos Analysis, and then click Replace Members.
The subset editor window opens.

9. From the Available Members pane, expand plan_business_unit and then expand the 10000 item.

10. Select 10100, 10200, 10300, and 10400 and then click the add icon to add these members to the
Selection pane.

11. Click OK.
Cell A3 is now a selector.
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Chapter 14. Troubleshoot

Use troubleshooting information as a resource to help you solve specific problems you may encounter
during or after the installation of IBM Planning Analytics for Microsoft Excel.

For more information, see “What are some common errors when installing Planning Analytics for
Microsoft Excel?” on page 273

Troubleshoot a problem

Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to
determine why something does not work as expected and how to resolve the problem.

The first step in the troubleshooting process is to describe the problem completely. Problem descriptions
help you and the IBM technical-support representative know where to start to find the cause of the
problem. This step includes asking yourself basic questions:

What are the symptoms of the problem?
« Where does the problem occur?

When does the problem occur?

Under which conditions does the problem occur?

Can the problem be reproduced?

The answers to these questions typically lead to a good description of the problem, which can then lead
to a resolution of the problem.

What are the symptoms of the problem?

When starting to describe a problem, the most obvious question is "What is the problem?" This question
might seem straightforward; however, you can break it down into several focused questions that create a
more descriptive picture of the problem. These questions can include:

« Who, or what, is reporting the problem?
« What are the error codes and messages?

« How does the system fail? For example, is the problem a loop, hang, crash, performance degradation, or
incorrect result?

Where does the problem occur?

Determining where the problem originates is not always easy, but it is one of the most important steps in
resolving a problem. Many layers of technology can exist between the reporting and failing components.
Networks, disks, and drivers are only a few of the components to consider when you are investigating
problems.

The following questions help you to isolate the problem layer:

- Is the problem specific to one platform or operating system, or is it common across multiple platforms
or operating systems?

« Is the current environment and configuration supported?

If one layer reports the problem, the problem does not necessarily originate in that layer. Part of
identifying where a problem originates is understanding the environment in which it exists. Take some
time to completely describe the problem environment, including the operating system and version, all
corresponding software and versions, and the hardware. Confirm that you are running within an
environment that is supported; many problems can be traced back to incompatible levels of software that
are not intended to run together or have not been fully tested together.

© Copyright IBM Corp. 2009, 2019 269



When does the problem occur?

Develop a detailed timeline of events leading up to a failure, especially for cases that are one-time
occurrences. You can most easily develop a timeline by working backward: Start at the time an error was
reported (as precisely as possible, even down to the millisecond), and work backward through the
available logs and information. Typically, you need to look only as far as the first suspicious event that you
find in a diagnostic log.

To develop a detailed timeline of events, answer these questions:

« Does the problem happen only at a certain time of day or night?

How often does the problem happen?

What sequence of events leads up to the time that the problem is reported?

Does the problem happen after an environment change, such as an upgrade or an installation of
software or hardware?

Under which conditions does the problem occur?

Knowing which systems and applications are running at the time that a problem occurs is an important
part of troubleshooting. These questions about your environment can help you to identify the cause of the
problem:

« Does the problem always occur when the same task is being performed?
« Does a certain sequence of events need to occur for the problem to occur?
« Do any other applications fail at the same time?

Answering these types of questions can help you explain the environment in which the problem occurs
and correlate any dependencies. Remember that just because multiple problems might have occurred
around the same time, the problems are not necessarily related.

Can the problem be reproduced?

Problems that you can reproduce are often easier to solve. However, problems that you can reproduce can
have a disadvantage. If the problem as a significant business impact, you do not want it to recur. If
possible, re-create the problem in a test or development environment, which typically offers you more
flexibility and control during your investigation. Answer the following questions:

« Can the problem be re-created on a test system?
- Are multiple users or applications encountering the same type of problem?

« Can the problem be re-created by running a single command, a set of commands, or a particular
application?

Get fixes

A product fix might be available to resolve your problem.

Procedure

To find and install fixes:

1. Determine which fix you need by using Fix Central (opens in new window) (http://www.ibm.com/
support/fixcentral/)

2. Download the fix. Open the download document and follow the link in the "Download package"
section.

3. Apply the fix by following the instructions in the "Installation Instructions" section of the download
document.

4. Subscribe to receive weekly email notifications about fixes and other IBM Support information.
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Contact IBM Support

IBM Support provides access to a variety of IBM resources for help with software questions.

Before you begin

After trying to find your answer or solution by using other self-help options such as technotes, you can
contact IBM Support. Before contacting IBM Support, your company must have an active IBM
maintenance contract, and you must be authorized to submit problems to IBM. You should also have the
following information at hand:

* Your customer identification number

« Your service request number, if it is an ongoing service request
« The phone number where you can be reached

« The version of the software you use

- The version of the operating environment you use

A description of what you were doing when the problem occurred

The exact wording of any error messages that display

Any steps you took to attempt to solve the problem

For information about the types of available support, see the Support portfolio topic in the Software
Support Handbook (opens in new window).

Procedure

Complete the following steps to contact IBM Support with a problem:

1. Define the problem, gather background information, and determine the severity of the problem. For
more information, see the Getting IBM support (opens in new window) topic in the Software Support
Handbook.

2. Gather diagnostic information.
3. Submit the problem to IBM Support in one of the following ways:

« Using IBM Support Assistant (ISA): Use this feature to open, update, and view an Electronic Service
Request with IBM. Any data that has been collected can be attached to the service request. This
expedites the analysis and reduces the time to resolution.

« Online through the IBM Support Portal (opens in new window): You can open, update, and view all
your Service Requests from the Service Request portlet on the Service Request page.

« By phone: For the phone number to call, see the Directory of worldwide contacts (opens in new
window) web page.

Results

If the problem that you submit is for a software defect or for missing or inaccurate documentation, IBM
Support creates an Authorized Program Analysis Report (APAR). The APAR describes the problem in
detail. Whenever possible, IBM Support provides a workaround that you can implement until the APAR is
resolved and a fix is delivered. IBM publishes resolved APARs on the IBM Support Web site daily, so that
other users who experience the same problem can benefit from the same resolution.

Exchange information with IBM

To diagnose or identify a problem, you might need to provide IBM Support with data and information from
your system.

In other cases, IBM Support might provide you with tools or utilities to use for problem determination.
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Send information to IBM Support

To reduce the time that it takes to resolve your problem, you can send trace and diagnostic information to
IBM Support.

Procedure

To submit diagnostic information to IBM Support:

1. Open a problem management record (PMR). You can use the IBM Support Assistant (opens in new
window) or the IBM Service Request tool (opens in new window).

2. Collect the diagnostic data that you need. Diagnostic data helps reduce the time that it takes to resolve
your PMR. You can collect the diagnostic data manually or automatically.

3. Compress the files by using the TRSMAIN or AMATERSE program. Download the free utility from the
IBM web site to the IBM Cognos system and then install the utility using the TSO RECEIVE command.

4. Transfer the files to IBM. You can use one of the following methods to transfer the files to IBM:

« The Service Request tool (opens in new window)
« Standard data upload methods: FTP, HTTP

« Secure data upload methods: FTPS, SFTP, HTTPS
« Email

If you are using an IBM Cognos product and you use ServicelLink / IBMLink to submit PMRs, you can
send diagnostic data to IBM Support in an email or by using FTP.

All of these data exchange methods are explained on the IBM Support site (opens in new window).

Receive information from IBM Support

Occasionally an IBM technical-support representative might ask you to download diagnostic tools or
other files. You can use FTP to download these files.

Before you begin

Ensure that your IBM technical-support representative provided you with the preferred server to use for
downloading the files and the exact directory and file names to access.

Procedure

To download files from IBM Support:

1. Use FTP to connect to the site that your IBM technical-support representative provided and log in as
anonymous. Use your email address as the password.

2. Change to the appropriate directory:
a) Change to the /£romibm directory.

cd fromibm
b) Change to the directory that your IBM technical-support representative provided.
cd nameofdirectory
3. Enable binary mode for your session.
binary
4. Use the get command to download the file that your IBM technical-support representative specified.
get filename.extension
5. End your FTP session.

quit
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Subscribe to Support updates

Stay informed about IBM products that you use by subscribing to updates.

About this task

By subscribing to receive updates, you can receive important technical information and updates for
specific Support tools and resources. You can subscribe to updates by using one of two approaches:

RSS feeds and social media subscriptions

The following RSS feeds and social media subscriptions are available:

 RSS feed for the Support site for IBM Cognos Analysis for Microsoft Excel
« RSS feed for the Support site for IBM Cognos TM1
 RSS feed for the Support site for IBM Cognos Analytics

« RSS feed for a developerWorks® forum

For general information about RSS, including steps for getting started and a list of RSS-enabled IBM
web pages, visit the IBM Software Support RSS feeds (opens in new window) site.

My Notifications

With My Notifications, you can subscribe to Support updates for any IBM product. You can specify that
you want to receive daily or weekly email announcements. You can specify what type of information
you want to receive, such as publications, hints and tips, product flashes (also known as alerts),
downloads, and drivers. My Notifications enables you to customize and categorize the products that
you want to be informed about and the delivery methods that best suit your needs.

Procedure

To subscribe to Support updates:

1.
. Click Other, in the top navigation pane.

. Click My Notifications.

. Find the product that you want to subscribe to in the Product lookup: search box.
. Select the document types that you want to receive notifications for.

. Click Submit.

. Click Delivery preferences.
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Open the IBM Support Portal.

. Ensure that your e-mail address is correct and define the frequency, format, and language that you

want to receive notifications in.

. Click Submit.

Results

You're now subscribed to support updates for your product. Until you modify your RSS feeds and My
Notifications preferences, you will continue to receive notifications. You can modify your preferences
when needed (for example, if you stop using one product and begin using another product) from the My
Notifications page.

What are some common errors when installing Planning Analytics for
Microsoft Excel?

This section lists the most common errors that you might encounter.
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Configuration Issues
These issues are related to configuration and setup.

Convert to Formulas does not show value

You can create an Exploration View without experiencing an error, but when you convert that exploration
sheet to formulas, cells no longer display values properly. In one of the cells that has no value, you click
the cell and it shows the COGVAL formula, such as =COGVAL($C$1, $C$2, $B10, C$8, $B%$8). Attempting
to do this on another workstation you find that values are displayed correctly. If a user with administrative
rights to the workstation attempts to convert to formulas, the values are displayed correctly in the cells of
the worksheet.

The user did not use Microsoft Excel before IBM Planning Analytics for Microsoft Excel was installed and
did not get registered properly. There are two ways to resolve this problem. You can give the affected user
local administration rights to the workstation or you can run the file Register Cognos XLL.vbs, which will
add the proper registry entries for the new user.

For the Register Cognos XLL.vbs file process to work (both during the installation of the software or when
run separately to add a new user) the Microsoft Excel registry entries must have been created by
Microsoft Excel itself. You must ensure that the user run Microsoft Excel first, before attempting to add
registry entries for IBM Planning Analytics for Microsoft Excel. You can examine the ntuser.dat that the
script writes to check whether the user has been properly added.

Update server and package designations to make a server available

After changing the gateway alias or switching from a test to a production environment you receive the
following error message advising you that the server is not available and that the Cognos gateway is
unable to connect to the IBM Cognos Analytics server.

SERVER_NOT_AVAILABLE: The Cognos gateway is unable to connect to the Cognos Analytics server. The
server may be unavailable or the gateway may not be correctly configured.

This is probably caused by a change in the gateway URL.

Update the server and package designation in a workbook to switch from a test to a production
environment or to access information from a different set of financial data, such as a submission.

Procedure
1. Optionally, you can update information in cell references.

- From the worksheet you want to update, open the new server and package.

« From the Information folder, drag the updated server and package metadata to the server or
package cell.

2. Optionally, you can update information in embedded text.

« Use the Microsoft Excel search and replace function to update embedded references in the text of
cell formulas.

The Cognos Office interface fails to initialize in Microsoft Office

IBM Cognos Office may not initialize when the Microsoft .NET Framework is not installed or the version is
not correct. The required Microsoft .NET Framework version is 4.6.1 or later. Another possible reason for
this condition is that the add-in is either not installed or not registered.

If you are running the wrong version of Microsoft .NET Framework, uninstall it and then reinstall
Microsoft .NET Framework.
To install the IBM Cognos add-in, run the installation program.

Before you attempt to install Microsoft .NET Programmability Support, you must have installed
Microsoft .NET Framework.
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Cognos for Microsoft Office Fails to Initialize

If you use Internet Explorer to browse IBM Cognos Analytics and open a workbook, document, or
presentation published by IBM Cognos for Microsoft Office, the document launches in Microsoft Office,
but without full functionality.

To configure Internet Explorer to open Microsoft Office files in Microsoft Office instead of in Internet
Explorer, you must use the Folder Options tool to update browse options. It is also possible to do this in
Windows Registry.

Procedure

1. Open My Computer.

2. From the Tools menu, click Folder Options.

3. On the File Types tab, under Registered file types, click Microsoft Excel Worksheet, and then click
Advanced.
The Edit File Type dialog box appears.

4. Clear the Browse in same window check box and click OK.

5. Complete the same steps for Microsoft Office PowerPoint presentations and Microsoft Office Word
documents.

Microsoft Office does not open a Microsoft Office document published from Cognos Office

If you observe Microsoft Office trying to open a published document twice when you double-click the
workbook, document, or presentation from Microsoft Windows Explorer, the file association is either
corrupted or not installed properly.

There are two options to resolve this issue. You can start the Microsoft Office application first, and then
open the document using the Open command from the File menu, or you can reregister the file type.

Re-register file types with a Microsoft Office program

When you are not able to open a Microsoft Office document even though it is associated with the correct
file type, you must re-register the file type with the appropriate Microsoft Office program, such as Excel,
Word, or PowerPoint.

About this task

In these steps, program.exe is a placeholder for the executable file for the Microsoft Office program that
you want to re-register. If you installed Microsoft Office to another location, use the path that is correct for
that location.

Note: If you are using the command line on version 7 of Microsoft Windows operating system, you must
elevate the rights of the command line to perform certain tasks, such as re-registering file types. To open
an elevated command prompt, or a command prompt in Administrator mode, right-click the command
prompt shortcut, and select Run as Administrator.

Procedure

1. From the Start menu, click Run.
2. To disassociate the program version, in the Open box, type the following command, and then click OK:

program.exe/regserver
3. To specify the default version, from the Start menu, click Run.
4. In the Open box, type the following command, and then click OK:

program.exe/regserver

Unable to Open Published Microsoft Office Documents from Cognos Connection
If the browser does not prompt you to open or save the workbook, document, or presentation, it may
mean that the option to prompt before opening was cleared. Reset this option.

You must enable the File Download and Automatic prompting for file downloads in Internet Explorer.
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Confirm opening of documents
The procedure to confirm opening of documents is as follows.

Procedure

1. Start the Windows Control Panel.
2. Double-click Folder Options.

3. From the File Types tab, in the Registered file types list, click Microsoft Excel Worksheet, and then
click Advanced.

4. Ensure that the Confirm open after download check box is selected and click OK.

5. Repeat steps 3 and 4 for other Microsoft Office documents that are supported in IBM Cognos Office,
such as Microsoft Office Excel Template, Microsoft PowerPoint Presentation, Microsoft Office
PowerPoint Template, Microsoft Word Document, and Microsoft Office Word Template.

6. Click Close.

Reset internet security options
The procedure to reset internet security options is as follows.

Procedure

1. Start Internet Explorer.
2. From the Tools menu, click Internet Options.

3. From the Security tab, click the Web content zone for which you are updating these options, and then
click Custom Level.

4. Scroll down to the Downloads section and click Enable for the File download and Automatic
prompting for file downloads options.
5. Click OK twice.

.NET Messages are not in the installed .NET Framework language
When you install a non-English version of .NET Framework in a non-English operating system, you will
notice that the error messages, .NET shortcut, and .NET Console are in English.

To solve this issue, you must apply the .NET Framework Language Pack for your language.

The subkey numbers relate to the language. For example, English, French, German, and Japanese are
listed here: 1033=en-en, 1036=fr-fr, 1031=de-de, and 1041=ja. Refer to the Microsoft Support Site to
obtain subkey numbers for other languages.

If you are missing the language pack subkeys, you must install the .NET language pack, which is available
from the Microsoft support Web site.

Workbook closes unexpectedly
If you install the COM add-in and your Microsoft Excel workbook name contains a square bracket, Excel
stops responding or closes unexpectedly after opening.

To resolve this problem, rename the workbook so that it does not contain square brackets.

Reports unavailable in Cognos Connection jobs after using Save As command in Cognos Report
Studio

After opening a report in IBM Cognos Report Studio and saving a copy using the Save As command, you
may find that if the report is included in a job, it is not available in the IBM Cognos Connection portal.

Do not use the Save As command in IBM Cognos Report Studio to save changes when a report is included
in a job. Instead, make a copy of the report, make changes to the copy, and then copy the updated report
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to the IBM Cognos Connection portal. Use this method to overwrite the report in the job without breaking
the report links.

The content of the Custom Report shows #NAME?
When building a Custom Report, the content of the cells shows #NAME?

When you drag items from the source tree directly to a cell of a worksheet, you are creatinga COGNAME
or COGVAL formula that references the item in the database. This functionality is available only when the
CognosOfficeUDF.Connect automation add-in is loaded.

If #NAME? appears in the contents of the cell, it means that the add-in was not loaded and the
CognosOfficeUDF.Connect check box in the Add-in dialog box (Tools, Add-Ins) is not selected.

To resolve this issue and ensure that the add-in is always properly loaded, you must verify that the value
of the OPEN registry key is set to /A "CognosOfficeUDF.Connect". If you use version 7 of Microsoft
Windows operating system, you must use Run in XP from the command prompt to reregister file types.

Procedure

1. From the Windows Start menu, click Run.
2. In the Open box, type Regedit, and then click OK.
3. In the Registry Editor, go to the Registry branch:

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\version\Excel\Options
4. In the topic area, right-click the OPEN entry, and then click Modify.
5. In the Value Data box, type

/A "CognosOfficeUDF.Connect"
6. Click OK, and then close the Registry Editor.

Processing issues
The following issues are related to processing and rendering reports.

Improve performance for TM1 data

If you experience unacceptable performance when you work with TM1 data, the administrator of the TM1
system might be able to change cube or system settings to improve performance. To help the TM1
administrator evaluate the performance issue, provide the administrator with the details of the data you
are using and a description of actions that result in unacceptable performance.

The following are examples of TM1 settings that affect performance.

VMM (JCubeProperties)
For each cube, this property determines the amount of RAM reserved on the server for the storage of
stargate views. The more memory made available for stargate views, the better performance will be.
Sufficient memory must be available for the TM1 server to load all cubes.

VMT (}CubeProperties)
If the time required to calculate a cube view surpasses the specified threshold, TM1 attempts to store
a stargate view. If there is not enough memory available to store the stargate view, TM1 purges the
oldest stargate view that is not currently in use, and continues to purge views in this manner until
sufficient memory is made available.

The IBM Cognos TM1 Operation documentation includes more information about the CubeProperties and
other tuning options.

DPR-ERR-2079 Firewall Security Rejection
If you run a report after your session has expired and then try to navigate away from the first page of the
report, you encounter an error.

DPR-ERR-2079 Firewall Security Rejection. Your request was rejected by the security firewall. CAF
rejection details are available in the log. Please contact your administrator.
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When the DPR-ERR-2079 error occurs after an expired session, you must log on again to resolve the
problem.

Procedure

1. In the report list, right-click the node item, which appears before other items.
2. Click Log On.
3. Provide your authentication credentials as prompted and click OK.

Item cannot be expanded

Microsoft Excel has reached the maximum number of rows or columns for this worksheet. The number of
rows and columns is limited in Microsoft Excel. Expanding the current item is not possible because it
would shift rows or columns beyond this worksheet limit. Microsoft Excel cannot shift nonblank cells off
the worksheet.

Manually move items so that the row or column item can expand without reaching the limit, or move your
Exploration View, list, or report to another worksheet. Or, you can move the data to a new location and try
again.

Results have exceeded the Excel row or column limit
Microsoft Excel has reached the maximum number of rows or columns for this worksheet. The number of
rows and columns is limited in Microsoft Excel. Items are truncated.

Filter items so that the row or column items can be displayed without reaching the limit. Consider creating
additional Exploration Views, lists, or reports to spread the data over more than one worksheet. Consider
using a new version of Microsoft Excel that has larger limits for rows and columns.

Error: Exception from HRESULT:<location>
If you import a data item where the path to the data item exceeds 256 characters it results in the error:
Exception from HRESULT.

You must create names and unique data identifiers that keep to the 256-character limit inside Microsoft
Excel.

Error refreshing exploration saved in earlier version of Microsoft Excel
This workbook may have been created with an older version of Microsoft Excel that has a set maximum
number of rows or columns. Rows or columns that go beyond the maximum limits are truncated.

Although you are no longer using that version, the application is working within the limits of the older
version of Excel. You might encounter this situation when you are expanding items or when you are
refreshing items that have grown in size since the workbook was created.

To correct the problem, you must save the workbook with the .xlsx extension. Opening the workbook that
contains the exploration in a more recent version of Excel does not convert it to the new format. Saving
the workbook with the .xlsx extension converts the workbook to the new format.

Security Issues
The following issues are related to security setup.
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Cognos Office Unable to Create Trust Relationship

If you are using HTTPS to Report Data Service and you receive an error in IBM Cognos Office about being
unable to trust the relationship, the Certificate Authority (CA) certificate that was issued by the Web
server is not trusted on the client workstation.

To resolve this problem, you must ensure that the Certificate Authority (CA) that issued the Web server
certificate is also trusted on the client workstation. If the certificate is not from an authority that is already
trusted on the client, such as Verisign, you must install the CA certificate in the trust store on the client.

Procedure

1. Retrieve the CA certificate from the issuing authority.
The file has a .cer extension. This is not the same certificate as the one used by the Web server. It is
the certificate for the issuing authority itself.

2. Double-click the .cer file, click Install Certificate, and then click Next.

3. Click Place all certificates in the following store.

4. Click Browse, click Trusted Root Certification Authorities, and then click Next.

5. Click Finish.

Unable to View Reports After Clicking View Report

IBM Cognos for Microsoft Office is functioning normally, but you cannot use the View Report option to
view reports. The client machine, running IBM Cognos for Microsoft Office, cannot connect to the gateway
URL as configured in IBM Cognos Analytics. This may be because it is behind a firewall, the
hostname/DNS is not known to this client machine, or the client machine has proxy issues.

To resolve the connectivity issues, work with your system administrator.

Cognos Office Numbered Error Messages
The following error messages may appear in a dialog box and are recorded in the IBM Cognos Office log.

COI-ERR-2002 Block type is not valid
An internal processing error occurred. The block object was not able to be processed.

Contact IBM Cognos Resource Center. Be ready to supply all relevant logs and details related to this error.

COI-ERR-2003 Unexpected type: stacked block
An internal processing error occurred. The data object was not of the expected type and could not be
processed.

Contact IBM Cognos Resource Center. Be ready to supply all relevant logs and details related to this error.

COI-ERR-2005 This version of Microsoft Office is not supported
IBM Cognos Office supports only specific versions of Microsoft Office applications.

Load the report content into one of the supported applications and environments.

To review an up-to-date list of environments supported by IBM Cognos Office products, including
operating systems, patches, browsers, web servers, directory servers, database servers, and application
servers, go to the IBM Support Portal for IBM Cognos Analysis for Microsoft Excel or the IBM Support
Portal for IBM Cognos for Microsoft Office.

COI-ERR-2006 This Microsoft Office product is not supported

IBM Cognos Office supports only specific Microsoft Office applications, such as Microsoft Excel, Microsoft
Word, and Microsoft PowerPoint. You cannot load IBM Cognos Office content to another Microsoft Office
application, such as Microsoft Access even when there is an add-in that enables these applications to
interoperate.

Load the report content into one of the supported applications and environments.

To review an up-to-date list of environments supported by IBM Cognos Office products, including
operating systems, patches, browsers, web servers, directory servers, database servers, and application
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servers, go to the IBM Support Portal for IBM Cognos Analysis for Microsoft Excel or the IBM Support
Portal for IBM Cognos for Microsoft Office.

COI-ERR-2008 Unable to Retrieve from Resources. Tried '{0}
An internal processing error occurred.

Contact IBM Cognos Resource Center. Be ready to supply all relevant logs and details related to this error.

COI-ERR-2009 Unable to Perform This Operation Because Microsoft Excel is in Edit Mode
Report content cannot be refreshed while one of the cells of the workbook is being edited.

Click outside the active cell to return it to a non-edit mode and try again.

COI-ERR-2010 The name {0} is not valid. A name must not contain both a quote () character and an
apostrophe (') character

When you create a folder, rename a folder, or publish a document, the name can contain an apostrophe or
a quote, but not both.

To resolve this problem, rename the folder or document. Exclude the apostrophe or quote character from
the name.

COI-ERR-2011 The server did not return the expected response. Check that the gateway is valid.
This error message is displayed if the value entered in the System Gateway URI box of the Options dialog
box is not a valid IBM Cognos Analytics server.

To resolve this problem, reenter the System Gateway URI with the gateway address for a valid IBM
Cognos BI server.

COI-ERR-2013 Unable to load metadata
You may be unable to load metadata because you do not have security rights to all of the items in the
worksheet or because the items were removed or changed on the server.

Ensure that you have security rights to all of the items that you are trying to view. If this does not fix the
problem, ensure that the server and package information are correct and that any items that have been
removed from the source database are also removed from the worksheet.

COI-ERR-2015 There was a problem parsing the MIME encoded server response. Tried to find the
boundary [{0}] but found the boundary [{1}] instead

While using GZip compression, an option for compressing data that is retrieved from the server, an error
occurred. The codes to decompress the data are missing or unrecognized by IBM Cognos Office.

Turn compression off. Although compression is turned on by default, it can be turned off by setting the
UseGzipCompression property to false in the CommManagerSettings.xml file, which, by default, is located
in the Office Connection directory, such as C:\Documents and Settings\user name\Local Settings
\Application Data\Cognos\Office Connection or C:\Users\user name\AppData\Local\Cognos\Office
Connection.

Turn compression off if you need to run tests or perform troubleshooting.
To turn gzip compression off set the following attribute:

<setting name="UseGzipCompression">False</setting>

COI-ERR-2016 Worksheet protected, IBM Cognos styles cannot be populated
If the worksheet is protected, the IBM Cognos styles cannot be applied.

You must unprotect the worksheet for the styles to be applied during a refresh of the data.
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COI-ERR-2019 Connection failed
In Planning Analytics for Microsoft Excel, when you try to connect to a IBM Planning Analytics server, the
following error message appears:

COI-ERR-2019 Connection failed. Connection returned an error. Verify that the connection string,
including the server name and port number, is correct.

To resolve this issue, you must configure your antivirus software to allow connections from both
Microsoft .NET Runtime and Microsoft Excel.

COI-ERR-2305 Unable to perform this operation because Microsoft Excel is in edit mode
Report content cannot be refreshed while one of the cells of the workbook is being edited.

Click outside the active cell to return it to a non-edit mode and try again.
COI-ERR-2307 Login failed
Your user name and password are not correct.

Ensure that you typed a valid user name and password.

IBM Planning Analytics for Microsoft Excel numbered error messages
The following error messages may appear in a dialog box and are recorded in the IBM Cognos Office log.

COR-ERR-2004 Axis specification is not valid

The workbook specification is not capable of being generated because of an anomaly.
To fix the problem, you may attempt to do any of the following:
- Click Undo.

« Click Clear All Data.

« Close the workbook and open it again.

The workbook should now accept data from the source tree.
COR-ERR-2007 Error retrieving from resources. Tried '{0}'
The exploration sheet experienced a bad state.

Contact IBM Cognos Resource Center.

COR-ERR-2009 Name formula is not valid

The COGNAME formula did not parse correctly. It may have been altered manually and may have a
missing argument.

Check the COGNAME formula in the active cell and ensure that it is in the correct format, or optionally,
insert the member from the source tree.

COR-ERR-2010 Formula is not valid
If an argument to a COGNAME or COGVAL formula references a cell and that cell does not contain the
expected string formula you receive this error.

Check the cell and its dependents. Look for #REF or #VALUE in the cell. The contents of the cell may have
accidentally been deleted.

COR-ERR-2011 Invalid range: Please enter a valid range for crosstab or list

The range is not valid or is outside of the range of the data type.

To avoid this limitation, limit your data selections.

COR-ERR-2013 Exploration cannot be converted to formula based because at least one context item
contains a selection

With more than one item in the Context drop zone there is no way for the multiple items to be rendered
into the cells of the worksheet.
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Remove one dimension from the Context drop zone. You must have one item per dimension to convert to
a formula-based analysis.

COR-ERR-2014 Due to Excel worksheet limitations the results may be truncated
If the data that you receive back exceeds the row or column limits of Microsoft Excel, the result is
truncated. You receive this message to make you aware of the truncation.

To avoid this limitation, limit your data selections.

COR-ERR-2015 The current exploration cannot be rendered at this location on the worksheet
The exploration cannot write data outside the limits of the current worksheet. Either the exploration is too
large for Microsoft Excel or you have designated a starting location too close to the limit.

Try to move your start location. If that fails to fix the problem, try creating an Exploration View with fewer
rows or columns.

COR-ERR-2016 Unable to retrieve package <Name>
After you selected a package using the Open Package dialog box, an error occurred when trying to
download the package from the server.

This is an internal error.

Contact IBM Cognos Resource Center.

ValueNotInPickList (243)
The value you are trying to commit is not an available option in the picklist.

When entering a value into a report cell, ensure that the value is an available option in the picklist.

Microsoft Excel limits

There are specifications and limits in Microsoft Excel 2013-2016 that may affect the performance of
Planning Analytics for Microsoft Excel.

The following tables group the specifications and limits into categories:

« Worksheet and workbook
« Calculation

Table 58: Specifications and limits that apply to worksheets and workbooks

Specification Maximum limit / restrictions Notes

Column width 255 characters If the data that you enter or receive
exceeds the column limits of
Microsoft Excel, the result is
truncated.

Row height 409 points If the data that you enter or receive
exceeds the row limits of Microsoft
Excel, the result is truncated.

Total number of characters that a 32,767 characters If the data that you enter or receive

cell can contain exceeds the cell character limits of
Microsoft Excel, the result is
truncated.
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Table 58: Specifications and limits that apply to worksheets and workbooks (continued)

Specification

Maximum limit / restrictions

Notes

Maximum limits of memory storage
and file size for Data Model
workbooks

32-bit environment is subject to 2
gigabytes (GB) of virtual address
space, shared by Excel, the
workbook, and add-ins that runin
the same process. A data model’s
share of the address space might
run up to 500 — 700 megabytes
(MB), but could be less if other data
models and add-ins are loaded.

64-bit environment imposes no
hard limits on file size. Workbook
size is limited only by available
memory and system resources.

Due to the limitations with add-ins,
users can only copy and paste once
on top of a DBRW formula.

Adding tables to the Data Model
increases the file size. If you don’t
plan to create complex Data Model
relationships using many data
sources and data types in your
workbook, uncheck the Add this
data to the Data Model box when
you import or create tables, pivot
tables, or data connections.

Table 59: Specifications and limits that apply to calculations

Specification

Maximum limit / restrictions

Notes

Length of formula contents

8,192 characters

If the formula that you enter
exceeds the formula content limit
of Microsoft Excel, the result is
truncated.

Internal length of formula

16,384 bytes

If the formula that you enter
exceeds the internal length of
formula limit of Microsoft Excel, the
result is truncated.

Number of arguments that
worksheet functions can contain

30

Due to a limitation with Microsoft
Excel, worksheet functions can
contain no more than 30
arguments. When you construct a
cube reference,

one argument must be the cube
name, which leaves 29 arguments
for specifying the cube dimensions.
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Appendix A. Sample reports and packages

The IBM Cognos for Microsoft Office products include sample reports and packages that are based on the
sample company, The Sample Outdoors Company. After the samples are set up, you can find the samples
in Public Folders in IBM Cognos Connection, and in the source tree on the IBM Cognos pane.

The Sample Outdoors Company

The Sample Outdoors Company samples illustrate product features and technical and business best
practices.

You can also use them for experimenting with and sharing report design techniques and for
troubleshooting. As you use the samples, you can connect to features in the product.

The Sample Outdoors Company, or GO Sales, or any variation of the Sample Outdoors name, is the name
of a fictitious business operation whose sample data is used to develop sample applications for IBM and
IBM customers. Its fictitious records include sample data for sales transactions, product distribution,
finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or
transaction values, is coincidental. Unauthorized duplication is prohibited.

Samples outline
The samples consist of the following:

« Two databases that contain all corporate data, and the related sample models for query and analysis
« Sample cubes and the related models

« A metrics data source including associated metrics and a strategy map for the consolidated company,
and a model for Metric extracts.

« Reports, queries, query templates, and workspaces

To run interactive reports, scripts are required. To see all the reports included in the samples packages,
copy the files from the samples content installation into deployment folder and then import the
deployments into IBM Cognos Analytics.

Security
Samples are available to all users.

To implement security, see the IBM Cognos Analytics Administration and Security guide.

The Sample Outdoors Group of Companies

To make designing examples faster, especially financial examples, some general information about The
Sample Outdoors Company is useful.

To look for samples that use particular product features, see the individual sample descriptions in this
section.

Revenue for The Sample Outdoors Company comes from corporate stores and from franchise operations.
The revenues are consolidated from the wholly-owned subsidiaries. There are six distinct organizations,
each with its own departments and sales branches. Five of these are regionally-based companies.

The sixth company, GO Accessories:

« Has its own collection of products, differentiated from the other GO companies by brand, name, price,
color and size.

« Sells from a single branch to all regions and retailers.
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« Functions both as an operating company based in Geneva, and as a part owner of the three GO
subsidiaries in Europe.

The following diagram illustrates the consolidated corporate structure of the Sample Outdoors Company.
The diagram also includes the percentage changes in ownership for GO Central Europe, and the reporting
currency and GL (general ledger) prefix for each subsidiary. In year 1, GO Asia Pacific owns 60% of GO
Central Europe, and in year 3, its ownership decreases to 50%. In year 1, GO Accessories owns 40% of
GO Central Europe, and in year 3 its ownership increases to 50%.

Sample Outdoors Consolidated ‘

{holding company) USD

G0 Americas
(AN 109 USD

G0 Asia Pacific
EAX 4199) YEN

G0 Accessories

(EUX §199) EURD iy
Year 3 50%
Year 1 40%

Year 3 509 GO Central Europe
(CEU &1%49) EURO

GO Southern Europe
(SEU 7% EURO

| GO Northern Earope
(MNEL 5199) EURO

Figure 17: Consolidated corporate structure of the Sample Outdoors Company

Each corporation in the Sample Outdoors Company has the same departmental structure and the same
general ledger (GL) structure, as shown in the following table. Divisions may not report in the same
currencies. For example, the Americas subsidiary reports in US dollars, but the Corporate division local
currency reports in Canadian dollars, and the Operations division local currency is pesos.

Table 60: Departmental structure

Division (GL) Department (GL)

Corporate (1700) Sales (1720)
Marketing (1750)
IS&T (1760)

Human Resources (1730)
Finance (1740)
Procurement (1710)

Operations (1800) Production and Distribution (1820)
Customer Service (1820)
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Each corporation has a complete chart of accounts. Most of the accounts, such as those under non-
personnel expenses, are at the department level, and contain only summary amounts. For example,
although each marketing department has expenses, the cost is unspecified at the transaction level where
marketing promotions occur.

Employees

The Sample Outdoors data contains a full list of employees in all divisions, departments, and locations.

Data is available for reports about bonuses (Global Bonus report) and sales commissions (Sales
Commissions for Central Europe report), training (Employee Training by Year report), and performance
reviews and employee satisfaction surveys (Employee Satisfaction 2012). If you use Metric Studio,
sample metrics for human resources are also available.

In the GO Data Warehouse (analysis) package, groups of measures and the related dimensions are
organized into folders. The employees are organized in hierarchies for region and manager, to make
different kinds of aggregation easy to report on. Aggregation has been defined for the Employee Position
Summary measures, so that Position count and Planned position count aggregate correctly at each level
of time: monthly, quarterly, or yearly. For example, see the Planned Headcount report.

The employees are also listed in a sample LDIF file which could be used for any LDAP IBM product
authentication including Tivoli®. This authentication directory is necessary for IBM Cognos Planning
samples. No other samples depend on security profiles.

Sales and marketing

Data about sales and marketing is available for all of the companies in the Sample Outdoors group.

GO Accessories has richer details to support analysis examples. For example, see the Revenue vs % Profit
Margin by Product Brand analysis, based on the Sales and Marketing cube. Marketing and sales
campaigns are tied to the Sample Outdoors regional companies.

Overall, the GO companies have experienced solid growth across most product lines (Sales Growth Year
Over Year), in all regions (Revenue by GO Subsidiary 2011), because of factors like an increase in repeat
business and new or improved products, such as the high margin sunglasses product line. In the product
lines sold by the five regional companies (all but GO Accessories) promotions have had mixed success
(Promotion Success by Campaign, Bundle and Quarter). If you use Metric Studio, this can also be seen in
the sample metrics.

Customer surveys

The data also contains information from customer surveys. For example, the product line that includes
bug spray, sun screen, and so on has not been successful (Product Satisfaction - Outdoor Protection
2011) and a source of retailer dissatisfaction may be the level of customer service rather than the returns
(Customer Returns and Satisfaction). If you use Metric Studio, this information can also be monitored in
metrics.

Sales outlets

Revenue from the corporate outlets is available at the transaction level. Revenue from the franchise
outlets is available at the consolidated level only (Sales and Marketing cube). Metrics about retailers show
that the number of new retail outlets has dropped over the time period covered by this data.

GO Accessories sells worldwide, and sells only accessories. Transaction data for GO Accessories is the
primary source for analysis of product by brand, color and size. The other five subsidiaries in the group of
companies are regional and sell all product lines for retailers in their region. For example, the report Top
10 Retailers in 2011 uses sparklines and list data to review revenues at the retailer level.
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Sample Outdoors database, models, and packages

The Sample Outdoors Framework Manager models illustrate modeling techniques and support the
samples.

The models are based on the GO data warehouse and the GO sales transactional database and are the
basis for the sample reports and queries. Each model contains two packages for publishing analysis
(dimensional) and query views of the data.

You must have access to Framework Manager, the modeling tool in IBM Cognos Analytics, to look at the
sample models. You may also need to set up the sample databases and connections.

GO Data Warehouse

The GO Data Warehouse model, great_outdoors_data_warehouse.cpi, is based on the database
GOSALESDW. It contains data about human resources, sales and marketing, and finance, grouped into
business areas. In the Database view, the three business areas are grouped into separate namespaces.
The Database view contains a fourth namespace (GO Data) for the common information.

The Database view is very similar to the structure of the underlying database. All tables (database query
subjects) are unchanged. This enables IBM Cognos Analytics to retrieve metadata directly from the
package in most cases, instead of using a metadata call to the database. The following changes and
additions have been made in the Database view:

« Joins have been added as necessary.

- To allow for aggregation at different levels of granularity, some model query subjects have been created.
For example, see the relationships between Time and Sales or Sales fact.

« To allow single joins to be made between the lookup tables and each level in a dimension, lookup tables
have been copied. For example, see the Products look up tables.

The Business view contains only model query subjects, with no joins. The following changes and additions
have been made in the Business view:

« Calculations were added to the model query subjects. For example, the time dimension contains
language calculations.

- Where the database has multiple hierarchies, new dimensions have been created to organize each
hierarchy. For example, the employee hierarchies are organized into several categories, such as
manager and region.

The GO Sales transactional database

The GO Sales model, great_outdoors_sales.cpi, is based on the GOSALES database, which is
structured as a transactional database. It contains principally sales data.

The Database view is very similar to the underlying database structure. The following changes and
additions have been made in the Database view:

« To make it possible to join the fact tables to the time dimension, model query subjects and multipart
joins have been used.

« Other joins have been added as necessary.

The Business view contains only model query subjects, with no joins. The following changes and additions
have been made in the Business view:

« Calculations were added to the model query subjects.

« Model query subjects that were created in the Database view to enable joins on the time dimension
have been linked as reference shortcuts.
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- Where the database has multiple hierarchies, new dimensions have been created to organize each
hierarchy.

- Sales Staff is a subset of the slowly changing Employee dimension. There is no unique Employee key in
GO Sales, so a filter retrieves the current record only. This model does not use historical data.

The samples PowerCubes

The following cubes are delivered with the Sample Outdoors samples in English, French, German,
Japanese and Chinese:

« sales_and_marketing.mdc

- employee_expenses.mdc

- go_accessories.mdc

e go_americas.mdc

« go_asia_pacific.mdc

- great_outdoors_sales_en.mdc
- great_outdoors_7.mdc

The samples packages

The Sample Outdoors samples include six packages. A brief description of each available package is
provided.

Go Data Warehouse (analysis) is a dimensionally modeled view of the GOSALESDW database. This
package can be used in all studios, including IBM Cognos Analysis Studio. Using this package you can drill
up and down.

Go Sales (analysis) is a dimensionally modeled view of the GOSALES database. This package can be used
in all studios, including Analysis Studio. Using this package you can drill up and down.

Go Data Warehouse (query) is a non-dimensional view of the GOSALESDW database. This package can be
used in all studios except Analysis Studio, and is useful for reporting when there is no need for drilling up
and down.

Go Sales (query) is a non-dimension view of the GOSALES database. This package can be used in all
studios except Analysis Studio, and is useful for reporting when there is no need for drilling up and down.

Sales and Marketing (cube) is an OLAP package, based on the sales_and_marketing.mdc cube.
Great Outdoor Sales (cube) is an OLAP package, based on the great_outdoors_sales_en.mdc cube.

Note: The OLAP packages, Great Outdoor Sales (cube) and Sales and Marketing (cube), are not
multilingual. The IBM_Cognos_PowerCube. zip archive contains five versions of each package; one in
English, French, German, Japanese and Chinese.

Samples in the GO Data Warehouse (analysis) package

The following are some of the reports found in the GO Data Warehouse (analysis) package and GO Office
Report Samples.

Sample reports and packages 289



Employee Satisfaction Workspace

This workspace shows different measures of employee satisfaction, like training, bonuses, and employee
survey scores. The bonus list is filtered by country.

Return Quantity by Order Method

This report shows quantity sold, number of returns, and percentage of returns (with those greater than
5% highlighted) by return reason for each product in the Outdoor Protection product line. This report uses
the following features:

- filters

- lists

- conditional highlighting
« grouping

Return Quantity by Product Line Chart

This pie chart report shows return quantities of product lines for all subsidiaries.

Revenue Data Workspace

The workspace shows revenue by region, by country and product type (filtered with multiple values check
boxes), and by order method.

Samples in the GO Data Warehouse (query) package

The following reports are some of the reports found in the GO Data Warehouse (query) package and GO
Office Report Samples.

Baselines

This chart report shows the numeric baselines, mean and percentage, based on prompt values that are
used to filter on years.

Bursted Sales Performance Report

This list report shows how to burst a sales performance report to a manager of Northern Europe sales
staff. To successfully burst this report, IBM Cognos 10 must be configured to use an email server. This
report uses the following features:

- lists

- bursting

« conditional highlighting

- filters

- calculations

e summarizing

- blocks

 custom headers and footers
- sorting

grouping

Samples in the Sales and Marketing (Cube) package

The following reports are some of the reports found in the Sales and Marketing (Cube) package and GO
Office Report Samples.
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Revenue by Product Brand

This report shows the revenue and gross profit by product filtered by the product brand. There is always
product turnover, so the report conditionally highlights products that are discontinued. This report uses
the following features:

. lists

- filters

« prompts

- combination charts
« bar charts

« HTML items

- grouping

- sorting

- axis titles

Samples in the GO Sales (analysis) package

The following reports are some of the reports found in the GO Sales (analysis) package and GO Office
Report Samples.

Sales Summary

This report summarizes revenue and gross profit and shows the top sales representatives by revenue and
quantity sold. This report uses the following features:

- lists

- filters

« combination charts

- axis titles

 custom headers and footers
- conditions

Samples in the GO Sales (query) package

The following reports are some of the reports found in the GO Sales (query) package and GO Office Report
Samples.

Horizontal Pagination

This report shows a very wide Exploration View rendered across several horizontal pages. The first
Exploration View shows the fit-to-page behavior, while the second Exploration View shows the horizontal
pagination.

This report uses the following features:
- multiple pages

- horizontal pagination

« Exploration Views

 custom headers and footers
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No Data

Each page of this report presents a different option for dealing with a No Data condition. It also generates
invoices of sales for the Order Invoices - Donald Chow, Sales Person report in the GO Sales (query)
package.

This report uses the following features:

Exploration Views

 custom headers and footers
- nodata

- lists
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Appendix B. Accessibility features

IBM Planning Analytics for Microsoft Excel has accessibility features that help users who have a physical
disability, such as restricted mobility or limited vision, to use information technology products
successfully.

The following list includes the major accessibility features :
 You can use accelerators and command keys for navigation.

In Microsoft Windows, press the Alt key, then the accelerator to trigger an action; for example, Alt+F
shows the File menu. If they are enabled, you can use extended accelerators as well.

« IBM Planning Analytics for Microsoft Excel uses Microsoft Active Accessibility (MSAA). This means that
people with limited vision can use screen-reader software, along with a digital speech synthesizer, to
listen to what is displayed on the screen.

- IBM Planning Analytics for Microsoft Excel supports your system's display settings, such as color
scheme, font size, and high-contrast display.

« IBM Planning Analytics for Microsoft Excel provides text through standard system function calls or
through an API (application programming interface) that supports interaction with assistive technology,
such as screen-reader software. When an image represents a program element, the information
conveyed by the image is also available in text.

https://helpline.hursley.ibm.com has other features that you can customize to fit your individual needs:

« “Increase font size for future sessions” on page 300

« “View explorations in Windows high contrast mode” on page 300

Keyboard navigation

You can use keyboard shortcuts to navigate and perform tasks. If an action you use often does not have a
shortcut key, you can record a macro in Microsoft Excel to create one.

This product uses standard Microsoft Windows navigation keys in addition to application-specific keys.

Note: The keyboard shortcuts are based on U.S. standard keyboards. Some of the content in this topic
may not be applicable to some languages.

Access and use menus

Keyboard shortcuts allow you to access menus and the IBM Planning Analytics ribbon without using a
mouse or other pointing device.

Note: Shortcut keys may vary depending on the individual setup and operating systems used.

Table 61: IBM Planning Analytics ribbon

Action Shortcut keys

Start IBM Planning Analytics for Microsoft Excel or | ALT+Y, to place focus on the IBM Planning
IBM Cognos for Microsoft Office. Analytics tab in the ribbon.
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Table 61: IBM Planning Analytics ribbon (continued)

Action

Shortcut keys

When an item on the IBM Planning Analytics tab is
selected, select the next or previous button or
menu on the tab.

LEFT ARROW, RIGHT ARROW, UP ARROW, or
DOWN ARROW

Select the first or last command on the menu or HOME or END
submenu.

Open the selected menu, or perform the action for |ENTER

the selected button or command.

Open the context menu for the selected item or SHIFT+F10
area of focus.

Close an open context menu. ESC

Access and use the task pane

Keyboard shortcuts allow you to access the task pane without using a mouse or other pointing device.

Table 62: Task pane

Action

Shortcut keys

Selecting a database to log onto.

Note: A menu or the IBM Planning Analytics tab
must be active when performing this action.

Office 2013 and 2016 users:

- Move the focus to the task pane by holding Shift
and pressing F6 3 times.

Note: The focus will be moved to the task pane,
however, there is no visual representation to
indicate this.

« Select the server by pressing tab 2 times. The
Open icon will be highlighted. Press SPACE and
then press the DOWN ARROW to open and
navigate the sub menu.

« Select the database by pressing the RIGHT
ARROW and then pressing ENTER.

When the task pane is active, select a component,
such as IBM Planning Analytics for Microsoft Excel
or IBM Cognos for Microsoft Office

Office 2013 and 2016 users:
LEFT ARROW or RIGHT ARROW
Office 2010 users:

CTRL+TAB

LEFT ARROW or RIGHT ARROW
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Table 62: Task pane (continued)

Action

Shortcut keys

When the IBM Cognos Office pane is active, select
the next or previous option in the pane.

Office 2013 users:

TAB
Office 2010 users:
CTRL+TAB
Place the focus on the metadata tree. CTRL+M, T
Place the focus on the overview area of an CTRL+M, U
Exploration View.
Place the focus on the IBM Planning Analytics tab. |ALT+Y, 2

Use filter window

Keyboard shortcuts allow you to use the Edit Filter window without using a mouse or other pointing

device.

Table 63: Edit Filter window

operators are active, compress the expression.

Action Shortcut keys
When the Edit Filter window is active, change the |TAB

focus on controls by moving between buttons, filter

lines and conjunctions, which are the AND and OR

operators.

Toggle the expression between AND and OR when | SPACE KEY

a conjunction control is active.

When a conjunction control, such as AND and OR LEFT ARROW

MINUS KEY (-) on the numeric keypad

When a conjunction control, such as AND and OR
operators are active, expand the expression.

RIGHT ARROW
PLUS KEY (+) on the numeric keypad

Use windows

Keyboard shortcuts allow you to access dialog boxes without using a mouse or other pointing device.
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Table 64: Dialog boxes or windows

Action Shortcut keys
Move to the next option or option group. TAB

Move to the previous option or option group. SHIFT+TAB
Move between options in an open drop-down list, | Arrow keys

or between options in a group of options.

Perform the action for the selected button, or SPACEBAR

select or clear the selected check box.

Open the context menu, if it is closed, and move to
that option in the context menu.

SHIFT+F10, then press the first letter of an option
in a drop-down list

Open the selected drop-down list.

DOWN ARROW

First letter of an option in a drop-down list

Close the selected drop-down list.

Office 2013 users:
ESC
Office 2010 users:

First letter of an option in a drop-down list

Expand or collapse a folder.

Office 2013 users:
RIGHT ARROW, LEFT ARROW
Office 2010 users:

CTRL+ENTER
Cancel the command and close the window. ESC
Open the Select Package dialog box. CTRL+M, O
When the Open dialog box is active, open the ENTER

selected report locally.

When the Select Package dialog box is open,
select a package.

Office 2013 users:

TAB, to place focus on the System box
DOWN ARROW, to select a Cognos system
ENTER to view the packages

Office 2010 users:

TAB, to place focus on the System box

ENTER to view the packages

When the Publish dialog box is active and the
appropriate folder is expanded, publish the
selected Microsoft Office document.

After selecting the file name, tab to the Publish
button and press ENTER.
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Table 64: Dialog boxes or windows (continued)

Action

Shortcut keys

In IBM Cognos for Microsoft Office, move to a tab
page, such as the Browse Content or the Manage

Data page, on the IBM Cognos pane.

CTRL+TAB

Use tree view

Keyboard shortcuts allow you to access tree view without using a mouse or other pointing device.

Table 65: Tree view

Action

Shortcut keys

Move to the first selectable node.

If the node has children and the child node is
expanded, move to the first child node.

DOWN ARROW

Move to the next selectable node.

UP ARROW or DOWN ARROW

Expand the selected node, or move to the first RIGHT ARROW
selectable child node

Collapse the selected node, move to the parent LEFT ARROW
node, or move to the first selectable node.

Move to the first node in a tree control. HOME

Move to the last node in a tree control. END

Use report options

Keyboard shortcuts allow you to perform report actions.

Table 66: Report options

Action Shortcut keys
Rebuild a Dynamic Report. ALT+F9
Perform drill through ALT+Y, 2,D
Undo the most recent action in the exploration CTRL+M, Z
Redo the most recent action in the exploration CTRL+M, Y
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Table 66: Report options (continued)

Reports.

Action Shortcut keys
Expand or collapse a consolidated element in a CTRL+M, G
Dynamic Report

Edit the annotation for the selected cell CTRL+M, A
Commit the changed value for the selected cell CTRL+M, C
Hold the value in the selected cell, or release a CTRL+M, H
hold on a cell

Refresh the current Quick Report or Exploration CTRL+M, R
View.

Clear the data from the current Quick Report. CTRL+M, L
Refresh all Quick Reports on the worksheet CTRL+M, W
Show the properties for the current Quick Report. | CTRL+M, P
Commit changed values in the current Quick CTRL+M, C

Use the set editor

The following keyboard shortcuts allow you to use the set editor without using a mouse or other pointing

device.

Note: When an area of the screen has focus, it has a contrasting line around it. When you open the set
editor, the first highlighted item is the Available Members pane.

Table 67: Set editor

Action

Shortcut keys

Move between enabled items in the set editor

Press the Tab key to move to the next item.

Press Shift+Tab to go to the previous item.

Open a menu

With the focus on the menu, press Enter or the
Space bar.

Move through items in a menu and members

Press the up and down arrow keys. To move to a
sub menu, press the right-facing arrow key.

Select an option

Press Enter.

Select consecutive members

Highlight the first member that you want to select,
hold Shift, and then use the arrow keys to select
the next members.
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Table 67: Set editor (continued)

Action

Shortcut keys

Expand and collapse consolidated members

Press Enter, or the right arrow to expand
consolidated members, and press Enter or the left
arrow to collapse.

Show a context menu

Press Shift+F10. Use the up and down arrow keys
to move through the items.

Work in attributes menus

Tab to |II and press Enter. Press the up and
down arrow keys to move through the menu, and
press Enter to select an attribute. Tab to OK and
press Enter to close the menu.

Navigate in the MDX Editor

To move around the controls, press the Tab key to
move to the next control and press Shift+Tab to go
back to the previous control.

When the focus is inside the rich text editor, press
CTRL+F2 to move to the next control, and Shift
+CTRL+F2 to go to the previous control.

Supported languages

IBM Planning Analytics for Microsoft Excel supports different languages in its user interface as well as its

documentation.

The following table shows the languages supported in the user interface and in the documentation.

Table 68: Supported languages in Planning Analytics for Microsoft Excel.

Language

User interface

Documentation

Brazilian Portuguese

Croatian

Czech

Danish

Dutch

English

Finnish

French

German

IR AR IR AR IR JR< <

QODOVOOOO
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Table 68: Supported languages in Planning Analytics for Microsoft Excel. (continued)

Language User interface Documentation

Hungarian

Italian

Japanese

Kazakh

Korean

Norwegian (Bokmal)

Polish

Romanian

Russian

Simplified Chinese

Slovak

Slovenian

Spanish

Swedish

Thai

Traditional Chinese

Turkish

IR AN AR TN IR IR IR AN IR IR IR AR TN AN IR IN<
QOO DOOOOO

Interface information

The following sections describe various ways that you can customize your settings to make IBM Planning
Analytics for Microsoft Excel more accessible.

Increase font size for future sessions

It is best to change the size of your IBM Planning Analytics for Microsoft Excel fonts by changing your
display fonts in Windows. Changing your Windows display fonts affects all programs on your computer.
For more information, refer to Windows Help.

View explorations in Windows high contrast mode

Microsoft Windows users with low vision can make IBM Planning Analytics for Microsoft Excel easier to
view by enabling High Contrast Mode. For more information, see the documentation for your operating
system.
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Vendor software

IBM Planning Analytics for Microsoft Excel includes certain vendor software that is not covered under the
IBM license agreement. IBM makes no representation about the accessibility features of these products.
Contact the vendor for the accessibility information about its products.

IBM and accessibility

See the IBM Human Ability and Accessibility Center for more information about the commitment that IBM
has to accessibility.

http://www.ibm.com/able
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Appendix C. Rebrand Cognos Office Components

This section is intended for clients and partners who need to rebrand, customize, or localize labels,
messages, or other strings in IBM Cognos Office products, such as IBM Planning Analytics for Microsoft
Excel, IBM Cognos Office, and IBM Cognos for Microsoft Office.

Resource Files

All the customizable strings for IBM Cognos Office products are in XML-based resource (.resx) files.

The .resx resource file format consists of XML entries that specify objects and strings inside XML tags. One
advantage of a .resx file is that when opened with a text editor (such as Notepad) it can be written to,
parsed, and manipulated. When viewing a .resx file, you can see the binary form of an embedded object,
such as a picture when this binary information is a part of the resource manifest. Apart from this binary

information, a .resx file is readable and maintainable.

A .resx file contains a standard set of header information that describes the format of the resource
entries, and specifies the versioning information for the XML code that parses the data.

These files contain all the strings, labels, captions, and titles for all text in the three IBM Cognos Office
components. For each language, there are three files, one for each component. The following table

identifies each of the files.

Table 69: IBM Cognos Office resource files

Language

IBM Planning Analytics
for Microsoft Excel files

(internal name cor)

IBM Cognos for

Microsoft Office files

(internal name coc)

IBM Cognos Office files

(internal name coi)

Language Neutral

cormsgs.resx

cocmsgs.resx

coimsgs.resx

Chinese (simplified)

cormsgs.zh-cn.resx

cocmsgs.zh-cn.resx

coimsgs.zh-cn.resx

Chinese (traditional)

cormsgs.zh-tw.resx

cocmsgs.zh-tw.resx

coimsgs.zh-tw.resx

Croatian cormsgs.hr.resx cocmsgs.hr.resx coimsgs.hr.resx
Czech COrmsgs.cs.resx €cOCMsgs.cs.resx C0iMsgs.cs.resx
Danish cormsgs.da.resx cocmsgs.da.resx coimsgs.da.resx
Dutch cormsgs.nl.resx cocmsgs.nl.resx coimsgs.nl.resx
English cormsgs.en.resx cocmsgs.en.resx coimsgs.en.resx
Finnish cormsgs.fi.resx cocmsgs.fi.resx coimsgs.fi.resx

French cormsgs.fr.resx cocmsgs.fr.resx coimsgs.fr.resx

German cormsgs.de.resx cocmsgs.de.resx coimsgs.de.resx
Hungarian cormsgs.hu.resx cocmsgs.hu.resx coimsgs.hu.resx
Italian cormsgs.it.resx cocmsgs.it.resx coimsgs.it.resx
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Table 69: IBM Cognos Office resource files (continued)

Language IBM Planning Analytics | IBM Cognos for IBM Cognos Office files
for Microsoft Excel files | Microsoft Office files . .
(internal name coi)
(internal name cor) (internal name coc)
Japanese cormsgs.ja.resx cocmsgs.ja.resx coimsgs.ja.resx
Kazakh cormsgs.kk.resx cocmsgs.kk.resx coimsgs.kk.resx
Korean cormsgs.ko.resx cocmsgs.ko.resx coimsgs.ko.resx
Norwegian €Ormsgs.no.resx cocmsgs.no.resx €oimsgs.no.resx
Polish cormsgs.pl.resx cocmsgs.pl.resx coimsgs.pl.resx
Portuguese cormsgs.pt.resx cocmsgs.pt.resx coimsgs.pt.resx
Romanian COrmsgs.ro.resx COCMSZS.ro.resx C0imsgs.ro.resx
Russian COrmsgs.ru.resx cocmsgs.ru.resx coimsgs.ru.resx
Slovenian cormsgs.sl.resx cocmsgs.sl.resx coimsgs.sl.resx
Spanish COrmsgs.es.resx cocmsgs.es.resx coimsgs.es.resx
Swedish COrmsgs.sv.resx COCMSES.SV.resx €oimsgs.sv.resx
Thai cormsgs.th.resx cocmsgs.th.resx coimsgs.th.resx
Turkish cormsgs.tr.resx cocmsgs.tr.resx coimsgs.tr.resx

Run Cognos Office components in English in a localized Microsoft Windows
environment

You can display English in Cognos Office components in a Microsoft Windows environment that is
configured to use another language.

About this task

For example, if Microsoft Windows is set to use French, Cognos Office components also use French by
default. But you can configure Cognos Office components to use English instead of French.

Procedure

1. Close all Microsoft Office windows.

2. In Windows Explorer, navigate to the Cognos Office installation location.

Tip: On Windows 7, the default installation location is C: \Program Files (x86)\IBM\cognos
\Cognos for Microsoft Office.

3. Find the folder that corresponds to the locale you are using in Windows, for example, fr if you are
using French in Microsoft Windows.

4. Move the folder to a location outside of the Cognos Office installation location.
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Example

For example, if your Region and Language settings in Windows are set to French (France), but you want to
see English in IBM Planning Analytics for Microsoft Excel, move the fr folder outside of the Cognos for
Microsoft Office folder. When you open IBM Planning Analytics for Microsoft Excel, or any other
Cognos Office component, the user interface is in English.

Rebrand or Localize Cognos Office Components

If you are setting the IBM Cognos component for a multilanguage environment, you must compile both
the language-neutral file and the language file for your locale. The program detects the user locale
settings in Windows and uses the appropriate language file.

For example, suppose you installed IBM Planning Analytics for Microsoft Excel and your locale is set to
French (France). You must make changes to the language-neutral files: cormsgs.resx and coimsgs.resx,
and to the French files: cormsgs.fr.resx and coimsgs.fr.resx.

To customize or localize the component names and text messages, follow these steps:

 Edit the language-neutral resource files, and if necessary, the language resource files for your locale.

« Download and then run the Resource File Generator (Resgen.exe) required for compiling the updated
resource files.

» Test your work.

Editing the resource (.resx) files

For each component, there exists a set of files that support the various languages. The country or region
code distinguishes the filenames.

With the exception of the language-neutral set of files (cormsgs.resx, cocmsgs.resx, and coimsgs.resx)
that serve as the default files, each file follows the following naming convention:

componentcodemsgs.languagecode.resx
You can change strings, not icon or graphic resources.

When changing text strings, consider the string length. The width of fields were created using the existing
strings. Significantly increasing string length may result in some strings getting truncated in some of the
dialog boxes.

The resource file contains metadata and comments that can help you determine when and where strings
are used in the software.

Important: To edit XML resource files, use an XML editor. It is important to preserve the Unicode
encoding and format, including white space. Simple text editors will likely corrupt the files. A validating
XML editor ensures that the contents of the files are well formed and valid. Modify only string information.
Do not change other information in the files.

Procedure
1. Install the IBM Cognos Office components locally to a workstation.

This gives you access to the resource files.
2. Locate the resource files.

If you install locally and accept all the defaults, they are found in the following location:

[installation directory]\Program Files\IBM\cognos\Cognos for Microsoft
Officel\resouzces

3. In an XML Editor, open the componentcodemsgs.languagecode.resx file.

Use an editor such as Visual Studio or XMLSpy to change the branding details or to translate strings
into another language.
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If you are creating new language files, follow the naming convention by inserting the 2 or 5-character
language code into the middle of the file name. For example, if you add a Romanian language file for
IBM Cognos for Microsoft Office, you would save it as cocmsgs.10.resx.

4. Save the file.
5. Repeat steps 3 and 4 for each component file associated with the language that you want to translate.

Results
The updated resource files are now ready to be compiled.

Compile the updated resource files

Before you can deploy updated files, you must download the Resource File Generator (Resgen.exe). The
Resource File Generator converts .txt files and .resx (XML-based resource format) files to common
language runtime binary .resources files that you can embed in a runtime binary executable or compile
into satellite assemblies.

The Resource File Generator is a Microsoft .NET Framework Software Development Kit (SDK) program
that generates compiled resource files. The resgen executable is shipped with the Microsoft .NET SDK and
comes with Microsoft Visual Studio development system. You must choose a version of the Resource File
Generator that is compatible with the version of .NET Framework that is used by IBM Cognos Office
components.

Resgen.exe performs the following conversions:

« Converts .txt files to .resources or .resx files.
« Converts .resources files to text or .resx files.
« Converts .resx files to text or .resources files.

Procedure

1. Download the resgen.exe from the Microsoft .NET developer Web site.
2. After downloading the Resource File Generator, open a command prompt window.
3. Find the location where Resgen was downloaded.

For example, cd C:\Program Files\Microsoft Visual Studio 8\v2.0\Bin
4. To compile the resource files, from the command prompt, type

resgen /compile "[resx file location]\[file name.resx]"

For example, resgen /compile "c:\ProgramFiles\Cognos\Cafe\resources

\cormsgs.resx"

Resource files are automatically renamed to include the .resource extension in their file name.
5. Copy the resulting files to the Resouxces directory.

Test your work

To test your work, run IBM Cognos Office using a variety of locales and start each component (IBM
Cognos Office, IBM Cognos for Microsoft Office, and IBM Planning Analytics for Microsoft Excel) to ensure
that your changes are reflected in each area.

Check the text changes in all the interfaces exposed to your users. Pay particular attention to generic
dialog boxes, which are easy to miss.

306 IBM Planning Analytics: Planning Analytics for Microsoft Excel



Notices

This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be required to own a copy
of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.
This document may describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document.
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U.S.A.
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Legal and Intellectual Property Law
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Index

Special Characters

.NET Framework
troubleshooting 276
version 274
.NET programmability support 274
#NAME! 111
#NAME? 277
#VALUE! 111

A

access privileges, See security
action buttons
adding 184
appearance 189
copying 190
deleting 190
editing 190
mapping fields 187, 188
navigating to a worksheet 186, 189
overview 183

recalculating or rebuilding a worksheet 189

renaming 190

running a process 185, 189

understanding processing 183
add-ins

TM1 Perspectives add-in 110

TM1 worksheet functions add-in 110
adding

measures to an Exploration View 150
aggregation

samples and time dimensions 287

using filters for BI data 161
alternate hierarchies 150
annotations, See comments
API

Custom Report functions overview 223

Dynamic Report functions overview 220

exploration functions overview 204

global functions overview 194

importing automation macros 191

processing outside VBA 230

processing within VBA 230

Quick Report functions overview 210
API functions

Clear 205, 210

ClearAllData 194

ClearBook 194

ClearCache 194

ClearSelection 194

ClearSheet 195

ColumnHierarchies 210

Create 205, 211, 220, 223

CreatefromMDX 220, 223

CreateFromMDX 205, 212

Cube 212

API functions (continued)
Custom Report 223
Custom Reports 223
DataSource 213
Dynamic Reports 220-222
EnableIndents 213
Error 201
ExecuteFunction 224
ExecuteQuery 213
FormatAreaVisible 221
GetColumnSuppression 206
GetMDX 221
GetReport 211, 215
GetRowSuppression 206
GetSpecification 206, 215
GetTuple 214
GetValue 207
HTTPLogonCredentials 195
ID 215
Logoff 196
Logon 196
Name 216
Publish 197
Quick Reports 210, 213, 214, 218, 219
Rebuild 216, 222
RebuildSpecification 216
Refresh 207, 216, 222
RefreshAllData 198
RefreshAllDataAndFormat 199
RefreshSelection 199
RefreshSheet 200
Replace 216
ReplaceWithFormats 217
RowHierarchies 218
Select 218
SetColumnSuppression 208
SetRowSuppression 208
SetSlicer 218
SetSpecification 209
Settings 200
SetValue 209
SlicerHierarchies 219
SuppressMessages 201
SwapRowsAndColumns 207
Tracelog 201
Unlink 209
UnlinkAllData 202
UnlinkBook 202
UnlinkSelection 202
UnlinkSheet 203
UpdateServerUrl 203
UseServerFormats 219
Wait 204
application programming interface, See API
applications
setting up startup 21
asymmetrical Exploration Views
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asymmetrical Exploration Views (continued)
layouts 70
attributes
modifying 113, 114
retrieving 113
authentication
forms-based authentication 22
logging on 17
Auto prompts 26, 29, 31
auto spread 27
Automate_COI_Excel.vbs 232
Automate_COI.vbs 232
AutomateServerURLSample.vbs 232
automation
action buttons 224
Appending information into the log file 201
Applying server based formatting 219
applying zero-suppression 206
Clearing a selection 194
Clearing books 194, 204
clearing data values 194, 205
Clearing Quick Reports 210
Clearing sheets 195
clearing the cache 194
Create from MDX Custom Reports 223
Create from MDX Dynamic Reports 220
Creating Custom Report 223
Creating Dynamic Reports 220
Creating Exploration View 205
Creating QuickReports 211, 212
Defining subset and dimension properties 209
disconnecting link to IBM Cognos server 202
FormatAreaVisibleDynamic Reports 221
GetReport 211, 215
GetValue 207
logging errors 192
logging off all the IBM Cognos servers 196
logging on 196
overview 191
Rebuilding Dynamic Reports 222
Refresh 207
refreshing data 198, 199
Refreshing Dynamic Reports 222
refreshing formatting 199
Refreshing Quick Reports 216
Refreshing selections 199
Refreshing sheets 200
Replacing MDX 216, 217
Retrieving MDX Dynamic Reports 221
Retrieving Quick Report specifications 215
Retrieving rebuild specifications 216
running processes 57
sample macro files 231
security settings 191
Setting Quick Report slicer dimensions 218
Setting zero-suppression 208
SetValue 209
suppressing alerts and messages 201
Swapping rows and columns 207
tracking activities and errors 201
TurboIntegrator processes 224
Unlinking books 202
Unlinking data 209
Unlinking selections 202
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automation (continued)
Unlinking sheets 203
updating system URLs 203
using action buttons 183

base data 99,102
Baselines sample 290
batch processing 191
best practices
Exploration Views for BI
best practices 154
BI reports
Exploration Views 61, 149
lists 60, 147
BI servers
logging on 17
blank columns
adding an Excel calculation 73, 165
inserting into Exploration Views 65, 152
inserting into lists 61, 148
blank rows
adding an Excel calculation 73, 165
inserting into Exploration Views 65, 152
bottom or top values
viewing in TM1 Exploration Views 68
BulkUploadAutoCommitValid 109

C

CA reports
cell-based 165
cache
clearing 194
clearing in Planning Analytics for Microsoft Excel 22
calculations
adding to BI lists 148
adding to Exploration Views 66, 73, 151, 165
capability assignments 98
cell styles 69, 79
cell-based reports
clearing data 52
cells
annotating 108
colors for sandbox data 101
converting to snapshot 53
displaying data source 86, 140, 169
excluding from data spreading 103
grouping 72, 154
Certificate Authority (CA)
unable to create trust relationship 279
changes
committing to TM1 102
discarding sandbox data 101
previewing 102
Clear (API function) 205, 210
Clear Cache (API function) 194
ClearAllData (API function) 194
ClearBook (API function) 194
ClearSelection (API function) 194
ClearSheet (API function) 195
COGNAME




COGNAME (continued)

troubleshooting 170
Cognos Analysis servers

updating URLs 21
Cognos Analytics servers

connecting 16
Cognos Connection, See IBM Cognos Connection
Cognos Office Reporting TM1 add-in 110
Cognos systems

changing 159, 169
CognosOfficeAutomationExample.bas 191, 231
CognosOfficeAutomationExample.xls 224
CognosOfficeAutomationPPExample.bas 191, 231
CognosOfficeMessageSuppressor.cls 191, 231
CognosOfficeReportingSettings.xml

settings options for committing data 109
CognosOfficeTM1.x1l 110
CognosOfficeXLLSettings.xml 111
COGVAL

troubleshooting 170
ColumnHierarchies (API function) 210
columns

calculated 66, 73, 148, 151, 165

inserting in a Dynamic Report 85

inserting into Exploration Views 65, 152

inserting into lists 61, 148

limiting 68

nesting 65,153

renaming 61

sorting 148

swapping with rows 67, 159
Com Add-in

Excel workbook closes unexpectedly 276
comments

adding and editing 108
CommitWithoutConfirmation 109
compression

data queries 171
conditional formatting 73, 165
connections

adding 16
consolidation holds, See holds
content

automating 191
context

defining with formulas 141

filters 152
context area

using in TM1 Exploration Views 67
convert to formulas

errors 274, 278
Create (API function) 205, 211
Create(API function) 220, 223
CreateFromMDX (API function) 205, 212
CreatefromMDX(API function) 220, 223
CSV format 171
CSV formats 72, 154
cube

changing 73

changing for Quick Reports 80
Cube (API function) 212
cubes, See data sources
custom filters, See filters
Custom Report

Custom Report (continued)
#NAME? errors 277
best practices 170
changing the cube and datasource 91
changing the system and data source 169
converting to snapshot 53
creating from an Exploration View 166
creating from Exploration Views 90
creating from scratch 167
creating manually 91
displaying package 86, 140, 169
drilling down 169
example 168
expanding items 169
formulas 165
modifying DBRW formulas 140
overview 49, 165
refreshing 52
troubleshooting 170
Custom Reports
clearing 52
overview 47, 90
publishing 54
refreshing 52
custom sets
creating using items in a drop zone 163
creating using items in the source tree 164

D

dashboards, See see workspaces

data
adding to BI Exploration Views 157
base 99
clearing 52
committing to TM1 72,79, 102
converting to snapshot 53
discarding sandbox values 101
editing in a Quick Report 79
editing in a TM1 Exploration View 69
editing in TM1 102
filtering 152
finding 50
presenting for IBM Cognos Analytics 165
private 99
refreshing 52
restoring after clearing 52

data items
adding 150

data queries
compressing 171

data sets
large 171

data source
displaying for formulas cells 86, 140, 169
loading most recent 24

data sources
changing 18, 73, 159
changing for Quick Reports 80
dimensionally modeled relational (DMR) 56
logging on 17
OLAP 56
opening 17

data spreading
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data spreading (continued)
clearing 104
excluding cells 103
in TM1 reports 103
methods 104
overview 103
syntax 106, 107
datasource
refreshing 18
Datasource
connection 16
DataSource (API function) 213
datasources
changing 91
changing for Dynamic Reports 86
DBR
dragging members to modify 140
modifying 140
modifying a range 141
overview 112
DBRA
overview 113
DBRW
dragging members to modify 140
in Custom Report 91
in formula-based reports 90
modifying 140
modifying a range 141
overview 113
DBS 113
DBSA 114
DBSS 115
DBSW 116
default measures
changing 155
DFRST 116
dimensional data sources
using in a list 254
using in an Exploration View 251

dimensionally modeled relational (DMR) data sources, See

DMR
dimensions
nesting 65,153
overview 56
retrieving names of 129
retrieving the first member 116
retrieving the number of levels 118
retrieving the number of members 117
searching 50, 51
DIMIX 116
DIMNM 117
DIMSIZ 117
direct writeback method 98
direct writeback mode 99
DisableSandboxing parameter 99
display count
limiting 24

DTYPE 119

Dynamic Reports
adding multiple 82
changing context members 85
changing the cube and datasource 86
collapsing rows 84
creating 82
displaying data source 86, 140, 169
editing sets 85
expanding rows 84
formatting 87-89
inserting columns 85
inserting rows 86
overview 80
publishing 54, 89
rebuilding 83, 189
recreating 83
refreshing 52, 83, 189
suppressing zeros 85
TM1ELLIST 129
TM1GLOBALSANDBOX 132
TM1INFO 132
TM1RPTELISCONSOLIDATED 133
TM1RPTELLEV 134
TM1RPTELLSEXPANDED 134
TM1RPTFILTER 134
TM1RPTROW 135
TM1RPTTITLE 137
TM1RPTVIEW 137
TTM1PRIMARYDBNAME 133

Dynamic Reports Planning Analytics
overview 47

dynamic sets, See sets

E

ELCOMP 119

ELCOMPN 120
elements, See members
ELISCOMP 121
ELISPAR 122

ELLEV 123

ELPAR 123

ELPARN 124

ELSEN 125

ELWEIGHT 126

Employee Satisfaction Workspace sample 290

EnableIndents (API function) 213
enabling

AutoLogFile 192
equal across leaves spreading method 104
equal spreading method 104, 107
error messages

COI-ERR-2002 Block type is not valid 279
COI-ERR-2005 this version of Microsoft Office is not

supported 279

COI-ERR-2006 This Microsoft Office product is not

DMR . supported 279

filter expressions 160 COI-ERR-2008 Unable to retrieve from resources 280
DNEXT 118 COI-ERR-2009 Unable to perform this operation
DNLEV 118 because Microsoft Excel is in Edit mode 280
Double-click 30 COI-ERR-2010 The name {0} is not valid. A name must
DPR-ERR-2079 error 277 not contain both a quote (") character and an
drop zones 8 apostrophe () character 280
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error messages (continued)
COI-ERR-2011 The server did not return the expected
response 280
COI-ERR-2016 Worksheet protected, IBM Cognos styles
cannot be populated 280
COI-ERR-2305 Unable to perform this operation
because Microsoft Excel is in Edit mode 281
COI-ERR-2307 Login Failed 281
Convert to Formulas does not show value 274
COR-ERR-2004 Axis specification is not valid 281
COR-ERR-2007 error retrieving from resources 281
COR-ERR-2009 Name formula is not valid 281
COR-ERR-2010 Formula is not valid 281
COR-ERR-2011 Invalid range: Please enter a valid range
for crosstab or list 281
COR-ERR-2013 exploration cannot be converted to
formula based 281
COR-ERR-2014 Due to Excel Worksheet Limitations the
Results May Be Truncated 282
COR-ERR-2015 The current exploration cannot be
rendered at this location on the worksheet 282
COR-ERR-2016 Unable to retrieve package 282
Error: Exception from HRESULT:<location> 278
Excel workbook closes unexpectedly 276
IBM Cognos Office fails to initialize in Microsoft Internet
Explorer 275
IBM Cognos Office Fails to Initialize in Microsoft Office
274
IBM Cognos Office unable to create trust relationship
279
Microsoft Office Excel does not open a workbook
published from IBM Cognos Office 275
reports unavailable in IBM Cognos Connection jobs after
using Save As command in IBM Cognos Report Studio
276
Results have exceeded the Excel row or column limit
278
server not available 274
This item cannot be expanded 278
unable to open published Microsoft Office documents
from IBM Cognos Analytics 275
unable to view reports after clicking view report 279
ValueNotInPickList (243) 282

errors
resolving data commit errors 108

examples
Custom Report 168
logging on with VBA 230
macros 231
VBS 230
VBS scripts 232

ExecuteFunction (API function) 224

ExecuteQuery (API function) 213

expand direction 72, 154

Expand direction 25

Expanding consolidated members 30

expired sessions 277

Exploration Views
converting 82
layouts 70
relational data 252

Exploration Views for BI
adding calculations 73, 165
best practices 154

Exploration Views for BI (continued)
creating 147
drilling down 157
filtering 152
inserting hierarchies 150
inserting members 155, 157
inserting rows and columns 65, 152
nesting data 252
nesting rows and columns 153
overview 49, 61, 149
publishing to IBM Cognos Connection 56
removing measures from 150
renaming rows or columns 158
reordering rows or columns 159
selecting measures 150
sorting rows 158
swapping rows and columns 67, 159
Exploration Views for IBM Cognos Analytics
adding calculations 66, 151
converting to aCustom Report 166
Exploration Views for Planning Analytics
overview 47
Exploration Views for TM1
adding calculations 66, 73, 151, 165
adding comments to cells 108
changing the system and data source 73, 159
committing data 72
converting 75
converting to formulas 90
converting to snapshot 53
creating from scratch 62
creating from views 62
drilling down 69
editing data 69
filtering data 67
inserting members 63, 64
inserting rows and columns 65, 152
limiting items 68, 157
nesting rows and columns 65
publishing 54
renaming rows or columns 65
reordering rows or columns 65
resolving data errors 108
setting options 72, 154
setting options for committing data 109
sorting rows 67
spreading data 103
swapping rows and columns 67, 159
viewing top or bottom values 68
zero suppression 68, 153
Exploration Views forIBM Cognos Analytics
limiting items 157
explorations
changing the system and data source 73, 159
clearing data 52
converting 75
converting to other report type 71
converting to snapshot 53
copying and moving 54
creating 147
Custom Report 165
displaying the information area 73, 159
Dynamic Reports 80
editing TM1 data 102
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explorations (continued)
Exploration Views 61, 149
formula-based reports 90
lists 60, 72, 147, 154
publishing to IBM Cognos Connection 56
Quick Reports 74
refreshing 52
report types for BI data 49
report types for Planning Analytics data 47
spreading data (TM1) 103

F
file size
reducing 22
file types
registering 275
reregistering 275
filters
context 152

overview 160

top or bottom values 68
firewall security rejection 277
font colors 101
format definitions

applying 89

creating 89
format range 87-89
FormatAreaVisible(API function) 221
formats

CSV 72,154,171

raw XML 72, 154

refreshing 52
forms-based authentication 22
formula-based reports

creating from views 91

displaying data source 86, 140, 169

modifying SUBNM formulas 141
formulas

Custom Report 165

displaying data source 86, 140, 169
function editor 110, 140, 141

functions
Custom Report formulas 165
TM1109

G

GetColumnSuppression (API function) 206
GetMDX(API function) 221
GetReport (API function) 211, 215
GetRowSuppression (API function) 206
GetSpecification (API function) 206, 215
GetTuple (API function) 214
GO Data Warehouse (analysis) package (samples) 289
GO Data Warehouse (query) package (samples) 290
GO Sales (analysis) package 291
GO Sales (analysis) sample 291
GO Sales (query) package 291
growth percent spreading method 104, 107
GZip compression

CSV lists 171

316

H

hierarchies
inserting 150
overview 56

holds
applying to cells 103
syntax 107

Horizontal Pagination sample 291
HTTPLogonCredentials (API function) 195

I

IBM Cognos Analytics servers
changing 169
IBM Cognos BI gateway addresses 280
IBM Cognos Connection
downloading Microsoft Office documents 20
opening Microsoft Office documents 19
troubleshooting unavailable reports 276
unable to open published Microsoft Office documents
275
IBM Cognos for Microsoft Office
downloading documents in IBM Cognos Connection 20
firewall security rejection 277
unable to view reports 279
IBM Cognos Office
downloading documents in IBM Cognos Connection 20
failure to initialize in Microsoft Office 274
numbered error messages 279
security issues 278
supported Microsoft Office applications 279
troubleshooting opening published documents 275
IBM pane
overview 8
IBM Planning Analytics for Microsoft Excel
numbered error messages 281
IBM Planning Analytics tab
showing or hiding 10
IBM Planning Analytics Workspace 54, 89
IBM TM1 Perspectives
feature differences 11
opening reports 13
upgrading action buttons 14
ID (API function) 215
index
retrieving for a member 116
using to retrieve members 117
information area 73, 159
information folder 169
installations
COM add-in 274
Internet Explorer 275
items
searching for 51

K

Keep command 252
keep-only 68, 157
KEY_ERR 111



L

labels 72,154

language 304

languages
troubleshooting pack subkeys 276

large data sets
system optimization 171

layouts
Exploration View 70

leaf holds 107

level
hierarchies 56

Level based indents 36

levels
determining for members 123
finding the number of 118
inserting 64
inserting in BI Exploration Views 156
inserting members from multiple levels 63, 156
overview 56

lists
creating a sample list report 254
examples 254
refreshing 52
understanding 254

lists for BI
adding calculations 148
creating 147
inserting members 155, 157
nesting rows 153
optimizing 171
overview 49, 60, 147
publishing to IBM Cognos Connection 56
renaming rows or columns 158
reordering columns 159
sorting rows 148

lists for IBM Cognos Analytics
adding calculations 73, 165
CSV formatted 171
zero suppression 61, 149

lists for Planning Analytics
overview 47

lists for TM1
adding calculations 73, 165
converting to snapshot 53
creating from scratch 60
inserting columns 61, 148
inserting members 63
nesting columns 65
renaming columns 61
reordering columns 61
zero suppression 61, 149

local cache, See cache

localization 304

log files
enabling 22
viewing 22

Logoff (API function) 196

Logon (API function) 196

M

Macro trust access 13

macros
importing 191
sample files 231
security 191
MapAddedRowColumnStyle 76
match title elements 188
MDX expressions 92
measures
adding 150
adding to an Exploration View 155
default 155
removing from an Exploration View 150
member properties 56
members
adding to a Quick Report 76
adding to the context area 67
determining child members 121
determining level 123
determining name length 125
determining parents 122
determining the number of 117
determining the number of parents 124
determining the type 119
determining weight 126
folders 56
inserting from multiple levels 63, 156
inserting in a BI Exploration View 155-157
inserting in a TM1 exploration 63
inserting in a TM1 Exploration View 64
limiting 24, 68
renaming 65, 158
reordering 65, 159
replacing in a Quick Report 77
retrieving child members 119
retrieving parents 123
retrieving the index 116
retrieving the next 118
retrieving the number of 128
retrieving the number of children 120
retrieving using SUBNM 127
retrieving using the index 117
searching for 50
sorting by values 67
sorting by values or names 148, 158
viewing top or bottom values 68
metadata prompts 170
Microsoft Excel
#NAME? errors 277
clearing cell contents 52
conditional formatting 73, 165
inserting calculations 73, 165
refreshing content, troubleshooting 280, 281
row and column restrictions, resolving 278
workbook closes unexpectedly 276
Microsoft Internet Explorer
cannot initialize IBM Cognos Office 275
setting security options 275
Microsoft Office documents
downloading from IBM Cognos Connection 20
opening from IBM Cognos Connection 19
model
refreshing 18
models
logging on 17




models (continued)

sample models and packages 288
Models

opening workbooks 18

N

Name (API function) 216
named ranges
TM1RPTFMTIDCOL 137
TM1RPTFMTRNG 137
named sandboxes 98, 99
nest
rows and columns 65, 153
nested
Exploration View layouts 70
nested cells
setting label options for Exploration Views 72, 154
nesting
data in Exploration Views 252
No Data sample 292
non-English operating system
troubleshooting .NET Framework 276
null suppression, See zero suppression

o

OLAP
data sources 56
filter expressions 160
online analytical processing, See OLAP
options
setting for Planning Analytics for Microsoft Excel 21
overview area 8

P

package
displaying for formulas cells 86, 140, 169
loading most recent 24
refreshing 18, 52
package information 27
packages
changing 159, 169
GO Data Warehouse (analysis) 289
GO Data Warehouse (query) 290
GO Sales (analysis) sample 291
logging on 17
opening 17
overview 56
Sales and Marketing (Cube) 290
searching 51
percent calculations 66, 148, 151
percent change spreading method 104, 107
performance
TM1 data sources 277
personal workspace capability 98
Perspectives, See IBM TM1 Perspectives
PIAs (Primary Interop Assemblies)
installing subkeys 274
Planning Analytics for Microsoft Excel
clearing cache 22
overview 8
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Planning Analytics for Microsoft Excel (continued)
setting preferences 21
showing or hiding on the ribbon 10

Planning Analytics Workspace 78

port number 16

preferences

setting for IBM Planning Analytics for Microsoft Excel 21

Primary Interop Assemblies (PIAs) 274
private sets, See sets
private workspace, See sandboxes
processes
running 57
running with action buttons 185, 189
prompt values
report samples 292
prompts 170
proportional spread 27
proportional spreading method 104, 107
public sets, See sets
Publish (API function) 197
published documents
opening in Microsoft Office 275
unable to open from IBM Cognos Connection 275

Q

queries
compressing 171

Quick Report options
double-clicking 79

Quick Reports
adding comments to cells 108
adding members 76
automatic refreshing 77
changing the cube and datasource 80
clearing data 52
committing data 79
converting 82
converting to snapshot 53
copying and moving 54
creating 75
creating from views 75
deleting 78
editing data 79
overview 47, 74
publishing 54, 78
refreshing 52, 77
regions 75
replacing members 77
resolving data errors 108
setting options for committing data 109
spreading data 103
type-in refresh 77

R

raw XML 72,154

Rebuild(API function) 216, 222
RebuildSpecification (API function) 216
RECALC_0_0111

Refresh (API function) 207, 209
Refresh(API function) 216, 222
RefreshAllData (API function) 198




RefreshAllDataAndFormat (API function) 199
RefreshSelection (API function) 199
RefreshSheet (API function) 200
relational data
Exploration Views 252
relational data sources
using in a list 254
using in an Exploration View 251
repeat across leaves spreading method 104
repeat spreading method 104, 107
Replace (API function) 216
replacement system 21
ReplaceWithFormats (API function) 217
report samples 285
Report Studio
saving changes in a job 276
report types
overview 10
reports
cell-based with #NAME? errors 277
copying and moving 54
downloading 20
lists 254
opening and saving 18, 19
running IBM Cognos for Microsoft Office reports after
expired session 277
securing 22
unable to view reports in IBM Cognos for Microsoft
Office 279
request formats 171
Return Quantity by Product Line sample 290
Revenue Data Workspace sample 290
ribbon
IBM Planning Analytics tab 8
showing or hiding the IBM Planning Analytics tab 10
rollup calculations 66, 151
RowHierarchies (API function) 218
rows
calculated 66, 73, 151, 165
editing set in a Dynamic Report 85
inserting in a Dynamic Report 86
inserting into Exploration Views 65, 152
limiting 68, 157
nesting 65,153
sorting 67, 158
suppressing zeros 85
swapping with columns 67, 159
rows and columns
nesting 153

S

Sales and Marketing (Cube) package (samples) 290
Sample Outdoors Company
databases, models, and packages 288
samples 285
samples
Baselines 290
cubes 289
database, models, and packages 288
Employee Satisfaction Workspace 290
employees 287
GO data warehouse 288
GO Data Warehouse (analysis) package 289

samples (continued)

GO Data Warehouse (query) package 290

GO Sales (analysis) package 291
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